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Platform Administration Overview
This guide provides instructions on how to open, configure, and administer HP Business Service
Management (BSM).

The guide is divided into the following parts:

l Accessing and Navigating BSM. Describes how to start BSM, how to log into the application,
and a general overview of the user interface.

l Setup and Maintenance. Describes basic setup options such as infrastructure settings, time
zones, languages, logs, and backups.

l Data Enrichment. This part has the following sections:

n Location Manager - Describes how to work with multiple geographic locations.

n Content Packs - Describes how to define objects or CIs included in content packs monitored
by BSM.

n Downtime Management - Describes how to control system downtime.

l Users, Permissions, and Recipients. Describes how to control user access to BSM.

l Reports and Alerts Administration. Describes how to schedule reports and set up alerts.

l Troubleshooting. Discusses common system issues or limitations.
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Part 1

Accessing and Navigating BSM
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Chapter 1

BSM Administration
This section discusses how to start BSM, view the status of processes and services, and the
options in theWindows Start menu.
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How to Start and Stop BSM
To start or stop BSM in Windows:

Select Start > Programs > HP Business Service Management > Administration > Enable |
Disable Business Service Management. When enabling a distributed environment, first enable
the Data Processing Server, and then enable the Gateway Server.

To start or stop BSM in Linux:

/opt/HP/BSM/scripts/run_hpbsm start | stop

To start, stop, or restart BSM using a daemon script:

/etc/init.d/hpbsmd {start| stop | restart}

Note:When you stop BSM, the BSM service is not removed fromMicrosoft’s Services
window. The BSM service is removed from the Services window only after you uninstall BSM.
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How to View the Status of Processes and Services
You can view the status of the processes and services run by the BSM service and High
Availability Controller on the BSM server status HTML page.

To view the status of the processes and services, perform the appropriate procedure:

l Windows: Select Start > Programs > HP Business Service Management > Administration
> HP Business Service Management Status.

l Linux: Run opt/HP/BSM/tools/bsmstatus/bsmstatus.sh

l From a remote computer: Enter the URL http://<server-
name>:8080/myStatus/myStatus.html in a web browser.

Limitations:

l This page is only available remotely once the JBoss application server is up.

l If you configured JMX-RMI with basic authentication over SSLwas setup using the
SYSTEM user, this page will not display any data. For details, see Securing JMX-RMI Channel
Used for Internal BSM Communications in the BSMHardening Guide.
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Start Menu in Windows
During the installation of BSM in aWindows environment, a menu for BSM is added to the Start
Menu of themachine on which BSM is installed.

To access the BSM menu, select Start > Programs > HP Business Service Management.

Themenu includes the following options:

Administration
The Administrationmenu option includes the following sub-options:

Sub-
option Description

Configure
BSM

Runs the Setup and Database Configuration utility. This enables you to create and
connect to management, RTSM, RTSM history, and application databases/user
schemas onMicrosoft SQL Server or Oracle Server. For details, see Server
Deployment and Setting Database Parameters in the BSM Installation Guide.

Disable
BSM

Stops BSM on the specific machine, and disables it from being run automatically
when themachine is started.

Enable
BSM

Starts BSM on the specific machine, and sets it to be run automatically when the
machine is started.

BSM
Server
Status

Enables you to view the status of the services run by the BSM service and High
Availability Controller. For details on this HTML page, see Post-Deployment in the
BSM Installation Guide.

Documentation
The Documentationmenu option, available on the Gateway Server only, includes the following sub-
option:

Sub-option Description

BSM Documentation
Library

Opens the BSM Documentation Library home page in yourWeb
browser.

Open BSM

Select this option to open the BSM application login page in a web browser.
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Chapter 2

Logging into BSM
You can access BSM using a supportedWeb browser, from any computer with a network
connection (intranet or Internet) to the BSM servers. The level of access granted to a user depends
on the user's permissions. For details on granting user permissions, see "How to Assign
Permissions" on page 239.

BSM is by default configured with Lightweight Single Sign-On (LW-SSO). LW-SSO enables you to
log into BSM and automatically have access to other configured applications, without needing to log
into those applications. For details on how LW-SSO affects logging into BSM, see "Logging into
BSM with LW-SSO" on next page.

For details onWeb browser requirements, as well as minimum requirements to successfully view
BSM, see the BSM System Requirements and Support Matrixes.

Note: HP Software-as-a-Service customers access BSM using the HP Software-as-a-Service
support Web site (portal.saas.hp.com).
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Logging into BSM with LW-SSO
When Lightweight Single Sign-On (LW-SSO) Authentication Support is enabled, youmust ensure
that the other applications in the Single Sign-On environment have LW-SSO enabled and are
working with the same initString.

If you do not require Single Sign-On for BSM, it is recommended that you disable LW-SSO. You can
disable LW-SSO using one of the following utilities:

l The Authentication Strategy Wizard. For details on using the Authentication Strategy Wizard,
see "AuthenticationWizard" on page 345.

l The JMX console. For details on disabling LW-SSO through the JMX console, see
"Troubleshooting and Limitations" on page 35.

Once LW-SSO is disabled, the default BSM authentication service is automatically enabled. When
either LW-SSO is disabled, or the Identity Management Single Sign-On (IDM-SSO) or Lightweight
Directory Access Protocol (LDAP) authentication strategies are enabled, you do not need to enter
the syntax .<domain_name> in the BSM login URL
(http://<server_name>.<domain_name>/HPBSM).

For details on implementing either an IDM-SSO or LDAP authentication strategy, see
"AuthenticationWizard" on page 345.

For details on the requirements for logging into BSM, see "How to Log In andOut" on page 26.
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Advanced Login Options
Advanced login options enable you to automate login, provide direct login capabilities, limit login
access, and link to a specific page in BSM.

Advanced login options include:

l Automatic login. You can configure BSM so that after the initial login, you do not have to enter
a login name and password, but instead, the default page that is set to open for the user opens
automatically. For details, see "Enable Automatic Login in the Login Page" on page 27.

l Direct login capabilities. You can guide another user to a specific target page in BSM. For
details, see "Use the Link to This PageOption to Open a Specific Page" on page 28.

l Limiting login access. You can limit the number of machines accessing BSM using the same
login name. For details, see "Limit Access by Different Machines Using the Same Login Name"
on page 28.

l Linking to specific pages. You can guide another user to a specific target page in BSM by
creating a URLwith a user name, password, and information about the target page. For details,
see "Linking to a Specific Page" on next page.

HP Business ServiceManagement (9.20)Page 22 of 427



BSM Platform Administration Guide
Chapter 2: Logging into BSM

Linking to a Specific Page
You can guide another user to a specific target page in BSM by creating a URLwith a user name,
password, and information about the target page.

Depending on how you use the Link to this page option, the receiver accesses the page using one
of the following:

l His own user name and password.

l A URL encrypted with your user name and password.

l A URL encrypted with another user's user name and password.

If using an encrypted URL, the receiver bypasses the BSM login page because the URL supplies
the user name and password information.

The user name sent in the URLmust be an account with sufficient privileges to access the target
page. If the account does not have sufficient privileges, the receiver is sent to the page above the
target page.

For example, you want to direct the receiver to the Infrastructure Settings page, but you configure
the Link to this page option selectingUse Credentials of a regular user (who is not authorized to
view Infrastructure Settings). When the receiver uses this URL, he is sent to the Setup and
Maintenance page and is unable to access Infrastructure Settings.

The Link to this page option does not verify the user name and password sent in the URL.
Verification is done only when the receiver tries to access the target page. If the user name and
password are not correct, or the user account has been deleted, the receiver is sent to the BSM
login page to log in normally. Once logged in, the receiver does not proceed to the target page.
There is no informational message about the reason for the login failure.

To view Service Health or MyBSM pages in a third-party portal, select theEmbedded link
checkbox in the Link to this pagewindow. The generated URL can be used in a third-party portal,
so that only the specific page is displayed, and not the entire BSM application with menus.

Note: In a third-party portal, only one Service Health or MyBSM page can be embedded in
each portal page. If you need to seemore information, create a page which uses tabbed
components. For details, see How to Set Up theMyBSMWorkspace in the BSMUser Guide.

For details on the user interface for the Link to this page option, see "Link to This PageWindow"
on page 33.

Creating a Direct Link in the RTSM
You can create a link to a specific target page in the Run-time ServiceModel (RTSM) using the
Direct Links feature. For details on Direct Links, see "Generate a Direct Link - Overview" in the
Modeling Guide.

HP Business ServiceManagement (9.20)Page 23 of 427



BSM Platform Administration Guide
Chapter 2: Logging into BSM

Using the JMX Console
The JMX console comes embedded in BSM, and enables you to:

l Perform management operations

l View performance of processes

l Troubleshoot problematic areas of BSM

To access the JMX console, youmust first enter the relevant URL (http://<Gateway or Data
Processing Server name>:8080/jmx-console/, whereGateway or Data Processing Server
name is the name of themachine on which BSM is running), and enter the JMX console
authentication credentials.

The credentials to access the JMX console are configured when installing BSM and running the
Setup and Database Configuration utility. You can change the password but not the user name. For
details on changing the JMX password, see "How to Change the JMX Password" on page 29.

Note: The login name cannot be changed.

You canmonitor the availability of your BSM system on the HP Business ServiceManagement
server status HTML page. For details, see "How to View the Status of Processes and Services" on
page 18.

You can configure the JMX console to work with SSL, to encrypt JMX data for added security. For
details, see Configuring the Application Server JMX Console toWork with SSL in the BSM
Hardening Guide.
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BSM Login Flow
This section describes the general authentication flow in BSM:

1. A user accesses the login page and enters a principal (login name) and credentials (password)
and submits the login request (in this case, clicks Log In).

2. The request is transferred to the BSM AuthenticationManager together with the strategy name,
principal, and credentials. You configure an authentication strategy in the Authentication
Strategy wizard. For details, see "AuthenticationWizard" on page 345.

3. The AuthenticationManager reads the strategy name and dispatches the request to the
relevant authentication strategy to validate the user.

4. The relevant authentication strategy accepts the request and tries to authenticate the user
against the authentication service in question.

5. If authentication is approved, BSM verifies the user according to the selected strategy.

Note:When creating users in BSM, make sure that user names match the user names in
the relevant strategy database. A user cannot log into BSM if the name does not match.

6. If the user passes the previous steps, they are considered an authenticated user. The BSM
Site Map page is displayed in theWeb browser (or whichever page has been defined as the
default page).

If any of the steps fail, the user is notified (a page and error message are sent back to theWeb
browser). The page content and error message depend on which strategy you are
implementing.
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How to Log In and Out
You log into BSM from the login page.

When you have completed your session, it is recommended that you log out to prevent
unauthorized entry.

To access the BSM login page and log in:
1. In aWeb browser, enter the URL http://<server_name>.<domain_name>/HPBSM, where

server_name and domain_name represent the Fully Qualified Domain Name (FQDN) of the
BSM server. If there aremultiple servers, or if BSM is deployed in a distributed architecture,
specify the load balancer or Gateway Server URL, as required.

2. Enter the login parameters (login name and password) of a user defined in the BSM system,
and click Log In. After logging in, the user name appears at the top right of the page, under the
topmenu bar.

Initial access can be gained using the administrator user name ("admin") and password
specified in the Setup and Database Configuration utility.

Caution:

n It is recommended that the system superuser change this password immediately to
prevent unauthorized entry. For details on the user interface for changing the password,
see "General Tab (User Management)" on page 304.

n The login name cannot be changed.

For details on the user interface for creating users in the BSM system, see "Create User Dialog
Box" on page 302.

For details on login authentication strategies that can be used in BSM, see "Authentication
Strategies" on page 340.

For login troubleshooting information, see "Troubleshooting and Limitations" on page 35.

Note: For details on accessing BSM securely, see the BSMHardening Guide.

To log out of BSM:
Click Logout at the top of the page.

Note: Clicking Logout cancels the Automatic Login option. If a user has logged out, the next
time the user logs in, the Login page opens and the user must enter a login name and
password. This can be useful if another user must log in on the samemachine using a different
user name and password.
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How to Use Advanced Login Options
You can choose to enable advanced login options for BSM. For details, see "Advanced Login
Options" on page 22.

Enable Automatic Login in the Login Page
This task describes how to enable automatic login to BSM.

1. On the BSM login page, select Remember my login name and password for 14 days.

Caution: This could be considered a security risk and should be used with caution.

2. When completing your session, close the browser window. Do not click Logout at the top of
the page.

Clicking Logout disables the automatic login option and requires the login name and password
to be entered when again accessing BSM.

Note:When automatic login is enabled from the login page and the user enters the URL to
access BSM:

n The login page does not open.

n The login name and password do not have to be entered.

n The default page that is set to open for the user opens automatically.

Modify Automatic Login Settings — Optional
You can optionally modify the automatic login settings that you have configured.

1. Navigate toAdmin > Platform > Setup and Maintenance > Infrastructure Settings.

2. Choose Foundations, and select Security. In this context, you can:

n Customize the number of days to enable the option by editing theDays to remember login
value to the desired number of days (the default value is 14).

n Prevent the automatic login option from appearing on the login page by setting theEnable
automatic login value to false (the default value is true).

n Configure the number of machines that can simultaneously access BSM using the same
login name by configuring theMaximum machines per login name value (the default value
is 0). A value of 0means that the number of logins is unlimited.

For details on using the Infrastructure Settings page, see "Infrastructure Settings" on page 91.

Use the Automatic Login URL Mechanism
You can use a special URL, containing several parameters (including login name and password), to
access BSM and automatically log in.

Caution: Though convenient, this method is not secure since the password is not encrypted in
the URL.
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In aWeb browser, enter the following URL:
http://<server_name>.<domain_name>/<HPBSM_root_directory>/TopazSiteServlet?
autologin=yes& strategyName=Topaz&requestType=login&userlogin=
<loginname>&userpassword=<password>&createSession=true

where:

l server_name represents the name of the BSM server.

l domain_name represents the name of the user's domain according to his network
configuration.

l loginname and userpassword represent the login name and password of a user defined in
BSM.

To enable direct entry to BSM, bookmark the Automatic Login URL.

Use the Link to This Page Option to Open a Specific Page
Use the Link to this page option to guide another user to a specific target page in BSM. Link to
this page creates a URLwith a user name, password, and information about the target page.

Depending on how you configure the parameters in the Link to this page dialog box, the receiver
accesses the target page using his own user name and password, or through a URL encrypted with
either your user name and password or another user's user name and password. You can send this
URL by email or SMS to another user. If accessing the page through an encrypted URL, the
receiver bypasses the BSM login page because the URL supplies the user name and password
information. For details, see "Link to This PageWindow" on page 33.

Limit Access by Different Machines Using the Same Login Name
BSM can be accessed using the same login name from different machines. The number of
machines accessing BSM using the same login name can be limited using the Infrastructure
Settings page.

Tomodify theMaximum machines per login name value in Infrastructure Settings:

1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.

2. Choose Foundations.

3. Select Security.

4. Locate theMaximum machines per login name entry, andmodify the value to the number of
machines you want to enable to access BSM using the same login name. The default value is
zero (0), which enables limitless logins.

If themaximum value has been reached when a user tries to log into BSM, the user receives a
login error message and is unable to log in.

For a limitation of this feature, see "Troubleshooting and Limitations" on page 35.

Open an Application Page Using a URL
You can open a specific BSM page directly in your browser by using a URL. For details, see
"Linking to a Specific Page" on page 23.
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How to Change the JMX Password
This task describes how to change the JMX password.

1. Stop the BSMGateway or Data Processing Server.

2. Run the file <HPBSM root directory>\tools\jmx\changeCredentials.bat on either the
Gateway or Data Processing Server.

The Change Password dialog box opens, where you enter and confirm your new password. The
password change is registered and encrypted on either the Gateway or Data Processing Server.

3. Restart BSM.

Note: The login name cannot be changed.
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How to Create a Keystore Certificate
This task describes how to create a keystore certificate if you do not already have one.

1. Run cmd.exe to open a Command Prompt window.

2. Run the following command to generate the keystore file:

keytool -genkey -dname "CN=YourName,OU=yourDepartment,

O=yourCompanyName,L=yourLocation,S=yourState, C=yourCountryCode" -

alias <youralias> -keypass changeit -keystore "<keystore location>"

-storepass changeit -keyalg "RSA" -validity 360

For example:

keytool -genkey -dname "CN=John Smith, OU=FND, O=HP, L=Los Angeles,

ST=Unknown, C=USA" -alias john -keypass mypassword -keystore

"D:\HPBSM\JRE\lib\security\cacerts" -storepass changeit -keyalg

"RSA" -validity 360

3. The keystore certificate is generated in the location you specified in the
-keystore parameter.

4. Restart BSM.
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How to Track Login Attempts and Logged In Users
To track who has attempted to log into the system:

View <HPBSM root directory>\log\EJBContainer\UserActions.servlets.log.

The appender for this file is located in <HPBSM root
directory>\conf\core\Tools\log4j\EJB\topaz.properties

To display a list of users currently logged in to the system:

1. Open the JMX console on this machine. (For detailed instructions, see "Using the JMX
Console" on page 24.)

2. Under the Topaz section, select service=Active Topaz Sessions.

3. Invoke the java.lang.String showActiveSessions() operation.
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Security Notes and Precautions
This section describes security notes and precautions to be aware of when using Direct Login to log
into BSM:

l The user name and password in the URL are encrypted so that no login information is ever
revealed.

l Sending encrypted information by email still entails a security risk, since themail system can be
breached. If the email is intercepted, access to BSM is given to an unknown party.

l Do not use the URL from Direct Login as a link in any Web page.

l The receiver has all privileges of the user name he was given in the URL. Once the receiver
accesses the target page, he can perform all actions permitted to that user name anywhere in
BSM.
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Logging into BSM User Interface
This section includes:

l "BSM Login Page" below

l "Link to This PageWindow" below

BSM Login Page
This page enables you to log into BSM.

To access In aWeb browser, enter the URL http://<server_name>.<domain_
name>/<HPBSM root directory>, where server_name is the name or IP
address of the BSM server, and domain_name is the name of the user's domain
according to his network configuration.

Important
information

If Lightweight Single Sign-On (LW-SSO) is disabled, you do not need to add the
.<domain_name> syntax in the login URL.

Relevant
tasks

"How to Log In andOut" on page 26

See also "Logging into BSM with LW-SSO" on page 21

User interface elements are described below:

UI Element (A-Z) Description

Login Name Enter the relevant login name to access BSM.

Password Enter the relevant password to access BSM.

Remember my login
name and password
for 14 days

Select to enable BSM remember your login name and password for 14
days. Login credentials are automatically entered in future login
sessions when this option is selected.

Link to This Page Window
This window enables you to guide another user to a specific target page in BSM.

Note: By default only administrators have security rights to access this feature.

To access Select Admin > Link to this page.

Relevant tasks "How to Use Advanced Login Options" on page 27

See also "Advanced Login Options" on page 22

"Generate a Direct Link User Interface" in theModeling Guide.

User interface elements are described below:

HP Business ServiceManagement (9.20)Page 33 of 427



BSM Platform Administration Guide
Chapter 2: Logging into BSM

UI Element
(A-Z) Description

Cancel Cancels the Link to this page operation.

Create
Link

Creates a URL for the user to enter into their browser and displays the specified
BSM page.

Note: If you select this option after selectingNo Credentials or Use credentials
(to use credentials other than your own) and you want to invoke the login URL on
the same local machine you created it on, youmust first log out of BSM.

Confirm
password

Re-enter the password entered in thePassword field.

Copy to
Clipboard

Copies the content of the Link field to the clipboard.

Note: If you use the Firefox browser, youmust change your security settings for
this option to work. Enter about:config in the browser's search window, locate
the signed.applets.codebase_principal_support option, and set it to true.

Embedded
link

Displayed in Service Health andMyBSM only.

Select this checkbox to create a URLwhich can be used in a third-party portal, so
that only the specific page is displayed, and not the entire BSM application with
menus.

Generate
HTML

Generates an HTML page for the specified BSM page.

Note: If you select this option after selectingNo Credentials or Use credentials
(to use credentials other than your own) and you want to log in using the generated
HTML page on the same local machine you created it on, youmust first log out of
BSM.

Link The URL that the receiver uses to access the specified BSM page.

Login
name

The login name to be encrypted in the URL the receiver uses to access the
specified page. This must be the login name of an actual user.

My
credentials

Select if the link is to be encrypted with your login name and password.

No
credentials

Select if the receiver uses his own login name and password to access the page
specified in the link.

Password The password to be encrypted in the URL the receiver uses to access the
specified page. This must be the password of an actual user.

Use
credentials

Select if the link is to be encrypted with the login name and password of another
user.
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Troubleshooting and Limitations
This section describes troubleshooting and limitations for logging into BSM.

Login Troubleshooting
Reference the possible login failure causes using the error number shown in the error alert dialog
box. For additional troubleshooting information, refer to the HP Software Self-solve Knowledge
Base.

Error
No. Problem/Possible Cause(s) Solution(s)

LI001 BSM failed to connect to the JBoss
application server running on the
Gateway Server. This may be due
to:

l the JBoss server being down

l problems with the BSM service

l the port required by the
application server being used by
another application

Solution 1:Close all applications on the
Gateway Server machine and restart the
machine.

Solution 2:Ensure that there are no other
running applications on theGateway Server
machine that use this port (for example,
applications that run from the Startup directory,
another instance of JBoss, anMSDE or
Microsoft SQL Server, or any other process).

LI002 The JBoss application server running
on theGateway Server is not
responding or is not installed
correctly.

Restart the BSMapplication.

LI003 Themanagement database is
corrupted (for example, if a user
record was accidentally deleted from
the database).

Try logging in as a different user, or ask the
BSMadministrator to create a new user for you.

LI004 The connection between the Tomcat
servlet engine and the JBoss
application server failed due to a
RemoteMethod Invocation (RMI)
exception. This may be due to
problems in RMI calls to JBoss.

Ensure that none of the JBoss ports are in use by
another process. Also, ensure that the RMI ports
are bound.

For details on ports, see "Port Usage" on page
138.
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Error
No. Problem/Possible Cause(s) Solution(s)

LI005 The BSMlogin fails or hangs. This
may be due to:

l an incorrect login name/password
combination

l inability to connect to the
management database

l current user does not have
access rights to any profile

l authentication strategy has not
been set/configured correctly

Solution 1:Ensure that you or the user enters a
correct login name/password combination.

Solution 2:Ensure that the connection to the
management database is healthy. To do so:

1. In aWeb browser, type
http://<Gateway or Data Processing
Server name>:8080/jmx-
console/index.html
to connect to the JMX management console.

2. Click the link System > JMX MBeans >
Topaz > Topaz:service=Connection Pool
Information.

3. Locate java.lang.String
showConfigurationSummary()and click
the Invoke button.

4. InActive configurations in the
Connection Factory, find the appropriate
row for themanagement database.

5. Verify that columns Active Connection
and/or Idle Connection have a value greater
than 0 for themanagement database.

6. If there is a problem with the connection to
the database, verify that the database
machine is up and running; if required, rerun
the Setup and Database Configuration utility.

Solution 3:Ensure that the user has appropriate
permissions to access BSM. For details on user
permissions, see "Permissions" on page 223.

Solution 4:Verify that an authentication strategy
has been configured correctly. For details on
authentication strategies, see "Authentication
Strategies" on page 340.
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Error
No. Problem/Possible Cause(s) Solution(s)

LI006 The BSMlogin fails. This may be due
to:

l Incorrect cookie settings in the
Web browser

l An unsupported character in the
names of themachines running
the BSMservers

Solution 1:Ensure that the client Web browser
is set to accept cookies from BSMservers.

Solution 2:Ensure that there are no underscore
characters (_) in the names of themachines
running the BSMservers. If there are, either
rename the server or use the server's IP address
when accessing themachine. For example, to
access BSM, use:
http://111.222.33.44/<BSM root

directory>

instead of
http://my_server/<BSM root

directory>

LI007 The BSMlogin fails. This is because
themaximum number has been
reached of concurrent logins from
different machines that access
BSMusing the same login name.

Solution 1: Log out of the instances of BSMthat
have logged in using the same login name from
different machines. You can then retry logging in,
if themaximum number has not been reached.

Solution 2: Log in using a different login name, if
available.

Solution 3: The administrator can edit the
Infrastructure Settings to remove the limitation or
increase themaximum number of concurrent
logins using the same login name from different
machines.

To edit this setting:
1. Select Admin > Platform > Setup and

Maintenance > Infrastructure Settings.

2. Choose Foundations, select Security and
locate theMaximum machines per login
name entry in theSecurity - Login table.

3. Modify the value as required.

The default value is 0, which enables unlimited
logins.

Limiting Access by Different Machines Using the Same Login Name
Limitation
In certain network configurations wheremultiple clients are funneled through a default Gateway or
Proxy server, the IP address resolved to BSM is that of the Gateway or Proxy server and not the IP
address of the client. As a result, BSM treats each client as coming from the same IP address.
Since the number of logins from the samemachine (IP address) is not limited, all of the clients can
log into BSM.
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Configuring the JMX Console to Work with SSL Limitations
After configuring the JMX console to work with SSL, it is not possible to access the \<BSM root
directory>\AppServer\webapps\myStatus.war\myStatus.html page to view the availability of
BSM.

Resetting LDAP/SSO Settings Using the JMX Console
If your LDAP or SSO settings have not been configured properly, youmay be prevented from
accessing BSM. If this happens, youmust reset your LDAP or SSO settings remotely using the
JMX console in the Application server that comes with BSM.
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Navigating and Using BSM
BSM runs in aWeb browser. Youmove around BSM using the following navigation functions:

l Site Map. Enables quick access to all top-level contexts in the Applications menu or the
Administration Console. The Site Map is the first page that opens, by default, after logging into
BSM. If the default page is changed after login, you can access the Site Map by clicking theSite
Map link, either on the topmenu or from the Helpmenu.

l Menu Bar. Enables navigation to the applications, Administration Console pages, help
resources, and a link to the Site Map.

You can click the Full Screen View link to display the current page over the full screen. When
selecting Full Screen View, the Task Assistant (if displayed), Menu Bar, Breadcrumbs, and Tabs
are hidden. To return to the standard view of the page, click Standard View or press Esc on your
keyboard.

Additionally,there is a Logout button on the top right corner of the page.

l Tabs. Enable navigation to various contexts within a particular area of BSM, such as to different
types of reports within an application, views within a report, or administrative functions within
the Administration Console. In certain contexts, tabs are used to distinguish between functions;
in other contexts, tabs are used to group logically similar functions or features together.

l Tab main menus. Enable navigation from a tab front page to various contexts related to the tab.
Tabmainmenus appear when selecting a tab that represents a category containing several
contexts, such as report types or administrative settings. Tabmainmenus include a description
and thumbnail image of each tab context.
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l Tab controls. Assist in navigation from any context related to a tab to any other of the tab's
contexts. To open the tabmainmenu, click the tab name.

To quickly jump to another context related to the tab, move your pointer over the tab and click the
down arrow to open the tab dropdownmenu. Click a tabmenu option tomove to that context.

l Navigation buttons.

Forward and back buttons, positioned in the upper left corner of the window, enable to you to
navigate between viewed pages. You can go back to themost recently viewed page or forward
to the previously viewed page before clicking the back button.

l History.

You can select from a dropdown list of pages that are now stored in history. It is enabled by
selecting the down arrow adjacent to the forward and back navigation buttons. This history is
composed of the latest contexts you have viewed. You can view up to twenty viewed pages.

The pages stored in history are those that BSM has stored in its server. For all reports, if you
return to a previously viewed page, the page opens exactly as you left it with the filters and
conditions selected as previously.

There are several pages whose contexts and selections are not saved as previously viewed and
when you return to that page, youmay have tomake your selections again. For example, if you
were working in a specific context in Infrastructure Settings and return to the Infrastructure
Settings page using the history option, your context has not been saved and you are returned to
the default Infrastructure Settings page.

Tip: You can change the number of pages stored in history (default is twenty) by accessing
the file <HPBSM root directory>\conf\settings\website.xml and changing the value
of the history.max.saved.pages field. This change is on the server and, therefore,
affects all users.

l Breadcrumbs. Enable returning to previous pages within amulti-level context by clicking the
appropriate page level. For example, in the following breadcrumb trail, you would click
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Breakdown Summary to return to the Breakdown Summary report:

If the breadcrumb is longer than the width of the screen, only the tail of the breadcrumb is

displayed. Click theView icon to the left of the breadcrumb to display the hidden portion of
the breadcrumb in the current tab.

Tip: TheWeb browserBack function is not supported in BSM. Using theBack function
does not always revert the current context to the previous context. To navigate to a
previous context, use the navigation buttons within BSM or the breadcrumb function.
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User Interface Enhancements
The BSM interface includes many features to enhance the user experience. These include:

l Section 508 compliance. BSM is compliant with the accessibility and usability standards for
people with disabilities set by the US Federal Electronic and Information Technology
Accessibility and Compliance Act ("Section 508"), and supports the JAWS® screen reader.

JAWS users should change theUser Accessibility setting from false to true. To do this:

n Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.

n Select Foundations.

n Select Business Service Management Interface.

n In theBusiness Service Management Interface - Display area, locateUser Accessibility.
Change the value to true.

l Personalization. BSM remembers from one session to the next adjustments to tables (such as
columnwidth and column visibility) that you canmake in a variety of applications and features,
such as recipient management, reports management, reports, and report scheduling.

Note: If two or more users are logged in simultaneously with the same credentials, BSM
may not remember their personalized settings.

l Table functionality. You canmanipulate tables in BSM in a number of ways. A variety of
controls enable, for example:

n Filtering. BSM tables include various filtering options. For advanced editing of filters, click

.

n Sorting. Click on a column heading to sort by that column. Sort order changes between
ascending and descending each time you press the column heading.

n Selecting columns. Click to choose which columns to display.

n Changing column width. Drag a column heading border to the left or right to modify column

width. Click to reset columnwidth to its original state.

n Changing column order. Drag a column heading to the left or right to change column order.

n Paging. Use buttons on the page control to move to a table's first,
previous, next, or last page.

n Exporting. Click the appropriate button to export a table to another format, such as Excel

, PDF or CSV .

For details about table functionality in reports, see CommonReport and Page Elements.

Note: Not all tables support all table functionality.
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l Customization of the masthead title and logo. You can customize the header text of the
application title and themasthead logo (HP logo by default) displayed in the upper left-hand
corner of the BSMwindow. This change is made on the server side and affects all users
accessing BSM. For details, see "How to Customize theMasthead Title and Logo " on next
page.

l Session expiration. By default, a ping-to-server mechanism, calledSession Keepalive,
prevents your BSM session from timing out when not in active use. You can enable automatic
session expiration by disabling Session Keepalive.

To disable Session Keepalive, select Admin > Platform > Setup and Maintenance >
Infrastructure Settings:

n Select Foundations.

n Select Business Service Management Interface.

n In theBusiness Service Management Interface - Timing area, locateEnable Session
Keepalive. Change the value to false.
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How to Customize the Masthead Title and Logo
To change the header text and logo:

1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.

2. Select the Foundations context.

3. Select Business Service Management Interface from the list.

4. In theBusiness Service Management Interface - Customized Masthead table, change the
following:

n In theCustomized Masthead Application Title, enter the text to use as the title for the
application. Business ServiceManagement appears by default if there is no value defined for
this field. You can use html coding to enter the text but do not include any scripts. If you using
html, verify its validity before saving.

n In theCustomized Masthead Logo URL, enter the URL of the file containing the logo you
want to appear at the top of the window. The HP logo appears by default if there is no value
defined for this field. It is recommended to use an image with a height of 19 pixels. If the
image is higher, it does not appear correctly in themasthead.

Once youmodify these settings, the changes appear as soon as the browser is refreshed.
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Client Requirements for Viewing BSM
The following table describes minimum and recommended client system requirements for viewing
BSM:

Display Minimum: color palette setting of at least 256 colors

Recommended: color palette setting of 32,000 colors

Resolution l 1280x1024 or higher (supported)

l 1400x1200 or higher (recommended)

Supported Browsers l Microsoft Internet Explorer (IE) 9.0

l Microsoft Internet Explorer (IE) 8.0

l Microsoft Internet Explorer (IE) 7.0

l Mozilla Firefox ESR 10.0

Note:

l The browser must be set to accept all cookies.

l The browser must be set to enable JavaScript execution.

l The browser must support for pop-up windows. HP Business Service
Management will not perform properly if you useWeb applications
that are set to block pop-up windows in your browser.

l Internet Explorer users must set browser caching to automatically
check for newer versions of stored pages.

Flash Player Adobe Flash 10.1 or later

Fonts The following fonts must be installed on client systems:

l MS Gothic for Japanese locales

l Gulim for Korean locales

l SimSun for simplified Chinese locales

l Arial for all other locales
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Java Plug-in (to view
applets)

Recommended:Version 6 update 31

Supported:Version 6 update 26 and higher, or version 7

Note:Youmay not be able to view all HP Business Service
Management applets with an earlier version of Java and you will need to
download the latest version from the Java download site
(http://www.java.com/en/download/manual.jsp) and install it. Youmay
also have to disable earlier versions after download.

To do this in Internet Explorer: Select Tools > Internet Options >
Advanced tab, locate the Java (Sun) item and select the check box for
the correct Java version, click OK, close the browser, and reopen it.

For details about how to verify the Java version in Mozilla Firefox, see
theMozilla Firefox documentation.

Viewing the
Documentation
Library

The Documentation Library is best viewed in Internet Explorer.

The Documentation Library is best viewed from a browser with Java
support. If your browser does not have Java support, download the Sun
Java plug-in from the Sun JavaWeb site (http://java.com/en/index.jsp).
Note that if Java support is not available, the Documentation Library
automatically opens using the JavaScript implementation. The
JavaScript implementation provides the same basic functionality as the
Java implementation, however does not allow use of the Favorites tab
within the navigation pane.

If you experience a JavaScript error when opening the Documentation
Library, disable the Show Exception Dialog Box in the Java Console and
open the Help again.

Tip for users having trouble opening Java applets:

If you are having trouble opening Java applets in the user interface, try one or both of the
following:

l If you are using Internet Explorer, select Tools > Internet Options > Connections > Local
Area Network (LAN) Settings. Clear the following options: Automatically detect
settings andUse automatic configuration script.

l Select Control Panel > Java > General tab > Network Settings > Select Direct
connection option (instead of the default option to Use browser settings).
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Menus and Options
The topmenu bar enables navigation to the following applications and resources:

MyBSM
Opens theMyBSM application, a portal that individual users can customize to display key content
relevant to them. For details, see UsingMyBSM in the BSMUser Guide.

Business User Applications
BSM features the business user applications listed below. You access all applications from the
Applicationsmenu, except for theMyBSM application which is accessed from the topmenu bar.

Menu Option Description

Service
Health

Opens the Service Health application, a real-time dashboard for viewing
performance and availability metrics from a business perspective. For details,
see Service Health Overview in the BSMUser Guide.

CI Status Opens the CI Status Reports interface. For details, see CI Status Reports User
Interface in the BSMUser Guide.

Service
Level
Management

Opens the Service Level Management application to proactively manage service
levels from a business perspective. Service Level Management provides IT
Operations teams and service providers with a tool to manage service levels and
provide service level agreement (SLA) compliance reporting for complex
business applications in distributed environments. For details, see Service Level
Management Application Overview in the BSMUser Guide.

End User
Management

Opens the End User Management application, used tomonitor applications from
the end user perspective and analyze themost probable cause of performance
issues. For details, see End User Management Reports Overview in the BSM
User Guide.

Operations
Management

Opens theOperations Management application, used to proactively manage
events from a business perspective, in order to restore services andminimize
service disruptions. For details, seeOperations Management Orientation in the
BSMUser Guide.

Transaction
Management

Displays transaction topology and infrastructure for data collection and report
viewing. For details, see Introducing TransactionManagement Reports and
Topologies in the BSMUser Guide.

System
Availability
Management

Opens the System Availability Management application, used for complete
system and infrastructuremonitoring as well as event management. For details,
see Using System Availability Management Overview in the BSMUser Guide.

Service
Health
Analyzer

Opens the Service Health Analyzer application, used to view CIs with
anomalies. For further information, see Service Health Analyzer Overview in the
BSMUser Guide.
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Menu Option Description

User
Reports

Opens the Report Manager, used for creating and saving user reports—
customized reports containing user-defined data and formatting that can help you
focus on specific aspects of your organization's application and infrastructure
resource performance. For details on the Report Manager, see Reports
Overview in the BSMUser Guide.

Administration Console
Administrators use the Administration Console to administer the BSM platform and applications.
The Administration Console consists of several sections, organized by function. You access each
functional area from theAdminmenu. You select from the followingmenu options:

Menu Option Description

Service Health Opens the Service Health Administration pages, where you attach Key
Performance Indicators (KPIs) to CIs, define the custom and geographical
maps, and customize the repositories. For details, see Service Health
Administration - Overview in the BSM Application Administration Guide.

Service Level
Management

Opens the Service Level Management Administration pages, where you
create service agreements (SLAs, OLAs, UCs) and build services that link to
the data that Service Level Management collects. For details, see Service
Level Management Administration Overview in the BSM Application
Administration Guide.

Operations
Management

Opens theOperations Management Administration pages. For details, see
Setup in the BSM Application Administration Guide.

End User
Management

Opens the End User Management Administration pages, where you configure
and administer Business Process Monitor and Real User Monitor data
collectors, as well as configure transaction order, color settings, and report
filters. For details, see End User Management Administration in the BSM
Application Administration Guide.

System
Availability
Management

Opens the System Availability Management Administration pages, where you
configure and administer the SiteScope data collector. For details, see SAM
Administration Overview in the BSM Application Administration Guide.

RTSM
Administration

Opens the RTSM Administration pages, where you build andmanage amodel
of your IT universe in the Run-time ServiceModel (RTSM). From RTSM
Administration, you use Data Flow Management and the adapter sources that
are used to populate the IT Universemodel with configuration items (CIs), the
templates for creating CIs, and the viewing system for viewing the CIs in BSM
applications. You can alsomanually create CIs to add to themodel. For
details, see theModeling Guide.
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Menu Option Description

Business
Service
Management
for Siebel
Administration

Opens the ApplicationManagement for Siebel Administration page.

Platform Opens the Platform Administration pages, which provide complete platform
administration and configuration functionality. .

Integrations Opens the BSM Integrations administration area, where you can administer
the following:

• BSM Connector integrations to capture and forward data from third-party
systems to BSM.

• Mappings between CIs andOperations Orchestration runbooks.

• Application Lifecycle Management integrations to export related data and
monitoring tools configurations.

• Deprecated integrationmethods - Integrations Adapter and EMS
Integrations.

For details, see Integrating with Other Applications - Overview in the BSM
Application Administration Guide.

Link to this
page

Select to access the Link to this page feature, where you can create a URL
that enables direct access to a specific page in BSM. For details, see "Link to
This PageWindow" on page 33.

Note: By default only administrators have security rights to access this
feature.

Personal
Settings

Select to access the Personal Settings tab, which enables personalization of
various aspects of BSM, includingmenus and passwords. Note that Personal
Settings are available to all users. For details, see "Personal Settings" on
page 333.

Help Menu
You access the following online resources from the BSMHelpmenu:

Menu Option Description

Help on this
page

Opens the Documentation Library to the topic that describes the current
page or context.

Documentation
Library

Opens the Documentation Library home page. The home page provides
quick links to themain help topics.
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Menu Option Description

Diagnostics
Help

Opens the Diagnostics Help, if an Diagnostics server is connected to BSM.

Troubleshooting
& Knowledge
Base

Opens the HP Software Support Web Site directly to the troubleshooting
landing page (required HP Passport login). The URL for this Web site is
http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software
Support

Opens the HP Software Support Web Site. This site enables you to browse
the knowledge base and add your own articles, post to and search user
discussion forums, submit support requests, download patches and updated
documentation, andmore. The URL for this Web site is
http://www.hp.com/go/hpsoftwaresupport.

HP Software
Web Site

Opens the HP SoftwareWeb site, which contains information and resources
about HP Software products and services. The URL for this Web site is
http://www.hp.com/go/software.

Task Assistant Opens the Task Assistant, which assists in accomplishing specific tasks by
listing the task steps and providing links to the relevant Help topics for each
step.

Site Map Opens the site map, which enables quick access to all top-level contexts in
the Applications menu or the Administration Console.

Note: The Site Map is the default entry page when you log into BSM. Click
Change the default page on the Site Map to open the Personal Settings tab
and select a different entry page. For details on configuring Personal
Settings, see "Personal Settings" on page 333.

What's New? Opens theWhat's New document, which describes the new features and
enhancements of the version.

About HP
Business
Service
Management

Opens the About HP Business ServiceManagement dialog box, which
provides version, license, patch, and third-party notice information.
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Downloads
After the servers for BSM are installed, there are several components that must be downloaded.
These components include tools for monitoring your enterprise and recording business processes.

To view and download components from the Downloads page after installing BSM, youmust install
the data collector setup file. For details, see "Installing Component Setup Files" in the BSM
Installation Guide.
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Tasks
How to Download Components
This task describes how to download components on the Download Components page:

1. Click the component you want to download.

2. Save the component's setup file to your computer.

3. Run the component's setup file to install the component.
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UI Components
Download Components Page

This page lists the BSM components available for download, including tools for monitoring your
enterprise and recording business processes.

To access Select Admin> Platform > Setup and Maintenance > Downloads

Important
information

l You can filter the downloadable components either by category or by system.

l Since some files run immediately when you click to download them, right click
the file you want to download, select Save Target As, and choose the location
in which you want to save the file.

User interface elements are described below:

UI Element (A-Z) Description

Resets the table columns' width to its default setting. You
can adjust the width of the table's columns by dragging
the borders of the column to the right or the left.

Opens the Select Columns dialog box enabling you to
select the columns you want to be displayed on the table.

Divides the table of data into pages. Youmove from page
to page by clicking the relevant button:

l To view more reports, click Next page or Last page.

l To view previous reports in the list, click Previous
page or First page.
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UI Element (A-Z) Description

Category The downloadable component's category. Available
categories are:

l Business Process Insight. Downloadable files that
enable you to install and run Business Process Insight
components on BSM.

l Business Process Monitor. Downloadable files that
enable you to install and run Business Process Monitor
components on BSM.

l Data Flow Probe. The Data Flow Probe
downloadable file that enables you to install and run
the Data Flow Probe component on BSM.

l Diagnostics. Downloadable files that enable you to
install and run Diagnostics components.

l Other. Used for other applications for download. If you
see no applications listed for this category, there are
none available.

l Real User Monitor. Downloadable files that enable
you to install and run Real User Monitor components.

l SiteScope. The SiteScope downloadable file that
enables you to install and run SiteScope components.

Note:Ensure that you have selected the file that
corresponds to your operating system.

l TransactionVision. Downloadable files that enable
you to install and run TransactionVision components.

l TransactionVision or Diagnostics. Downloadable
files that enable you to install and run the HP
Diagnostics/TransactionVision Agent for Java file.

Description An explanation of the specific downloadable file.

Document A link to the PDF describing the component.

Note:Not all components have a corresponding PDF
document available.

File Name The name of the specific file available for download.

System The operating system onwhich BSM components are to
run.
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License Management
Youmust have a valid license to runmonitors and transactions, and to use various integral
applications in BSM.

The BSM license enables you to simultaneously run a predetermined number of monitors and
transactions for a specified period of time. The number of monitors and transactions that you can
run simultaneously, the specific applications that you can run, and the license expiration date, all
depend on the license your organization has purchased from HP.

The initial licensemay be installed only in the configuration wizard, during the installation process.

BSM posts a license expiration reminder after the login page of theWeb site (for administrators
only), 15 days before license expiration.

A number of BSM applications require additional licensing. To use these applications, youmust
obtain a license from HP and then upload the license file in BSM. For specific information on the
Operations Manager i (OMi) licensing structure, see Licensing in the BSMUser Guide.

To access
To open the LicenseManager Page, select Admin > Platform > Setup and Maintenance >
License Management.

To review the status of your license, select Admin > Platform > License Management.
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Tasks
Add a new license
To update your deployment with a new license:

1. Select Admin > Platform > Setup and Maintenance > License Management.

2. Click Add license from file to open the Add license dialog box where you can search for the
relevant .dat file. The file is uploaded from the client machine to the BSM server.

3. At the bottom of the LicenseManagement page, click theServer Deployment link.

HP Business ServiceManagement (9.20)Page 57 of 427



BSM Platform Administration Guide
Chapter 5: LicenseManagement

UI Description
LicenseManager Page

UI Element Description

Add License. Opens the Add License dialog box.

Use the dialog box to upload a license file. Youmust determine the location of the
license file. These files are data files and end in .DAT.

Name This is the name of the licensed feature. It includes an association to the product
resource with which it was bundled.

License
Type

There are three types of licenses:

l Evaluation:A license with a fixed trial period of up to 60 days.

This type of license is available only until a Time Based or Permanent license is
purchased. Once purchased, the trial period immediately terminates.

Note: An Evaluation License cannot be renewed.

l Time Based: A license which has a time-based expiration date.

l Permanent:A license which does not expire.

Days Left Displays the number of days that the licensemay continue to be used.

When green, expiry time is pending; when red, the license is expired.

Expiration
Date

Displays the license's fixed expiration date.

This date is displayed only for time-based licenses.

Capacity If the license is capacity based, the amount of capacity available and the amount
of capacity used will be expressed by means of a status bar.

Available when:

This feature is available when the license is capacity based. If the license is not
capacity based, the words Not Applicable will appear in the capacity column.

Capacity
Details

If the license is capacity based, the amount of capacity available and the amount
of capacity used will be expressed by means of a ratio.

Available when:

This feature is available when the license is capacity based. If the license is not
capacity based, the words Not Applicable will appear in the capacity column.

Server
Deployment
Link

When you add a license to BSM, youmust enable the application in the Server
Deployment page. This includes a check to see whether the physical resources
of your deployment can handle the added application.

For details, see "Server Deployment" on page 60.
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Tips/Troubleshooting
Manual License Activation
Some licenses are not automatically activated upon installation. These licenses must be activated
for specific use and do not run at all times. To activate such a license, click theServer
Deployment link at the bottom of the LicenseManager pane.

Installed Licenses and Server Deployment
Although a particular license is installed, youmay find that not all features offered by the license are
available to you. This can be a result of how these features are configured in BSM. You can
configure these on the BSM Server Deployment page, available by clicking theServer
Deployment link at the bottom of the LicenseManager pane, or by running the BSM Setup and
Database Configuration Utility. For details, see "Server Deployment and Setting Database
Parameters" in the BSM Installation Guide.

Tip: Make sure that the enabled application always matches the installed licenses.
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Server Deployment
This section provides information about how to determine and configure the optimal BSM server
deployment.

To access
Select Admin > Platform > Setup and Maintenance > Server Deployment
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Learn More
Server Deployment Overview
BSM is composed of many applications and subsystems that consume hardware and software
resources. The available applications answer a variety of use cases, not all of which are required by
every user. You can align the deployment of the BSM servers with your company's business
requirements.

BSM's Server Deployment page provides amechanism to deploy only the applications required by
your company. You can determine the required hardware according to the required capacity for your
specific deployment. The Server Deployment feature displays exactly how much hardware
capacity you need for your deployment and enables you to free up unused resources.

The Server Deployment page is available both in the Setup and Database Configuration utility that
is run once BSM servers are installed, and in the Platform Admin area of the BSM interface. This
enables you to update your deployment, enable or disable applications as needed, and adjust your
deployment's capacities even after installation is complete and any time you have adjustments to
make to your BSM deployment. You can enable or disable applications as needed so as not to use
any unnecessary resources in your deployment.

Capacity Calculator
You can use the capacity calculator Excel sheet to determine the scope and size of your BSM
deployment. You input the information regarding the scope of your deployment in terms of numbers
of applications running, users, and expected data. The capacity calculator then calculates the
requiredmemory, CPU cores, and determines the size of your deployment. If you aremaking any
change to your deployment, for example adding a license for an application, you use the information
in the capacity calculator to determine your hardware requirements and deployment configuration.

You can upload a file that has been saved with your data directly into the Server Deployment page.
This enables you to automatically populate the fields in the page with the data as you entered it into
the Excel sheet.

If you used the file when you first installed BSM, use your saved version whenever you need to
make any changes to your deployment. If you do not have your own version, the file can be found in
theDocumentation folder in themain BSM installation DVD, or you can download the latest
version from the HP Software Product Manuals Web site
(http://h20230.www2.hp.com/selfsolve/manuals).

You enter the information regarding your deployment in theDeployment Calculator sheet of the
file. In theCapacity Questionnaire columns, include information such as applications and size
and theOutput tables automatically calculate the hardware and software requirements. Make sure
to save the file in a location from which you can upload it to the Server Deployment page. It is
recommended that youmake a copy of the file each time before updating it.

When you update the capacity calculator, you are not making any changes to your deployment. You
use the capacity calculator to update the values in the Server Deployment page. Only changing
values and clickingSave in the Server Deployment page actually updates your deployment.
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Tasks
How to Update Your BSM Licenses, Applications, or Deployment Scope
This task describes how tomake changes to your server deployment.

1. Use the capacity calculator to determine the required capacity of your
deployment change
Before youmake any changes to your BSM deployment, such as adding a license for an
application, it is recommended that you use the capacity calculator Excel file to determine if
your current servers meet the required capacity.

It is recommended that youmodify the saved version of the capacity calculator that was used
prior to installing BSM. If you did not save your own version of the capacity calculator before
installation or thereafter, a version can be found in theDocumentation folder in themain BSM
installation DVD, or you can download the latest version from the HP Software Product
Manuals Web site (http://h20230.www2.hp.com/selfsolve/manuals).

Make sure to save the file with your current requirements in a location from which you can
upload it to the Server Deployment page.

2. Add a new license — optional
Perform this step if you are updating your deployment with a new license.

Select Admin > Platform > Setup and Maintenance > License Management.

Click Add license from file to open the Add license dialog box where you can search for the
relevant .dat file. The file is uploaded from the client machine to the BSM server.

At the bottom of the LicenseManagement page, click theServer Deployment link.

3. Update the deployment in the Server Deployment page
Select Admin > Platform > Setup and Maintenance > Server Deployment.

n Input table. Click theBrowse button to upload the saved version of your capacity
calculator Excel file. When you select a file to upload, the values entered in the capacity
calculator file automatically populate the Server Deployment page with the correct
information for your deployment.

Alternatively, you can enter the required information in the upper table manually, but it is
recommended to use the capacity calculator so that it calculates the capacity for you and
determines the scope of your deployment based on the values you input.

n Server status table. In the lower table indicating the status of the servers, ensure that the
requiredmemory does not exceed the detectedmemory on the servers. If it does, youmust
either remove selected applications, change the capacity level, or increase thememory on
the servers.

4. Restart BSM
After you click Save in the Server Deployment page, youmust disable and enable BSM.

Select Start > Programs > HP Business Service Management > Administration >
Disable HP Business Service Management/Enable HP Business Service Management.
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5. Results
If you added any applications to your deployment, they now appear in the BSMmenus. For
example, if you enabled the System Availability Management application, you can now find the
menu option under both theAdmin andApplications menu.

Conversely, if you removed any applications from your deployment, they are no longer
available in the applicable menus.
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UI Description
Server Deployment Page
This page enables you to update your deployment and determine if your hardwaremeets the
memory requirements of any change youmake. Once you save the changes to this page, BSM
must be restarted for the changes to take effect.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element Description

<Capacity
Calculator
file
name>

Use theBrowse button to locate and upload your saved capacity calculator Excel
file.

If you have not yet entered your values into a capacity calculator, it is
recommended that you do so prior to making any changes to this page. A capacity
calculator file can be accessed from theDocumentation folder in themain BSM
installation DVD, or you can download the latest version from the HP Software
Product Manuals Web site (http://h20230.www2.hp.com/selfsolve/manuals).
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UI
Element Description

<Capacity
table>

The upper table in the page displays the current information regarding deployment
and applications. If you upload a capacity calculator file, this table is automatically
updated with the information in the capacity calculator.

You can change capacity level of your deployment for:

l Users. Number of logged in users.

l Model. The number of configuration items in your model determines whether
your model is small, medium, large, or extra-large.

l Metric Data. The number of monitored applications, transactions, locations,
and hosts determines whether your metric data load is small, medium, or large.

You can also enable/disable applications and features, and change their
capacity levels.

l End User Management

l TransactionVision

l Diagnostics

l Business Process Insight

l OMi.

n TBEC. Topology-Based Event Correlation used to correlate events with OMi.

n Custom Rules. Used to customize event processing. For example, to
customize event enrichment, or to provide custom actions in the event
browser. If you are unsure whether users will be using custom rules, select to
enable this feature if OMi is enabled.

l System Availability Management

l Service Level Management

l Service Health Analyzer

l Baselining

After you click Save and restart BSM:

l If you selected an application that was previously not selected, the application is
available in BSM and applicable menus.

l If you cleared an application that was previously selected, the application is no
longer accessible.
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UI
Element Description

<Server
status
table>

The lower table lists all the servers running BSM including:

l Status. Whether themachine is up and running.

l Aligned. Whether this machine is aligned with the current deployment
configuration. It would be aligned only if BSM was restarted on this machine
after any changes weremade. If BSM was not yet restarted on this machine
since any configuration changes weremade in this page, themachine is not
aligned.

l Machine. The name of the server.

l Installed. Which type of BSM server is installed on themachine, Gateway or
Processing or both (Typical installation whenGateway and Data Processing are
on the samemachine).

l Activated. Which type of BSM server is currently activated on themachine,
Gateway or DPS (data processing server).

l Detected. The freememory detected on themachine.

l Required. The requiredmemory for each type of server based on the
applications and capacity levels listed in the upper table.

If the Requiredmemory is higher than thememory in the Detected column, you
must either:

n Change capacity levels for your deployment, for example: clear applications
from the list of available applications.

n Addmemory to the physical machines and try to update your deployment
again.

To
disable
machine

Link to page on which you can disable server machines whose installed BSM
components are no longer relevant to the ongoing operation of the system. Before
disabling amachine, verify that it is no longer an operational part of the BSM server
architecture. To re-enable amachine after disabling it here, you need to run the
Setup and Database Configuration Utility on that machine.
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Troubleshooting and Limitations
Troubleshooting

l If an application is missing from the BSM interface, activate it using the Server Deployment
page.

l If an application was activated but does not appear in the BSM interface, restart all BSM
servers.

l If an application was selected in the capacity calculator but was not imported to the Server
Deployment page, ensure that you have a valid license for this application.

HP Business ServiceManagement (9.20)Page 67 of 427



Chapter 7

Database Administration
HP Operations administers these pages and the interface is hidden from your view.

You canmaintain and administer the databases BSM uses to storemonitoring data. You can create
andmanage profile databases directly from the Platform Administration. You can use the Partition
and PurgingManager to purge the data in the database periodically according to your organization's
needs.

Before you configure your monitoring environment, youmust configure the database into which you
want monitoring data saved. A profile database can store data for different types of data sources
(Business Process Monitor, SiteScope). You can either create one database for all data or create
dedicated databases (for example, for each data type).

Note: The term database is used to refer to a database inMicrosoft SQL server. The term user
schema refers to a database in Oracle server.

BSM supports two database types:

l Microsoft SQL server. This database runs onWindows operating systems only. For details on
how to configure a database on aMicrosoft SQL server, see "How to Configure a Profile
Database on aMicrosoft SQL Server" on page 73.

l Oracle server. This database runs on any BSM supported operating system. AnOracle server
database is referred to as a user schema. For details on how to configure a database on an
Oracle server user schema, see "How to Configure a User Schema on anOracle Server" on
page 74.

The Profile DatabaseManagement page, accessed from Admin > Platform > Setup and
Maintenance, enables you to perform the following databasemanagement tasks:

l Create a new database. BSM automatically creates a new database and populates it with
profile tables.

l Assign a default profile database. Youmust assign a default profile database, to enable BSM
to collect the following types of data:

n Service Level Management data

n SOA data

n data from Real User Monitor and Business Process Monitor

n data used in Service Health

n Diagnostics data

n persistent custom data
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Note: The first database added on the DatabaseManagement page is automatically
designated as the default profile database.

l Add profile tables to an existing, empty database. BSM connects to an empty database
that was manually created on your database server, and populates it with profile tables.

l Connect to an existing database populated with profile tables. BSM connects to a profile
database that was either manually created and populated with profile tables, or previously
defined in Platform Administration.

To deploy profile databases onMicrosoft SQL server or Oracle server for your organization's
particular environment, follow the instructions in Introduction to Preparing the Database
Environment in the BSMDatabaseGuide. It is recommended that you review the relevant portions
of the BSMDatabaseGuide before performing profile databasemanagement tasks.

Note: BSM data collectors collect performance data and transmit it to the Gateway Server,
which submits the data to profile databases using the loader mechanism. Data is inserted into
the database along with a timestamp. BSM components synchronize their time clocks with
that of the database server machine hosting the BSM database. Thus, the timestamp attached
to eachmeasurement inserted into the database is that of the database server clock at the time
themeasurement was collected.
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Partitioning and Purging Historical Data from
Databases

Note:HP Operations administers these pages and the interface is hidden from your view.

You use the Partition and PurgingManager to instruct the platform to automatically partition
historical data for later removal from profile and SHP databases.

The data collection tables in the profile and SHP databases can grow to a very large size. Over
time, this can severely degrade system performance.

BSM's Partition and PurgingManager splits fast growing tables into partitions at defined time
intervals. After a defined amount of time has elapsed, data in a partition is made inaccessible for
use in BSM reports. After nomore than two hours, that partition is purged from the profile database.

The Partition and PurgingManager is activated for each profile or SHP database and handles
partitioning and later purging of historical data according to the time period listed for the database
table. The size of each partition is determined by the EPM (events per minute) value displayed on
the PurgingManager page. The default EPM values are preset according to the appropriate level of
the specified database table. Optionally, youmay want to adjust the EPM value, if necessary:

l If data partitions are too large (accumulatingmuchmore than 1million rows), raise the EPM
value to create new partitions more frequently.

l If data partitions are too small (accumulatingmuch less than 1million rows), lower the EPM
value to create new partitions less frequently.

Note: The partitioningmethod used by the Partition and PurgingManager is Database Native
Partitioning. (Refer to database support matrix in the release notes for the SQL SERVER and
Oracle Enterprise editions supported for this release). In anOracle database, the Oracle
Partitioning option should be enabled. If the Oracle Partitioning option is not available, the
Partition and PurgingManager does not partition or purge data. Failure to partition or purge
may result in major performance issues.

You can also use the Partition and PurgingManager to set a specific time period—per table—for
removing historical data. For details on the user interface for performing this task, see "Purging
Manager Page" on page 87.

The Partition and PurgingManager runs every hour to check if a new data partition needs to be
created and to purge data older than the retention time defined per table.

Note: By default, the Partition and PurgingManager does not purge data. Make sure to
configure purging policies for your data samples using the Partition and PurgingManager
administration screen.

For guidelines and tips on using the Partition and PurgingManager, see "Guidelines and Tips for
Using the Partition and PurgingManager" on next page.

The PurgingManager page is divided into the following tabs:
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l Template and Multiple Databases. Used tomodify the template configurations, as well as
database configurations in multiple databases. Any databases added at a later time adopt the
template configurations.

Once you havemade changes, the settings displayed in the Template andMultiple Databases
tab remain the template settings, even if you did not make changes to the template and have
manually changed settings for specific databases. Once thosemanual changes are applied, the
settings displayed revert to the template settings. To see the settings you changed for specific
databases, navigate to theDatabase Specific tab and select the appropriate database.

l Database Specific. Displays the configurations for the specified database.

For details on advanced partitioning and purging capabilities, see Data Partitioning and Purging in
the BSMDatabaseGuide.

Guidelines and Tips for Using the Partition and Purging Manager
This section contains guidelines and tips for using the Partition and PurgingManager.

l Prior to purging, the Partition and PurgingManager performs an additional check to ensure that
raw data is not purged before it has been aggregated and reported to BSM.

If a particular set of data is scheduled for purging but its raw data has not yet been aggregated, the
Partition and PurgingManager does not purge the data according to its schedule. The Partition and
PurgingManager automatically purges the data on its next hourly run only after the data has been
aggregated.

For example, if data was scheduled to be purged on Sunday at 8:00 but its data will only be
aggregated on Sunday at 10:00, the Partition and PurgingManager checks the data at 8:00, does
not purge the data, and automatically purges the data on its next hourly run only after Sunday at
10:00 once the data has been aggregated.

l If you find that data is not being purged according to the schedules set in the Partition and
PurgingManager and your profile databases are growing too large, check that the aggregator is
running properly and view the Partition and PurgingManager logs located on the Data
Processing Server at <HPBSM server root directory>\log\pmanager.log.

l Use the following principle when defining purging for your raw and aggregated data: the length of
time that raw data is kept is shorter than the length of time that one-hour chunks of aggregated
data are kept, which is shorter than the length of time that one-day chunks of aggregated data
are kept.

l Any changes made under the Template andMultiple Databases tab affect the default time
periods for new profile databases created in the system. If a new profile database is created
after you havemademodifications to the time periods under the Template andMultiple
Databases tab, data is kept in the tables of that new profile database for the time periods now
listed under Template andMultiple Databases for all tables.
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Removing Unwanted Data from the Profile
Database

Note: This section is not relevant to HP Software-as-a-Service customers.

The DataMarking utility enables BSM users with superuser security privileges tomark specific
sets of data in profile databases as unwanted. This filters out unwanted data and enables BSM to
display only themost relevant data for the specified time period. After the utility marks the specified
data as unavailable, BSM automatically re-aggregates the remaining raw data for the selected time
period.

The DataMarking utility also enables removal of unwanted Business Process Monitor and
SiteScope data.

After youmark a specific set of data from a given time period as unwanted, BSM reruns the
aggregation process on remaining raw data for the relevant time period so that themarked data is
not displayed. The DataMarking utility also enables you to re-aggregate a defined set of data
without marking it as unavailable. For details, see "How to Enable the Re-aggregation-Only Option"
on page 78.

During installation, BSM installs the DataMarking utility on the Gateway Server. While the utility
does not physically removemarked data from the database, it renders it unusable in reports and
applications by assigning themarked data a status of unavailable in the database.

The DataMarking utility supports partitions. Thus, users running the Partition and PurgingManager
can also use the DataMarking utility.
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How to Configure a Profile Database on a
Microsoft SQL Server

This task describes how to configure one or more profile databases on aMicrosoft SQL server.

1. Prerequisites
Before you begin, make sure that you have the following connection parameters to the
database server:

a. Server name. The name of themachine on which aMicrosoft SQL server is installed. If
you are connecting to a non-default Microsoft SQL server instance in dynamic mode, enter
the server name in the following format:

<host_name>\<instance_name>

b. Database user name and password. The user name and password of a user with
administrative rights on aMicrosoft SQL server (if using SQL server authentication).

c. Server port. TheMicrosoft SQL server's TCP/IP port. The default port, 1433, is
automatically displayed. Youmust change the port number in one of the following
instances:

o The default Microsoft SQL server instance listens to a port other than 1433.

o You connect to a non-default Microsoft SQL server instance in static mode.

o You connect to a non-default Microsoft SQL server instance in dynamic mode. In this
case, enter port number 1434.

If required, consult with your organization's DBA to obtain this information.

2. Add a Database
a. Access the DatabaseManagement page, located at Admin > Platform > Setup and

Maintenance > Manage Profile Databases.

b. SelectMS SQL from the dropdown list, and click Add.

c. Enter the parameters of your database on theProfile Database Properties - MS SQL
Server page. For user interface details, see "Profile Database Properties —MS SQL
Server Page" on page 84.
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How to Configure a User Schema on an Oracle
Server

This task describes how to configure one or more profile user schemas on your Oracle server.

1. Prerequisites
Before you begin, make sure that:

a. You have created a dedicated default tablespace for profile user schemas (and a dedicated
temporary tablespace, if required).

b. You are using a secure network connection if you do not want to submit database
administrator connection parameters over a non-secure connection. If you do not want to
submit database administrator connection parameters using yourWeb browser at all, you
canmanually create profile user schemas and then connect to them from the Database
Management page.

2. Gather Connection Parameters
Make sure that you have the following connection parameters to the database server:

a. Host name. The name of themachine on which the Oracle server is installed.

b. SID. TheOracle instance name that uniquely identifies the instance of the Oracle database
being used, if different from the default value, orcl.

c. Port. TheOracle listener port, if different from the default value, 1521.

d. Database administrator user name and password. The name and password of a user
with administrative permissions on theOracle server. These parameters are used to create
the BSM user, and are not stored in the system.

e. Default tablespace. The name of the dedicated default tablespace you created for profile
user schemas (for details on creating a dedicated tablespace, seeOverview of Oracle
Server Deployment in the BSMDatabaseGuide). If you did not create, and do not require,
a dedicated default tablespace, specify an alternate tablespace. The default Oracle
tablespace is called users.

f. Temporary tablespace. The name of the dedicated temporary tablespace you created for
profile user schemas. If you did not create, and do not require, a dedicated temporary
tablespace, specify an alternate tablespace. The default Oracle temporary tablespace is
called temp.

If required, consult with your organization's database administrator to obtain this
information.

3. Add a User Schema
a. Access the DatabaseManagement page, located at Admin > Platform > Setup and

Maintenance > Manage Profile Databases.

b. Select Oracle from the dropdown list, and click Add.

c. Enter the parameters of your user schema on theProfile Database Properties - Oracle
Server page. For user interface details, see "Profile User Schema Properties —Oracle
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Server Page" on page 85.

If your Profile database is part of Oracle Real Application Cluster (RAC), see Support for
Oracle Real Application Cluster in the BSMDatabaseGuide.
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How to Work with the Purging Manager
This task describes how to work with the PurgingManager.

This task includes the following topics:

l "Prerequisites" below

l "Change the Database Template" below

l "Change Settings for Multiple Databases" below

l "Change Settings for Individual Databases" on next page

1. Prerequisites
Ensure that you have at least one profile database configured in your BSM system. For details
on configuring a profile database on aMicrosoft SQL server, see "How to Configure a Profile
Database on aMicrosoft SQL Server" on page 73.

For details on configuring a user schema on anOracle server, see "How to Configure a User
Schema on anOracle Server" on page 74.

2. Change the Database Template
To change settings for the database template, follow these steps:

a. Access the Template and Multiple Databases tab on the PurgingManager page.

b. Select the check box next to the setting you want to change. You can select multiple check
boxes at once.

c. Modify the specified setting accordingly in theKeep Data for andChange to EPM fields,
and click Apply.

d. Click theApply to link and ensure that the appropriate template (Enterprise for Native
Partitioning databases, orStandard for View Partitioning databases) is selected.

e. Click OK to register your changes to the template.

Note: Once you havemade changes, the settings displayed in the Template &
Multiple Databases tab remain the template settings, even if you did not make
changes to the template and havemanually changed settings for specific databases.
Once thosemanual changes are applied, the settings displayed revert to the template
settings. To see the settings you changed for specific databases, navigate to the
Database-Specific tab and select the appropriate database.

3. Change Settings for Multiple Databases
To change settings for multiple databases at once, follow these steps:

a. Access the Template and Multiple Databases tab on the PurgingManager page.

b. Select the check box next to the setting you want to change. You can select multiple check
boxes at once.

c. Modify the specified setting accordingly in theKeep Data for andChange to EPM fields,
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and click Apply.

d. Click theApply to link and ensure that the appropriate databases are selected. Clear the
check box next to the template if you do not want your changes to apply to the template.

e. Click OK to register your changes to the selected databases.

Note: Changes made to the databases are displayed only on the Database Specific
tab, after the relevant database has been selected in theSelect a profile database
dropdown.

4. Change Settings for Individual Databases
To change settings for individual databases, follow these steps:

a. Access theDatabase Specific tab on the PurgingManager page.

b. Select the check box next to the settings you want to change.

c. Select the profile database that you want your changes to apply to in theSelect a profile
database field.

d. Modify the specified setting accordingly in theKeep Data for andChange to EPM fields,
and click Apply.
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How to Enable the Re-aggregation-Only Option
By default, the DataMarking utility always runs the datamarking process, followed by the re-
aggregation process. If required, you can enable a feature that allows you to instruct BSM to run
only re-aggregation. This might be required if datamarking passed successfully but re-aggregation
failed. Alternatively, you can use this feature to re-aggregate a defined set of data without marking it
as unavailable (for example, if data was aggregated and then late-arriving data was inserted into the
raw data tables in the database).

To enable the re-aggregation-only option:

1. Open the file <Gateway Server root directory>\tools\dataMarking\dataMarking.bat in a
text editor.

2. Add theDadvanceMode property with a value of true to theSET SERVICE_MANAGER_
OPTS line. For example:

SET SERVICE_MANAGER_OPTS=-DhacProcessName=%PROCESS_NAME % -

DadvancedMode=true

3. Save the file. The next time you open the DataMarking utility, theAdvanced button appears.

After you enable this feature, you can instruct the DataMarking utility to only run the data re-
aggregation process when clicking theStart button.

To run data re-aggregation only:

1. Define the set of data you want to re-aggregate, as described in "Removing Unwanted Data
from the Profile Database" on page 72.

2. Click theAdvanced button. The Advanced window opens.

3. Select theRun re-aggregation only check box.

4. Select the categories of data for the re-aggregation and click OK to confirm selection.

5. Click Start.
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How to Determine the Events Per Minute for Data
Arriving in BSM

You can determine the amount of data per minute that is arriving in BSM. You enter this number in
theChange to EPM box at the top of thePurging Manager page.

To determine the Events Per Minute for the selected data type:

1. Open the file located at:

<Gateway Server root directory>\log\db_loader\LoaderStatistics.log

2. Locate the line in the select data sample that reads:

Statistics for: DB Name: <database name> Sample: <sample name> - (collected over
<time period>):

3. Locate the line in the statistics section of the data sample that reads:

Insert to DB EPS (MainFlow)

The selected number represents the events per second; multiply this number by 60 to retrieve
the events per minute.

To determine to which data table in the PartitionManager the sample belongs, follow the
instructions for Generic Reporting Engine API in the BSM Extensibility Guide. The resulting list
displays the data table in parentheses next to the name of the sample. You can then enter the
EPM number for the correct table.

If you havemore than oneGateway Server, youmust total the values obtained from each
server.
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How to Customize Data Marking Utility
Configurations

You can configure themaximum duration for each datamarking run. The current default is 6 hours
and 59minutes.

To configure the maximum duration:

1. Open the <Gateway Server root directory>\tools\dataMarking\dataMarking.bat file in a
text editor.

2. Add theDmaximumDuration property, with a value of themaximum duration in hours, to the
SET SERVICE_MANAGER_OPTS line.

For example, to change themaximum duration to 23 hours and 59minutes:

SET SERVICE_MANAGER_OPTS=

-DhacProcessName=%PROCESS_NAME%

-Dlog.folder.path.output=%PROCESS_NAME% -DmaximumDuration=24

3. Save and close the file.
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Database Administration User Interface
This section includes:

l "DatabaseManagement Page" below

l "DataMarking Utility Page" below

l "Profile Database Properties —MS SQLServer Page" on page 84

l "Profile User Schema Properties —Oracle Server Page" on page 85

l "PurgingManager Page" on page 87

Database Management Page
This page enables you tomaintain and administer the databases BSM uses to storemonitoring
data.

To access Select Admin > Platform > Setup and Maintenance > Manage Profile
Databases

Important
information

The first database added on the DatabaseManagement page is automatically
designated as the default profile database.

User interface elements are described below:

UI Element
(A-Z) Description

Disconnects the database or user schema.

Note:You cannot delete the default profile database or a database which is in use.

Add Adds aMicrosoft SQL server database or Oracle server user schema, as specified
in the dropdown database list.

Database
Name

The name of the database.

Database
Type

The type of database, either Microsoft SQL or Oracle.

Server
Name

The name of the server on which the database is running.

Data Marking Utility Page
This page enables you to select sets of data for removal by application or by location for Business
Process Monitor data, and by SiteScope target machine for SiteScope data.
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To access On theGateway Server, double-click the <HPBSM Gateway Server root
directory>\tools\dataMarking\dataMarking.bat file. A Command Prompt
window opens, followed by the DataMarking utility login dialog box. Enter the
user name and password of a BSM user with superuser privileges.

Important
information

l Do not runmore than one instance of the DataMarking utility at a time, as this
can affect the re-aggregation process.

l Do not mark data sets for time periods that include purged data (data that has
been removed using the Partition and PurgingManager) as this can affect the
re-aggregation process.

See also l "Removing Unwanted Data from the Profile Database" on page 72

l "Troubleshooting and Limitations" on page 90

User interface elements are described below:

UI Element (A-
Z) Description

Applications List of applications you canmark as obsolete.

Business
Transaction
Flows

List of business transaction flows you canmark as obsolete.

Note: This field is visible only in the Applications view (if you chose
Applications in theView by dropdown).

Duration Select the period of time, starting from the specified start time, for the utility to
mark data as unavailable.

Note:You can set amaximum duration of up to 6 hours and 59minutes for
each datamarking run. For details on customizing this value, see "How to
Customize DataMarking Utility Configurations" on page 80.

Get Info Click before running the DataMarking utility to view the number of data rows
to bemarked. For details, see "DataMarking Utility Page" on previous page.

Locations List of locations you canmark as obsolete.

Mark data as
obsolete

Marks the filtered criteria (Applications, Business Transaction Flows,
Transactions, Locations, or SiteScope Targets) as obsolete.

Mark data as
valid (undo
mark as
obsolete)

Makes selected data available again after having beenmarked as obsolete.

Progress Displays the progress of the datamarking process and re-aggregation
process.
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UI Element (A-
Z) Description

SiteScope
Targets

List of SiteScope target machines (i.e., machines beingmonitored by
SiteScope) you canmark as obsolete.

Note: This field is visible only in the SiteScope view (if you choseSiteScope
View in theView by dropdown).

Start Activates the DataMarking utility andmarks data as obsolete.

Start Time Select a starting date and time for data to bemarked as unavailable.

Transactions List of transactions you canmark as obsolete.

Note: This field is visible only in the Applications view (i.e., if you chose
Applications in theView by dropdown).

View by Select the type of view to be visible in the DataMarking utility:

l Applications

l Locations

l SiteScope Targets

Data Marking Information Window
This window displays the data to bemarked as obsolete by the DataMarking utility.

To access Click theGet Info button on the DataMarking utility page.

Important
information

The lower portion of the DataMarking Information window displays the SLAs
affected by themarked data. You can recalculate the affected SLAs on the
Agreements Manager tab underAdmin > Service Level Management. For
details, see Recalculation for SLAsin the BSM Application Administration Guide.

See also l "Removing Unwanted Data from the Profile Database" on page 72

l "Troubleshooting and Limitations" on page 90

User interface elements are described below:

UI Element (A-
Z) Description

Application
Name

The name of the application to bemarked as obsolete.

Number of
Rows to
Update

The number of data rows to bemarked as obsolete.

Total Rows to
Update

The total number of rows available to bemarked as obsolete. This number can
differ from the value of theNumber of Rows to Update field.
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Profile Database Properties — MS SQL Server Page
This page enables you to configure a new or existing profile database onMicrosoft SQL server.

To access Select Admin> Platform > Setup and Maintenance > Manage Profile
Databases, selectMicrosoft SQL from the dropdown database list and click
Add.

Important
information

l It is recommended that you configureMicrosoft SQL server databases
manually, and then connect to them in the DatabaseManagement page. For
details onmanually configuringMicrosoft SQL server databases, see
"Overview of Microsoft SQL server Deployment" in the BSMDatabaseGuide.

l Database creation can take several minutes.

Relevant
tasks

"How to Configure a Profile Database on aMicrosoft SQL Server" on page 73

See also "Database Administration" on page 68

User interface elements are described below:

UI Element (A-Z) Description

Create database
and/or tables

Select or clear as required.

l To create a new database, or connect to an existing, empty
database and populate it with profile tables, select the check box.

l To connect to an existing database already populated with profile
tables, clear the check box.

Database name l If you are configuring a new database, type a descriptive name for
the database.

l If you are connecting to a database that was previously created,
type the name of the existing database.

Disconnect Disconnects the database from BSM.

Note: This button appears only after you have clicked theDisconnect

Database button on the DatabaseManagement page.

Make this my default
profile database
(required for custom
data types)

Select or clear as required.

Note:

l This setting is required if you are collecting Service Health, Real
User Monitor, HP Diagnostics (if installed), Service Level
Management, SOA, or persistent custom data.

l Selecting this check box overwrites the existing default profile
database.
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UI Element (A-Z) Description

Password l Should remain empty if you are usingWindows authentication.
Make sure BSM service runs by a windows user configured in the
database server as an authorized windows login.

l If you are using SQL server authentication, enter the password of a
user with administrative rights onMicrosoft SQL server.

Port Enter the port number if:

l TheMicrosoft SQL server's TCP/IP port is configured to work on a
port different from the default (1433).

l You use a non-default port in static mode.

l You use a non-default port in dynamic mode. In this case, enter port
1434.

Server name Enter the name of themachine on which theMicrosoft SQL server is
installed. If you are using a non-default instance in dynamic mode,
enter the server name in the following format: <my_server\my_
instance>

SQL server
authentication

Select if theMicrosoft SQL server is using SQL server authentication.

User name l Should remain empty if you are usingWindows authentication.

l If you are using SQL server authentication, enter the user name of a
user with administrative rights onMicrosoft SQL server.

Windows
authentication

Select if theMicrosoft SQL server is usingWindows authentication.

Profile User Schema Properties — Oracle Server Page
This page enables you to configure one or more profile user schemas on your Oracle server.

To access Select Admin > Platform > Setup and Maintenance > Manage Profile
Databases, select Oracle from the dropdown database list and click Add.

Important
information

l It is recommended that you configure Oracle server user schemas manually,
and then connect to them in the DatabaseManagement page. For details on
manually configuring Oracle server user schemas, seeOverview of Oracle
Server Deployment in the BSMDatabaseGuide.

l User schema creation can take several minutes. The browser might time out
before the creation process is completed. However, the creation process
continues on the server side.

If a timeout occurs before you get a confirmationmessage, verify that the user
schema name appears in the database list on the DatabaseManagement page
to ensure that the user schemawas successfully created.
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Relevant
tasks

"How to Configure a User Schema on anOracle Server" on page 74

See also "Database Administration" on page 68

User interface elements are described below:

UI Element (A-Z) Description

Create database
and/or tables

Select or clear as required.

l To create a new user schema, or connect to an existing, empty user
schema and populate it with profile tables, select the check box.

l To connect to an existing user schema already populated with profile
tables, clear the check box.

Note:Clearing this check box disables the database administrator
connection parameter and tablespace fields on the page, and instructs
the platform to ignore the information in these fields when connecting to
the Oracle server machine.

Database
administrator
password

Enter the password of a user with administrative permissions onOracle
server.

Note: This field is enabled only if you selected theCreate database
and/or tables check box.

Database
administrator user
name

Enter the user name and password of a user with administrative
permissions onOracle server.

Note: This field is enabled only if you selected theCreate database
and/or tables check box.

Default tablespace Enter the name of the default tablespace designated for use with profile
user schemas.

Default Value: users

Disconnect Disconnects the user schema from BSM.

Note: This button appears only after you have clicked theDisconnect

Database button on the DatabaseManagement page.

Host name Enter the name of themachine on which the Oracle server is installed.

HP Business ServiceManagement (9.20)Page 86 of 427



BSM Platform Administration Guide
Chapter 7: Database Administration

UI Element (A-Z) Description

Make this my
default profile
database (required
for custom data
types)

Select or clear as required.

Note:

l This setting is required if you are collecting Service Health, Real
User Monitor, HP Diagnostics (if installed), Service Level
Management, SOA, or persistent custom data.

l Selecting this check box overwrites the existing default profile
database.

Port Enter the required Oracle listener port, or accept the default value.

Retype password Retype the user schema password.

SID Enter the required Oracle instance name, or accept the default value.

Temporary
tablespace

Enter the name of the temporary tablespace designated for use with
profile user schemas.

Default Value: temp

TNS name Enter the TNS name of the Oracle Client, as specified in the
tnsnames.ora file on the Gateway Server machine, located in the
<ORACLE_HOME>\network\admin directory.

User schema name l If you are configuring a new user schema, enter a descriptive name
for the user schema.

l If you are connecting to a user schema that was previously created,
enter the name of the existing user schema.

User schema
password

l If you are configuring a new user schema, enter a password that
enables access to the user schema.

l If you are connecting to a user schema that was previously created,
enter the password of the existing user schema.

Note:Youmust specify a unique user schema name for each user
schema you create for BSM on theOracle server.

If your Profile database is part of Oracle Real Application Cluster (RAC), see Support for Oracle
Real Application Cluster in the BSMDatabaseGuide.

Purging Manager Page
This page enables or disables the Partition and PurgingManager which instructs BSM to begin or
stop the process of partitioning the data.

To access Select Admin> Platform > Setup and Maintenance > Data Partitioning and
Purging
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Important
information

Partitioning and Purgingmanager partitioningmethod is native partitioning. In an
Oracle database, the Oracle Partitioning option should be enabled. For details on
purging data from anOracle database, see "About Data Partitioning and Purging"
in the BSMDatabaseGuide.

See also "Partitioning and Purging Historical Data from Databases" on page 70

User interface elements are described below:

UI Element
(A-Z) Description

Apply to Used to select the databases and template to which you want the configurations
on the Template andMultiple Databases tab to apply. You can clear all databases
tomake changes only to the selected template.

Change to
EPM

The amount of data per minute configured to arrive in BSM.

Note: Leave this field empty to retain the existing EPM value.

For details on determining this value, see "How to Determine the Events Per
Minute for Data Arriving in BSM" on page 79.

Database
Specific

Select this tab to change the time range for purging data in a table per individual
profile database.

Description Describes the corresponding database table.

Epm Value The amount of data per minute that is arriving in BSM. For details on determining
this value, see "How to Determine the Events Per Minute for Data Arriving in
BSM" on page 79.

Keep Data
for

The time range for keeping data in the database tables whose check box is
selected. This element appears as follows:

l Selection fields. At the top of the page, set the time period for how long you
want data kept in the selected database tables.

l Column heading. Displays the time range for keeping data in each database
table. This value is configured in theKeep Data for selection fields at the top
of the page.

Note: The time period configured in theKeep Data for fields indicates that the
data is stored for at least the specified amount of time; it does not indicate when
the data is purged. By default, retention time is Infinite, meaning no purging is set.
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UI Element
(A-Z) Description

Name of
Table in
Database

The name of the table in the database.

Database tables are listed by the data collector from which the data was gathered.
The following data types are available:

l Alerts

l BPI

l Business Logic Engine

l Business Process Monitor

l Diagnostics

l Real User Monitor

l SOA

l Service Level Management

l SiteScope

l TV

l UDX (custom data)

l WebTrace

Select a
profile
database

Select a profile database for which you want to modify time range configurations
for purging data.

Note: This field is visible only on the Database Specific tab.

Template
and
Multiple
Databases

Select this tab to:

l Change the partitioning and purging parameters for multiple profile databases.

l Change the database template, for parameters to be adopted by new
databases added in the future.

Note:Once you havemade changes, the settings displayed in the Template &
Multiple Databases tab remain the template settings, even if you did not make
changes to the template and havemanually changed settings for specific
databases. Once thosemanual changes are applied, the settings displayed revert
to the template settings. To see the settings you changed for specific databases,
navigate to theDatabase-Specific tab and select the appropriate database.

HP Business ServiceManagement (9.20)Page 89 of 427



BSM Platform Administration Guide
Chapter 7: Database Administration

Troubleshooting and Limitations
This section describes troubleshooting and limitations for database administration.

This section includes:

l "Troubleshooting DataMarking Utility Errors" below

l "DataMarking Utility Limitations" below

Troubleshooting Data Marking Utility Errors
Various types of errors might occur while using the DataMarking utility. Generally, when an error
occurs, the utility displays the following error message:

The Data Marking utility must shut down due to an internal error. For

details see: <HPBSM Gateway Server root directory>\log\datamarking.log

Reasons for which the utility might display this error include:

l Failure to connect to the database server or profile database.

l Failure to complete the datamarking process, for example, due to a communication error
between the Aggregation server and database.

l Failure of BSM to successfully re-aggregate raw data for the defined data set.

In case of error, check the <HPBSM Gateway Server root directory>\log\datamarking.log file
for error information.

Data Marking Utility Limitations
Following are limitations associated with the DataMarking utility:

l The utility does not support the removal of late arriving data.

For example, if a set of data for a specific time period is marked for removal and BSM later
receives data from that time period (which arrived late due to a Business Process Monitor
temporarily being unable to connect to the Gateway Server), the late arriving data is not available
for use in reports. Use theGet Info button to check for late arriving data. If any value other than
zero rows are displayed, run the utility again, if required, to remove the data that arrived late.

l The utility does not support removal of data arriving during the datamarking process.

For example, if a set of data for a specific time period is marked for removal, and during that
same time period (while the utility is running), data arrives and enters the profile database, the
rows of newly arrived data are not marked for removal, and are therefore not removed. In this
case, after the utility finishes running, use theGet Info button to determine whether all rows of
data were removed for the selected time period. If rows are displayed, run the utility again, if
required, to remove the data that arrived during the run. This is a rare scenario, as you typically
mark data for a previous time period and not for a time period that ends in the future.

l While the utility is running and removing data, reports that are generated for that time periodmay
not show accurate results. Therefore, it is recommended to run the utility during off-peak hours
of BSM usage.
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Infrastructure Settings
You can configure BSM settings tomeet your organization's specifications for the platform and its
applications. You configuremost infrastructure settings directly within the Administration Console.

BSM enables you tomodify the value of many settings that determine how BSM and its
applications run.

Caution: Modifying certain settings can adversely affect the performance of BSM. It is highly
recommended not to modify any settings without first consulting HP Software Support or your
HP Services representative.

In the Infrastructure Settings Manager, you can select different contexts from which to view and
edit settings. These contexts are split into the following groups:

l Applications. This list includes those contexts that determine how the various applications
running within BSM behave. Contexts such as Service Health Application, MyBSM, and
Service Level Management are listed.

l Foundations. This list includes those contexts that determine how the different areas of the
BSM foundation run. Contexts such as RTSM (Run-time ServiceModel) and LDAP
Configuration are listed.

Descriptions of the individual settings appear in theDescription column of the table on the
Infrastructure Settings page.

For details on configuringmost infrastructure settings, see "How toModify Infrastructure Settings
Using the Infrastructure Settings Manager" on next page.

Some infrastructure settings are configured outside the Infrastructure Settings Manager. For
details, see "How toModify the Ping Time Interval" on page 93, and "How toModify the Location
and Expiration of Temporary Image Files" on page 94.
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How to Modify Infrastructure Settings Using the
Infrastructure Settings Manager

This task describes how to use the Infrastructure Settings Manager to modify infrastructure
settings.

To modify infrastructure settings using the Infrastructure Settings Manager:

1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.

2. Choose to view a group of contexts: Applications, Foundations, orAll.

3. Select a specific context from the drop-down box.

4. All configurable infrastructure settings relating to that context are displayed, along with
descriptions and the current values of each setting. Click theEdit Setting button andmodify
the value of a specific setting.
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How to Modify the Ping Time Interval

Note: This infrastructure settings task is performed outside the Infrastructure Settings
Manager.

You canmodify the time interval after which BSM pings the server to refresh a session.

To modify the ping time interval:

1. Open the file <Gateway Server root directory>\conf\settings\website.xml in a text editor.

2. Search for the parameter: user.session.ping.timeinterval.

3. Change the value (120, by default) for the ping time interval. This valuemust be less than half,
and it is recommended that it be less than a third, of the value specified for the session timeout
period (the user.session.timeout parameter).

4. Restart BSM on theGateway Server machine.

5. If you havemultiple Gateway Server machines, repeat this procedure on all themachines.
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How to Modify the Location and Expiration of
Temporary Image Files

Note: This infrastructure settings task is performed outside the Infrastructure Settings
Manager.

When you generate a report in BSM applications, or when BSM automatically generates a report to
send through the scheduled report mechanism, images (for example, graphs) are created. BSM
saves these images, for a limited period of time, in temporary directories on the Gateway Server
machines on which the images are generated.

You canmodify the following settings related to these images:

l The path to the directory in which the temporary image files are stored

For details, see "How toModify the Directory inWhich Temporary Image Files Are Stored" on
next page.

l The configuration of a shared location for temporary image files

For details, see "How to Access TempDirectory with Multiple Gateway Server Machines" on
page 96.

l The length of time that BSM keeps temporary image files before removing them

For details, see "How toModify the Length of Time that BSM Keeps Temporary Image Files" on
page 99.

l The directories from which temporary images are removed

For details, see "How to Specify the Directories fromWhich Temporary Image Files Are
Removed" on page 102.
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How to Modify the Directory in Which Temporary
Image Files Are Stored

You canmodify the path to the directory where BSM stores generated images used in scheduled
reports. For example, youmight want to save generated images to a different disk partition, hard
drive, or machine that has a greater storage capacity than the partition/drive/machine on which the
Gateway Server machine is installed.

To modify the path to the directory holding temporary image files:

1. Open the file <Gateway Server root directory>\conf\topaz.config in a text editor.

2. Search for the parameter images.save.directory.offline.

3. Remove the comment marker (#) from the line that begins #images.save.directory.offline=
andmodify the value to specify the required path.

Note: InWindows environments, use UNC path syntax (\\\\server\\path) when defining
the path. In a Solaris environment, use forward slashes (/) and not backslashes (\) when
defining the path.

4. Save the topaz.config file.

5. Restart BSM on theGateway Server machine.

6. Repeat the above procedure on all Gateway Server machines.

7. Map the newly defined physical directory containing the images to a virtual directory in theWeb
server on all Gateway Server machines. For details, see "How to Access TempDirectory with
Multiple Gateway Server Machines" on next page.
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How to Access Temp Directory with Multiple
Gateway Server Machines

If BSM reports are accessing the Gateway Server machine using a virtual IP, the load balancer
could send requests to any of the Gateway Server machines. Thus, the image files need to be in a
common location that is configured on all the Gateway Server machines and shared among them.
This is typical when there aremultiple Gateway Server machines running behind a load balancer in
the BSM architecture.

To support a shared location for temporary images in aWindows environment, the following
configuration is recommended:

l All Gateway Servers—and themachine on which the shared image directory is defined, if
different from theGateway Servers—should be on the sameWindows domain.

l The IIS virtual directory should be configured to use the credentials of an account that is a
member of the domain users group.

l The account for the virtual directory should be given read/write permissions on the shared image
directory.

Note: If your server configuration requires placing servers on different Windows domain
configurations, contact HP Software Support.

If you set a custom path to temporary images, as defined in the images.save.directory.offline
parameter (for details, see "How toModify the Directory inWhich Temporary Image Files Are
Stored" on previous page), youmust map the physical directory containing the images to a virtual
directory in theWeb server on all Gateway Server machines.

To configure the virtual directory in IIS:

1. Rename the default physical directory containing the temporary scheduled report images on
theGateway Server machine.

For example, rename:

<Gateway Server root directory>\AppServer\webapps\

site.war\Imgs\chartTemp\offline

to

<Gateway Server root directory>\AppServer\webapps

\site.war\Imgs\chartTemp\old_offline

2. In the IIS Internet Services Manager on the Gateway Server machine, navigate toDefault
Web site > Topaz > Imgs > ChartTemp.

The renamed offline directory appears in the right frame.

3. In the right frame, right-click and select New > Virtual Directory. The Virtual Directory
CreationWizard opens. Click Next.

4. In the Virtual Directory Alias dialog box, type offline in the Alias box to create the new
virtual directory. Click Next.
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5. In theWeb Site Content Directory dialog box, type or browse to the path of the physical
directory containing the temporary images, as defined in the images.save.directory.offline
parameter (for details, see "How toModify the Directory inWhich Temporary Image Files Are
Stored" on page 95). Click Next.

6. If the physical directory containing the temporary images resides on the local machine, in the
Access Permissions dialog box, specify Read and Write permissions.

If the physical directory containing the temporary images resides on amachine on the network,
in the User Name and Password dialog box, enter a user name and password of a user with
permissions to access that machine.

7. Click Next and Finish to complete Virtual Directory creation.

8. Restart BSM on theGateway Server machine.

9. Repeat the above procedure on all Gateway Server machines.

To configure the virtual directory on Apache HTTP Web Server:

1. Rename the default physical directory containing the temporary scheduled report images on
theGateway Server machine.

For example, rename:

<Gateway Server root

directory>\AppServer\webapps\site.war\Imgs\chartTemp\offline

to

<Gateway Server root

directory>\AppServer\webapps\site.war\Imgs\chartTemp\old_offline

2. Open the Apache configuration file <Gateway Server root
directory>\WebServer\conf\httpd.confwith a text editor.

3. Map a virtual directory named offline to the physical location of the common directory by
adding the following line to the file:

Alias /Imgs/chartTemp/offline <shared_temp_image_directory>

where <shared_temp_image_directory> represents the path to the physical directory
containing the temporary scheduled report images, as defined in the
images.save.directory.offline parameter (for details, see "How toModify the Directory in
Which Temporary Image Files Are Stored" on page 95).

4. Save the file.

5. Restart BSM on theGateway Server machine.

6. Repeat the above procedure on all Gateway Server machines.

To configure the virtual directory on Sun Java SystemWeb Server:

1. Rename the default physical directory containing the temporary scheduled report images on
theGateway Server machine.

For example, rename:
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<Gateway Server root

directory>\AppServer\webapps\site.war\Imgs\chartTemp\offline

to

<Gateway Server root

directory>\AppServer\webapps\site.war\Imgs\chartTemp\old_offline

2. Open the Sun Java SystemWeb Server configuration file <Sun Java System Web Server
installation directory>\server\<server_nam>\config\obj.confwith a text editor.

3. Add the following line inside the <Object name=default> directive (before the line
NameTrans fn=document-root root="$docroot", and before the lineNameTrans
fn="pfx2dir" from="/Imgs" dir="ProductDir/Site Imgs/", if it exists):

NameTrans fn="pfx2dir" from="/topaz/Imgs/chartTemp/offline"

dir="<shared_temp_image_directory>"

where <shared_temp_image_directory> represents the path to the physical directory
containing the temporary scheduled report images, as defined in the
images.save.directory.offline parameter (for details, see "How toModify the Directory in
Which Temporary Image Files Are Stored" on page 95).

4. Save the file.

5. Restart the Sun Java SystemWeb Server on the Gateway Server machine.

6. Repeat the above procedure on all Gateway Server machines.
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How to Modify the Length of Time that BSM Keeps
Temporary Image Files

You canmodify settings that control how long BSM keeps temporary image files generated by the
Gateway Server machine, before removing them from the defined temporary directories. You can
modify settings for the following directories in the <HPBSM Gateway Server root
directory>\conf\topaz.config file:

Directory Setting Description

remove.files.0.path=
../../AppServer/webapps/site.war/Imgs/chartTemp/offline

Path to images created when
generating reports

remove.files.1.path=
../../AppServer/webapps/site.war/Imgs/chartTemp/online

Path to images created when
generating reports in BSM
applications

remove.files.3.path=
../../AppServer/webapps/site.war/snapshots

Path to images created by the
Snapshot on Error mechanism and
viewed in Error Summary reports

For the above temporary image directories, you canmodify the following settings:

l remove.files.directory.number=<number of directories>

Specifies the total number of directories for which you are defining settings.

l remove.files.<num_of_path>.path=<path to directory>

Specifies the path to the directory that contains the files you want to remove. For the default
directories that remove temporary image files, these values must match the
images.save.directory.online and images.save.directory.offline parameters, also defined in
the topaz.config file.

Note: InWindows environments, use UNC path syntax (\\\\server\\path) when defining the
path. In Solaris environments, use forward slashes (/) only when defining the path.

l remove.files.<num_of_path>.expirationTime=<file expiration time in sec>

Specifies the time, in seconds, that BSM leaves a file in the specified directory. For example, if
you specify "3600" (the number of seconds in 1 hour), files older than one hour are removed.

Leave this setting empty if you want BSM to use only maximum size criteria (see below).

l remove.files.<num_of_path>.maxSize=<maximum size of directory in KB>

Specifies the total size, in KB, to which the defined directory can grow before BSM removes
files. For example, if you specify "100000" (100MB), when the directory exceeds 100MB, the
oldest files are removed in order to reduce the directory size to 100MB.

If you also define a value in the remove.files.<num_of_path>.expirationTime parameter,
BSM first removes expired files. BSM then removes additional files if themaximum directory
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size limit is still exceeded, deleting the oldest files first. If no files have passed their expiration
time, BSM removes files based only on themaximum directory size criteria.

This parameter is used in conjunction with the remove.files.<num_of_defined_
path>.deletePercents parameter (see below), which instructs BSM to remove the specified
percentage of files, in addition to the files removed using the remove.files.<num_of_
path>.maxSize parameter.

Leave this and the remove.files.<num_of_defined_path>.deletePercents settings empty if
you want BSM to use only the expiration time criterion.

l remove.files.<num_of_path>.deletePercents=<percent to remove>

Specifies the additional amount by which BSM reduces directory size—expressed as a
percentage of themaximum allowed directory size—after directory size has been initially
reduced according to the remove.files.<num_of_path>.maxSize parameter. BSM deletes the
oldest files first.

Leave this and the remove.files.<num_of_path>.maxSize settings empty if you want BSM to
use only the expiration time criterion.

l remove.files.<num_of_path>.sleepTime=<thread sleep time in sec>

Specifies how often BSM runs themechanism that performs the defined work.

Example:

BSM is instructed to perform the following work once every 30minutes: BSM first checks
whether there are files older than 1 hour and, if so, deletes them. Then BSM checks whether
the total directory size is greater than 250 MB, and if so, it reduces directory size to 250MB
by removing the oldest files. Finally, BSM reduces the total directory size by 50% by
removing the oldest files. As a result, BSM leaves files totaling 125MB in the directory.

# remove files older than 1 hour (3600 sec.)

remove.files.0.expirationTime=3600

# reduce folder size to 250MB

remove.files.0.maxSize=250000

# remove an additional 50% of max. folder size (125MB)

remove.files.0.deletePercents=50

# perform work once every 30min. (1800 sec)

remove.files.0.sleepTime=1800

Tip: You can configure the file removal mechanism to remove files from any defined
directory. You define the parameters and increment the index. For example, to
clean out a temp directory, you would specify 6 instead of 5 for the number of
directories in the remove.files.directory.number parameter; then you would
define the directory's path and settings using the index value 4 (since 0-4 are
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already being used by the default settings) in the num_of_path section of the
parameter. Do not use this mechanism to remove files without first consulting with
your HP Software Support representative.

To modify the default settings:

1. Open the file <HPBSM Gateway Server root directory>\conf\topaz.config in a text editor.

2. Beforemodifying the values, back up the file or comment out (using #) the default lines so that
the default values are available as a reference.

3. Modify the settings as required.

4. Save the topaz.config file.

5. Restart BSM on theGateway Server machine.

6. Repeat the above procedure on all Gateway Server machines.
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How to Specify the Directories from Which
Temporary Image Files Are Removed

By default, temporary image files are removed from the root path of the specified directory.
However, you can also configure BSM to remove temporary image files from the subdirectories of
the specified path.

To configure BSM to remove temporary images files from subdirectories:

1. Open the file <Gateway Server root directory>\conf\topaz.config in a text editor.

2. Insert the following line after the specified path's other settings (described in the previous
section):

remove.files.<num_of_path>.removeRecursively=yes

3. Save the topaz.config file.

4. Restart BSM on theGateway Server machine.

5. Repeat the above procedure on all Gateway Server machines.
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UI Description - Infrastructure Settings Manager
Page

This page enables you to define the value of many settings that determine how BSM and its
applications run.

To access Select Admin> Platform > Setup and Maintenance > Infrastructure Settings

Important
information

Modifying certain settings can adversely affect the performance of BSM. It is
highly recommended not to modify any settings without first consulting HP
Software Support or your HP Services representative.

See also "Database Administration" on page 68

User interface elements are described below:

UI Element
(A-Z) Description

All Select to view all the settings for both Applications and Foundations.

Applications Select to edit one of the BSM Applications.

Description Describes the specific infrastructure setting.

Note: This field is visible on both the Infrastructure Settings Manager page, and

the Edit Setting dialog box after clicking theEdit Setting button next to the
relevant setting.

Foundations Select to edit one of the BSM Foundations.

Name The name of the setting.

Note: This field is visible on both the Infrastructure Settings Manager page, and

the Edit Setting dialog box after clicking theEdit Setting button next to the
relevant setting.

Restore
Default

Restores the default value of the setting.

Note: This button is visible on the Edit Setting dialog box after clicking theEdit

Setting button next to the relevant setting.

Value The current value of the given setting.

Note: This field is visible on both the Infrastructure Settings Manager page, and

the Edit Setting dialog box after clicking theEdit Setting button next to the
relevant setting.
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Audit Log
You use the audit log to keep track of different actions performed by users in the system, according
to specific contexts.

To access

Select Admin > Platform > Setup and Maintenance > Audit Log
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Learn About
About the Audit Log
You use the audit log to keep track of different actions performed by users in the system, according
to specific contexts:

l Alert Administration. Displays actions related to creating andmanaging alerts.

l CI Status Alert Administration. Displays actions related to creating alert schemes for a
configuration item (CI) status alert.

l Data Collector Maintenance. Displays actions related to removing Business Process Monitors
and SiteScopes.

l Database Management. Displays actions related to creating, deleting, andmodifying users and
passwords for profile databases, as well as modifying the status of the PurgingManager.

l Deleted Entities. Displays actions related to adding and deleting data collectors (Business
Process profiles, Real User Monitor engines, and SiteScopemonitors) from EndUser
Management Administration.

l Downtime/Event Scheduling. Displays actions related to creating andmodifying downtime
and scheduled events.

l End User Management Applications. Displays actions related to adding, editing, updating,
disabling and deleting event-based alerts, as well as registering and unregistering alert
recipients.

l IT World Configuration. Displays actions, including editing, updating, and removing CIs and
relationships, performed in the IT UniverseManager application.

l Locations Manager.Displays actions related to adding, modifying, and deleting locations,
performed in the LocationManager application.

l Notification Template Administration. Displays actions related tomodifying open ticket
information, ticket settings, closed tickets, ticket templates, and subscription information:
notification types (locations or general messages), and recipients.

l Operations Management. Displays actions related operations management, such as the
creating andmodifying of content packs, event rules, and notifications.

l Permissions Management. Displays all actions related to assigning permissions, roles, and
permissions operations for resources onto users and user groups.

l Recipient Administration. Displays actions related tomodifying information about the
recipients of audit logs.

l Scheduled Report Administration. Displays actions related tomodifying the reportingmethod
and schedule of reported events.

l Service Health. Displays actions related to the Service Health application.

l Service Health Administration.Displays actions related to configurations made in the Service
Health Administration.

l Service Level Management Configuration. Displays actions related to service level
agreements performed in the Service Level Management application.
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l SLA Alert Administration. Displays actions related to creating, modifying, or deleting SLA
alerts.

l System Availability Manager. Displays actions related to system availability and SiteScope.

l User Defined Reports. Displays actions related to the creation andmodification of Custom
reports.

l User/Group Management. Displays actions related to adding, modifying, and deleting users
and user groups.

l View Manager. Displays actions related to KPIs such as adding a KPI, editing a KPI, and
deleting a KPI. Additionally, it displays actions related to changing theSave KPI data over
time for this CI and theMonitor changes options.
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Tasks
How to Use the Audit Log
This task describes how to access the Audit Log, which is available from the Audit Log page in the
Setup andMaintenancemenu in Platform Administration.

To use the Audit Log:

1. Select Admin > Platform > Setup and Maintenance > Audit Log. The Audit Log page
opens.

2. Select a context using the Context filter.

3. Where relevant, select a profile from the list. BSM updates the table with the relevant
information.

4. Optionally, click the Auditing Filters link to open the Auditing Filters pane and specify filter
criteria. The following filters are available:

n User. Specify a user in the system to view actions performed by only that user.

n Containing text. Specify a text string that the actionmust contain to be displayed.

n Start after and End before. Specify a starting and ending time period to view actions for

only that period. Click theMore button to open the Calendar dialog box where you can
select a date.

5. Click Apply. BSM updates the table with the relevant information.

If required, use thePrevious Page arrow to navigate to the previous page of the Audit Log, or

theNext Page arrow to navigate to the next page of the Audit Log.

How to Customize a Log File for Audit Log

Audit log uses the Apache log4j logging utility.

To customize the log file, edit its configuration file, located at <HPBSM root
directory>\conf\core\Tools\log4j\EJB\auditlog.properties, using the log4j configuration syntax.
The log level should be set to INFO or higher. The appender name,
com.mercury.topaz.tmc.bizobjects.audit.AuditManager.writeAudit, should not be changed.
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UI Descriptions
Audit Log Page
This page enables you to keep track of different actions performed by users in the system.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

Moves to the previous page or next page in the Audit Log.

<Audit log
table>

Displays the contents of the audit log.

<EUM
applications>

Select an <EUM application> for which you want to view the actions
performed.

Note: This field is displayed only if you have chosen the End User
Management-Applications context.

Auditing
Filters

Click the Auditing Filters heading to specify filter criteria.

Context Select a context to view.

For user Displays the user whose actions are displayed in the Audit Log, as specified in
the Auditing Filters pane.

Default Value:All

SiteScope Select a SiteScope for which you want to view the actions performed.

Note: This field is displayed only if you have chosen the System Availability
Manager context.

Time period Displays the time period whose actions are displayed in the Audit Log, as
specified in the Auditing Filters pane.

Default Value:All

Auditing Filters Pane
User interface elements are described below:

UI Element (A-
Z) Description

Opens the Calendar dialog box enabling you to select a date.

Expands the Auditing Filters pane.
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UI Element (A-
Z) Description

Collapses the Auditing Filters pane.

Apply Applies the selected filters.

Cancel Cancels filtering and closes the Auditing Filters pane.

Clear All Clears the filters and displays all log items.

Containing text Specify a text string to filter out all the actions that do not include this text
string.

End before Specify an ending time until which you want to view actions.

Start after Specify a starting time from which you want to view actions.

User Select a user to view actions performed by only that user.

Audit Log Table

Important
information

For details about the audit log for the EUM Alert Administration, see Alerts Log
Report in the BSMUser Guide.

User interface elements are described below:

UI Element (A-Z) Description

Actions Displays the actions performed by the specified user.

Additional Information Displays additional information, where relevant.

Modification Date Displays the date and time that the specified actions were performed.

Modified By Displays the user who performed the specified actions.
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BSM Server Time Synchronization
In order to ensure that the BSM serve clocks are accurate and synchronized, the BSM servers
check their system clocks against an NTP server every twenty minutes by default.

Several NTP servers are configured by default, but you canmanually add one in the configuration
file:

<BSM_HOME>\conf\settings\mtime\mtime.xml

If no NTP server is reachable, the database clock is used for synchronization instead.
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How to View the BSM Server Time
You can view the current BSM server time via the following URLs:

To view Unix time in plain text:

http://<BSM_Server>/topaz/services/technical/time?alt=text/plain

Example results:

1314089070858

To view the current time in XML format:

http://<BSM_Server>/topaz/services/technical/time

Example results:

<entry xmlns="http://www.w3.org/2005/Atom">

<id>timeService:1</id>

<title type="text" xml:lang="en">Time service.</title>

<summary type="text" xml:lang="en">The time is 2011-08-23 08:44:30,

858</summary>

<published>2011-08-23T11:44:31.382+03:00</published>

<content type="text">1314089070858</content>

</entry>

To view the log for this feature, see:

<BSM_HOME>\logs\topaz_all.ejb.log
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Working in Non-English Locales
This section describes how to configure BSM to work with languages other than English and
discusses some of the issues that arise when using a non-Latin character set.
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Installation and Deployment Issues
l If you use a CJK language in your browser, youmust ensure that the Gateway Server machine

running BSM has East Asian languages installed. On themachine on which the BSMGateway
Server is installed, youmust select Control Panel > Regional & Language Options >
Languages > Install files for East Asian languages.

l If you have installed BSM on a non-EnglishWindows operating system, the command line tool
output may not be displayed correctly because theWindows andOEM code pages differ. This
may not be the case onmany Asian language systems, but is often experienced on non-English
European systems.

To fix this, Windows Command Prompt must be configured so that a TrueType font is used and
theOEM code page is the same as theWindows code page.

In aWindows Command Prompt window (run cmd.exe), right-click the title bar, select
Properties, and open the Font tab. Change the font from Raster Fonts to a TrueType font, and
change the font size if necessary (for example: select Lucida Console, 12 pt). If prompted,
modify the shortcut to make the font change global.

Note: If you use other command line tools, such as PowerShell or Cygwin Bash, you
must change the font for each of these tools separately.

To change the codeset for the system, open the registry editor (regedit), and go to:
Computer\HKEY_LOCAL_MACHINE\SYSTEM\

CurrentControlSet\Control\Nls\CodePage. If the values of ACP andOEMCP differ,
edit OEMCP to the same value as for ACP, and reboot the system.

Note: If changing the OEM code page for the system is not acceptable, for each newly
opened Comand Prompt window, change the code page value using the command: chcp
<APC value>.

l Business Process Monitors and theGateway Server must be installed on an operating system
that has the same locale as the data.

l During Business Process Monitor installation, non-Latin characters cannot be used for the host
name and location. If necessary, after installation you can change the names to include non-
Latin characters, inAdmin > End User Management > Settings.

l The installation path for all BSM components must not contain non-Latin characters.

l When content packs are available in more than one language, the language of content packs
automatically loaded during BSM installation depends on the current locale of the host operating
system. If there arematching content packs for the current locale, these are installed. If the
locale does not have localized content packs, English content packs are used. Later, a user can
upload the content pack in another languagemanually.

At every Gateway Server startup, the contents of the following directory is checked: <HPBSM
root directory>/conf/opr/content/<locale of server>
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Any package that has not already been loaded, and that does not have unresolved package
dependencies (references to packages, which are neither already loaded nor in the same folder),
is loaded during this startup.

The following directory is checked next: <HPBSM root directory>/conf/opr/content/en_US

Any content packs that were not uploaded from the first location are uploaded. This can result in
mixed-language content.

The packages are loaded with the standard import mode; already existing artifacts are not
changed. Only new artifacts are added.

Note: Progress can be followed in the admin backend log file. The operation is done in the
background andmay still be in progress when a user logs in. The system prevents multiple
content packages from being loaded at the same time.
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Database Environment Issues
l Towork in a non-Latin-character language BSM environment, you can use either anOracle

Server database or aMicrosoft SQL Server database. When using aMicrosoft SQL Server
database, it should use the same encoding as you use in your BSM servers. When using an
Oracle Server database, the encoding of the database can also be UTF-8 or AL32UTF-8, which
supports both non-Latin-character languages as well as multiple languages. For a list of
supported and tested database servers, refer to the BSM System Requirements and Support
Matrixes.

l When you create a new Oracle instance in anOracle database, youmust specify the character
set for the instance. All character data, including data in the data dictionary, is stored in the
instance's character set. For details on working with Oracle databases, refer to Deploying and
Maintaining the Oracle Server Database in the BSMDatabaseGuide. For supported and
certified Oracle character sets, refer to Oracle Summary Checklist in the BSMDatabaseGuide.

l The SiteScope DatabaseQuery Monitor can connect to anOracle database but the Oracle user
names and passwords must contain only Latin characters.
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Administration Issues
l E-mail alerts sent with ISO-2022-JP encoding are supported only by an SMTP server running on

aWindows platform. Use of this encoding affects all BSM servers.

l When using the default authentication strategy, Lightweight SSO, to authenticate users logging
into BSM, user names and passwords can be in non-Latin characters.

l To support non-Latin characters in BSM databases, the encoding for databases must be defined
as UTF-8 or AL32UTF-8 (Oracle only), or set to the specific language.

l To support non-Latin characters in log files, set the log4j encoding property on the log4j
configuration files.

To write a specific log in UTF-8 encoding, do the following:

n Search the specific log name in log4j configuration at conf/core/Tools/log4j.

n In the properties file where this log file is configured, add the following property:

log4j.appender.<appender name>.Encoding=UTF-8

For example, the jboss_server.log configuration follows:

#######################################

### define appender: jboss.appender ###

#######################################

# jboss.appender is set to be a FileAppender which outputs to

log/jboss_server.log

log4j.appender.jboss.appender=org.apache.log4j.RollingFileAppender

log4j.appender.jboss.appender.File=${merc.home}/${log.file.path}

/jboss_server.log

log4j.appender.jboss.appender.MaxFileSize=${def.file.max.size}

log4j.appender.jboss.appender.Encoding=UTF-8

log4j.-

appender.jboss.appender.MaxBackupIndex=${def.files.backup.count}

log4j.-

appender.jboss.appender.layout=org.apache.log4j.PatternLayout

log4j.-

appender.jboss.appender.layout.ConversionPattern=${msg.layout}

HP Business ServiceManagement (9.20)Page 116 of 427



BSM Platform Administration Guide
Chapter 11: Working in Non-English Locales

Service Health Issues
Youmay have to perform several steps to enable displaying non-Latin languages in the Service
Health Top View.

To display non-Latin languages in Service Health Top View:

1. Verify that you have followed the instructions on installing the JRE on a non-WesternWindows
system. The instructions are found at the SunMicrosystems site
(http://java.sun.com/j2se/1.5.0/jre/install-windows.html).

2. Make sure that you:

n have administrative permissions to install the J2SE Runtime Environment onMicrosoft
Windows 2000 and XP.

n (For users installing the JRE on non-Western 32-bit machines) choose aCustom Setup
Type. In Custom Setup under feature 2 (Support for Additional Languages), select This
feature is installed on local hard drive.

3. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings, click
Applications, select Service Health Application, and locate the Top View Font Name
entry in theService Health Application – Top View Properties table. Change the value to
Arial Unicode MS.

Caution: If the value of the Top View Font Name entry is default, you do not need to
perform this step, as the Top View Font Name property automatically assumes
the Arial UnicodeMS value in that case.

4. Close all instances of theWeb browser.

5. Log into BSM and access Service Health Top View. Verify that the Chinese or Japanese
characters now appear correctly.
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Service Level Management Issues
Service Level Management does not support service names that contain more than 50multibyte
characters.
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Application Management for Siebel Issues
l Non-Latin characters may not appear or may be corrupted in the Topology View. If you

encounter this problem, install the Arial UnicodeMicrosoft font from theMicrosoft Web site.

l BSM by default only supports English language Siebel. Do not deliver data from a non-English
version of Siebel to BSM. You should use special translation adapters to enable BSM to work
with a non-English version of the Siebel application. For details, contact HP Software Support.
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Report Issues
l BSM does not support Custom Report names that contain more than 50multibyte characters.

l The Page Component Breakdown report does not support URLs that contain multibyte
characters. When specifying a URL and a location from which to run the breakdown, youmust
enter Latin characters in the URL box.

l Excel reports must have Latin-character file names when uploading to BSM running on a
Chinese Simplified operating system. To view Excel reports, select Applications > User
Reports > Report Manager.

l Reports downloaded from BSM to Excel cannot be displayed properly on an operating system
whose language differs from the data language.

To download Excel files with multibyte data when BSM is installed on an English-language
machine, set the user.encoding entry in the <HPBSM root
directory>\AppServer\resources\strings.properties file to the correct encoding.
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Business Process Monitor Issues
l If the Business Process Monitor (BPM) log files contain non-Latin-character data, youmust

open them in a viewer that supports UTF-8 format parsing, for example, Notepad, rather than
from the View BPM Files window in the BPM Admin Console.

Log files that are saved in the default encoding of the server on which the BPM Admin Console
is installed are shown correctly in the View BPM Files window.

l All BPM instances (application, scripts, parameters, etc.) should be namedwith Latin
characters or BPM Server locale characters only.
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SiteScope Issues
l In international version SiteScopes (supportingmultilingual character sets), theReturn to

Group link displayed duringmonitor set creation shows the indexed-based group name (for
example, group0) instead of the user-defined group name.

l The DatabaseQuery Monitor can connect to anOracle database only if the Oracle user names
and passwords contain Latin-only characters.

l SiteScope does not support non-Latin characters in the username/password.

l The user interface can be displayed in several languages. For details, see Using SiteScope in an
Internationalization (I18N) Environment in the SiteScope Help.

l For a list of monitors that are tested for internationalization, seeMonitors Supported for
Internationalization in the SiteScope Help.
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Real User Monitor Issues
l Real User Monitor supports non-Latin characters in UTF-8 format. For details on configuring the

HPReal User Monitor probe to support non-Unicode encodings, see Configuring the HP Real
User Monitor Probe for I18N in the Real User Monitor Administration Guide.

l To support non-Latin characters from Real User Monitor, the encoding for BSM databases must
be defined as UTF-8, or set to the specific language. For further details, see "Database
Environment Issues" on page 115.

l The Real User Monitor ProbeWindows installation screens are not translated and are in English
only. For details on installing the Real User Monitor Probe, see Installing the HP Real User
Monitor Probe in the Real User Monitor Administration Guide.
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End User Management Administration Issues
l Global replace does not support non-Latin-character languages.

l When accessing the Status Snapshot in End User Management (Applications > End User
Management > Status Snapshot), certain characters appear unreadable. To resolve this,
ensure that you have installed files for East Asian Languages on your local machine, as follows:

Select Start > Control Panel > Regional and Language Options > select the Languages tab
> select Install Files for East Asian Languages.
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Data Flow Management Issues
When exporting a CI instance to a PDF file, Japanese characters are not displayed in the PDF file.
(Data Flow Management > Discovery Control Panel > Basic Mode. Run discovery. When
discovery has finished, select a CIT in theStatistics Results pane. Click theView Instances
button. In the Discovered by dialog box, select Export Data to File > Export Displayed CIs to
PDF.)
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Multilingual Issues
l The SNMP notificationmethod does not support multilingual text, and can only send a

notification in the character set of the Gateway Server machine. This is because BSM uses
SNMP version 1.0, which does not support multilingual data.

l Error messages in the Failed Transactions report do not display correctly when BSM runs on an
English operating system and the Business Process Monitor runs on a Japanese operating
system. To access the Failed Transactions report, select Applications > End User
Management > Business Processes > Error Summary. Locate the General Errors table, and
click a link to open the Failed Transactions window.

l BSM can storemultilingual data. However, a regular executable cannot usually accept
multilingual data on the command line.

The following table describes the procedures that youmust perform to addmultilingual data to
the command line when running an executable file upon alert:

Platform Procedure

Windows To prevent multilingual data from being lost, write the application with a wmain
function instead of amain function. You can also use another main-type function
that can take command line parameters of type wchar instead of type char.

Note:When you use the SubAlerts command line option, the created XML file
does not include an encoding attribute, and the encoding is different from the
default UTF-8 encoding.

Solaris Inform the writer of the application that the parameters passed to the application
must be encoded in UTF-8.

For details on Using a Custom Command LineWhenRunning an Executable File upon Alert,
see Run Executable File Dialog Box in the BSM Application Administration Guide.

l An executable file that was created for a previous version of BSM is compatible with a
multilingual version.
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Multilingual User (MLU) Interface Support
The BSM user interface can be viewed in the following languages in yourWeb browser:

Language Language Preference in Web Browser

English English

French French (France) [fr]

Japanese Japanese [ja]

Korean Korean [ko]

Simplified Chinese Chinese (China) [zh-cn]

The following are languages in which BSM can operate but the user interface of only Run-time
ServiceModel (RTSM)-related pages are presented in the language.

Language Language Preference in Web Browser

Dutch Dutch (Netherlands) [nl]

German German (Germany) [de]

Portuguese Portuguese (Brazil) [pt-br]

Russian Russian [ru]

Spanish Spanish [es]

Italian Italian (Italy) [it]

Use the language preference option in your browser to select how to view BSM. The language
preference chosen affects only your local machine (the client machine) and not the BSMmachine or
any other user accessing the same BSMmachine.

To set up and view BSM in a specific language:

1. Install the appropriate language's fonts on your local machine if they are not yet installed. If you
choose a language in yourWeb browser whose fonts have not been installed, BSM displays
the characters as squares.

2. If you are logged into BSM, youmust log out. Click Logout at the top of the BSMwindow.

Close every open browser window or alternatively clear the cache (if BSM is running on
Internet Explorer).

3. If BSM is running on Internet Explorer, configure theWeb browser on your local machine to
select the language in which you want to view BSM (Tools > Internet Options).

a. Click the Languages button and in the Language Preference dialog box, highlight the
language in which you want to view BSM.

b. If the language you want is not listed in the dialog box, click Add to display the list of
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languages. Select the language you want to add and click OK.

c. Click Move Up to move the selected language to the first row.

d. Click OK to save the settings.

e. Display the BSM login window.

f. From the Internet Explorer menu, select View > Refresh. BSM immediately refreshes and
the user interface is displayed in the selected language.

Note: For details on viewingWeb pages in Internet Explorer that are written in a
different language, see How to View Web Pages That AreWritten in a Different
Language (http://support.microsoft.com/kb/306872/en-us).

4. If BSM is being viewed on FireFox, configure theWeb browser on your local machine as
follows:

a. Select Tools > Options > Advanced. Click Edit Languages. The Language dialog box
opens.

b. Highlight the language in which you want to view BSM.

If the language you want is not listed in the dialog box, expand theSelect language to
add... list, select the language, and click Add.

c. Click Move Up to move the selected language to the first row.

d. Click OK to save the settings. Click OK to close the Language dialog box.

Notes and Limitations
n There is no language pack installation. All translated languages are integrated into the BSM

Multilingual User Interface (MLU).

n Data remains in the language it is entered in, even if the language of theWeb browser
changes. Changing the language of theWeb browser on your local machine does not change
the language of any data that was entered by a user.

n You cannot deploy a package if the server locale is different from the client locale and the
package name contains non-Latin characters. For details, see "PackageManager" in the
RTSM Administration Guide.

n You cannot create a package that contains resources (for example, views and TQLs) having
non-Latin characters in their names, if the server locale is different from the client locale. For
details, see "Package Creation and Deployment in a Non-English Locale" in the RTSM
Administration Guide.

n In theModeling Studio, you cannot create a new view if the view's name contains more than
18 Japanese characters. For details on creating new views, see "Modeling Studio" in
Modeling.

n In LocationManager, all geographical locations are in English, regardless of the UI language
selected. Logical locations may be named in any language you choose, and remain in that
language even if the UI language is subsequently changed.
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n The BSM server status HTML page appears only in English. It is not translated into any other
language. For details, see Post-Deployment in the BSM Installation Guide.
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BSM Logs
Note: This chapter is not relevant for HP Software-as-a-Service customers.

BSM records the procedures and actions performed by the various components in log files. The log
files are usually designed to serve HP Software Support when BSM does not perform as expected.

The default severity threshold level for log files differs per log, but is generally set to eitherWarning
orError. For a definition of log levels, see "Log Severity Levels " on page 132.

You can view log files with any text editor.
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Log File Locations
Most log files are located in the <HPBSM root directory>\log directory and in subdirectories
organized by component.

Log file properties are defined in files in the following directory and its subdirectories: <HPBSM
root directory>\conf\core\Tools\log4j.

Log File Locations in a Distributed Deployment
In one-machine or compact installations, all BSM servers and their logs reside on the same
machine. In the case of a distributed deployment of the servers among several machines, logs for a
particular server are usually saved on the computer on which the server is installed. However, if it is
necessary for you to inspect logs, you should do so on all machines.

When comparing logs on client machines to those on the BSM server machines, keep inmind that
the date and time recorded in a log are taken from themachine on which the log was produced. It
follows that if there is a time difference between the server and client machines, the same event is
recorded by each with a different time stamp.
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Log Severity Levels
Each log is set so that the information it records corresponds to a certain severity threshold.
Because the various logs are used to keep track of different information, each is preset to an
appropriate default level. For details on changing the log level, see "How to Change Log Levels" on
page 135.

Typical log levels are listed below from narrowest to widest scope:

l Error. The log records only events that adversely affect the immediate functioning of BSM.
When amalfunction occurs, you can check if Error messages were logged and inspect their
content to trace the source of the failure.

l Warning. The log's scope includes, in addition to Error-level events, problems for which BSM is
currently able to compensate and incidents that should be noted to prevent possible future
malfunctions.

l Info. The log records all activity. Most of the information is normally routine and of little use and
the log file quickly fills up.

l Debug. This level is used by HP Software Support when troubleshooting problems.

Note: The names of the different log levels may vary slightly on different servers and for
different procedures. For example, Infomay be referred to as Always logged or Flow.

HP Business ServiceManagement (9.20)Page 132 of 427



BSM Platform Administration Guide
Chapter 12: BSM Logs

Log File Size and Automatic Archiving
A size limit is set for each type of log file. When a file reaches this limit, it is renamed and becomes
an archived log. A new active log file is then created.

For many logs, the number of archived log files saved can be configured. When a file reaches its
size limit, it is renamedwith the numbered extension 1. If there is currently an archived log with the
extension 1, it is renamedwith the extension 2, log.2 becomes log.3, and so on, until the oldest
archived log file (with the number corresponding to themaximum number of files to be saved) is
permanently deleted.

The following image shows an example of a log file, topaz_all.ejb.log, and its archived copies:

Themaximum file size and the number of archived log files are defined in the log properties files
located in <HPBSM root directory>\conf\core\Tools\log4j. An example is:

def.file.max.size=2000KB

def.files.backup.count=10
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JBoss and Tomcat Logs
The following <HPBSM root directory>\log directory holds JBoss- and Tomcat-related log files:

l jboss_boot.log. Logs startup activities including running the JBoss process, deployment, and
startup status, as well as the number of busy ports.

l jboss_server.log. Logs all JBoss activities including JBoss messages, deployment and startup
status.

l jboss_tomcat.log. Logs the Tomcat messages.

Note: You can view the JMX Console at http://<HPBSM server>:8080/jmx-

console.
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How to Change Log Levels
This task and the associated flowchart describe how to set up a system for delivering alerts to
recipients.

If requested by HP Software Support, youmay have to change the severity threshold level in a log,
for example, to a debug level.

To change the severity threshold level:

1. Open the log properties file in a text editor. Log file properties are defined in files in the following
directory: <HPBSM root directory>\conf\core\Tools\log4j.

2. Locate the loglevel parameter. For example,

loglevel=ERROR

3. Change the level to the required level. For example,

loglevel=DEBUG

4. Save the file.
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How to Enable Debug Trace Logging for an Event
It is possible to enable debug trace logging for an event by setting the custom attribute __TRACE_
_. It may have any value. This creates flow trace logs at the INFO level for this event.

This can be set on the HPOM server or agent sending the event, or can later be added to the event.
Whenever this custom attribute is set on an event, trace output for this event appears in the trace
logs:

l BSMData Processing Server: log/opr-backend/opr-flowtrace-backend.log

l BSMGateway Server: log/opr-gateway/opr-flowtrace-gateway.log

Default event flow trace logging level is set to INFO. Only events with the custom attribute __
TRACE__ set are logged to the flow trace log files. To enable flow tracing for all events, set the flow
trace log level to DEBUG.
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Logging Administrator
This tool allows you to temporarily modify the level of details displayed in BSM logs, as well as
create custom logs. To open the BSM Logging Administrator Tool, open the following URL:

http://<BSM Gateway Server>/topaz/logAdminBsm.jsp
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Port Usage
This section describes how to configure the ports that are used by BSM.
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How to Change Ports Manually
This section contains information about how to change different ports manually. The procedure
differs for each port.

Manually Changing Port 80
Port 80 is used by the BSMWeb Server. Tomodify this port, youmust reconfigure other
components on the BSM server and restart BSM.

1. Modify the virtual Gateway Server settings.

a. Navigate toAdministration Tab > Platform > Setup and Maintenance Tab >
Infrastructure Settings and locate thePlatform Administration - Host Configuration
table. If this table is not visible, set theSelect Context option toAll.

b. Modify theVirtual Gateway Server for Application Users URL to http://<server
name>:<new port>.

c. Modify theDefault Virtual Gateway Server for Data Collectors URL to http://<server
name>:<new port>.

2. Modify the direct Gateway Server settings

a. In the same table, modify theDirect Gateway Server for Application Users Server
URL to include the new port.

b. Modify theDirect Gateway Server for Data Collectors URL to include the new port.

3. Modify the local virtual Gateway Server settings

a. In the same table, modify the Local Virtual Gateway Server for Application Users URL
to include the new port.

b. Modify the Local Virtual Gateway Server for Data Collectors URL to include the new
port.

4. Modify the Open BSMURL

a. Remotely connect to the BSMGateway server and select Start > All Programs > HP
Business Service Management.

b. Right-click Open HP Business Service Management and select Properties.

c. In theWeb Document tab, modify theURL field as follows: http://<Gateway
Server>:<new port>/topaz.

5. Modify the web server settings

Modify the web server settings. This procedure varies depending on your version of windows
and web server type. They should all be performed in the BSMGateway server. The following
are examples forWindows Server 2008 using three different web servers:

For IIS 6.0 with Windows Server 2008:

a. In theMicrosoft IIS Internet Services Manager, right-click Default Web Site and select
Properties.

b. In theWeb Site tab, modify the TCP Port value as required.
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For IIS 7.x with Windows Server 2008:

a. OpenMicrosoft’s Computer Management tool by right-clickingMy Computer and
selectingManage.

b. ExpandRoles > Web Server and select Internet Information Services.

c. In the right-hand panel you can see the IIS Manager. In the left part of this panel
(Connections), expand the connection of the current machine and expand theSites node.

d. Right-click Default Web Site and select Edit Bindings.

e. Select the line that listens to port 80 and click edit to change the value to the new port.

For Apache with Windows Server 2008:

a. Open the file <BSM_Gateway_home>\WebServer\conf\httpd.conf in a text editor.

b. Go to the line that begins with Listen, andmodify the port value as required.

c. Go to the line that begins withServerName andmodify the port value as required.

6. Restart all BSM servers and update data collectors

Restart all BSM servers and update any data collectors that were configured before you
modified the port (for example, RUM, BPM, SiteScope). Modify the Gateway Server address in
each data collector to reflect the new port as follows: BSM Gateway>:<new port>.

Manually Changing Ports 1433 and 1521
These ports control the communication between HP BSM andDatabase Servers.

1. Modify theManagement Database port

Run the Setup and Database Configuration Utility. Skip to the screen that specified the
Management Database port andmodify it as desired. For details about the Setup and
Database Configuration Utility, see the BSM Installation Guide.

Note: You can also perform this proceduremanually as follows: On all BSM servers
(Gateway and DPS), open <BSM_home>\conf\TopazInfra.ini in a text editor andmodify
the dbPort property as required.

2. Modify Profile Database port.

Navigate toAdmin > Platform > Setup and Maintenance > Manage Profile Databases
and click theEdit Database Properties button tomodify the desired database configuration to
include the new port.

3. Restart all BSM servers.
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Incoming BSM Traffic

Note: The ports listed here are those ports that BSM uses. If you need to change a port
assignment, it is strongly recommended that you first consult with HP Software Support.

There are two categories of incoming BSM traffic:

Internal Traffic
Internal traffic is the traffic between two BSM servers. The following table lists the ports used to
transmit data between two BSM servers:

Port
Number

BSM Servers that
Listen on Port Port Usage

4444 Gateway Server,
Data Processing
Server

RemoteMethod Invocation (RMI) channel between BSM
servers

4445 Gateway Server,
Data Processing
Server

RMI channel between BSM servers

9389 Gateway Server TCP local LDAP connection for communication between
Gateway Servers in a distributed deployment environment

2506 Data Processing
Server

Bus domainmanager for the connection between the Data
Processing Server and theGateway Server

2507 Gateway Server,
Data Processing
Server

Main bus processes for the connection between BSM servers

383 Gateway Server,
Data Processing
Server

Events coming from Operations Manager into the Operations
Management application

External Traffic
External traffic is the traffic coming into one of the BSM servers from a client that is not a BSM
server. The following table lists the ports used to transmit data from an external BSM client
machine to a BSM server:

Port
Number

BSM Servers that Listen on
Port Port Usage

80/443 Gateway Server l 80. HTTP/S channel to Gateway Server
applications

l 443. Port for reverse proxy
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Outgoing BSM Traffic

Note: The ports listed here are those ports that BSM uses. If you need to change a port
assignment, it is strongly recommended that you first consult with HP Software Support.

The following table lists the ports used by the BSM servers to connect to external servers (non-
BSM servers):

Port
Number

BSM Servers
that Connect to
Port Port Usage

25 Gateway Server,
Data Processing
Server

SMTP channel from the BSM servers to the SMTP mail server

123 Gateway Server NTP channel from theGateway Server to the NTP server

161 Data Processing
Server

SNMP channel from the Data Processing Server to the SNMP
manager

389 Gateway Server Connection between theGateway Server and LDAP server for
authentication (optional). For more information, see
"Authentication Strategies" on page 340.

1433 Gateway Server,
Data Processing
Server

Connection between the BSM servers and theMicrosoft SQL
Server.

This is the default port. This port may be changed during
installation or thereafter.

1434 Gateway Server,
Data Processing
Server

Connection between the BSM servers and theMicrosoft SQL
Browser Service.

This port is in use only when a named instance is used.

1521 Gateway Server,
Data Processing
Server

Connection between the BSM servers and theOracle Server

This is the default port. This port may be changed during
installation or thereafter.

80/443 Gateway Server l 80. HTTP/S channel between theGateway Server and data
collectors for remote administration tasks

l 443. Port for reverse proxy
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Local BSM Traffic
The table below lists the ports used for communication between components on all BSM server
machine.

Note: The ports listed here are those ports that BSM uses. If you need to change a port
assignment, it is strongly recommended that you first consult with HP Software Support.

Port Number
BSM Servers that
Connect to Port Port Usage

1098 Gateway Server, Data
Processing Server

RemoteMethod Invocation (RMI) management
channel used by the jboss application server

1099 Gateway Server, Data
Processing Server

Naming service used by the jboss application server

4504 Gateway Server TCP local LDAP connection used by the Gateway
Server

5001 Gateway Server Used to connect VuGen to Central Repository Service

8009 Gateway Server, Data
Processing Server

Tomcat AJP13 connector

8010 Gateway Server, Data
Processing Server

Tomcat AJP13 forWDE connector

8080 Gateway Server, Data
Processing Server

HTTP channel for samemachine components

8083 Gateway Server, Data
Processing Server

RMI dynamic class loading

8093 Gateway Server, Data
Processing Server

TCP JMS OIL/2 and UIL used by the jboss application
server

11020 Gateway Server, Data
Processing Server

RMI management channel for the BSM service

11021 Gateway Server, Data
Processing Server

HTTP channel for the BSM service

21212 Data Processing
Server

HTTP channel for the RTSM process

21301 Data Processing
Server

RMI communication from backend to EPI server
Admin services

21302 Gateway Server RMI communication from console web-app to admin
web-app
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Port Number
BSM Servers that
Connect to Port Port Usage

21303 Gateway Server RMI communication from console web-app to custom
action script server running on the same host

29601 Gateway Server, Data
Processing Server

RMI management channel for the jboss application
server

29602 Gateway Server, Data
Processing Server

RMI management channel for the bus processes

29603 Gateway Server RMI management channel for the DB Loader process

29604 Gateway Server RMI management channel for theWebData Entry
(WDE) process

29608 Data Processing
Server

RMI management channel for the Offline BLE process

29610 Data Processing
Server

RMI management channel for the Partition and Purging
Manager

29612 Gateway Server, Data
Processing Server

RMI management channel for the RTSM process

29616 Gateway Server RMI management channel for the Scheduler process

29620 Data Processing
Server

RMI management channel for the BPI repository

29622 Data Processing
Server

RMI management channel for the Operations Manager
backend process

29628 Data Processing
Server

RMI for script execution for pipeline processing in OMi

29629 Gateway Server RMI for script execution for customizable context
menus in the event browser of OMi

29630 Data Processing
Server

RMI

29700 Data Processing
Server

RMI port for online BLE processes

29711,29712,
29713, 29714

Data Processing
Server

RMI port for online BLE processes

29720 Data Processing
Server

RMI port for online BLE processes

29800 Data Processing
Server

HTTP port for online BLE processes
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Port Number
BSM Servers that
Connect to Port Port Usage

29807 Gateway Server, Data
Processing Server

Shutdown of main bus processes

29811,29812,
29813

Data Processing
Server

HTTP port for online BLE processes

29820 Data Processing
Server

HTTP port for online BLE processes

29903 Gateway Server HTTP channel for the DB Loader process

29904 Gateway Server HTTP channel for theWebData Entry (WDE) process

29908 Data Processing
Server

HTTP channel for the Offline BLE process

29910 Data Processing
Server

HTTP channel for the Partition and PurgingManager

29916 Gateway Server HTTP channel for the Scheduler process

29922 Data Processing
Server

HTTP channel for the Operations Manager backend
process

29928 Data Processing
Server

HTTP port for script execution for pipeline processing
in OMi

29929 Gateway Server HTTP port for script execution for customizable
context menus in the event browser of OMi

29930 Data Processing
Server

HTTP

30020 Data Processing
Server

HTTP port for online business logic engine processes

31000-31999;

32000-32999

Gateway Server, Data
Processing Server

BSM service, uses the first available port in each range

Dynamic
ports

Gateway Server, Data
Processing Server

Some dynamic ports are used for inter-component
channels
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File Backup Recommendations
BSM directories that contain key configuration and data files should be backed up on a daily basis
as a precautionary measure.

The table below lists the BSM directories that contain such files and should therefore be backed up.
All directories are under <HPBSM root directory>.

Resource Comments

\HPBSM\BLE Configuration of business rules. Back up if
business rules have been created.

\HPBSM\conf Assorted BSM configuration files.

\HPBSM\dat Assorted BSM configuration files.

\HPBSM\dbverify\conf Configuration files for dbverify. This directory
does not have to be backed up if dbverify has
not been run.

\HPBSM\EJBContainer\bin Configuration files for the scripts used to run
BSM, and environment settings.

\HPBSM\bin BSM binary files. Back up if changes weremade
to any of the installation defaults.

\HPBSM\lib BSM library files. Back up if changes weremade
to any of the installation defaults.

\HPBSM\AppServer\GDE Configuration files for the Generic Reporting
Engine, used for obtaining data for reports.

\HPBSM\odb\conf RTSMmain configuration directory

\HPBSM\odb\lib RTSM library files. Back up if changes were
made to any of the installation defaults.

\HPBSM\odb\classes RTSM patch files. Back up if any patches were
added.

\HPBSM\odb\runtime\fcmdb RTSM adapter files.

\HPBSM\_postinstall Post-installation configuration files.

\HPBSM\opr\bin Operations Management application binary files.
Back up if changes weremade to any of the
installation defaults.
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Resource Comments

\HPBSM\opr\lib Operations Management library files. Back up if
changes weremade to any of the installation
defaults.

\HPBSM\opr\webapps BSMWeb application files. Back up if changes
weremade to any of the installation defaults.

\HPBSM\opr\newconfig Assorted BSM configuration files and libraries.

\HPBSM\AppServer\webapps\site.war\WEB-
INF\sam\hi-mapping-monitors.xml

Custom EMS monitor types. Back up if any
customer EMS SiteScopemonitors were
configured.
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Location Manager
The LocationManager is used to define geographical and logical location CIs and assign them
ranges of IP addresses. Location CIs can be attached to any other CI. They are used, for example,
to attach a location to a Business Process Monitor (BPM) agent or a page discovered automatically
by Real User Monitor (RUM).

To access the LocationManager:

Select Admin > Platform > Locations
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Learn More
Location Manager Overview
You can:

l Access LocationManager from EndUser Management Administration (Admin > End User

Management > Settings > Business Process Monitor Settings > BPM Agents). Click
to open the Change Agent Location dialog box.

l View location CIs in the IT UniverseManager (Admin > RTSM Administration > Modeling >
IT Universe Manager). To see location CIs, select Locations view.

LocationManager is accessible to users who have Administrator or SystemModifier predefined
permissions. Permissions are configured inAdmin > Platform > Users and Permissions.

Location Details and Descriptions

Location Entity. An entity that describes a place in the world. It may be a geographical location,
such as a country or a city, or a logical location, such as a building. The location entity may be
connected to devices and logical CIs representing end-users or data center locations.

Geographical Location. An absolute location in the world, selected from a predefined list of
cities/states/countries, and assigned specific geographical coordinates.

Logical Location. A user-defined virtual location, whichmay or may not relate to a real location in
physical space. If you assign geographical coordinates to a logical location, these coordinates can
be changed or deleted.

Note: All geographical locations are in English, regardless of the UI language selected. Logical
locations may be named in any language you choose, and remain in that language even if the
UI language is subsequently changed.

Hierarchy. Locations may be nested under other locations, creating a hierarchical tree with a
maximum of seven levels under the root.

Geographical Coordinates. Longitude/latitude values, in degrees (expressed as decimal
fractions). Coordinates are assigned to individual locations.

Default Container. The parent location for all locations discovered automatically by Real User
Monitor (RUM). By default, the Default Container isWorld (the root of the Locations tree), but any
location on the tree can be set as the Default Container.

IP Ranges. Each locationmay be assigned a set of IP ranges. An IP range is a range of IP
addresses that have been designated for use by devices in a certain geographical area.
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Tasks
Populating the Location Manager
LocationManager can be populated with locations in a number of ways:

Using the Location Manager in Platform Admin. For details on the user interface, see "Location
Manager Page" on page 156.

Mass upload from an XML file. BSM enables you to create and define location CIs using an XML
file external to the user interface. Mass upload is an alternative to using the user interface, and
better suited for defining a large number of locations.

For details, see "Creating andWorking with the XML File" below.

Using. Real User Monitor (RUM).WhenRUM encounters an IP address for which the location is
unknown, that IP is propagated to the LocationManager for location discovery. The Location
Manager then searches in the Hexasoft IP2Location repository for a geographical location that
matches the given IP address. If a match is found, new locations are created in the Location
Manager for the IP address. Depending on the information in the IP addresses repository, at most
three locations (country, state, and city) may be created for each IP address.

Note: If End User Management (EUM) is enabled after being disabled, it may take a few hours
until automatic discovery of locations starts to work. This is the time that it takes for the IP-to-
location information to load into the database.

Creating and Working with the XML File
You can define your own hierarchy of locations by creating an XML file and loading it through a Java
Management Extensions (JMX) console. (For details on accessing and using the JMX, see "Using
the JMX Console" on page 24.)

The XML can be generated and edited in any tool that supports text. You can create the file
yourself, or base it on an XML file created by BSM in the JMX console, which already includes the
tags, elements, and attributes necessary for themass upload XML file.

XML File Details

For a reference detailing all the XML tags, elements, and attributes included in themass upload file,
see "XML Tag Reference" on page 163.

Eachmass upload XMLmust begin with the following declarations:

l <?xml version="1.0" encoding="UTF-8"?> This states that this is an XML file with UTF-8
character encoding.

l <!DOCTYPE locations_manager SYSTEM "./locations.dtd"> This is the document type
declaration. The locations.dtd file is located in the HPBSM/conf/locations folder. The path to
locations.dtdmust be specified relative to the location of your XML file, andmay need to be
updated. If your XML file is saved in the same location as locations.dtd, no path is necessary.

The XML file is validated using the locations.dtd file. If the XML structure is incorrect, you get a
SAXParseException and the operation fails. If the DOCTYPE line does not correctly reference the
path of the locations.dtd file, validation and the entire operation fails.
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Note: Populating the locationmanager through XML results in deletion of all locations that
were previously defined in the LocationManager.

XML File Example

In this example, customer 1 wants to upload an XML file to create a hierarchy of locations in
LocationManager, as follows: The first location, a site in Los Angeles, includes geographical
coordinates, ISP address ranges, and ISPs. Locations 2 and 3 are nested under the first location
(Los Angeles), and 2a and 2b are under 2. Location 4 is parallel to Los Angeles in the hierarchy.

World

l Los Angeles; latitude 34.0396, longitude -118.2661; ISPv4 address range 4.38.41.136 to
4.38.80.152 (ISP = Level 3 Communications); ISPv6 address range
2002:0C19:8B00:0000:0000:0000:0000:0000 to 2002:0C19:B28F:0000:0000:0000:0000:0000
(ISP = AT_TWorldNet Services)

n location_2

o location_2a

o location_2b

n location_3

l location_4

Note: There is no need to add theWorld root location.

The XML file used to upload this hierarchy of locations is as follows:

<?xml version="1.0" encoding="utf-8" ?>

<!DOCTYPE locations_manager SYSTEM "conf/locations/locations.dtd">

<locations_manager>

    <customer_hierarchy customer_id="1">

        <locations_list>

            <location location_name="Los Angeles">

                <latitude>34.0396</latitude>

                <longitude>-118.2661</longitude>

                <ip_ranges>

                    <ip_range>

                        <start_ip>4.38.41.136</start_ip>

                        <end_ip>4.38.80.152</end_ip>

                        <isp>Level 3 Communications</isp>

                    </ip_range>

                    <ip_range ip_v6="true">

                        <start_

ip>2002:0C19:8B00:0000:0000:0000:0000:0000</start_ip>

                        <end_

ip>2002:0C19:B28F:0000:0000:0000:0000:0000</end_ip>

                        <isp>AT_T WorldNet Services</isp>

                    </ip_range>

                </ip_ranges>

                <locations_list>
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                    <location location_name="location_2">

                        <locations_list>

                            <location location_name="location_2a" />

                            <location location_name="location_2b" />

                        </locations_list>

                    </location>

                    <location location_name="location_3" />

                </locations_list>

            </location>

            <location location_name="location_4" />

        </locations_list>

    </customer_hierarchy>

</locations_manager>

For information on each of the XML elements and attributes, see "XML Tag Reference" on page
163.

How to Populate the Location Manager
The LocationManager can be populated with location CIs in a number of ways. You can:

l "Create locations with the user interface" below

l "Populate the LocationManager using an XML file" below

Create locations with the user interface

Use the Locations Manager user interface to create, edit, andmanage locations and assign them IP
ranges. For details about the user interface, see "LocationManager Page" on page 156.

Populate the Location Manager using an XML file

Upload location CIs to the LocationManager using an XML file external to the user interface. Mass
upload is an alternative to using the user interface, and better suited for populating the Location
Manager with a large number of locations.

For details on this task, see "How to Update Locations UsingMass Upload" below.

How to Update Locations Using Mass Upload
This task describes how to load an XML file, change an existing location hierarchy using XML, and
view the results.

To create and modify an XML file to upload locations:

1. Create an XML file with no IDs for the locations in the following ways:

Create the file yourself in any tool that supports text. Save the XML file you created to a
network location accessible to the BSM server. For details, see "Creating andWorking with
the XML File" on page 151. For details on the XML file elements and attributes, see "XML Tag
Reference" on page 163.

Export the current hierarchy as XML using the JMX console, as described in the steps below.

2. Open the JMX console on this machine. (For detailed instructions, see "Using the JMX
Console" on page 24.)

3. Under theBSM-Platform section, select service=Locations Manager.
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4. If you are creating an XML file from the current hierarchy, invoke the
convertLocationsHierarchyToXMLmethod entering the following values:

customerId. By default, use 1 for customerID. If you are an HP SaaS customer, use your
HP SaaS customer ID.

target path. The location where you want to save the XML file.

5. Locate and edit the XML file just saved:

a. Check that the list of existing locations looks accurate. TheWorld root location is not
included in this XML file.

b. To add a new location, no ID should be defined.

c. Tomodify a location, change the fields, but do not change the real ID.

d. To delete a location, delete all its details from the XML file.

e. To change a location's position in the hierarchy, move the location with its real ID to
another position in the XML file.

f. Save the XML file you created to a network location accessible to the BSM server.

Tip:Save the XML file into the same directory as the locations.dtd file so you do not
have to reference a different path in the document type declaration line of the XML file.
The locations.dtd is located in the <HPBSM root directory>\conf\locations
directory.

6. To upload your edited XML file, in the JMX service=Locations Manager, invoke the
buildLocationsHierarchyFromXMLmethod.

a. In xmlFilePath, enter the path to the location where you saved the XML file.

b. In the saveInFile parameter, choose True to save the existing locations hierarchy in the
file <HPBSM root directory>\conf\locations\current_locations_hierarchy.xml.

Notes:

1. The XML file must comply with the rules listed below. If any of the rules are violated,
buildLocationsHierarchyFromXML will abort before any changes aremade to the
locations model:

o No two locations on the same hierarchical level (having the same parent) may have
the same name. A location directly under customer_hierarchy (that is, directly
under the root location, World) and a location in another place in the hierarchy may
not have the same name unless one instance refers to a geographical location and
the other to a logical location; or they refer to different types (country, state or city)
of geographical locations, such as the country Mexico and city Mexico, or the state
New York and city New York.

o A maximum of seven levels of hierarchy can be defined.

o No two locations may have the same ID.
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o All location ID values in the XMLmust match an existing location with that ID.

o No two overlapping IP ranges are allowed.

2. Saving the existing hierarchy in a file may lengthen the time required to load the new
XML file.

7. The locations have now been uploaded to the LocationManager. They are visible on the
Locations Tree of the user interface and through the JMX console.

To view through the JMX:

n Under service=Locations Manager, locate the getAllLocationsmethod.

n Enter the relevant customer ID. By default, use 1 for customerID. If you are an HP SaaS
customer, use your HP SaaS customer ID.

n Invoke themethod and check that all your locations are there, including theWorld root
location.

HP Business ServiceManagement (9.20)Page 155 of 427



BSM Platform Administration Guide
Chapter 15: LocationManager

UI Descriptions

Location Manager Page
This page enables you tomanage locations and assign them IP ranges.

To access Select Admin > Platform > Locations

Relevant tasks "How to Populate the LocationManager" on page 153

See also "LocationManager Overview" on page 150

l Locations Area — Left Pane

In the Locations area, on the left pane of the Locations page, you can add, delete, andmove
locations, and set a location as the default container. Locations appear in a tree structure, with a
maximum of seven hierarchical levels, whose root (level zero) is calledWorld.

User interface elements are described below. You can also access these actions from a context
menu by right-clicking on the Locations area of the left pane:

UI
Element Description

Add location. Click to add a new location below the selected location. Opens the
Location Properties area.
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UI
Element Description

Delete location. Click to delete a location and its children locations.

A Confirmationwindow opens, asking if you are sure you want to delete the location,
and warning that the locationmay be in use by other BSM components and that there
is no undo for this action.

If you delete a location, any IP ranges assigned to it or its children can bemoved to its
parent location. To do this, select theMove IP Ranges to the Parent Location
check box in theConfirmationwindow.

Cut location. Click to cut a location. The location is copied to the clipboard, and can
be pasted below another element in the locations tree.

Note:When a location is cut, it remains visible, grayed out, in its former place on the
tree, until it has been pasted in a different position. To deselect a cut location before it
has been pasted to a different position, and return it to its original position, click Cut
location again.

Paste location. Available when a location has been cut and the user has navigated to
another part of the tree.

Note: Locations may be pasted under other locations, creating a hierarchical tree with
amaximum of seven levels under the root. Assigning the same name to sibling
locations under the same parent is not permitted. A location underWorld and a
location in another place in the treemay not have the same name unless one instance
refers to a geographical location and the other to a logical location; or they refer to
different types (country, state or city) of geographical locations, such as the country
Mexico and city Mexico, or the state New York and city New York.

Set as default container. Click to set a particular location as the default container.
This is the parent location for all automatically discovered locations.

For more information, see "LocationManager Overview" on page 150.

l Location Properties Area

In the Location Properties area, you can set a geographical location and its coordinates from a
predefined list of countries and areas, states, and cities; or name a logical location and set its
geographical coordinates. Defining a location as a geographical location allows Discovery to
automatically assign discovered IP addresses to the location. To define a location as a
geographical location, select the appropriate country/state/city (country alone, country/state, or

country/city may be selected as well) and click .

Note: Geographical location can only be set from a predefined list. If youmanually enter the
name of a location, it is created as a logical location.

User interface elements are described below:
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UI Element Description

<Country or
Area>/<State>/<City>

Use the first and third drop-down controls to select country or area and
city. When USA is selected as country, themiddle drop-down
becomes available, and can be used to select a particular state.

Set geographical location. Click to locate the geographical
coordinates (longitude and latitude) of the selected country/state/city
and automatically enter name and coordinates into the appropriate
fields under Location Properties, thus defining the location as a
geographical location.

Select Location Coordinates. Click to launch the Geographical Map
dialog box, which can be used to select the geographical coordinates of
any location.

If geographical coordinates were previously entered into the Longitude
and Latitude boxes, these are passed to the Geographical Map dialog
box, which opens with a pin on that location.

For more information, see "Geographical Map Dialog Box" on page 161.

Get coordinates from nearest parent. Click to copy the geographical
coordinates of the closest parent location with coordinates, to the
selected location.

Name Enter the name of the location in theName text box.

Notes:

l The name field is mandatory. Assigning the same name to sibling
locations under the same parent is not permitted. A location under
World and a location in another place in the treemay not have the
same name unless one instance refers to a geographical location
and the other to a logical location; or they refer to different types
(country, state or city) of geographical locations, such as the
country Mexico and city Mexico, or the state New York and city
New York. Assigning the same name tomore than one location
under different parents is permitted, but a small caution symbol
displays, indicating that the name has already been defined for
another location in the tree and suggesting that the name here
should be changed.

l If you change the name of a geographical location, its association
with the original geographical location is maintained.

Longitude/Latitude Enter the longitude and latitude of the location in the longitude and
latitude text boxes.

If you select a location from the predefined drop-down lists of countries,
states, and cities, or from theGeographical Map dialog box, the
longitude and latitude boxes are filled automatically.
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l IP Ranges Area

You can use the IP Ranges area to assign IP ranges to a location. Real User Monitor (RUM) then
uses these ranges to assign newly discovered pages and other CIs to particular locations.

The table of IP ranges may contain thousands of pages. To view the table in a single file, you can
export it in Excel or Adobe Acrobat (PDF) formats.

User interface elements are described below:

UI
Element Description

New IP Range. Click to create a new IP range. Opens the New IP Range dialog box.

Note:A particular IP range can be assigned to only one location at a time.

l If you try to assign an IP range that overlaps with a parent IP range, amessage
displays, warning that this action will remove the IP range from the parent location.
(Only the area of overlapping ranges is removed, and the parent IP ranges are
adjusted accordingly.) Click Remove from Parent to remove the overlapping IP
range from the parent and reassign it to the selected location, orCancel.

l If you try to assign an IP range that overlaps with a range already assigned to
another location (not a parent), an error message is displayed and a different IP
rangemust be chosen.

Edit IP Range. Click to edit a selected IP range. Opens the Edit IP Range dialog box.

Delete IP Range. Click to delete one or more selected IP ranges.

Export to Excel. Click to export IP range information for the selected location to an
Excel spreadsheet.

Export to PDF. Click to export IP range information for the selected location to an
Adobe Acrobat file.

Change Visible Columns. Click to select which columns of IP range information are
visible in the IP Ranges area. The Choose Columns to Display dialog box opens.

Note:Columns not displayed on screen are also not exported to Excel or Adobe
Acrobat (PDF) files.
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UI
Element Description

Find
Range
of IP

To find an existing range in which a particular IP address is located:

1. Select the appropriate radio button:

n IPv4 (Internet Protocol version 4) for addresses consisting of four numbers,
each ranging from 0 to 255, in dot-decimal notation)

n IPv6 (Internet Protocol version 6) for addresses consisting of eight hexadecimal
numbers, each ranging from 0 to FFFF, in colon-separated notation)

2. Enter the IP address in the Find Range of IP box.

3. Click .

The system highlights the range in which the IP address is found.

Note: This searches for the IP range in the currently selected location only.

From
IP/To
IP, ISP,
IP
Version

To filter the IP ranges for a particular string of text in their lower and upper IP range
limits, ISP names, or IP versions, enter the string in the From IP, To IP, ISP, or IP
Version boxes.

These boxes may be used in combination with each other. An asterisk (*) may be
used as a wildcard to represent one or more characters.

For example:

l To filter for IPv6 addresses, enter "6" in the IP Version box

l To filter for IPv4 address ranges whose upper limits end in 0, enter "*.*.*.0" in
the From IP box.

New/Edit IP Range Dialog Box

To access
Select Admin > Platform > Locations and click under IP Ranges.

User interface elements are described below:

UI
Element Description

IP
version

Choose IPv4 or IPv6 to select:

l Internet Protocol version 4 (for IP addresses consisting of four numbers, each
ranging from 0 to 255, in dot-decimal notation)

l Internet Protocol version 6 (for IP addresses consisting of eight hexadecimal
numbers, each ranging from 0 to FFFF, in colon-separated notation)
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UI
Element Description

From
IP/To
IP

Use the From IP and To IP boxes to set the range of IP addresses for the location.

l For IPv4, as you enter an IP address in the From IP box, a corresponding address
ending with 255 is automatically entered into the To IP box. All values in both
boxes may be changed to any permissible value (0-255), but the address in the To
IP box must be the same or higher than the address in the From IP box.

Note: The IPv4 rangemust not exceed 50,000,000 IP addresses.

l For IPv6, as you enter an IP address in the From IP box, the same address is
automatically entered into the To IP box. All values in both boxes may be changed
to any permissible value (0-FFFF), and the address in the To IP box may be higher,
the same, or lower than the address in the From IP box.

ISP Specify the Internet Service Provider in the ISP box.

Geographical Map Dialog Box

This dialog box enables you to select the geographical coordinates of any location.

Note: Users who are not connected to the Internet see another version of this map.
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To access From the Location Properties area of the Locations page, click .

Important
information

If geographical coordinates were previously entered into the Longitude and
Latitude boxes, these are passed to the Geographical Map dialog box, which
opens with a pin on that location.

Relevant
tasks

"How to Populate the LocationManager" on page 153.

See also "LocationManager Page" on page 156.

User interface elements are described below:

UI Element Description

Zoom In. Click to zoom in on themap.

Note: This icon is located on the toolbar. Another Zoom In icon with
identical functionality appears on themap, itself.

Zoom Out. Click to zoom out on themap.

Note: This icon is located on the toolbar. Another Zoom Out icon with
identical functionality appears on themap, itself.

Reset. If you openGeographical Map at particular coordinates and then
pan elsewhere, click Reset to recenter themap at the starting
coordinates.

Pin/Drag radio
buttons

Select Pin to move the pin to any location on themap by clicking on
that location. Double-clickingmoves the pin and zooms in on the
location.

Select Drag to drag themap.

<Country or
Area>/<State>/<City>

Use the first and third drop-down controls to select country or area and
city. When USA is selected as country, themiddle drop-down
becomes available, and can be used to select a particular state.

Find location on map. Click to locate the selected country or area
and city on themap.

Pan in Any Direction. Hold down themouse button on this control
and drag to pan across themap.

Road View Click to see a roadmap of the world.

Aerial View Click to see an aerial photographic map of the world.

Bird's Eye The bird's-eye view is disabled.
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UI Element Description

Labels In Aerial View, click to display or hidemap labels. This is disabled in
Road View.

Enter Coordinates Click to automatically copy the coordinates of the pinned location to the
Longitude and Latitude boxes of the Location Properties area.

XML Tag Reference
Following are tables that list all the elements and attributes that are used in themass upload XML
file.

l Elements Table

Element Description Attributes

locations_
manager

Initial element in a block containing LocationManager data

customer_
hierarchy

Initial element in a hierarchy of locations for a particular customer customer_
id

locations_
list

Initial element in a list of locations

location Initial element in block defining attributes for a particular location location_
name

latitude Latitude of the location, in degrees

longitude Longitude of the location, in degrees

ip_ranges Initial element in a list of IP address ranges for a particular location

ip_range Initial element in block defining attributes for a particular IP address
range

ip_v6

start_ip Lower limit of IP address range

IP address ranges may be IPv4 or IPv6. LocationManager supports
the following notation formats:

IPv4 – number of 4 bytes

IPv4 – string in x.x.x.x format

IPv6 – number of 16 bytes

IPv6 – string in x:x:x:x:x:x:x:x format

IPv6 – IPv6 regular expression

HP Business ServiceManagement (9.20)Page 163 of 427



BSM Platform Administration Guide
Chapter 15: LocationManager

Element Description Attributes

end_ip Upper limit of IP address range. For supported IPv4 and IPv6
notation formats, see start_ip, above.

Note: IPv4 rangemust not exceed 50,000,000 IP addresses.

isp Name of ISP for the range

l Attribute Table

Attribute
Parent
Element Description Example

customer_
id

customer_
hierarchy

Number. Unique andmandatory. ID number of the
customer for whom a hierarchy of locations is built.

<customer_
hierarchy
customer_
id="1">

location_
name

location String. Mandatory. Not unique (several locations, if
not siblings, can have the same name). Name of a
particular location.

<location
location_
name="Los
Angeles">

ip_v6 ip_range Boolean. ="true" if IP addresses for a particular
range are in IP version 6 format. Otherwise, they
are in IP version 4 format.

<ip_range ip_
v6="true">

l Implied Attribute Table

The following attributes are exported when exporting the current hierarchy as XML but are not
required when defining new locations in the XML. When updating an existing location through XML,
these attributes need to be preserved:

Attribute Parent Element Description

original_geo_location_id location Used to identify geographical locations

location_type location Possible values:

l "undefined" (default)

l "country"

l "state"

l "city"

location_id location The real ID of an existing location

Example:

<location_name="UNKNOWN" location_type="undefined" location_
id="47a3711c334fd8577858c6da60b3e0e6" original_geo_location_id="Unknown_Unknown">
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Content Packs
Content is information that BSM uses to describe and enrich the objects or configuration items that
you aremonitoring in your IT environment. The objects can be, for example, network hardware,
operating systems, applications, services or users.

Content for a specific management area can be contained in a dedicated content pack. A content
pack can contain a complete snapshot of all, or any part of, your content -- the rules, tools,
mappings, indicators and assignments that you define and configure to help users manage your IT
environment. Content packs are used to exchange customized data between instances of BSM, for
example in test and production environments.

The Content Packs Manager helps youmanage packs of content data. It enables you to create a
content pack, save it in a file, install or update content, and take content from one installed instance
of BSM and upload it to another, using the export and import features.

BSM provides a number of content packs, for example for Smart Plug-ins (SPIs), that you can
either use in the default configuration or, if necessary, modify to suit the demands of your
environment. Such content is usually specified as Predefined, and can bemodified (Predefined
(Customized)). This modified content can be reverted to the predefined values.

You can use the Content Packs Manager to perform the following tasks:

l Define the contents of a content pack and save the definition. For details, see "Defining Content
Packs" on page 169.

l Manage dependencies between content packs. For details, see "Dependencies in Content
Packs" on page 170.

l Export a content pack (definition and content) and the data it references to a file called a content
pack. For details, see "Exporting Content Packs" on page 173.

l Import a content pack (definition and content) and the data it references. For details, see
"Importing Content Packs" on page 174.

Note: You can use permissions to grant and restrict access to the Content Packs Manager.
Permissions for using the Content Packs Manager are found inAdmin > Platform > Users
and Permissions.

After selecting the user for which you want to modify the Content Manager permissions,
select thePermissions tab in the right pane. The Context pane displays.

Select Operations Management context > Administrative UIs > Content Packs

Content Types
Content types are referred to using the following terminology:
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l Predefined Content

Predefined content is usually content provided by HP or HP Partners and is designed to provide
the initial configurations for a BSM installation.After installing a predefined content pack, you
may change these initial artifacts to suit your environment andmanagement needs. Any
modified predefined artifacts are labeled as Predefined (Customized).It is not possible to
remove predefined artifacts, but you can revert any customized artifacts to their original,
"predefined" values.

l Custom Content

Custom content is content that is created by the customer, for example for managing a custom,
in-house application, and is labeled as Custom.

l Customized Content

Modified predefined artifacts are labeled as Predefined (Customized).You can revert any
customized artifacts to their original, "predefined" values.

Content Pack Types
Content pack types are referred to using the following terminology:

l Predefined Content Pack

Predefined content packs are collections of predefined content typically provided by HP or HP
Partners and are designed to provide the initial configurations for a BSM installation.

After installing a predefined content pack, youmay change these initial artifacts to suit your
environment andmanagement needs. Any modified predefined artifacts are labeled as
Predefined (Customized).It is not possible to remove predefined artifacts, but you can revert
any customized artifacts to their original, "predefined" values.

When importing the content of predefined content packs, this content is labeled as Predefined.

n Predefined content packs must contain unique content. It is not possible to include identical
content in more than one predefined content pack. This is checked on export and an
appropriate error message displayed.

n Predefined content packs must not contain referenced content.

n Predefined content packs cannot bemodified or directly deleted (as opposed to artifacts
which can bemodified). If you want to make changes to a predefined content pack, youmust
create a new version. When you import a new predefined content pack version, it overwrites
the old version.

Note: Tomodify a predefined content pack, select Create a New Version of the
Selected Content Pack Definition and specify a new version number. For more details,
see "Create a New Version of a Predefined Content Pack Definition" on page 175.

It is only possible to delete a predefined content pack in Content Pack Development
mode (enabled in the Infrastructure Setting: Operations Management - Content Manager
Settings).

l Custom Content Pack
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Custom content packs are collections of content typically created by the BSM user, for example
for managing a custom, in-house application.

When importing the content of custom content packs, this content is labeled as Custom.

Custom content packs can have the same content as other custom or predefined content packs.

Content Pack Definitions
Content Pack Definitions serve two purposes:

l Creating Content Packs including the artifacts referenced by it.

l Describing predefined content of the system, serving as an inventory of predefined content.

A Content Pack Definition is identified by its name and version. It is not possible to have two
Content Pack Definitions in the system with same name and version. It is possible to duplicate any
definition by specifying either different name or different version. A new or duplicated content pack
definition is labeled as a custom definition.

Only one Content Pack Definition with a given name can be predefined. If a Content Pack with
predefined content based on a Content Pack Definition with the same name is imported, its
definition does replace the existing definition.

Predefined content packs with predefined content from HP are imported during the BSM product
installation. You can change the predefined artifacts, which then aremarked as Predefined
(Customized). You can also revert customized artifacts to their original predefined values, but you
cannot delete them.

Exporting and Importing Content Packs
You can export a Content Pack definition and included content. There are twomodes:

l Normal Mode

Content of exported content packs is labeled as custom.

l Content Pack Development Mode

When a content pack is exported, you can define its content as predefined or custom, and is
independent of whether the content pack definition used as base for the export is predefined or
custom.

Content Pack Development mode is enabled under the Operations Management - Content
Manager Infrastructure Settings.

Caution: It is not recommended to create new versions of predefined Content Packs that
you are not responsible for - as this may result in upgrade errors in the future.

If you import a content pack, its content is predefined or custom depending on how the content pack
was exported.

Content Packs Manager Interfaces
The Content Packs manager has the following interfaces:

l BSM Content Packs User Interface

You can start the BSM Content Packs manager using one of the followingmenu options:
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Admin > Platform > Content Packs

Admin > Operations Management > Setup > Content Packs

There are twomodes for working with content packs:

n Normal—Only custom content packs can bemodified and exported.

n Content Pack Development—When exporting a content pack definition, you can specify
whether it is predefined or custom. Custom content pack definitions can bemodified.
Predefined content pack definitions cannot bemodified andmust be replaced with an updated
version if required.

Caution: It is not recommended to create new versions of predefined Content Packs
that you are not responsible for - as this may result in upgrade errors in the future.

Content Pack Development mode can be enabled in the Infrastructure Setting at the following
location:

Admin > Platform > Setup and Maintenance > Infrastructure Settings > Applications,
use the list to set the administration context to Operations Management, and set the Enable
Content Pack development entry underOperations Management - Content Manager
Settings to true.

For further details, see "Content Packs Manager User Interface" on page 182.

l ContentManager Command-line Interface (CLI)

The features and functionality of the Content Pack manager are also accessible using the
ContentManager command-line interface. You can access theContentManager command-
line interface directly, in a shell, or remotely, for example, in a script.

For details, see "Content Pack Manager Command-Line Interface " on page 192.

Note: You cannot use theContentManager command-line interface to create a content
pack definition.

l ContentAutoUpload Command-line Interface (CLI)

During BSM installation, all prdefined Content Pack Definition files are automatically uploaded
from the default content pack location on the Data Processing Server:

<BSM Root Dir>/conf/opr/content/<locale>

Using the ContentAutoUpload, you can:

n retrigger the default content pack upload

n specify a different folder from where content packs are uploaded

For details, see "Content Pack Auto Upload Command-Line Interface" on page 195.
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Defining Content Packs
A content pack definition contains a list of the data and the relationships between them to be
included in a content pack which you can export to another BSM installation.

Note: The content pack definition does not include the CI types themselves. To exchange CI
types, use the features provided by the Run-time ServiceModel (RTSM).

TheContent Packs Definitions pane enables you to view andmanage the content pack
definitions. For example, you can perform the following actions:

l Create, modify, and save a content pack definition

l Delete a content pack definition

l Export or import an existing definition along with the data it references

Creating a content pack is a two-step process. First you create the content pack definition in the
Content Manager, and then you use the definition to export selected content to a content pack file.
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Dependencies in Content Packs
Some content in BSM is part of a hierarchy that may relate to and depend upon other content. When
you select content for inclusion in a content pack, its dependent content must also be included,
either as part of the same content pack, or referred to from another content pack that will also be
uploaded. For example, if you include a KPI assignment, any indicators, KPIs, menus, or rules
necessary for this KPI assignment must also be included.

Automatically Including Dependent Content
If you select content that has dependent content, and the dependent content is not part of another
content pack, the dependent content is automatically included in the content pack definition along
with the content that requires it.

For example, the correlation ruleBB DB Connection Status requires two indicators: the BB
Component indicatorBB DB Connection Status and the Database indicatorDatabase Server
Status. If you include the correlation rule BB DB Connection Status in a content pack definition and
the indicators BB DB Connection Status and Database Server Status are not included in other
content packs, they are automatically included in this content pack definition.

Setting Dependency
If dependent content is included inmore than one other content pack, you can select which content
pack to reference. This is called setting dependency.

For example, if Content Packs A and B both include the indicatorCPU Load and you select the
correlation ruleDatabase Affects WebApp (which depends onCPU Load) for inclusion in Content
Pack C, you can set the dependency in Content Pack C to referenceCPU Load in either Content
Pack A or B.
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Referencing Dependent Content Included in Another Content Pack
If dependent content is already included in another content pack, by default the new content pack
references its inclusion in the other content pack rather than including it in both. You can, however,
use the Dependencies page to also add it to the included content in the new content pack.

For example, if content pack definition A includes the indicatorPing Availability and now you
select the correlation ruleDatabase Affects WebApp (which depends onPing Availability) for
inclusion in Content Pack B, Content Pack B references the inclusion of Ping Availability in
Content Pack A.

On the Content Pack B Dependencies page, Ping Availability is listed in bold, under Content
Pack A The dependency is set automatically. To includePing Availability in Content Pack B (and
thus, in both contact packs), select it and click Add to Included Content.

Note: It is not recommended to have content in multiple content packs. It is preferable to set
dependencies between content packs.
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Deleting Referenced Content Pack
If you delete a referenced content pack containing dependent content, the dependent content is
automatically added to the content pack definition that depends on it.

For example, if Content Pack B includes the correlation ruleDatabase Affects WebApp and
references the dependent indicatorExtend TS in Content Pack A, and you delete Content Pack A,
Extend TS is automatically included in Content Pack B.

Note: You are warned via a pop-upmessage if you delete a referenced content pack containing
dependent content.

Deleting Referenced Content Pack on Which Dependency Was Set
If you delete a referenced content pack on which dependency was set, the dependent content is
automatically added to the content pack definition that depends on it. You can set dependency to
another content pack manually, but it is not set automatically.

For example, if Content Packs A and B both include the indicatorExtend TS, and Content Pack C
includes the correlation ruleDatabase Affects WebApp (which depends onExtend TS) and has
dependency set to referenceExtend TS in Content Pack A, and then you delete Content Pack A,
Extend TS is automatically included in Content Pack C. You can then set dependency toExtend
TS in Content Pack B, but it is not set automatically.
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Exporting Content Packs
Using the Content Packs Manager, you can export configuration data to a file. The content pack
contains the references to configuration data, and the referenced data.

The configuration data in a content pack makes references to configuration items stored in the Run-
time ServiceModel (RTSM) used by the system from which the content pack was exported. If
these configuration items are not present in the RTSM used by the system into which you want to
import the content pack, the configuration data in the content pack cannot work.

Tip: Use the features provided by the RTSM to export and import configuration items.

For details about exporting content packs, see "How to Create andManage Content Packs" on
page 175.
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Importing Content Packs
When importing a content pack, you generally overwrite any existing data and add any new data. If
you are importing a predefined content pack, only predefined content is overwritten with new data.
Customized content is left untouched. Importing a custom content pack always overwrites existing
data.

If you want to run a test of the import operation without actually importing any of the listed data, you
can use the Test feature. The Test feature is a useful way to list any unresolved dependencies (for
example, to unknownCI types) contained in the imported content pack definition.

For details about the task, see "How to Create andManage Content Packs" on next page. For
details about the user interface and the options available in the import operation, see "Import
Content Pack Dialog Box" on page 191.
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How to Create and Manage Content Packs
The following steps describe how to create, export and import content packs.

Create and Edit Content Pack Definitions
To create and edit a content pack definition:

1. Open the Content Packs Manager: Admin > Platform > Content Packs.

n To create a new content pack definition, click the button. TheCreate New Content
Pack Definitionwizard opens.

n To edit an existing content pack definition, select it and click . The Edit Content Pack
Definition dialog box opens.

2. In the General page of the wizard, or the General tab of the dialog box, the fields Display
Name, Name, andVersion are required.

n Name andVersion combinationmust be unique.

n TheName field is limited to amaximum length of 255 characters. The first character must
be a letter (A-Z, a-z) or an underscore (_). All other characters may be letters, numbers, or
underscores. No leading or trailing spaces are allowed. When you export the content pack,
this is the default file name for the file, withOMi Content Pack - as a prefix.

n Display Name is the name displayed in the Content Pack Definitions list, and need not be
unique. It is limited to amaximum length of 255 characters.

n Version is a free text field. UseVersion in combination withDisplay Name to manage
revision control of your content packs.

3. Continue to follow the wizard pages or edit the tabs of the dialog box to select content, set
dependencies, and see a summary of your content pack definition's contents and any
problems found.

For details on the user interface and all the available options, see "Create New Content Pack
DefinitionWizard " on page 184.

Create a New Version of a Predefined Content Pack Definition
To create a new version of a predefined content pack definition:

1. Make sure that Enable Content Pack development settings is enabled:

Caution: It is not recommended to create new versions of predefined Content Packs that
you are not responsible for - as this may result in upgrade errors in the future.

a. Open Infrastructure Settings from the Platform Administration:

Admin > Platform > Setup and Maintenance > Infrastructure Settings

b. Select Applications and use the list to set the administration context toOperations
Management.

c. Enable theEnable Content Pack development setting in the Content Manager pane.
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2. Open the Content Packs Manager: Admin > Platform > Content Packs and select the
predefined content pack definition for which you want to create a new version.

3. Select the button to open the Create New Content Pack Definition Version dialog box.

4. Change the version number of the content pack and click OK.

The new version of this content pack is saved as a custom content pack.

5. Open the new version of the content pack definition, make the changes that you need, and
save the changes.

For details on the user interface and all the available options, see "Create New Content Pack
DefinitionWizard " on page 184.

Export Content Packs
To export a content pack:

1. Open the Content Packs Manager: Admin > Platform > Content Packs

2. In theContent Pack Definitions pane, select the content pack that you want to export.

3. To export the selected content pack to a file, select the button, select the location where
you want to save the content pack, and select Save.

Tip: By default, BSM saves the content pack to the file system on the system where you are
running the Content Packs Manager. If you want to save the file in an alternative location,
make sure that you have access to that location. The default file type is ZIP.

Export Predefined Content Packs
To export a predefined content pack:

1. Make sure that Enable Content Pack development settings is enabled:

Caution: It is not recommended to create new versions of predefined Content Packs that
you are not responsible for - as this may result in upgrade errors in the future.

a. Open Infrastructure Settings from the Platform Administration:

Admin > Platform > Setup and Maintenance > Infrastructure Settings

b. Select Applications and use the list to set the administration context toOperations
Management.

c. Enable theEnable Content Pack development setting in the Content Manager pane.

2. Open the Content Packs Manager: Admin > Platform > Content Packs

In theContent Pack Definitions pane, select the content pack that you want to export.

3. To export the selected content pack to a file, select Export Content Pack Definitions and

Content (Predefined), select the button, specify the location where you want to save the
content pack, and select Save.
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Tip: By default, BSM saves the content pack to the file system on the system where you are
running the Content Packs Manager. If you want to save the file in an alternative location,
make sure that you have access to that location. The default file type is ZIP.

Import Content Packs
To import a content pack:

Note: In SaaS installations, predefined content packs can only be imported by a SaaS Admin
(Super User).

1. Open the Content Packs Manager: Admin > Platform > Content Packs

Select the button in theContent Pack Definitions pane to open the Import Content Pack
dialog box.

2. In the Import Content Pack dialog box, use theBrowse (...) button to locate the content pack
you want to import. Content packs are usually in ZIP format. However, XML format content
packs can also be imported.

The default location for content packs is:

<HPBSM root directory>\conf\opr\content\<locale>

In a distributed deployment, this directory is located on the Data Processing server.

Note: By default, BSM looks for content packs in the file system on the system where you
start the browser session. If the browser is running on a remote system, youmust
navigate to the file system of the BSM host.

3. Optional: You can select Test to run the import in test mode. In test mode, changes are not
committed, so you can see if any problems exist before running an actual import.

Note: Existing items with the same ID are generally overwritten.

If you are importing a predefined content pack, only predefined content is overwritten with
new data. Customized content is left untouched. Importing a custom content pack always
overwrites existing data.

Unresolved references in the imported definition (for example, to unknownCI types) are
not allowed.

4. Select Import to start the import or test operation.

Note: It is not possible to start an import if an import is already running.

For details about the Import Content Pack dialog box, see "Import Content Pack Dialog Box" on
page 191.
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Checklist for Publishing Content Packs
Before you publish a newly developed content pack you shouldmake the following checks on a
system where all available Content Packs (at least all OOTB Content Packs) plus your Content
Pack is imported.

These checks helps to have clear ownerships of the content artifacts which helps in upgrade
scenarios and in developing new Content Packs.

Problems Found by Content Manager
Select your Content Pack Definition in the Content Manager and check if there is aProblems
Found panel reported at the bottom of the Details pane.

This section typically reports inconsistencies between your Content Pack Definition and the
available content. Youmust solve the reported problems before exporting the Content Pack. For
example, your Content Pack Definition references content or dependent content that does not exist
in the system. Youmust either remove the referenced content or dependency from your Content
Pack Definition or make sure that the referenced content dependency is "installed".

Check for Content in other Content Packs
Open your Content Pack Definition for editing in the Content Manager and select theContent tab.
Check if there is a section titledContent in other Content Packs (bottom of Included Content
pane).

In the Content in other Content Packs section, inspect each content artifact and decide if you are
really the owner of this content artifact. If you are not the owner, exclude the content artifact from
your Content Pack Definition and set a dependency to the owning Content Pack. Otherwise,
contact the owner of the other Content Packs and request that they exclude the content artifact
from their Content Pack Definition.
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Check for Referenced Content included in This Content Pack
Select your Content Pack Definition in the Content Manager and check if there is aReferenced
Content included in This Content Pack panel reported in the Details pane.

It is not recommended to have referenced content within your ownContent Pack because this is an
indication that the ownership of such content is not clear. If you are the owner, include the
referenced content into your Content Pack Definition. Otherwise, set a dependency to the Content
Pack Definition that owns the referenced content.
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Include the referenced content into your Content Pack Definition
Open your Content Pack Definition for editing in the Content Manager and select theContent tab.

Search for referenced content and include it in your Content Pack Definition.

Make sure that you have completed the steps described above.
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Set a Dependency
Open your Content Pack Definition for editing in the Content Manager and select the
Dependencies tab.

Inspect all content artifacts printed in normal font. Choose the Content Pack that is the owner of the
referenced artifact and set a dependency to it. The goal is to have no content artifacts displayed in
printed in normal font in the Dependencies tab.
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Content Packs Manager User Interface

Content Packs Page
This area enables you tomanage content pack definitions. A content pack definition describes the
items included in a content pack. A content pack is a snapshot of the configuration data and other
items that you have defined to helpmanage the resources in the IT environment you aremonitoring
with BSM. The Content Packs Manager displays a list of all known content pack definitions.

To access Use one of the following:

l Admin > Platform > Content Packs

l Admin > Operations Management > Setup > Content Packs

Important
information

BSM provides several ways to perform actions with buttons or menu items. The
buttons in theContent Pack Definitions pane duplicate the options available in
shortcut menus.

Relevant
tasks

"How to Create andManage Content Packs" on page 175

See also "Content Packs" on page 165

Definitions Pane
TheContent Pack Definitions pane displays a list of all the content pack definitions that are
available for your environment.

UI elements listed in the following table.

UI
Elements Description

Refresh. Refreshes the contents of the displayed list. Use if new content becomes
available while you are working or you have uploaded new contents (for example,
from the command-line interface).

New Item. Opens theCreate New Content Pack Definitionwizard. For details
about the wizard, see "Create New Content Pack DefinitionWizard " on page 184.

Create a New Version of the Selected Content Pack Definition. Opens the
Create New Content Pack Definition Version dialog box from which you can create a
new version of the selected content pack definition.

Alternatively, double-click a section in theDetails pane to open the appropriate tab in
the Create New Content Pack Definition Version dialog box or the Content Pack
Definition in the Definitions pane (not valid for a not predefined content packs).

For details, see "Create a New Version of a Predefined Content Pack Definition" on
page 175.
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UI
Elements Description

Edit Item. Opens the Edit Content Pack Definition dialog box, which enables to you
edit the name, version, and description; content to be included; and dependencies for
the selected content pack. This dialog box presents the same screens as theCreate
New Content Pack Definitionwizard, but in tab format.

Alternatively, double-click a section in theDetails pane to open the appropriate tab in
the Edit Content Pack Definition dialog box or the Content Pack Definition in the
Definitions pane (not valid for a predefined content packs).

For details, see "Create New Content Pack DefinitionWizard " on next page.

Delete Item. Deletes the selected content pack definition (but not referenced
content such as indicators and KPIs) from the list of definitions displayed.

Import Content Pack Definitions and Content. Opens the Import Content Pack
dialog box, which enables you to specify or browse to a file that contains the
definition details for import.

You can first run the import in test mode, where changes are not committed.
Unresolved references in the imported definition (for example, to unknownCI types)
are not allowed. For details, see "Import Content Pack Dialog Box" on page 191.

Export Content Pack Definitions and Content. Opens the Select Location for
Download dialog box, which enables you to specify or browse to a file location where
you want to export the definition details.

Export Content Pack Definitions and Content (Predefined). Opens the Select
Location for Download dialog box, which enables you to specify or browse to a file
location where you want to export the definition details as a predefined content pack.

Details Pane
TheDetails pane provides high-level information concerning the properties of the selected content
pack definition and a short summary of the content pack definition's content and any problems
found.

User interface elements are described below:

UI
Elements Description

General Displays the name, display name, version, dependent content packs, a description
of the selected content pack definition, and its origin (whether it is predefined or not).
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UI
Elements Description

Summary Displays a summary of the selected content pack definition's contents, divided into
the following subsections. Each subsection contains a list of content and for each
item in the list, the following information is displayed:

l Total number of artifacts

l Number of predefined artifacts

l Number of Predefined (Customized) artifacts

l Number of custom artifacts

Expanding the content group displays the artifacts contained within that group, the
CI Type of the artifact, and the origin of the artifact (Predefined, Predefined
(Customized), Custom).

l Selected Content. Displays a list of the content, grouped by content type,
selected for inclusion in the selected Content Pack Definition.

l Referenced Content Included in This Content Pack. Displays a list of the
referenced content, grouped by content type, included in this content pack.

l Referenced Content from Other Content Packs. Displays a list of the
dependent content, grouped by content type, referenced from other content
packs.

Problems
Found

Displays information on any problems, such as unresolved dependencies (content
that is included in the selected content pack definition but no longer exists in BSM),
found in the selected content pack definition.

Create New Content Pack Definition Wizard
This wizard enables you to create a new content pack definition, giving it a name, version, and
description; selecting the content to be included; setting dependencies; and diagnosing problems.

To
access

Use one of the following:

l Admin > Platform > Content Packs

l Admin > Operations Management > Manage Content > Content Packs

and then click

Relevant
tasks

"How to Create andManage Content Packs" on page 175

Wizard
map

This wizard contains:

"General Page" on next page > "Content Page" on page 186 > "Dependencies Page"
on page 189 > "Summary Page" on page 190

See also "Content Packs" on page 165
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General Page
This wizard page enables you to define the display name, name, version and description of a new
content package.

Important
information

l General information about this wizard is available here: "Create New
Content Pack DefinitionWizard " on previous page.

l This wizard page appears as the General tab in the Edit Content Pack

Definition dialog box that opens when you click .

Wizard map The "Create New Content Pack DefinitionWizard " on previous page contains:

General Page > "Content Page" on next page > "Dependencies Page" on page
189 > "Summary Page" on page 190

See also "Content Packs" on page 165

User interface elements are described below:

UI
Elements Description

ID No action required. The content pack ID is assigned automatically when the
content pack is first created.

Note: ID field is only displayed in the General tab of the Edit Content Pack
Definition dialog box, not on the General page of theCreate New Content Pack
Definitionwizard.

Display
Name

Name displayed in Content Pack Definitions list. This name does not have to be
unique. It is limited to amaximum length of 255 characters.

Name Name of the content pack definition, which is limited to amaximum length of 255
characters. The first character must be a letter (A-Z, a-z) or an underscore (_). All
other characters may be letters, numbers, or underscores. No leading or trailing
spaces are allowed.

Note: The name and version combinationmust be unique.

When you export the content pack, this is the default file name for the file, with
OMi Content Pack - as a prefix.

Version Required, free text field. Use to control versions of your content packs. It is
limited to amaximum length of 255 characters.

Description Brief description (limited to 1024 characters) of the content pack definition you
want to add to (or have selected in) theContent Pack Definitions pane. Use the
Description box to remind other users of the scope and content of the content
pack.
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UI
Elements Description

Predefined Predefined content is usually content provided by HP or HP Partners and is
designed to provide the initial configurations for a BSM installation.After installing
a predefined content pack, youmay change these initial artifacts to suit your
environment andmanagement needs. Any modified predefined artifacts are
labeled as Predefined (Customized).It is not possible to remove predefined
artifacts, but you can revert any customized artifacts to their original, "predefined"
values.

Note:Only displayed in the Details pane.

Content Page
This wizard page enables you to select the content to be included in a new content pack definition.

Important
information

l General information about this wizard is available here: "Create New
Content Pack DefinitionWizard " on page 184.

l This wizard page appears as the Content tab in the Edit Content Pack

Definition dialog box that opens when you click .

Wizard map The "Create New Content Pack DefinitionWizard " on page 184 contains:

"General Page" on previous page > Content Page > "Dependencies Page" on
page 189 > "Summary Page" on page 190

See also "Content Packs" on page 165

User interface elements are described below:

UI
Elements
(A-Z) Description

Refresh:Refreshes the contents of the displayed list. Use if new content
becomes available while you are working or you have uploaded new contents (for
example, from the command-line interface).

Add to Included Content: Adds the selected item(s) to the list of included
content.

If included content has already been included in another content pack, it is listed in
theContent in Other Content Packs pane, and can safely be excluded from the
content pack you are creating. It is not necessary to include content in multiple
content packs.

Tip:Selecting a CI type automatically selects all assigned content of the CI type
and also all assigned content for child CI types. Selecting specific content, such
as an individual indicator or KPI, automatically selects the reference to the CI type
to which the content is related.
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UI
Elements
(A-Z) Description

Expand Selection: Expands the Available Content or Included Content list to
display items belonging to the selected group.

Collapse Others:Collapses all open branches except for the selected branch.

Expand: Expands the Filter pane to display available filters.

Collapse: Collapses the Filter pane.

Expands the selected folder.

Collapses the selected folder.

Exclude: Removes the selected item(s) from the list of included content.

Exclude All: Removes all item from the list of included content.

Display All Selected Content Pack Items: Expands the Included Content list to
display all items selected for inclusion in the content pack.

Search Content: Use the Search field to find the content in theAvailable
Content or Included Content pane. Enter a search string in the Search box and

click . The first content to match the specified string is highlighted. If that
content is not initially visible, the tree expands to

display it. To find the next occurrence of content matching the specified string,

click again.

The search stringmust be at least three characters long. Searching is
automatically started as soon as the third character is entered and the first match
is highlighted. This prerequisite avoids searches being started too often and
resources being blocked. Names with less than three characters can be found by
clicking on the button.
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UI
Elements
(A-Z) Description

Available
Content

Hierarchical list representing the available content in your IT environment.

Tip: To include content in a content pack definition, drag it from theAvailable
Content pane to the Included Content pane or select it and click theAdd to
Included Content button. BSM warns you if content already exists in other
content packs when you perform an include operation.

Color coding:

l Folder with no content: gray

l Selected content: bold

l Referenced content: italic

l Dependent content pack definition with version number: blue

Filter:
Show only
CI types
with
assigned
content

Filters the CI Types tree to display only CI types that have content assigned to
them.

Included
Content

List of content selected for inclusion in a content pack, along with any dependent
content.

Tip: To exclude an item, select an item (or group of items) and select theExclude
button.

Color coding:

l Folder with no content: gray

l Selected content: bold

l Referenced content: italic

l Dependent content pack definition with version number: blue

Content in
Other
Content
Packs

If content selected for inclusion is included in other content packs, it is listed here
to indicate that it can be removed from this content pack. It is not necessary to
include the same content in multiple content packs, and the recommended
practice is not to do so.

Shortcut Menus
BSM provides many shortcut menus. The shortcut menus enable quick and direct access to
information about selected elements and actions that you can perform on them.

You display a shortcut menu by right-clicking an element in the user interface. The information
available and the actions that are possible from a shortcut menu depend on the element you right-
click and the context in which it exists.

The shortcut menu in the Content tab includes the following elements:
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UI Elements (A-Z) Description

Add to Included Content Adds the selected item(s) to the list of included content.

Collapse Others Collapses all open branches except for the selected branch.

Display All Selected
Content Pack Items

Expands the Included Content list to display all items selected for
inclusion in the content pack.

Exclude Removes the selected item(s) from the list of included content.

Exclude All Removes all item from the list of included content.

Expand Selection Expands the Available Content or Included Content list to display
items belonging to the selected group.

Dependencies Page
This wizard page enables you to set dependencies on dependent content that is included inmore
than one other content pack.

Important
information

l General information about this wizard is available here: "Create New Content
Pack DefinitionWizard " on page 184.

l This wizard page appears as the Dependencies tab in the Edit Content Pack

Definition dialog box that opens when you click .

Wizard map The "Create New Content Pack DefinitionWizard " on page 184 contains:

"General Page" on page 185 > "Content Page" on page 186 > Dependencies
Page > "Summary Page" on next page

See also "Content Packs" on page 165

"Dependencies in Content Packs" on page 170

User interface elements are described below:

UI
Elements Description

Refresh. Refreshes the contents of the displayed list of dependencies. Use if new
content becomes available while you are working or you have uploaded new
contents (for example, from the command-line interface).
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UI
Elements Description

Set Dependency. If referenced content is also included in other content pack
definitions, amessage indicating this is displayed, and one of these was
automatically set for you.

To specify a different content pack definition for this content, use theSet
Dependency action. To include the referenced content in your content pack
definition, use theAdd to Included Content action.

The dependent content in the referenced content pack is displayed in bold,
indicating that dependency has been set on it.

Add to Included Content. Adds the selected dependent content to the list of
content included in this content pack.

<Color
coding>

Color coding:

l Internally referenced content: normal

l Content included in the currently selected content pack definition: bold

l Content included in another content pack definition: gray

<Version
dropdown
box>

If there is more than one version of a content pack that could be specified for
referenced content, the version dropdown box becomes active and displays the
selected content pack version.You can select an alternative version and set the
dependency to it.

Summary Page
This wizard page enables you to see summary information regarding the content, dependencies,
and any problems found in a new content pack definition.

Important
information

l General information about this wizard is available here: "Create New
Content Pack DefinitionWizard " on page 184.

l This wizard page appears as the Summary tab in the Edit Content Pack

Definition dialog box that opens when you click .

Wizard map The "Create New Content Pack DefinitionWizard " on page 184 contains:

"General Page" on page 185 > "Content Page" on page 186 > "Dependencies
Page" on previous page > Summary Page

See also "Content Packs" on page 165

User interface elements are described in the table below.

The Summary Page displays a summary of the selected content pack definition's contents, divided
into the following subsections. Each subsection contains a list of content and for each item in the
list, the following information is displayed:
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l Total number of artifacts

l Number of predefined artifacts

l Number of Predefined (Customized) artifacts

l Number of custom artifacts

Expanding the content group displays the artifacts contained within that group, the CI Type of the
artifact (where applicable), and the origin of the artifact (Predefined, Predefined (Customized),
Custom).

For example, indicators, mapping rules, and indicators, also show CI type, that is, the type of
configuration item to which the indicator is assigned (for example: Application, Host, or
Oracle System).

UI Elements Description

Selected Content Displays a list of the selected content, grouped by content type, included in
the selected content pack definition.

Referenced
Content Included
in This Content
Pack

Displays a list of the referenced content, grouped by content type, included
in the selected content pack definition.

Referenced
Content from
Other Content
Packs

Displays a list of the dependent content referenced from other content
packs, including the display name and version of each referenced content
pack.

Problems Found Displays information on any problems, such as unresolved dependencies
(content that is included in the selected content pack definition but no longer
exists in BSM), found in the selected content pack definition.

Import Content Pack Dialog Box
The Import Content Pack dialog box enables you to locate the content pack that you want to import
and how you want the import to be performed.

Note: A content pack contains the items to import. A content pack definition lists the items
included in the content pack.

To access Use one of the following:

l Admin > Platform > Content Packs

l Admin > Operations Management > Setup > Content Packs

and then click .

Relevant tasks "How to Create andManage Content Packs" on page 175

The Import Content Pack dialog box displays the UI elements listed in the following table.
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UI Element Description

Content
Pack File

Enables you to browse to the location of the content pack file that you want to
import.

Test Runs a simulated import operation using the selected content pack definition, but
does not commit any changes to BSM.

Import Starts the specified content data import and closes the Import Content Pack
dialog box.

Content Pack Manager Command-Line Interface
This section describes the options and parameters available in theContentManager command-line
interface.

TheContentManager command-line interface is located on theGateway Servers and the Data
Processing Servers in:

<BSM_Root_Directory>/bin

Note: The user executing theContentManagerCLI must have read access to the file:

<BSM_Root_Directory>/conf/TopazInfra.ini

Usage

ContentManager <Operation> [Connection] <UserCredentials> [Option]

Operation (one of the following):

Import Operations:

-import <in_file> [-test]

Export Operations:

-snapshot -output <out_file>

-export <name> -output <out_file>

[-contentPackVersion <version>] [-asPredefined]

Miscellaneous Operations:

-list

-delete <name> [-contentPackVersion <version>]

-version

Connections (one of the following):

-url <URL>

-server <gatewayserver> [-port <port>] [-ssl]
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User Credentials:

-username <login name> [-password <password>]

[-customer <customer Id>]

Options:

-verbose

The following table gives more information about the arguments recognized by the
ContentManager command:

Option Description

-asPredefined Marks the exported Content Pack as predefined.

-cpv,-contentPackVersion
<version>

Version number of the Content Pack Definition

-cu-customer <customer
Id>

Id of customer in SaaS environment.

If this parameter is not set the default value is 1.

-d,-delete <content_pack_
name>

Deletes the content pack definition specified in <content_
pack_name>. It does not delete the content pack’s content.
Content includes definitions for event type indicators, health
indicators, calculation rules for key performance indicators (KPI),
topology-based correlation rules, tool definitions, view mappings,
and graph families.

-e,-export <content_pack_
name>

Exports the named content pack definition and its content to the
file specified using the -output option.

-h,-help Displays a summary of the command options and exits.

-i,-import <input_file> Imports the content pack definition and its content from the
specified file.

Importing a custom content pack overwrites the existing objects.
Importing a predefined content pack overwrites all none-
customized objects.

-l,-list Lists the content pack definitions.

-o,-output <output_file> Specifies the name of the file to which you want the command to
write during the export operation.

-p,-port <port> Sets the port number. The default port numbers are 80 for HTTP
and 443 for HTTPS. Do not specify this option in conjunction with
the -url option.

-password <password> Requests the password of the user specified in the -username
option, whose account is being used for authentication purposes.
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Option Description

-server <gateway_server> Sets the target BSM gateway server using either a hostname or
an IP address. The specified server must be a BSM gateway
server. Default is ''{0}''.

Note:Do not specify this option in conjunction with the -url option.

-skipCheck Omits the content pack consistency check. The content pack
consistency check verifies if dependent content that is not part of
another content pack is either in the content pack itself or already
imported.

Caution: This option should only be used when upgrading to a
newer version of the Content Pack.

-snapshot Exports a snapshot of all content that can bemanaged by
Content Packs Manager.

-ssl Sets the protocol to HTTPS. The default protocol is HTTP. Do not
specify this option in conjunction with the -url option. If you do not
use the -port option to specify a non-standard port, the command
uses the standard port number reserved for HTTPS: 443.

-t,-test Runs import in preview mode and display the results immediately.
No changes are committed to the database.

-u, -url <URL> Specifies the URL of the BSM gateway server to access. The
default value is:

http://<Gateway Server DNS name>:<port>/opr-

admin-server

Do not specify this option in conjunction with the -server option.

-username <login_name> The name of the user, whose account is being used for
authentication purposes.

-v,-verbose Prints verbose output.

-version Prints the version information of the command and exits.

TheContentManager command displays the following values to indicate the exit status of the
requested operation:

Exit Status Description

0 Successful completion

1 Failure of requested operation

300-399 HTTP Redirection (300-399)

400-499 HTTP Client Error (400-499)

500-599 HTTP Internal Server Error (500-599)
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The exit status numbers (300-599) reflect a standard HTTP-status category (and number), for
example: Redirection (300-399). For more information about a specific HTTP error status,
for example: 307, which signifies a temporary HTTP re-direct, see the publicly available HTTP
documentation.

Content Pack Auto Upload Command-Line Interface
This section describes the options and parameters available in theContentAutoUpload
command-line interface.

TheContentAutoUpload command-line interface is located on the Data Processing Server in:

<BSM_Root_Directory>/bin

Note: The user executing theContentAutoUpload CLI must have read access to the file:

<BSM_Root_Directory>/conf/TopazInfra.ini

Usage

ContentAutoUpload <Operation> [Option]

Operation (one of the following)::

Import Operations:

-autoUpload [-uploadFolder <directory>]

[-forceReload]

Miscellaneous Operations:

-version

Options:

-verbose

The following table gives more information about the arguments recognized by the
ContentAutoUpload command:
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Option Description

-a,-
autoUpload

Automatically uploads the Content Pack Definition files from the default content
pack directory on the Data Processing Server:

<BSMRoot Dir>/conf/opr/content/<locale>/

Windows:
C:\HPBSM\conf\opr\content\<locale>\

Linux:
/opt/HP/BSM/conf/opr/content/<locale>/

If you want to upload content pack definitions from an alternative directory on
the Data Processing Server, specify the directory location using the -
uploadFolder <directory> option.

Note: If you havemore than one Data Processing Server, youmust keep
the content pack folders synchronized because it is not possible to specify
from which Data Processing Server content packs may be imported.

All predefined content pack definition files in the specified directory are imported
in the order of their dependencies. If a content pack definition is already
uploaded to the repository, it is not uploaded again.

For information about import errors, see the following log file:

<BSMRoot Dir>/log/EJBContainer/opr-webapp.log

Windows:
C:\HPBSM\log\EJBContainer\opr-webapp.log

Linux:
/opt/HP/BSM/log/EJBContainer/opr-webapp.log

-forceReload Enforces the reload of all content packs located in the default directory (<BSM
Root Dir>/conf/opr/content/<locale>/) or the directory specified
using the -uploadFolder <directory> option. Non-customized content is
overwritten.

-h,-help Displays a summary of the command options and exits.

-skipCheck Omits the content pack consistency check. The content pack consistency
check verifies if dependent content that is not part of another content pack is
either in the content pack itself or already imported.

Caution: This option should only be used when upgrading to a newer version of
the Content Pack.

-
uploadFolder
<directory>

If you want to upload content packs from an alternative directory, specify the
directory location using the -uploadFolder <directory> option.

For example:

ContentAutoUpload -a -uploadFolder c:\temp
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Option Description

-v,-verbose Prints verbose output.

-version Prints the version information of the command and exits.

TheContentAutoUpload command displays the following values to indicate the exit status of the
requested operation:

Exit
Status Description

0 SUCCESS (At least one content pack was imported and no errors occurred.)

1 FAILURE (No content packs were imported - complete failure.)

2 FAILURE_PARTIAL (Some content packs were imported successfully, others had
errors.)

3 NO_OPERATION (No new content was found for upload.)

4 NO_PERMISSION (User does not have appropriate permissions to execute this
tool.)

5 SYNTAX_ERROR (Wrong command-line arguments were specified.)
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Troubleshooting and Limitations
This section provides troubleshooting help related to content management, including but not limited
to: creating, modifying, and enabling configuration items.

Content Not Included in Content Pack

Make sure you perform the Include action at the correct level in the configuration item type
hierarchy so that all elements assigned to the selected configuration item type (and any children)
are included at the same time.

Unresolved References to CIs on Import

Content pack contains references to configuration items that do not exist on the target system.
Make sure that the Override and Create options are correctly specified before starting the import.
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Downtime Management
Downtime or other scheduled events can skew CI data. Youmay want to exclude these periods of
time from being calculated for events, alerts, reports, views, or SLAs. Downtimes are configured
based on associated CIs. For example, youmight want to exclude a recurringmaintenance event or
a holiday for a specific host CI whose physical host you know will be down for that period of time.

You define andmanage downtimes using the DowntimeManagement page in Platform Admin BSM
enables you to:

l Configure the downtime to occur once or to recur weekly or monthly.

l Select multiple CIs to be affected by the downtime.

When configuring a downtime, you select specific instances of CIs from the available views. You
can select CIs of the following CI types for the downtime:

l node

l running software

l business process

l business application

l ci collection

l infrastructure service

l business service

Downtime Actions
You can select what action is taken during the downtime on the CIs specified in the downtime
configuration. Downtime can impact the following:

l Alerts and Events. Events are suppressed and no CI Status alerts, EUM alerts, or notifications
are sent for any of the CIs associated with the downtime.

l KPIs. KPIs attached to the CI and impacted CIs are not updated and display the downtime for
the CI in Service Health. For details on how downtime configurations affect Service Health, see
KPI Status Colors and Definitions in the BSMUser Guide.

l Reports. End User Management Reports are not updated and display the downtime for the CI.
For details on how downtime configurations affect reports, see Downtime Information in Reports
in the BSMUser Guide.

l SLAs. Selected SLAs that are attached to the CI are not updated. You can select which SLAs to
include in the downtime. For details on how downtime configurations affect SLAs, see
Retroactive SLA Data Corrections in the BSM Application Administration Guide.

l Monitoring. Business Process Monitor and SiteScopemonitoring stops for any of the CIs
associated with the downtime. For details on how downtime configurations affect SiteScope
monitoring, see CI Downtime in the BSMUser Guide.
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The options you select in the downtime wizard are combinations of the above actions, grouped in
this order. This means that each option includes the previous options listed. The actions that are
taken in BSM during the downtime depends on the option selected during downtime configuration.

Events in Operations Management
When you select an action option that includes suppressing events in a downtime on a selected CI,
the result in the Operations Management application depends on how the downtime behavior is
configured in Operations Management. For details, see Downtime Behavior in the BSM Application
Administration Guide.

Downtime REST Service
You can retrieve, update, create, and delete downtimes through a RESTful Web service running on
theGateway Server. For details, see "Downtime REST Service" on page 203.
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How to Create and Manage Downtimes for CIs
This task describes how to create andmanage downtimes for the CIs in your system.

1. Prerequisites
Plan how you want the downtime to affect the CIs in your system. Before working in the
wizard:

n When determining which CIs may need downtimes, take into consideration CI's that impact
the CI's you selected. In some cases, these CI's are also affected by downtime. To
understand the downtime impact model, see the BSMDowntime_topology TQL in the RTSM
Modeling Studio. You can only select CIs from the following CI types:

o node

o running_software

o business_process

o business_application

o ci_collection

o infrastructure_service

o business_service

n Determine which actions should be applied to which CIs. The options for what happens
during downtime are to:

o Take no actions

o Suppress alerts and close events

o Enforce downtime on KPI calculations; suppress alerts and close events

o Enforce downtime on Reports and KPI calculations; suppress alerts and close events

o Stopmonitoring (BPM and SiteScope); enforce downtime on Reports & KPI calculations;
suppress alerts and close events (affects all related SLAs)

2. Configure how events are handled in Operations Management —
optional
You canmanage how events associated with CIs that are in downtime are handled. You do
this inAdmin > Operations Management > Tune Operations Management > Downtime
Behavior.

For details on this topic, see Downtime Behavior in the BSMUser Guide.

3. Run the Create Downtime wizard
Go toAdmin > Platform > Downtime and click theAdd Downtime button.

For user interface details, see "New DowntimeWizard" on page 209.

4. Results
After running the wizard, the details of the downtime are displayed in the DowntimeManager
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page. You can export the details of the downtimes to a .pdf or Excel file.

For user interface details, see "DowntimeManagement Page" on page 207.

Tip: To limit the downtimes in the exported file to a specified selection, you can filter the
visible downtimes in the DowntimeManager and then export to a .pdf or Excel file.
You can filter by any combination of one or more columns, including: Name, CIs,
Status, Action, Scheduling, Next Occurrence, Modified By, Approved By, Planned,
and Category.
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Downtime REST Service
You can use a RESTful Web service running on theGateway Server to retrieve, update, create, and
delete downtimes. HTTP requests can be entered in your browser, and combinations of HTTP
requests and XML commands in a REST client. Service authentication is based on basic
authentication.

Supported HTTP Requests
The downtime REST service supports the following HTTP requests:

Note: CustomerID is always 1 except in the case of HP SaaS customers.

Action HTTP Command

Retrieve all
downtimes

http://<HPBSM server>/topaz/bsmservices/customers/

[customerId]/downtimes

Retrieve a specific
downtime

http://<HPBSM server>/topaz/bsmservices/customers/

[customerId]/downtimes/[downtimeId]

Update a downtime
using http PUT

http://<HPBSM server>/topaz/bsmservices/customers/

[customerId]/downtimes/[downtimeId] + XML of the downtime

Create downtime
using http POST

http://<HPBSM server>/topaz/bsmservices/customers/

[customerId]/downtimes + XML of the downtime

Note:Successful creation of the downtime causes a return of the newly
created downtime in XML format, including the downtime ID.

Delete downtime
using http DELETE

http://<HPBSM server>/topaz/bsmservices/customers/

[customerId]/downtimes/[downtimeId]

Allowed Downtime Actions
Use the XML commands listed for the following downtime actions:

Action Description XML Command

Take no actions <action name="REMINDER"/>

Suppress alerts and close
events

<action name="SUPPRESS_NOTIFICATIONS"/>

Enforce downtime on KPI
calculations; suppress alerts
and close events (continue
monitoring)

<action name="ENFORCE_ON_KPI_CALCULATION"/>
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Action Description XML Command

Enforce downtime on Reports
and KPI calculations; suppress
alerts and close events
(continuemonitoring)

<action name="ENFORCE_ON_REPORTS"/>

Enforce downtime on Reports
and KPI calculations; suppress
alerts and close events
(continuemonitoring), including
all SLAs

<action name="ENFORCE_ON_REPORTS">

<propGroup name="SLA" value="ALL"/>

</action>

Enforce downtime on Reports
and KPI calculations; suppress
alerts and close events
(continuemonitoring), including
specific SLA

<action name="ENFORCE_ON_REPORTS">

<propGroup name="SLA" value="SELECTED">

<prop>dda3fb0b20c0d83e078035ee1c005201</prop>

</propGroup>

</action>

Stop activemonitoring (BPM
and SiteScope); enforce
downtime on Reports & KPI
calculations; suppress alerts
and close events

<action name="STOP_MONITORING"/>

Downtime XML Example
The following fields may not exceed themaximum lengths specified:

l Name: 200 characters

l Description: 2000 characters

l Approver: 50 characters

<downtime userId="1" planned="true"

id="8898e5a5dbcdc953e04037104bf5737c">

    <name>The name of the downtime</name>

    <action name="ENFORCE_ON_REPORTS">

    </action>

    <approver>The approver name</approver>

    <category>1</category>

    <notification>

        <recipients>

            <recipient id="24"/>

            <recipient id="22"/>

            <recipient id="21"/>

        </recipients>

    </notification>

    <selectedCIs>

        <ci>

            <id>ac700345b47064ed4fbb476f21f95a76</id>

            <viewName>End User Monitors</viewName>
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        </ci>

    </selectedCIs>

    <schedule xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xsi:type="WeeklyScheduleType">

        <type>WEEKLY</type>

        <startDate>2010-06-10T15:40:00+03:00</startDate>

        <timeZone>Europe/Zurich</timeZone>

        <days>

            <selectedDays>WEDNESDAY</selectedDays>

            <selectedDays>THURSDAY</selectedDays>

            <selectedDays>FRIDAY</selectedDays>

            <selectedDays>SATURDAY</selectedDays>

        </days>

        <startTimeInSecs>52800</startTimeInSecs>

        <durationInSecs>300</durationInSecs>

    </schedule>

</downtime>

Scheduling
Keep the following inmind when setting the downtime schedule:

l Retroactive downtime is not supported. You cannot:

n Create a downtime that is scheduled in the past.

n Delete a downtime that has started or that occurred in the past.

n Modify a downtime that has started or that occurred in the past.

l The date format of startDate/endDate is: yyyy-MM-dd'T'HH:mm:ssZ

l For weekly andmonthly downtimes, the startDate and endDate should be defined at midnight.
For example:

n <startDate>2010-07-24T00:00:00+03:00</startDate>

n <endDate>2010-09-04T00:00:00+03:00</endDate>

Example of a Downtime Schedule with One Occurrence
<schedule xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xsi:type="OnceScheduleType">

    <type>ONCE</type>

    <startDate>2010-06-08T14:40:00+03:00</startDate>

    <endDate>2010-06-08T14:45:00+03:00</endDate>

    <timeZone>Asia/Tokyo </timeZone>

</schedule>

HP Business ServiceManagement (9.20)Page 205 of 427



BSM Platform Administration Guide
Chapter 17: DowntimeManagement

Example of a Weekly Downtime Schedule
<schedule xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xsi:type="WeeklyScheduleType">

    <type>WEEKLY</type>

    <startDate>2010-06-10T15:40:00+03:00</startDate>

    <timeZone>Europe/Zurich</timeZone>

    <days>

        <selectedDays>WEDNESDAY</selectedDays>

        <selectedDays>THURSDAY</selectedDays>

        <selectedDays>FRIDAY</selectedDays>

        <selectedDays>SATURDAY</selectedDays>

    </days>

    <startTimeInSecs>52800</startTimeInSecs>

    <durationInSecs>300</durationInSecs>

</schedule>

Example of a Monthly Downtime Schedule
<schedule xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xsi:type="MonthlyScheduleType">

    <type>MONTHLY</type>

    <startDate>2010-06-10T14:40:00+03:00</startDate>

<timeZone>America/Montevideo</timeZone>

<days>

        <selectedDays>WEDNESDAY</selectedDays>

        <selectedDays>THURSDAY</selectedDays>

        <selectedDays>FRIDAY</selectedDays>

        <selectedDays>SATURDAY</selectedDays>

    </days>

    <startTimeInSecs>52800</startTimeInSecs>

    <durationInSecs>300</durationInSecs>

</schedule>
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Downtime Management User Interface

Downtime Management Page
Displays the list of scheduled downtimes configured for the associated CIs.

To access: Select Admin > Platform > Downtime Management

Important
information

l To add, edit or delete downtimes, youmust have Full permission on the
Downtime resource. In addition, you should have View permission on the
Views to which CIs in the downtime belong. For details on permissions, see
"Permissions" on page 223.

l The values you see in this page are view only. To edit any of the values for a
downtime, highlight the downtime and click Edit. The DowntimeWizard opens
and you can edit the value in the page in which it appears.

l For downtimes that have already occurred, only the following fields are
editable:

n Properties page - all fields

n Scheduling page -End by date inRange of recurrence

n Notification page -Selected Recipients

l Each column includes the option of filtering the list by the contents of the
column. For example, you can select a category type in the category column
and see only those downtimes configured with that category. By default,
downtimes with completed status are filtered out. To change these settings,
open the Status filter button and select completed.

Relevant
tasks

"How to Create andManage Downtimes for CIs" on page 201

See also "DowntimeManagement" on page 199

User interface elements are described below

UI Element
(A–Z) Description

Create new downtime. Opens the New Downtime wizard where you configure a
new downtime. For details, see "New DowntimeWizard" on page 209.

Edit downtime. Opens the Edit Dowtime wizard, which enables to you edit the
configuration of an existing downtime. This wizard presents the same screens as
the New Downtime wizard. For details, see "New DowntimeWizard" on page
209.

Duplicate downtime. Clones the settings of an existing downtime to a new
downtime.
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UI Element
(A–Z) Description

Delete downtime(s). Deletes selected downtime(s). Downtimes that are active
now or were active at any time in the past cannot be deleted. This is designed to
prevent the loss of historical data.

Export to Excel. Exports the table of configured downtimes to a file in Excel
format.

Export to PDF. Exports the table of configured downtimes to a PDF file.

Action The action that takes place when the downtime is in active status. You configure
the action for the downtime in the New Downtime wizard. For details about the
possible actions, see "Action Page" on page 213.

CIs The CIs associated with the downtime. These are the CIs that are impacted when
the downtime is in active status.

Modified
by

The user who last created or modified the downtime configuration.

Name The name of the downtime as configured in the Downtime wizard.

Next
Occurrence

The date and time of the next occurrence of the downtime. This field is updated
automatically.

Scheduling Displays the:

l Date, time, time zone, and duration

For recurring downtimes, also displays:

l What day of the week or month the downtime is scheduled to recur

l Range of recurrence

Status Displays whether the downtime is currently:

l Active. The CIs are currently in downtime and the action selected for the
downtime is now taking place.

l Inactive. The downtime is configured but it is currently not the time for the
downtime to take place.

l Completed. The time for the downtime has passed and the actions configured
for the downtime have occurred.

Optional Columns

Approved
by

Indicates if there was an approval for the downtime and who approved it.
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UI Element
(A–Z) Description

Category The category assigned to the downtime. Options include:

l Application installation

l Applicationmaintenance

l Hardware installation

l Hardwaremaintenance

l Network maintenance

l Operating system reconfiguration

l Other

l Security issue

You can also create your own customized categories using Infrastructure
Settings.

To add a custom downtime category, select Admin > Platform > Setup and
Maintenance > Infrastructure Settings:

l Select Foundations.

l Select Downtime.

l In theDowntime - General settings table, edit theDowntime categories
value to the name you want to use as a customized category for the downtime.
The name you enter appears as an option in the list of available downtime
categories.

Planned Indicates whether the downtime is planned or not.

New Downtime Wizard
This wizard enables you to create and edit downtimes for the CIs in your model.

To
access

Admin > Platform > Downtime > click theCreate new downtime button, or
select existing downtime and click theEdit downtime button.

Relevant
tasks

"How to Create andManage Downtimes for CIs" on page 201

Wizard
map

This New Downtime Wizard contains:

"Properties Page " on next page > "Select CIs Page " on next page > "Scheduling
Page " on page 211 > "Action Page" on page 213 > "Notification Page " on page 214
> "Preview Page " on page 215

See also "DowntimeManagement" on page 199
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Properties Page
This wizard page enables you to configure the general properties of the downtime.

Important
information

For downtimes that have already occurred, all of the fields in the Properties page
are editable.

Wizard
map

This "New DowntimeWizard" on previous page contains:

Properties Page > "Select CIs Page " below > "Scheduling Page " on next page
> "Action Page" on page 213 > "Notification Page " on page 214 > "Preview Page
" on page 215

See also "DowntimeManagement" on page 199

User interface elements are described below:

UI Element Description

Downtime
Name

Cannot exceed 200 characters.

Downtime
Description

This description also appears in the Downtime Information Areain the BSMUser
Guide.

Approved
by

You can enter the person or department who approved this downtime. Cannot
exceed 50 characters.

Planned Select if you want this downtimemarked as planned. You can create downtimes
that are unplanned. This is for information purposes only.

Downtime
Category

Select a category from the drop-downmenu. This category describes the reason
for the downtime.

You can also create your own customized categories using Infrastructure
Settings.

To add a custom downtime category, select Admin > Platform > Setup and
Maintenance > Infrastructure Settings:

l Select Foundations.

l Select Downtime.

l In theDowntime - General settings table, edit theDowntime category
value to the name you want to use as a customized category for the downtime.
The name you enter appears as an option in the list of available downtime
categories after you restart BSM.

Select CIs Page
This wizard page enables you to select the CIs that are affected by the downtime.

HP Business ServiceManagement (9.20)Page 210 of 427



BSM Platform Administration Guide
Chapter 17: DowntimeManagement

Important
information

For downtimes that have already occurred, you cannot edit the selected CIs in
this page.

Wizard
map

This "New DowntimeWizard" on page 209 contains:

"Properties Page " on previous page > Select CIs Page > "Scheduling Page "
below > "Action Page" on page 213 > "Notification Page " on page 214 > "Preview
Page " on page 215

See also "DowntimeManagement" on page 199

User interface elements are described below:

UI
Element
(A-Z) Description

Available
CIs

Select from the list the view that contains the CIs to be affected by this downtime.

You can use the button to browse and perform a search among the available
views.

Highlight a CI from the view tomove it to the Selected CIs list. Hold the Ctrl key
for selectingmultiple CIs.

All views that the user has permission to seemay be selected. You can select CIs
only of the following CI types:

l node

l running software

l business process

l business application

l ci collection

l infrastructure service

l business service

Selected
CIs

Once CIs are selected, they appear in the Selected CIs list. To remove a CI from a
downtime, select the CI in the Selected CIs and click the back arrow tomove it back
to the Available CIs list.

Scheduling Page
This wizard page enables you to configure the schedule for the downtime.
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Important
information

l You cannot schedule a downtime in the past.

l For downtimes that have already occurred, only the following field is editable in
the Scheduling page:

End by date inRange of recurrence

To cancel a recurring downtime that has already occured at least once, edit the
downtime andmodify this field.

Wizard
map

This "New DowntimeWizard" on page 209 contains:

"Properties Page " on page 210 > "Select CIs Page " on page 210 > Scheduling
Page > "Action Page" on next page > "Notification Page " on page 214 > "Preview
Page " on page 215

See also "DowntimeManagement" on page 199

User interface elements are described below:

UI Element Description

Time of
occurrence

l Start. The dropdown list includes times set for every half hour on the hour and
half hour. To select a different time of day, select the closest half hour and edit
the field to enter the actual time you want the downtime to start. For example,
for 2:10 am, select 2:00 am and edit theminutes to indicate 2:10 am.

l End. You can select an end time and the duration automatically updates. Or
select the duration and the end time automatically updates.

l Duration. Includes options from 5minutes to one week. The downtime
durationmust be in increments of 5minutes and be defined in lengths of
minutes, hours, days, or weeks.

If the length of time you want to specify does not appear, for example 1 1/2
hours, then enter the end time and the duration automatically updates.

To select a time greater than 1 week, select 1 week and edit the field to the
correct number of weeks.

Recurrence
pattern

Select one of the following:

l Once. The downtime happens only once as scheduled and does not recur.
Select the calendar date for the occurrence.

l Weekly. Select the day of the week for the scheduled weekly recurrence.

l Monthly. Select a day in themonth from the dropdown list for the scheduled
monthly recurrence.

Range of
recurrence

If you selectedWeekly orMonthly:

l Youmust define aStart date.

l Select either anEnd by date orNo end date.

Time zone All time zones are displayed in relation to GMT.
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Action Page
This wizard page enables you to define the set of actions taken during the downtime.

Important
information

For downtimes that have already occurred, no fields in the Action page are
editable.

Wizard
map

This "New DowntimeWizard" on page 209 contains:

"Properties Page " on page 210 > "Select CIs Page " on page 210 > "Scheduling
Page " on page 211 > Action Page > "Notification Page " on next page >
"Preview Page " on page 215

See also "DowntimeManagement" on page 199

User interface elements are described below:

UI Element Description

Take no actions There is no action taken on the associated CIs or the CI monitoring,
alerts, reports, or SLAs.

Note:During this downtime, the affected CI doesn't change its status
toDowntime. CI Status Alerts configured to be triggered if the CI
changes its status.

Suppress alerts and
close events

l No alerts or their associated notifications or actions are sent for any
of the CIs associated with the downtime.

l By default, events are submitted as closed. If OMi is installed,
event handling in downtime can be configured in Admin >
Operations Management > TuneOperations Management >
Downtime Behavior, and overrides the setting here.

l Monitoring continues, and reports, status in Service Health, and
SLAs are updated.

Note:During the downtime period, the affected CI may change its
status, and the status changemay trigger the relevant CI Status alert.

Enforce downtime on
KPI calculations;
suppress alerts and
close events

l KPI calculations are not run and status in Service Health is not
updated, and instead display the downtime for the CI.

l No alerts or their associated notifications or actions are sent for any
of the CIs associated with the downtime.

l By default, events are submitted as closed. If OMi is installed,
event handling in downtime can be configured in Admin >
Operations Management > TuneOperations Management >
Downtime Behavior, and overrides the setting here.

l Reporting andmonitoring continue. SLAs are updated.
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UI Element Description

Enforce downtime on
Reports and KPI
calculations;
suppress alerts and
close events

l Report data is not updated and the downtime is displayed for the
associated CIs.

l Selected SLAs are not updated for those SLAs affected by CIs
associated with the downtime.

l KPI calculations are not run and status in Service Health is not
updated, and instead display the downtime for the CI.

l No alerts or their associated notifications or actions are sent for any
of the CIs associated with the downtime.

l By default, events are submitted as closed. If OMi is installed,
event handling in downtime can be configured in Admin >
Operations Management > TuneOperations Management >
Downtime Behavior, and overrides the setting here.

l Monitoring continues.

Stop active
monitoring (BPM &
SiteScope); enforce
downtime on Reports
& KPI calculations;
suppress alerts and
close events (affects
all related SLAs)

l Business Process Monitor and SiteScopemonitoring stops.

l Report data is not updated and the downtime is displayed for the
associated CIs.

l SLAs are not updated for those SLAs affected by CIs associated
with the downtime.

l KPI calculations are not run and status in Service Health is not
updated, and instead display the downtime for the CI.

l No alerts or their associated notifications or actions are sent for any
of the CIs associated with the downtime.

l By default, events are submitted as closed. If OMi is installed,
event handling in downtime can be configured in Admin >
Operations Management > TuneOperations Management >
Downtime Behavior, and overrides the setting here.

Note: If you configure a downtime period for an Application CI (whose
data is updated by BPMmonitoring), DowntimeManager automatically
sends an event to the BPM Agent when the downtime period starts.
The agent stops sending samples to BSM. The samples that are
suppressed are the BPM samples that correspond to the Transaction
CIs, which are child CIs of the Application CIs on which the downtime
is configured. There is one sample per transaction.

Notification Page
This wizard page enables you to select recipients to receive notification of the downtime.
Notifications are sent by email at the time of downtime occurrence and immediately after it
completes. You can select only those recipients with an email address defined.

HP Business ServiceManagement (9.20)Page 214 of 427



BSM Platform Administration Guide
Chapter 17: DowntimeManagement

Important
information

For downtimes that have already occurred, you can edit theSelected Recipients
in the Notification page.

Wizard
map

This "New DowntimeWizard" on page 209 contains:

"Properties Page " on page 210 > "Select CIs Page " on page 210 > "Scheduling
Page " on page 211 > "Action Page" on page 213 > Notification Page > "Preview
Page " below

See also "DowntimeManagement" on page 199

User interface elements are described below:

UI
Element Description

Opens theNew recipient dialog box to create a recipient that is not yet in the list of
available recipients. The recipients you create are available as recipients in all of
BSM. For details on creating recipients, see "How to Configure andManage
Recipients" on page 319.

Available
Recipients

Lists the available recipients for downtime notification by means of either email,
SMS, or pager.

Selected
Recipients

Lists the selected recipients for downtime notification by means of either Email,
SMS, or Pager. Either one, two or all threemeans of notificationmay be selected.

Preview Page
This wizard page enables you to preview a summary of your Downtime settings.

Wizard
map

This "New DowntimeWizard" on page 209 contains:

"Properties Page " on page 210 > "Select CIs Page " on page 210 > "Scheduling Page "
on page 211 > "Action Page" on page 213 > "Notification Page " on previous page >
Preview Page

See
also

"DowntimeManagement" on page 199

User interface elements are described below:

UI
Element Description

Preview
table

Table listing all the values configured for this downtime. Gives you the opportunity to
click theBack button to return to a page that has a value that should bemodified or
deleted.

Once you click Finish on this page, the downtime is added to the system and
displayed in the DowntimeManager page.
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Troubleshooting and Limitations
This section describes troubleshooting and limitations for the DowntimeManager.

Editing Downtimes
l If while editing a downtime in the Downtime wizard its status changes from Idle toActive, the

downtime cannot be saved.

l If you want to cancel a recurring downtime that has already occured at least once, edit the
downtime's End by date in the Scheduling page.

Downtime and Daylight Saving Time
In time zones that observe Daylight Saving Time (DST), downtime calculations take into account
the transitions between Standard and Daylight Time, using the following rules:

Note: The examples that follow use the daylight saving changes observed throughout most of
the United States.

l March 14 2010 -- when 2:00 am arrives, the clock moves forward to 3:00 am. Thus, the
period 2:00-2:59 am does not exist.

l November 7 2010 -- when 2:00 am arrives, the clock moves back to 1:00 am. Thus, the
period 1:00-1:59 am appears twice.

In other time zones, the behavior is the same, but the transition dates and times may vary.

These examples are summarized in the table "DST Changes Affecting Downtime—
Example Summary" on page 218.

Spring (Standard to Daylight Time)
l When downtime starts before the DST change and ends the day after the change, its end time is

as expected, but the duration is 1 hour less than defined.

Example 1:

Monthly downtime starting 14th day of month at 1:30 am and ending on 15th day of month at
2:40 am. Duration is 1 day, 1 hour, and 10minutes.

No DST change: Downtime starts on 14th at 1:30 am and ends on 15th at 2:40 am. Duration is 1
day, 1 hour, 10minutes.

DST change onMarch 14 2010: Downtime starts on 14th at 1:30 am and ends on 15th on 2:40
am, but the duration is 1 day, 0 hours, 10minutes (1 hour less than defined).

l When downtime starts before the DST change and ends the same day as the change, but after
the change, its end time is 1 hour more than defined, but its duration is as defined.

Example 2:

Monthly downtime on 13th day of month, starting at 11 pm (23:00), for a duration of 5 hours.

No DST change: Downtime starts on 13th at 11:00 pm and ends on 14th at 4:00 am.
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DST change onMarch 14 2010: Downtime starts on 13th at 11:00 pm and ends on 14th at 5:00
am, and the duration remains 5 hours.

l When downtime is defined to start during the skipped hour, the start time shifts 1 hour forward
and keeps the defined duration.

Example 3:

Monthly downtime on 14th day of month, starting at 2:30 am, for a duration of 2 hours.

No DST change: Downtime starts on 14th at 2:30 am and ends on 14th at 4:30 am.

DST change onMarch 14 2010: Downtime starts on 14th at 3:30 am and ends on 14th at 5:30
am, and the duration remains 2 hours.

l When downtime is defined to start before the DST change and end during the skipped hour, the
end time shifts 1 hour forward and keeps the defined duration.

Example 4:

Monthly downtime on 13th day of month, starting at 1:30 am, for a duration of 1 day, 1 hour, and
10minutes.

No DST change: Downtime starts on 13th at 1:30 am and ends on 14th at 2:40 am. The duration
is 1 day, 1 hour, and 10minutes.

DST change onMarch 14 2010: Downtime starts on 13th at 1:30 am and ends on 14th at 3:40
am, and the duration remains as defined -- 1 day, 1 hour, and 10minutes.

l When downtime is defined to start and end during the skipped hour, downtime takes place one
hour later than defined.

Example 5:

Monthly downtime on 14th day of month, starting at 2:00 am, for a duration of 1 hour.

No DST change: Downtime starts on 14th at 2:00 am and ends on 14th at 3:00 am.

DST change onMarch 14 2010: Downtime starts on 14th at 3:00 am and ends on 14th at 4:00
am, and the duration remains as defined -- 1 hour.

Fall (Daylight Time to Standard Time)
l When downtime starts and ends after the DST change, its end time and duration are as defined.

l When downtime starts before the DST change (same day as change or day before) and ends
after the change during the day of the change, the end time is 1 hour less than expected, and
duration is as defined.

Example 6:

Twomonthly downtimes, both starting on the 7th day of month at midnight. The first downtime
duration is 1 hour, and the second is 2 hours.

No DST change: The first downtime is on 7th from 0:00 to 1:00 am (1 hour duration), and the
second on 7th from 0:00 to 2:00 am (2 hours duration).

DST change on November 7 2010: The first downtime starts on 7th at 0:00 Daylight Time and
ends on 7th at 1:00 am Daylight Time, with a duration of 1 hour. The second downtime starts on
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7th at 0:00 Daylight Time and ends on 7th at 1:00 am Standard Time, and the duration remains 2
hours.

Example 7:

Monthly downtime on 7th day of month, starting at midnight, for a duration of 4 hours.

No DST change: Downtime starts on 7th at 0:00 and ends on 7th at 4:00 am.

DST change on November 7 2010: Downtime starts on 7th at 0:00 and ends on 7th at 3:00 am,
and the duration remains as defined -- 4 hours.

Example 8:

Monthly downtime on 6th day of month, starting at 8:00 pm (20:00), for a duration of 7 hours.

No DST change: Downtime starts on 6th at 8:00 pm and ends on 7th at 3:00 am.

DST change on November 7 2010: Downtime starts on 6th at 8:00 pm and ends on 7th at 2:00
am, and the duration remains as defined -- 7 hours.

l When downtime starts before the DST change and ends the day after the change, the end time
is as expected, and duration is 1 hour more than defined.

Example 9:

Monthly downtime on 7th day of month, starting at midnight (0:00), for a duration of 1 day, 1 hour
(25 hours).

No DST change: Downtime starts on 7th at 0:00 and ends on 8th at 1:00 am.

DST change on November 7 2010: Downtime starts on 7th at 0:00 and ends on 8th at 1:00 am,
but the duration is 26 hours.

DST Changes Affecting Downtime — Example Summary

Example
Downtime as Set/With
DST Change Start Time End Time Duration

1 Set 14th at
1:30 am

15th at 2:40 am 1 day, 1 hour, 10
minutes

With DST Change 14th at
1:30 am

15th at 2:40 am 1 day, 0 hours, 10
minutes

2 Set 13th at
11:00 pm

14th at 4:00 am 5 hours

With DST Change 13th at
11:00 pm

14th at 5:00 am 5 hours

3 Set 14th at
2:30 am

14th at 4:30 am 2 hours

With DST Change 14th at
3:30 am

14th at 5:30 am 2 hours
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Example
Downtime as Set/With
DST Change Start Time End Time Duration

4 Set 13th at
1:30 am

14th at 2:40 am 1 day, 1 hour, and
10minutes

With DST Change 13th at
1:30 am

14th at 3:40 am 1 day, 1 hour, and
10minutes

5 Set 14th at
2:00 am

14th at 3:00 am 1 hour

With DST Change 14th at
3:00 am

14th at 4:00 am 1 hour

6 1st Set 7th at 0:00 7th at 1:00 am 1 hour

With DST
Change

7th at 0:00 7th at 1:00 am 1 hour

2nd Set 7th at 0:00 7th at 2:00 am 2 hours

With DST
Change

7th at 0:00 7th at 1:00 am
Standard Time

2 hours

7 Set 7th at 0:00 7th at 4:00 am 4 hours

With DST Change 7th at 0:00 7th at 3:00 am 4 hours

8 Set 6th at 8:00
pm

7th at 3:00 am 7 hours

With DST Change 6th at 8:00
pm

7th at 2:00 am 7 hours

9 Set 7th at 0:00 8th at 1:00 am 25 hours

With DST Change 7th at 0:00 8th at 1:00 am 26 hours
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HP Business ServiceManagement (9.20)Page 220 of 427



Chapter 18

User Management
You use the User Management interface to:

l Configure BSM Groups and Users. Permissions enable you to restrict the scope of a user's
access to predefined areas. Permissions can be granted either directly to a user or by means of
a user group. You group users tomakemanaging user permissions more efficient. Instead of
assigning access permissions to each user one at a time, you can group users who are assigned
the same permissions levels on the same resources.

Youmay want to create different groups based on how users access the different resources in
BSM. Examples of criteria for grouping users that are relevant to your organizationmay be:

Functions Within the Organization Locations and Territories

Customer service representatives Users working in different sales territories

System administrators Users based on geographical location

High-level management Users accessing network servers in different locations

You can change a user's parameters, including username and password, on the General tab. For
details, see "General Tab (User Management)" on page 304.

For details on creating groups and users, see "Groups/Users Pane" on page 313.

l Define a superuser. One superuser is defined for every installation of BSM. This superuser's
login name is admin and the initial password for this account is specified in the Setup and
Database Configuration utility. This original superuser is not listed among the users in User
Management and therefore, this user's password can be changed only on theGeneral Settings
page in Personal Settings (Admin > Personal Settings). For details on the user interface for
performing this task, see "User Account Page" on page 337.

Superuser can be applied to other users in the system. These users with superuser permissions
are listed, and can bemodified, in User Management. For details on applying permissions, see
"How to Assign Permissions" on page 239.

l Assign recipient to user. You can assign a recipient to a user. A recipient can receive alerts
and scheduled reports. For details on recipients, see "Recipient Management" on page 318.

l Assign Permissions to Groups and Users. The User Management interface is available only
to users with appropriate permissions. A user's permissions are either inherited from assigned
roles, or granted individually when its parameters are configured. For details on permissions, see
"Permissions" on page 223.

l Set Group and User Hierarchy. You can add users to groups and nest groups within other
groups. For details, see "Group and User Hierarchy" on page 228.

l Customize User Settings. Select the page users see when entering BSM, and choose the
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menu items available on pages throughout BSM. For details, see "Customizing User Menus" on
page 230.
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Permissions
You can assign permissions to the groups and users defined in your BSM platform, enabling access
to specific areas of BSM.

Granting permissions has the following components:

l User

l Resource

l Role or operation being granted

The Permissions tab includes the following areas:

l The resource tree area in the center of the page, containing the contexts, resources, and
resource instances on which permissions are assigned. For details, see "Understanding
Permissions Resources" on next page.

l The roles and operations area on the right side of the page. For details on roles, see "Roles" on
page 226. For details on operations, see "Operations" on page 226.

Additionally, theGroups/Users pane is continually visible on the left side of the page.

The following is an example of Granting Permissions:

For details on assigning permissions, see "How to Assign Permissions" on page 239.

Note:

l If you have upgraded from a previous version of BSM and had specific users and security
levels defined, those users and security levels aremapped to the new roles functionality in
the Permissions tab. For details, see "Roles" on page 226.

l You can export users and groups, together with their assigned roles, from one BSM
machine to another. For details, contact HP Software Support.
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Understanding Permissions Resources
BSM enables you to fine-tune your permissions management by applying permissions at the
resource level. All of the resources on which permissions can be applied have been identified and
categorized in a hierarchical tree, representing the BSM platform.

The resources and instances of those resources are organized according to logical groupings called
contexts. Contexts make it easier to identify and select the area of the platform on which you want
to apply permissions.

The resources are divided according to the context in which they function within the platform and
not necessarily where they are found in the user interface.

This section also includes:

l "Resources and Resource Instances" below

l "Guidelines forWorking with Resources" on next page

Resources and Resource Instances
There are the following types of resources in Permissions Management. Each is represented by a
different icon in the resource tree:

Resource collection (a resource that can have instances)

Instance of a resource

Resource that cannot have instances in the permissions resource tree

An instance of a resource is displayed only if it has been defined in the platform. The instance of a
resource appears as a child object of the resource in the tree with the name as it has been defined in
the application. After instances of a resource are defined in the system, the resource collection acts
as the parent resource for those instances.

There are some resources, such as the different data collector profiles, that contain other resources
within them in the resource tree hierarchy. Some of these sub-resource types appear only if there
are instances of the resource defined in your platform, such as Monitor and Transaction resources
within a profile resource.

Resources that cannot have instances in the permissions tree are divided into the following types:

l Resources that are functions or options within the system that do not have any other instances
or types.

Example:

TheOutlier Value resource determines whether the user can edit the outlier threshold value. It
has no instances.

l Resources that do have instances; permissions can be applied only on the resource type and
affect all instances of the resource.
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Example:

The Category resource includes all categories defined in End User Management
Administration. Change permissions granted on the categories resource enables a user to
modify all the categories defined in the system. You cannot grant or remove permissions for
specific categories, only for every category defined in End User Management Administration.

Examples of Resources and Instances:

An example of how resources and instances are displayed in the permissions hierarchy is the
Applications resource collection within the End User Management context. The Applications
resource includes instances only if applications have been defined in the system. Some
instances may be defined by default, but others only exist if defined by the user. If there are
applications defined in the system, each of these appears as an instance of the Applications
resource.

Because BPM, RUM, and alerts are defined in your platform per application, the BPM, RUM,
and Alerts resources appear under each of the instances of the application resource.

You can apply permissions to the Applications resource level. This provides the user with
access to all applications created in the system. If you want to restrict a user's access to
specific applications that relate to the user's tasks, you can apply permissions to those
specific applications, and can also apply or removed permissions to specific resources per
application.

Guidelines for Working with Resources
l The Business ServiceManagement resource refers to all contexts in BSM.

l Only roles and not operations can be applied to the Business ServiceManagement resource. For
details, see "Roles" on next page.
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l Tomanage the permissions on a subresource, youmust provide the user with at least View
permission on the selected resource's parent.

l You grant Add permission only on a resource and not on an instance of a resource.

l When a user defines or creates an instance of a resource, for example creates a Business
Process profile, that user has Full Control permission on that resource instance and all of its
child resources.

Roles
BSM enables you to apply permissions using roles for specific users or groups in your organization.
These roles include a preconfigured collection of resources and a set of operations that apply to
those resources.

Roles are organized by context, which define what resources and operations have been
preconfigured and included in the roles. For details on how each operation applies to a specific
resource, see "Operations" below.

Roles can be applied only to specific resources:

l Roles that include resources from several contexts can be applied only to theBusiness
Service Management resource. Business Service Management appears as the first resource
collection in every context.

l Roles whose resources are all within one context can be applied to specific resources within
that context.

For a description of each role, including details of the resources on which roles can be applied, see
"User Management Roles Applied Across BSM" on page 252.

Operations
Whenworking with operations, keep the following inmind:

l All of the operations that can be applied to a resource collection can also be applied to any
instance of that resource. The one exception is theAdd operation which cannot be applied to an
instance of a resource.

l The Full Control operation automatically includes all the other operations available on the
resource. When applied, the other operations are automatically selected.

l When the Full Control operation is applied to any resource, the user also has permissions to
grant and remove permissions on that resource, or resource instance, for other users or groups.

l When theView operation is one of the resource's available operations and you select one of the
other available operations, theView operation is also automatically selected.

For details on the available operations in BSM, see "User Management Operations" on page 286.

Security Officer
The security officer is a user who has security privileges to view sensitive information in the
system. The security officer is typically not a regular BSM user and receives access to configure
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certain sensitive reporting information. In Real User Monitor, the security officer can configure
settings for masking sensitive data. For details, see Sensitive Data Area in the BSM Application
Administration Guide.

This user does not generally access the other areas of BSM.

There can be only one user in the system assigned as security officer. Only the user with superuser
permissions can assign the security officer for the first time. Thereafter, only the user assigned as
security officer can pass on the security office designation to another user, or change his or her own
password. The superuser can no longer assign security officer status.

The security officer is designated by highlighting a user in the User Management tree and clicking
on the Security Officer icon. For details on the user interface, see "Groups/Users Pane" on page
313.

No other user in the system can delete the user assigned as security officer. The security officer
designationmust be assigned to a different user by the security officer before the user who is the
current security officer can be deleted from the system.

In unforeseen circumstances, when the security officer is no longer able to access the system and
reassign the security officer designation to another user, the administrator can use the JMX console
to clear the security officer designation from the user. For details on how to perform this task
procedure, see "How to Remove Security Officer Status Using the JMX Console " on page 242.
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Group and User Hierarchy
You can nest groups tomakemanaging user and group permissions easier. Instead of assigning
access permissions to each group one at a time, you can nest a group to inherit the permissions of
its direct parent.

When nesting groups, note the following:

l A group can be amember of several groups.

l Permissions are assigned to nested groups in the sameway as for regular, non-nested, groups.
Changes in nested group permissions take effect at the user's next login.

l There is nomaximum number of levels of nested groups.

Example:

In the example below, Group_A and Group_B are nestedmembers of Group_C. Group_
C inherits the combined permissions of both groups. Group_C and Group_D are nested
members of Group_E. Group_E directly inherits the permissions of Group_C and
Group_D, and indirectly inherits the permissions of Group_A and Group_B.

When permissions are added to, or removed from, a nested group, the changes are
automatically implemented in the nested group's immediate parent and continue to
propagate onward. For example, if delete permission in Group_B is removed, Group_
C's permissions become add + change + view. Group_E's permissions become add
+ change + view + execute.

A circle of nested groups is not permitted. For example, Group_A is a member of Group_
B, and Group_B is a member of Group_C. Group_C cannot be amember of Group_A.

HP Business ServiceManagement (9.20)Page 228 of 427



BSM Platform Administration Guide
Chapter 18: User Management

Note: All permissions in the previous example refer to the same resource.

For details on setting up nested groups, see "How to Configure Group and User Hierarchy" on page
240.
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Customizing User Menus
You can customize user menus to:

l Select the default context that is displayed for specific users when logging into BSM.

l Specify the first page that is displayed for specific users in each of the different parts of BSM.

l Select whole contexts and applications to hide per user.

l Specify the tabs and options that are available on pages throughout BSM.

Customizing the entry page, menu items, and tabs enables the interface to display only the areas of
BSM that are relevant to specific users.

For details on customizing user menus, see "How to Customize User Menus" on page 245.

You customize user menus on the Customization tab. For details on the Customization tab user
interface, see "Customization Tab (User Management)" on page 303.

Note: For the Service Health andOperations Management applications, you cannot define
user access to specific pages; you can only enable or disable user access at the application
level.
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How to Configure Users and Permissions —
Workflow

This task describes a suggested working order for the User Management application. You can
configure User Management settings in any other logical order you choose.

For a use-case scenario related to this task, see "How to Configure Users and Permissions —Use-
Case Scenario" on page 233.

1. Prerequisites
Before you configure the User Management portal, you shouldmap out the required users and
groups and their relevant permission levels before defining them in BSM. For example, enter
the following information in a spreadsheet:

n A list of users required to administer the system, as well as the end users who are to access
Service Health and reports. Gather appropriate user details such as user names, login
names, initial passwords, and user time zones. Although not needed to define users, at this
stage it might be useful to also collect user contact information such as telephone number,
pager, or email address. (Contact information is required for HP Software-as-a-Service
customers.)

n If categorization of users into modes (operations and business) is required, specify into
which user mode to categorize each user. For details, see KPIs for User Modes in the BSM
Application Administration Guide.

n If multiple users require similar system permissions, a list of roles and the users that should
belong to each group.

n The permissions that each user or group requires. To aid in this process, review the
Permissions Management page to learn about the different contexts and resources for
which permissions can be granted. For details, see "Understanding Permissions
Resources" on page 224.

2. Create Groups
You create groups in theGroups/Users pane as follows:

a. Click theNew Group/User button in the Browse tab, after selecting an existing
group or the root group.

b. Select Create Group and enter the group's information in the Create Group dialog box. For
user interface details, see "Create Group Dialog Box" on page 302.

3. Assign Permissions to Groups
BSM enables you to apply permissions to groups and users for specific resources and
instances of those resources that are defined in the system. For task details, see "How to
Assign Permissions" on page 239.

4. Create Users
You create users and then place them into the appropriate groups. For user interface details,
see "Groups/Users Pane" on page 313.
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5. Configure User and Group Hierarchy
In the Hierarchy tab, you set user and group hierarchy by adding users to groups and nesting
groups within other groups. For task details, see "How to Configure Group and User Hierarchy"
on page 240.

6. Customize User Settings
In the Customization tab, you customize themenu items that are displayed in different
contexts for users. For task details, see "How to Customize User Menus" on page 245.

7. Configure and Manage Recipients
You create recipients by defining one or more notificationmethods, the template to use for alert
notices, and a notification schedule to receive reports. You create recipients andmanage
existing recipients in the Recipients page. For user interface details, see "How to Configure
andManage Recipients" on page 319.
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How to Configure Users and Permissions — Use-
Case Scenario

This use-case scenario describes how to configure users and groups in the User Management
portal.

Note: For a task related to this scenario, see "How to Configure Users and Permissions —
Workflow" on page 231.

1. Mapping Out Users and Groups
Jane Smith is the System Administrator at NewSoft Company, and wants to configure users
and groups to be authorized to use BSM, as well as end users who will be accessing Service
Health and reports. Before doing so, she requests the following preliminary information from
relevant staff members:

n User names

n Login names

n Initial Passwords

n User Time Zones

n Contact Information (for example, telephone number, pager, email address)

Note: Contact information is mandatory only for HP Software-as-a-Service customers.

With this information, she then decides to create one group with the permission level of
SystemModifiers, and another with the permission level of System Viewers. Further, one of
the users is assigned additional roles of SiteScope Administrator.

2. Creating Groups
Jane groups users together according to the level of permissions they are to be granted. She

clicks theNew Group/User button in theGroups/Users pane and creates the following
groups:

n System Viewers

n SystemModifiers

TheGroups/Users pane appears as follows:
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3. Assigning Permissions to Groups
Once the groups have been created, Jane assigns the relevant permission levels to the groups.
After selectingSystem Modifiers in theGroups/Users pane, she navigates to the
Permissions tab in the Information pane, and chooses the Root instance (Business Service
Management) from any context. In theRoles tab, she selects System Modifier and then
clicks Apply Permissions. She then selects System Viewers in theGroups/Users pane and
chooses System Viewer in theRoles tab, clickingApply Permissions.

The results are displayed on the Permissions tab as follows:

4. Creating Users
Janemust now create users to nest within the groups, in accordance with the desired

permission levels of the individual users. She clicks theNew Group/User button in the
Groups/Users pane and while on the Root group, (All), she selects Create User and
configures settings for each new user. TheGroups/Users pane appears as follows:

5. Configuring User and Group Hierarchy
Now that Jane has created users authorized to access BSM, she assigns their permission
level by nesting them within the appropriate group.

She selects theSystem Modifiers group from theGroups/Users pane to nest the appropriate
users in this group. Jane then selects theHierarchy tab from the Information pane on the right
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side of the page. The hierarchy tab indicates that the SystemModifiers group has no child
groups, as follows:

Jane clicks theEdit Child Groups and Users button to open the Edit Child Groups and
Users dialog box:
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She then selects the relevant users from theGroups/Users pane and clicks the right arrow to
move them to theChild Groups and Users pane. The Hierarchy tab indicates that these
users are nested within the SystemModifiers group, as follows:

After following the same procedure to nest the relevant users in the System Viewers group, the
Groups/Users pane is displayed as follows:

Since Steve has the added permission level of SiteScope Administrator, Jane selects the
username of the user in theGroups/Users pane whom she wants to give the added
permission level of SiteScope Administrator, and in thePermissions tab, selects theSystem
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Availability Management context. After selecting a resource, she then selects SiteScope
Administrator from theRoles tab, and clicks Apply Permissions. The resulting screen
appears as follows:

6. Customizing User Settings
Jane now sets the page each user sees when entering BSM, and themenu items available to
them on pages throughout BSM. After selecting each user, she clicks theCustomization tab
and sets the following parameters:

n The entry context that the user sees when logging into BSM. For example, Admin - End
User Management.

n The page within the entry context that the user sees on the selected context. For example,
Reports.

n The pages and tabs that are to be visible on each BSM page by selecting or clearing the
relevant check boxes. For example, the Transaction Topology and User-created reports
pages are cleared to ensure that they are not visible on theApplications - Transaction
Management context when the user logs in.

The configured settings are displayed on the customization tab as follows:
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The login page that the user sees according to the customized configurations is as follows:
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How to Assign Permissions
This task describes how to configure group and user permissions in User Management. For the
applied permissions to take effect, the user for whom permissions have been granted or removed
must log out and log in again to BSM.

1. Prerequisites
Ensure that groups and users are configured in your system. For user interface details, see
"Groups/Users Pane" on page 313.

2. Select a Group or User
Select a group or user from theGroups/Users pane on the left side of the page.

3. Select a Context
Select a context from the context list box above the resource tree in the center of the page. For
details on the available contexts, see "Resource Tree Pane" on page 308.

4. Assign a Role
Permissions are assigned using roles. You assign a role for the selected group or user in the
Roles tab on the right side of the page. For details on the available roles, see "User
Management Roles Applied Across BSM" on page 252.

5. Assign Operations — Optional
Optionally, you can assign individual operations in theOperations tab that the group or user
can perform in BSM. For details on the available operations, see "User Management
Operations" on page 286.

6. Configure Permissions Settings — Optional
Optionally, click Settings at the bottom of the resource tree. The Apply Permissions Settings
dialog box opens and you can configure the settings for the current session of applying
permissions. For user interface details, see "Resource Tree Pane" on page 308.
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How to Configure Group and User Hierarchy
This task describes how to configure user and group hierarchy. For details on the Hierarchy Tab
user interface, see "Hierarchy Tab (User Management)" on page 306.

1. Prerequisites
Ensure that you have configured at least one group and one user in theGroups/Users pane.
For user interface details, see "Groups/Users Pane" on page 313.

2. View Group and User Hierarchy
Select a group or user in theGroups/Users pane, and select theHierarchy tab on the right
side of the page to view the parent and child groups of the group or user, if applicable.

3. Nest Groups and Users
You choose a group in theGroups/Users pane, and choose groups and users to nest beneath
it.

a. Click a group or user in theBrowse tab of theGroups/Users pane on the left side of the
screen.

b. Click theHierarchy tab on the right side of the screen.

c. Select the group in theGroups/Users tab that you want to administer, and click theEdit
Child Groups and Users button. The Edit Child Groups and Users window opens.

The following is the Edit Child Groups and Users window:

d. Assign users and nest groups by selecting the user or group in theGroups/Users pane,
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and clicking on the left-to-right arrow tomove the group or user to theChild Groups and
Users pane.

Unassign users and remove nested groups by selecting the group or user in theChild
Groups and Users pane, and clicking on the right-to-left arrow.

4. Results
The nested groups and users appear in the Child Groups and Users pane in the Hierarchy tab.

Example:
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How to Remove Security Officer Status Using the
JMX Console

This task describes how to remove security officer status from a user using the JMX console. This
may be necessary if under unforeseen circumstances, the security officer cannot remove the
status himself. Once the security officer is assigned, there is no other user authorized tomake this
change within the User Management interface. For details on this topic, see "Security Officer" on
page 226.

To remove a security officer:

1. Enter the URL of the JMX console (http://<Gateway or Data Processing Server
name>:8080/jmx-console/) in a web browser.

2. Enter your JMX console authentication credentials. If you do not know your authentication
credentials, contact your system administrator.

3. Locate:

n Domain name: Foundations

n Service: Infrastructure Settings Manager

n Setting: setCustomerSettingDefaultValue

4. Modify the parameter values as follows:

n Context Name: enter security

n Setting Name: enter secured.user.login.name

n New Value: leave empty

5. Click Invoke.
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How to Export and Import User Information Using
the JMX Console

This task describes how use the JMX Console to copy user, role, and permission information from
a source system to a target system. For example, if you need to configure a new BSM database,
youmay need to copy user information from an existing database.

Set Contexts to Export
You can limit which contexts will be included in the export. You can view a list of available contexts
in the JMX Console:

1. In a browser, enter the following URL:
http://<SOURCE_Server>:8080/jmx-console/HtmlAdaptor?action=inspectMBean&
name=Topaz%3Aservice%3DAuthorization+Service

2. Enter your JMX Console user name and password.

3. On the JMX MBean View page, click the Invoke button below java.util.Set
listAuthorizationContexts(). JMX Console displays all contexts in TAS.

If you need to limit the contexts included in the export:

1. On the source server, open the following fileHPBSM\conf\tas\exportedContexts.properties

2. Modify the contexts-to-export property.
Contexts in the contexts-to-export property must be separated by commas only, without
spaces.

3. Save your changes.

Export
Use JMX Console to create a .zip file that contains .xml files with user, role, and permission
information.

1. In a browser, enter the following URL:
http://<SOURCE_Server>:8080/jmx-console/HtmlAdaptor?action=inspectMBean&
name=Topaz%3Aservice%3DAuthorization+Service+Data+Import+Export

2. On the JMX MBean View page, click the Invoke button below void loadExportedContexts()
and then click the Browser's Back button to return to the JMX MBean View page.

3. Below void exportAllTasEntities(), in theParamValue field, enter a location and file name for
the export file on the source server. The file namemust have a .zip extension for example:
C:\HPBSM\export.zip

4. Click the Invoke button below void exportAllTasEntities().

Transfer
You need to copy the export .zip file from the source server to the target server.

1. On the source server, browse to the export file as defined above.

2. Copy the file to the target server.
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Import
Import the users, roles and permissions from the .zip file to the target BSM system.

Caution: Before you import user and group information, make sure that the target server does
not have any created resources, such as reports, profiles, andmonitors, that have user
information that is not compatible with the information that you are importing.

1. In a browser, enter the following URL:
http://<TARGET_Server>:8080/jmx-console/HtmlAdaptor?action=inspectMBean&
name=Topaz%3Aservice%3DAuthorization+Service+Data+Import+Export

2. Enter your JMX Console user name and password.

3. Below void importAllTasEntities(), in theParamValue field, enter the location and file name
of the export file and click the Invoke button.
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How to Customize User Menus
This task describes how to customize the default page that users see when they log into BSM, and
choose themenu items available on pages throughout the system.

Tip: For a use-case scenario related to this task, see "How to Customize User Menus —Use-
Case Scenario" on page 247.

You can restrict access to features or set default pages for individual users or for all users in a
group, including all members of sub-groups that are part of a parent group. If you restrict access to a
feature or report for a group, all members of that group will not have access to the feature and you
will not be able to override the setting for individual users.

If you add users or sub-groups to a group that has group settings applied, the users or members of
the sub-groups will automatically get the access restrictions that were applied to the group.

1. Prerequisites
Ensure that you have configured at least one user in theGroups/Users pane. For user
interface details, see "Groups/Users Pane" on page 313.

2. Select a User
Select a user or group from theBrowse tab in theGroups/Users pane whose pages andmenu
items you want to customize, and select theCustomization tab.

3. Assign a Default Context
Select a context from theContexts pane that you want to be the default entry context this user
or all users in a group will see when they log into BSM, and click Set as Default Entry
Context. For user interface details, see "Customization Tab (User Management)" on page 303.

4. Select Contexts and Applications to Hide/Display
In theContexts pane, clear the check boxes of the contexts and applications that you want
hidden from the user or all members of the group. By default, all contexts and applications are
selected.

5. Select Context Pages and Tabs
In thePages and Tabs pane, select the check boxes of the pages and tabs that you want to
be visible on the selected context for the user or group. Clear the check boxes of the pages and
tabs that you want hidden from the user or group.

Note: For the Service Health andOperations Management applications, you cannot define
user access to specific pages; you can only enable or disable user access at the
application level.

6. Assign a Default Entry Page
Select a page or tab to be the default entry page for the selected context, and click Set as
Default Entry Page.

7. Results
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TheDefault Entry button appears next to the default entry context and page. Applications
and context visible to the user are selected in theContexts pane. Pages and tabs visible to the
user are selected in thePages and Tabs pane.
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How to Customize User Menus — Use-Case
Scenario

This use-case scenario describes how to customize user menus for individual users.

Note: For a task related to this scenario, see "How to Customize User Menus" on page 245.

1. Choosing a User
Mary, the administrator of ABC Insurance Company, is creating several users in the User
Management section of BSM. She decides that the user John Smith should be able to view
only certain pages and tabs in BSM, and that a specific page should appear on his screen when
he logs into BSM.

2. Assigning a Default Context
Since John's chief responsibility at ABC relates to service level management, Mary
designates the Applications - Service Level Management page as the default entry context.
Mary selects Applications - Service Level Management in the Contexts pane, and clicks
Set as Default Entry Context. TheApplications - Service Level Management context is
indicated as the default entry context with the default entry icon, as appears in the following
image:

3. Selecting Context Pages and Tabs
Since John is not authorized to view Outage Reports, that option is cleared in the Pages and
Tabs pane, leaving the remaining pages and tabs checked to be visible when John logs into
BSM. As SLA Reports are of the highest priority for ABC Insurance, Mary designates this as
the first page for John to see upon logging in. She selects SLA Reports in the Pages and Tabs
pane, and then clicks Set as Default Entry Page. SLA Reports is indicated as the default
entry page with the default entry icon, as appears in the following image:
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4. Results
The context that opens when John Smith logs into BSM is theService Level Management
context on the Applications menu. TheSLA Reports page opens, and the Status Snapshot,
Alerts, and SLA Management pages are also available to him.

The configured Customization tab in User Management appears as follows:

Screen that John sees when logging into BSM:
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How to Add a Custom Pager or SMS Service
Provider

If your pager or SMS service provider does not appear on the default provider list, and the provider
uses an email gateway, you canmanually add your provider to BSM. After doing so, your provider
appears on the list.

To add a provider that uses an email gateway, manually add the gateway information to the
management database. If necessary, ask your database administrator for assistance.

To add a provider that uses an email gateway:

1. Open theNOTIFICATION_PROVIDERS table in themanagement database.

2. In theNP_NOTIFICATION_PROVIDER_NAME column, add the name of the provider to the
bottom of the list.

Add the name exactly as you want it to appear in the provider list that opens in the SMS tab of
the Recipient Properties wizard. For details, see "SMS Tab" on page 329.

Note the ID number that is automatically assigned to the provider.

3. Close theNOTIFICATION_PROVIDERS table, and open theNOTIFPROVIDER_
NOTIFTYPE table.

4. In theNN_NOTIF_PROVIDER_ID column, add the ID number that was assigned to the new
provider.

5. In theNN_NOTIF_TYPE_ID column, assign the provider one of the following notification
types:

n 102 – for pager service provider

n 101 – for SMS service provider

6. Close theNOTIFPROVIDER_NOTIFTYPE table, and open theNOTIFICATION_
PROVIDER_PROP table.

7. In theNPP_NOTIFICATION_PROVIDER_ID column, add the ID number that was assigned
to the new provider.

Note that you add the ID number to two consecutive rows.

8. In theNPP_NPROVIDER_PROP_NAME andNPP_NPROVIDER_PROP_VALUE
columns, add the following new property names and values for the provider, one beneath the
other (for examples, see existing entries):

Property
Name

Property
Value Description

EMAIL_
SUFFIX

<email_
suffix>

The gateway's email suffix. For example, if the gateway email
address is 12345@example.com, enter example.com as the
property value for EMAIL_SUFFIX.

HP Business ServiceManagement (9.20)Page 250 of 427



BSM Platform Administration Guide
Chapter 18: User Management

Property
Name

Property
Value Description

EMAIL_
MAX_
LEN

<max_
length>

Themaximummessage length, in characters, of the body of the email
message. For example, 500.

When determining this value, take into consideration themaximum
length limit imposed by your service provider, as well as limitations to
your pager or mobile phone.

9. In theNPP_NPROVIDER_PROP_DATATYPE_ID column, specify an ID value as follows:

n for EMAIL_SUFFIX, specify: 1

n for EMAIL_MAX_LEN, specify: 2

10. Restart BSM.
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User Management Roles Applied Across BSM
The following roles can be applied across all contexts within BSM. Details of the resources on
which roles can be applied appear within the description of each role below.

For details about roles that can be applied only to specific contexts, see "User Management Roles
Applied to Specific Contexts" on page 282.

Superuser
TheSuperuser role can be applied only to theBusiness Service Management resource.

This role includes all available operations on all the resources in all the contexts. Only a superuser
can apply theSuperuser role to another user.

Caution: The default superuser does not have permissions to write to Business Service
Management from the UCMDBWS API. Specific roles exist for that purpose. For
details, see "User Management Roles Applied to Specific Contexts" on page 282 and
"User Management Roles Applied to Specific Contexts" on page 282.

Administrator
TheAdministrator role can be applied only to theBusiness Service Management resource.

An administrator has a collection of permissions that enable adding profiles to the system, and
managing the resources related to those profiles. Once a profile is added, the administrator has full
control privileges on all resources within that profile instance.

Business Process Insight

Resource Allowed Operations

Business Process Insight Application View

Business Process Insight Administration Full Control

Diagnostics

Resource Allowed Operations

Diagnostics Change

View

Execute

Full Control
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End User Management

Resource Allowed Operations

Alert - Create dependencies Change

Applications Add

View

BPM Agents View

RUM Engines View

Script Repository Add

Change

View

Delete

Full Control

MyBSM

Resource Allowed Operations

User Pages Full Control

Predefined Pages View

User Components Full Control

MyBSM (Legacy)

Resource Allowed Operations

Modules Full Control

Portlet Definitions Full Control
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Operations Management

Resource Allowed Operations

Events assigned to user Work On/Resolve

Close

Reopen

Assign To

LaunchOperator Action

Launch Automatic Action

Transfer Control

Close Transferred

Add/Remove Event Relations

Change Severity

Change Priority

Change Title

Change Description

Change Solution

Add/Delete/Update Annotations

Add/Delete/Update Custom Attributes
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Resource Allowed Operations

Events not assigned to user View

Work On/Resolve

Close

Reopen

Assign To

LaunchOperator Action

Launch Automatic Action

Transfer Control

Close Transferred

Add/Remove Event Relations

Change Severity

Change Priority

Change Title

Change Description

Change Solution

Add/Delete/Update Annotations

Add/Delete/Update Custom Attributes

Health Indicators Reset

Administrative UIs View

Tool Categories     Execute

Operations Orchestration Integration

Resource Allowed Operations

Administration Add

Change

View

Delete

Full Control
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Resource Allowed Operations

Execution Execute

Full Control

Platform

Resource Allowed Operations

Audit Log View

Full Control

Users Add

Change

View

Delete

Full Control

User Groups Add

Change

View

Delete

Full Control

Data Collectors Change

View

Scheduled Reports Add

Change

View

Delete

Full Control
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Resource Allowed Operations

Recipients Add

Change

View

Delete

Full Control

Custom Data Types Add

Change

View

Delete

Full Control

Downtime View

Full Control

Databases Add

Change

View

Delete

Full Control

RTSM

Resource Allowed Operations

Views Add

Change

View

Delete

Full Control

RTSM Full Control

CI Search Full Control

DataModifier Full Control
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Resource Allowed Operations

Get Related Full Control

ITU Manager Full Control

Modeling Studio Full Control

Service Health Analyzer

Resource Allowed Operations

Administration Full Control

Application Full Control

Service Level Management

Resource Allowed Operations

SLAs Add

Change

View

Delete

Full Control

SiteScopeOn demand monitors

Resource Allowed Operations

Administration Add

Change

View

Delete

Full Control

Execution Execute

Full Control

System Availability Management

Resource Allowed Operations

SiteScopes Add
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Transaction Management

Resource Allowed Operations

TransactionVision Processing Servers Change

Full Control

TransactionVision Analyzers Change

Execute

Full Control

TransactionVision JobManagers Change

Execute

Full Control

TransactionVision Query Engines Change

Execute

Full Control

Administration Change

Full Control

User Data View

Full Control

Applications Add

User Defined Reports

Resource Allowed Operations

Custom Reports Add

Change

View

Full Control

Trend Reports Add

Change

View

Full Control
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Resource Allowed Operations

Custom Links Change

View

Full Control

Excel Reports Change

View

Full Control

Default Footer/Header Change

Full Control

Favorite Filter Change

View

Delete

Full Control

Annotation Change

Delete

Full Control

Service Report Change

Delete

Full Control

Custom Query Reports Add

View

Full Control

System Modifier
TheSystem Modifier role can be applied only to theBusiness Service Management resource.

A systemmodifier can view and change any and all of the resources within BSM. There are some
resources on which the view or the change operation is not applicable. A systemmodifier has
permissions for only those operations that are available in BSM.
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Business Process Insight

Resource Allowed Operations

Business Process Insight Application View

Business Process Insight Administration Full Control

Diagnostics

Resource Allowed Operations

Diagnostics Change

View

End User Management

Resource Allowed Operations

Alert - Notification Template Change

View

Alert - Create dependencies Change

Applications Change

View

BPM Agents View

RUM Engines View

Script Repository View

Full Control

MyBSM

Resource Allowed Operations

Pre-defined Pages View

User Pages Full Control

User Components Full Control

Operations Orchestration Integration

Resource Allowed Operations

Administration Change

View
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Resource Allowed Operations

Execution Execute

Platform

Resource Allowed Operations

Audit Log View

Users Change

View

User Groups Change

View

Data Collectors Change

View

Scheduled Reports Change

View

Recipients Change

View

Custom Data Types Change

View

Send SNMP trap Change

Run executable file Change

Log to Event Viewer Change

Downtime Full Control

Databases Change

View

System Recipient Template Change

View
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RTSM

Resource Allowed Operations

Views Change

View

CI Search Full Control

Get Related Full Control

ITU Manager Full Control

Modeling Studio Full Control

Service Health Analyzer

Resource Allowed Operations

Administration Full Control

Application Full Control

Service Level Management

Resource Allowed Operations

SLAs Change

View

SiteScopeOn demand monitors

Resource Allowed Operations

Administration Change

View

Execution Execute

System Availability Management

Resource Allowed Operations

SiteScopes Change

View

Transaction Management
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Resource Allowed Operations

TransactionVision Processing Servers Change

TransactionVision Analyzers Change

Execute

TransactionVision JobManagers Change

Execute

TransactionVision Query Engines Change

Execute

Administration Change

Applications Change

View

User Defined Reports

Resource Allowed Operations

Custom Reports Add

Change

View

Trend Reports Add

Change

View

Custom Links Change

View

Excel Reports Change

View

Default Footer/Header Change

Favorite Filter Change

View

Delete
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Resource Allowed Operations

Annotation Change

Delete

Service Report Change

Delete

Custom Query Reports Add

View

System Viewer
The System Viewer role can be applied only to theBusiness Service Management resource.

A system viewer can only view resources within BSM and has no permissions to change, add, or
delete any resources or resource instances with the exception of the RUM Engines resource. There
are some resources on which the view operation is not applicable. A system viewer has no access
to those resources.

Business Process Insight

Resource Allowed Operations

Business Process Insight Application View

Diagnostics

Resource Allowed Operations

Diagnostics View

End User Management

Resource Allowed Operations

Alert - Notification Template View

Applications View

BPM Agents View

RUM Engines View, Edit

Script Repository View
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MyBSM

Resource Allowed Operations

Predefined Pages View

Operations Orchestration Integration

Resource Allowed Operations

Administration View

Platform

Resource Allowed Operations

Audit Log View

Users View

User Groups View

Data Collectors View

Scheduled Reports View

Recipients View

Custom Data Types View

Downtime View

Databases View

System Recipient Template View

RTSM

Resource Allowed Operations

Views View

CI Search Full Control

Get Related Full Control

ITU Manager Full Control

Modeling Studio Full Control

Service Health Analyzer

Resource Allowed Operations

Administration Full Control
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Resource Allowed Operations

Application Full Control

Service Level Management

Resource Allowed Operations

SLAs View

SiteScopeOn demand monitors

Resource Allowed Operations

Administration View

System Availability Management

Resource Allowed Operations

SiteScopes View

Transaction Management

Resource Allowed Operations

Applications View

User Defined Reports

Resource Allowed Operations

Custom Reports Add

View

Trend Reports Add

View

Custom Links View

Excel Reports View

Favorite Filter View

Custom Query Reports Add

View
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Customer Superuser

Note: This role can be applied to HP Software-as-a-Service customers only.

TheCustomer Superuser role can be applied only to theActive Customer resource instance.
TheActive Customer resource instance is available only to HP Software-as-a-Service customers
and represents the customer level in the permissions resource tree. It is available in all contexts
and applies to all contexts (like theBusiness Service Management resource).

Business Process Insight

Resource Allowed Operations

Business Process Insight Application View

Business Process Insight Application Full Control

Diagnostics

Resource Allowed Operations

Diagnostics View

Execute

End User Management

Resource Allowed Operations

Alert - Create dependencies Change

Full Control

Applications Add

Change

View

Delete

Execute

Full Control

BPM Agents View

RUM Engines View
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Resource Allowed Operations

Script Repository Add

Change

View

Delete

Full Control

MyBSM

Resource Allowed Operations

Predefined Pages Full Control

User Pages Full Control

User Components Full Control

MyBSM (Legacy)

Resource Allowed Operations

Modules Full Control

Portlet Definitions Full Control

Platform

Resource Allowed Operations

Audit Log View

Full Control

Users Add

Change

View

Delete

Full Control
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Resource Allowed Operations

User Groups Add

Change

View

Delete

Full Control

Data Collectors Change

View

Central Repository Service Add

Change

View

Delete

Execute

Full Control

Notification System View

Execute

Full Control

PackageWork Manipulation Change

Full Control

Scheduled Reports Add

Change

View

Delete

Full Control
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Resource Allowed Operations

Recipients Add

Change

View

Delete

Full Control

Custom Data Types Add

Change

View

Delete

Full Control

Customer Recipient Template Add

Change

View

Delete

Full Control

Downtime View

Full Control

RTSM

Resource Allowed Operations

Views Add

Change

View

Delete

Full Control

RTSM Full Control

CI Search Full Control

DataModifier Full Control
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Resource Allowed Operations

Get Related Full Control

ITU Manager Full Control

Modeling Studio Full Control

Service Health Analyzer

Resource Allowed Operations

Administration Full Control

Application Full Control

Service Level Management

Resource Allowed Operations

SLAs Add

Change

View

Delete

Full Control

System Availability Management

Resource Allowed Operations

SiteScopes Add

Change

View

Delete

Execute

Full Control
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User Defined Reports

Resource Allowed Operations

Custom Reports Add

Change

View

Full Control

Trend Reports Add

Change

View

Full Control

Custom Links Change

View

Full Control

Excel Reports Change

View

Full Control

Default Header/Footer Change

Full Control

Favorite Filter Change

View

Delete

Full Control

Annotation Change

Delete

Full Control

Service Report Change

Delete

Full Control
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Resource Allowed Operations

Custom Query Reports Add

View

Full Control

Customer Administrator

Note: This role can be applied to HP Software-as-a-Service customers only.

TheCustomer Administrator role can be applied only to theActive Customer resource instance.
The Active Customer resource instance is available only to HP Software-as-a-Service customers
and represents the customer level in the permissions resource tree. It is available in all contexts
and applies to all contexts (like theBusiness Service Management resource).

The customer administrator is granted full control on a selection of resources, as well as either
view, execute, or both on other resources. This user can add profiles of any type, and has full
control on the created profile. However, the user is not granted permissions for profiles that were
created by other users, even if these profiles are for the same customer. In the case of theMyBSM
resources, any user with this role canmake changes to resources defined by other users.

Business Process Insight

Resource Allowed Operations

Business Process Insight Application View

Business Process Insight Administration Full Control

Diagnostics

Resource Allowed Operations

Diagnostics View

Execute

End User Management

Resource Allowed Operations

Alert - Create dependencies Change

Full Control

Applications Add

View
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Resource Allowed Operations

BPM Agents View

RUM Engines View

MyBSM

Resource Allowed Operations

Predefined Pages View

User Components Full Control

User Pages Full Control

MyBSM (Legacy)

Resource Allowed Operations

Modules Full Control

Portlet Definitions Full Control

Platform

Resource Allowed Operations

Audit Log View

Full Control

Users Add

Change

View

Delete

Full Control

User Groups Add

Change

View

Delete

Full Control
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Resource Allowed Operations

Central Repository Service Add

Change

View

Delete

Execute

Full Control

Notification System View

Execute

Full Control

PackageWork Manipulation Change

Full Control

Scheduled Reports Add

Change

View

Delete

Full Control

Recipients Add

Change

View

Delete

Full Control

Custom Data Types Add

Change

View

Delete

Full Control
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Resource Allowed Operations

Customer Recipient Template Add

Change

View

Delete

Full Control

Downtime View

Full Control

RTSM

Resource Allowed Operations

Views Add

Change

View

Delete

Full Control

RTSM Full Control

CI Search Full Control

DataModifier Full Control

Get Related Full Control

ITU Manager Full Control

Modeling Studio Full Control

Service Health Analyzer

Resource Allowed Operations

Administration Full Control

Application Full Control
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Service Level Management

Resource Allowed Operations

SLAs Add

Change

View

Delete

Full Control

System Availability Management

Resource Allowed Operations

SiteScopes Add

User Defined Reports

Resource Allowed Operations

Custom Reports Add

Change

View

Full Control

Trend Reports Add

Change

View

Full Control

Custom Links Change

View

Full Control

Excel Reports Change

View

Full Control

Default Header/Footer Change

Full Control
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Resource Allowed Operations

Favorite Filter Change

View

Delete

Full Control

Annotation Change

Delete

Full Control

Service Report Change

Delete

Full Control

Custom Query Reports Add

View

Full Control

BPM Viewer
TheBPM Viewer role can be applied only to theBusiness Service Management resource.

These users have view permissions, but canmodify transaction threshold settings and transaction
descriptions.

Any regular user who was added as a user on a specific BPM Profile in the previous version is
upgraded to the BPM Viewer role for that profile.

Resource Allowed Operations

Applications View

BPM Agents View

Script Repository View

BPM Administrator
TheBPM Administrator role can be applied only to theBusiness Service Management
resource.

The BPM Administrator canmanage all of the platform's BPM profiles, including permissions on all
the profiles.
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Any administrator who was added as a user on a specific BPM profile in the previous version is
upgraded to the BPM profile administrator role for that profile. This is in addition to being assigned
the administrator role as described above (for details, see "Administrator" on page 252).

Resource Allowed Operations

Applications Add

Change

View

Delete

Execute

Full Control

BPM Agents View

Script Repository Add

Change

View

Delete

Full Control

RUM Administrator
TheRUM Administrator role can be applied only to theBusiness Service Management
resource.

Resource Allowed Operations

Applications Add

Change

View

Delete

Execute

Full Control

RUM Engines View

RUM Viewer
TheRUM Viewer role can be applied only to theBusiness Service Management resource.
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These users have view permissions, but canmodify transaction threshold settings and transaction
descriptions.

Any regular user who was added as a user on a specific RUM profile in the previous version is
upgraded to theRUM Viewer role for that profile.

Resource Allowed Operations

Applications View

RUM Engines View
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User Management Roles Applied to Specific
Contexts

The following roles can be applied only to specific contexts within BSM. Details of the resources
and contexts on which roles can be applied appear within the description of each role below.

For details about roles that can be applied across BSM, see "User Management Roles Applied
Across BSM" on page 252.

BPIAdministrator
TheBPIAdministrator role can be applied only to theBusiness Process Insight Administration
resource in theBusiness Process Insight context.

Context Resource Allowed Operations

Business Process Insight Business Process Insight Application Full Control

Business Process Insight Administration Full Control

BPIUser
TheBPIUser role can be applied only to theBusiness Process Insight Application resource in
theBusiness Process Insight context.

Context Resource
Allowed
Operations

Business Process
Insight

Business Process Insight Application View

Business Process Insight Process
Administration

View

BPIRestrictedViewUser
TheBPIRestrictedViewUser role can be applied only to theBusiness Process Insight
Application resource in theBusiness Process Insight context.

Context Resource Allowed Operations

Business
Process
Insight

Business Process Insight
Application

View only those deployed BPI processes to
which View permission has been granted.

Business Process Insight
Process Administration

CMDB Open API Query
TheCMDB Open API Query role can be applied only to theRTSM Open API resource in the
RTSM context.

This role enables users to query the CMDB (ConfigurationManagement Database) for
communication with third-party applications.
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Context Resource Allowed Operations

RTSM RTSMOpen API View

CMDB Open API Update
TheCMDB Open API Update role can be applied only to theRTSM Open API resource in the
RTSM context.

This role enables users to update the CMDB (ConfigurationManagement Database) for
communication with third-party applications.

Context Resource Allowed Operations

RTSM RTSMOpen API Change

CMDB Open API Impact
TheCMDB Open API Impact role can be applied only to theRTSM Open API resource in the
RTSM context.

This role enables users to impact operations on the CMDB.

Context Resource Allowed Operations

RTSM RTSMOpen API View

CMDB Open API Class Model
TheCMDB Open API Class Model role can be applied only to theRTSM Open API resource in
theRTSM context.

This role enables users to perform operations on CITs.

Context Resource Allowed Operations

RTSM RTSMOpen API View

SiteScope Administrator
TheSiteScope Administrator role can be applied only to theSiteScopes resource in theSystem
Availability Management context or specific instances of the resource.

When granted this role at the resource collection level, the SiteScope administrator canmanage all
of the platform's SiteScopes, including permissions on the SiteScopes. When granted this role at
the instance level, the administrator canmanage only those resources associated with the specific
SiteScope instance.

Any administrator who was added as a user on a specific SiteScope in the previous version is
upgraded to the SiteScope administrator role for that SiteScope.
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Context Resource Allowed Operations

System Availability Management SiteScopes Add

Change

View

Delete

Execute

Full Control

Default
TheDefault role is automatically assigned if no other role was selected. It allows very limited
permissions, mainly to enable adding and viewing custom and trend reports in theUser Defined
Reports context.

Note: To createmeaningful reports, the user will likely need additional permissions to specific
applications or configuration items.

Context Resource Allowed Operations

User Defined Reports Custom Reports Add

Trend Reports Add

TransactionManagementOperator
The TransactionManagementOperator role can be applied only to the TransactionVision
Analyzers resource in the Transaction Management context.

Context Resource Allowed Operations

TransactionManagement TransactionVision Analyzers Execute

TransactionVision JobManagers Execute

TransactionVision Query Engines Execute

Administration Change

Applications View

TransactionManagementAdministrator
The TransactionManagementAdministrator role can be applied only to the TransactionVision
Processing Servers resource in the Transaction Management context. The
TransactionManagementAdministrator role is useful in providing added security by enabling
users to have Full Control access of TransactionVision administration, but not enabling access to
the User Data resource.
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Context Resource Allowed Operations

TransactionManagement TransactionVision Processing Servers Change

Full Control

TransactionVision Analyzers Change

Execute

Full Control

TransactionVision JobManagers Change

Execute

Full Control

TransactionVision Query Engines Change

Execute

Full Control

Administration Change

Full Control

Applications Add

Change

View

Full Control

TransactionManagementUser
The TransactionManagementUser role can be applied only to theApplications resource in the
Transaction Management context.

Context Resource Allowed Operations

TransactionManagement Applications View
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User Management Operations
Within each context listed below is a table listing:

l Every resource

l Which operations can be applied to that resource

l A description of what the operation enables

Business Process Insight
Use theBusiness Process Insight context to assign permissions to the Business Process
Insight instance configured within the system.

Resources Operation Description

Business Process
Insight Application

View Enables entering the Business Process Insight application.

Business Process
Insight
Administration

Full
Control

Enables performing all available operations on Business
Process Insight administration, and granting and removing
permissions for other users.

Business Process
Insight Process
Definition

View Enables viewing of a process in the Business Process Insight
application.

Diagnostics
TheDiagnostics context enables you to define operations permitted for the Diagnostics
application.

Resources Operation Description

Diagnostics Change Enables viewing Diagnostics administration and configuring the
Diagnostics settings.

View Enables viewing Diagnostics when accessing Diagnostics from
BSM.

Execute Enables changing the settings in the Diagnostics UI, such as setting
thresholds.

Full
Control

Enables performing all operations on Diagnostics, and granting and
removing permissions for those operations.

End User Management
TheEnd User Management context enables you to define the operations permitted for the End
User Management application. Operations assigned to a folder affect all folders contained beneath
it.
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Resources Operation Description

Alert - Notification
Template

Change Enables editing the properties of a customer-specific
notification template.

View Enables viewing the properties of a notification template.

Full
Control

Enables performing all available operations on a notification
template, and granting and removing permissions for those
operations.

Alert - Create
dependencies

Change Enables creating and removing dependencies between
alerts.

Full
Control

Enables creating and removing alert dependencies, and
granting and removing permissions for those operations.

Applications Add Enables adding applications.

Change Enables editing applications, or a specific instance of
applications.

View Enables viewing applications, or a specific instance of
applications.

Delete Enables deleting applications, or a specific instance of
applications.

Execute Enables starting and stopping applications, or a specific
instance of applications.

Full
Control

Enables performing all available operations on applications,
or a specific instance of applications, and granting and
removing permissions for those operations.

Applications
(specific
instances)

BPM Add Enables creating a Business Process configuration for a
specific instance of applications.

Change Enables editing a Business Process configuration for a
specific instance of applications.

View Enables viewing a Business Process configuration for a
specific instance of applications.

Delete Enables deleting a Business Process configuration for a
specific instance of applications.

Execute Enables activating and disabling a Business Process
configuration for a specific instance of applications.

Full
Control

Enables performing all available operations on a Business
Process configuration for a specific instance of
applications.
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Resources Operation Description

RUM Add Enables creating a Real User Monitor configuration for a
specific instance of applications.

Change Enables editing a Real User Monitor configuration for a
specific instance of applications.

View Enables viewing a Real User Monitor configuration for a
specific instance of applications.

Delete Enables deleting a Real User Monitor configuration for a
specific instance of applications.

Execute Enables activating and disabling a Real User Monitor
configuration for a specific instance of applications.

Full
Control

Enables performing all available operations on a Real User
Monitor configuration for a specific instance of applications.

Alert View Enables viewing an Alert configuration for a specific
instance of applications.

Full
Control

Enables performing all available operations on an Alert
configuration for a specific instance of applications.

BPM Agents View Enables viewing BPM agents andmanagingmonitors on
those agents.

RUM Engines View Enables viewing Real User Monitor engines andmanaging
RUM configurations on those engines.

Script Repository Add Enables creating new folders in the script repository.

Change Enables renaming script repository folders andmodifying
scripts in those folders.

View Enables viewing script repository folders and scripts in
those folders.

Delete Enables deleting folders in the script repository.

Full
Control

Enables performing all available operations on script folders
and scripts in the script repository, and granting and
removing permissions for those operations.

RTSM
TheRTSM context enables you to define the operations permitted for the views defined in IT
Universe Administration and viewed in theModel Explorer, Service Health, and Service Level
Management.

Tip: If a user has permissions on a view in RTSM, all the profiles that are in that view are
visible to the user, even if the user does not have permissions on the profile. To prevent a
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user from viewing profiles for which the user does not have permissions while enabling the
user to access a view, create a view for the user including only those configuration items
for which you want the user to have permissions and grant the user permission on that
view.

Resources Operation Description

Views Add Enables adding and cloning views.

Change Enables editing views.

View Enables viewing views

Delete Enables removing views.

Full
Control

Enables performing all available operations on views.

RTSM Full
Control

Enables administrative operations for all of the Run-time Service
Model (RTSM), except ITU Manager andModeling Studio.

CI Search Full
Control

Enables the CI Search option from any location in the RTSM.

Data
Modifier

Full
Control

Enables the DataModifier option from any location in the RTSM.

Get
Related

Full
Control

Enables the Get Related CIs option from any location in the RTSM.

ITU
Manager

Full
Control

Allows the user to enter the ITU Manager. Once inside, the available
functionality within the ITU UniverseManager depends on
permissions the user has been granted on views.

Modeling
Studio

Full
Control

Allows the user to enter theModeling Studio. Once inside, the
available functionality within the ITU UniverseManager depends on
permissions the user has been granted on views.

RTSM
Open API

Change Enables running of updates in RTSMOpen API.

View Enables running of queries in RTSMOpen API.

Operations Management

Note: TheOperations Management context is available only if you have installed OMi on
your BSMmachine. For details on the OMi context, see User Context Panein the BSMUser
Guide.

TheOperations Manager i (OMi) context enables you to assign permissions to work with the
Operations Manager context. For details on the operations available for the Operations Manager i
(OMi) context, see User Operations Tabin the BSMUser Guide.
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Resources Operation Description

Events
assigned to
user

Work On / Resolve Enables the user to set the life cycle status for events that
are assigned to them toWork On or Resolve

Close Enables the user to set the life cycle status for events that
are assigned to them to Closed

Reopen Enables the user to set the life cycle status for Closed
events that are assigned to them to Open. The events can
now be reassigned for further investigation and resolution.

Note: Reopening symptom events with a closed cause is
not possible.

Assign To Enables the user to assign events that are assigned to
them to a specific user

LaunchOperator
Action

Enables the user to run HP Operations Manager operator
actions for events assigned to them containing event-
related actions
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Resources Operation Description

Events
assigned to
user

Launch Automatic
Action

Enables the user to run HP Operations Manager
automatic actions for events assigned to them containing
event-related actions.

Transfer Control Enables the user to transfer control of events assigned to
them in the Event Browser to an external manager.

Close Transferred Enables the user to close events assigned to them in the
Event Browser for which control has been transferred to
an external manager.

Add/Remove
Event Relations

Enables the user to add and remove relations between
events assigned to them in the Event Browser.

Change Severity Enables the user to change severity of events assigned to
them

Change Priority Enables the user to change priority of events assigned to
them

Change Title Enables the user to change title of events assigned to
them

Change
Description

Enables the user to change description of events
assigned to them

Change Solution Enables the user to change solution of events assigned to
them

Add/Delete/Update
Annotations

Enables the user to create, modify and delete annotations
for events assigned to them.

Add/Delete/Update
Custom Attributes

Enables the user to create, modify and delete custom
attributes for events assigned to them.
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Resources Operation Description

Events not
assigned to
user

View Enables the user to view events not assigned to them

Work On / Resolve Enables the user to set the life cycle status for events not
assigned to them toWork On or Resolve

Close Enables the user to set the life cycle status for events not
assigned to them to Closed

Reopen Enables the user to set the life cycle status for Closed
events not assigned to them to Open. The events can now
be reassigned for further investigation and resolution.

Note: Reopening symptom events with a closed cause is
not possible.

Assign To Enables the user to assign events not assigned to them to
a specific user or group

LaunchOperator
Action

Enables the user to run HP Operations Manager operator
actions for events not assigned to them containing event-
related actions

Launch Automatic
Action

Enables the user to run HP Operations Manager
automatic actions for events not assigned to them
containing event-related actions

Transfer Control Enables the user to transfer control of events not assigned
to them in the Event Browser to an external manager.
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Resources Operation Description

Events not
assigned to
user

Close Transferred Enables the user to close events not assigned to them in
the Event Browser for which control has been transferred
to an external manager.

Add/Remove
Event Relations

Enables the user to add and remove relations between
events not assigned to them in the Event Browser.

Change Severity Enables the user to change severity of events not
assigned to them

Change Priority Enables the user to change priority of events not assigned
to them

Change Title Enables the user to change title of events not assigned to
them

Change
Description

Enables the user to change description of events not
assigned to them

Change Solution Enables the user to change solution of events not
assigned to them

Add/Delete/Update
Annotations

Enables the user to create, modify and delete annotations
for events not assigned to them.

Add/Delete/Update
Custom Attributes

Enables the user to create, modify and delete custom
attributes for events not assigned to them.

Health
Indicators

Reset Enables the user to clear the current status of a health
indicator and reset the health indicator to the status
specified in the default health indicator value

Administrative
UIs

View Grants access to the Administration features in the
Operations Management Administration, for example:

l Correlation Rules manager

l Content Packs manager

l PerformanceGraphs manager

l View Mappings manager

l Event Processing Customization

l Custom Actions

Users who do not have read access to Operations
Management Administration are not able to see the
Operations Management Administration features or see
an error message when they try to start an Administration
manager
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Resources Operation Description

Tool
Categories

Execute Grants access to tool categories. Any tools belonging to a
tools category to which a user has access can be
executed by the user

Custom
Actions

Execute Grants access to custom actions. Any custom actions to
which a user has access can be executed by the user

Operations Orchestration Integration
TheOperations Orchestration Administration context enables you to define the operations
permitted for the Operations Orchestration Administration application.

Resources Operation Description

Administration Add Enables adding a run book.

View Enables viewing run book administration.

Change Enables editing run book administration.

Delete Enables deleting a run book.

Full
Control

Enables performing all available operations on run book
administration, and granting or removing permissions for other
users.

Execution Execute Enables run book execution.

Full
Control

Enables performing all available operations on run book execution,
and granting or removing permissions for other users.

Platform
ThePlatform context includes all the resources related to administering the platform.

Resources Operation Description

Authentication
Strategy

Change Enables the Configure button on the Authentication Strategy page,
which enables changing configurations on the Authentication
Strategy Wizard.

View Enables viewing the Authentication Strategy Wizard.

Full
Control

Enables performing all available operations on the Authentication
Strategy Wizard.

Audit Log View Enables viewing the audit log.

Full
Control

Enables viewing the audit log, and granting and removing
permission to view the audit log.
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Resources Operation Description

Users Add Enables adding users to the system.

Change Enables modifying user details.

View Enables viewing user details.

Delete Enables deleting users from the system.

Full
Control

Enables performing all available operations on users, and granting
and removing permissions for those operations.

User Groups Add Enables adding user groups to the system.

Change Enables modifying user group details.

View Enables viewing user group details.

Delete Enables deleting user groups.

Full
Control

Enables performing all available operations on user groups, and
granting and removing permissions for those operations.

Data
Collectors

Change Enables performing remote upgrades, remote uninstalls, and
settings updates on data collectors in Data Collector Maintenance.

View Enables viewing the data collectors in Data Collector Maintenance.

Delete Enables removing data collector instances.

Full
Control

Enables performing all available operations in Data Collector
Maintenance, and granting and removing permissions for those
operations.

Notification
System

View Enables viewing system tickets details.

Execute Enables executing system tickets in the system.

Full
Control

Enables performing all available operations on System Tickets,
and granting and removing permissions for those operations.

Scheduled
Reports

Add Enables creating new scheduled reports.

Change Enables modifying scheduled reports.

View Enables viewing scheduled reports.

Delete Enables deleting scheduled reports.

Full
Control

Enables performing all available operations on scheduled reports,
and granting and removing permissions for those operations.
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Resources Operation Description

Recipients Add Enables adding recipients to the platform.

Change Enables editing recipient details.

View Enables viewing recipients and recipient details.

Delete Enables deleting recipients from the platform.

Full
Control

Enables performing all available operations on recipients, and
granting and removing permissions for those operations.

Custom Data
Types

Add Enables adding custom data types to the system.

Change Enables modifying custom data types in the system.

View Enables viewing custom data types in the system.

Delete Enables deleting custom data types in the system.

Full
Control

Enables performing all available operations on sample types, and
granting and removing permissions for those operations.

Send SNMP
trap

Change Enables selecting the option to send SNMP traps on alert, editing
SNMP trap addresses, and clearing the option to send SNMP traps
on alert.

Full
Control

Enables performing all available operations on sending SNMP
traps on alerts, and granting and removing permissions for those
operations.

Run
executable file

Change Enables selecting the option to run an executable file on alert,
selecting and edition executable files to run on alert, and clearing
the option to run an executable file on alert

Full
Control

Enables performing all available operations on running an
executable file on alert, and granting and removing permissions for
those operations.

Log To Event
Viewer

Change Enables selecting whether alerts should be logged in theWindows
Event Viewer which is accessed fromWindow Administrative
Tools.

Full
Control

Enables selecting whether alerts should be logged in theWindows
Event Viewer, and granting and removing permissions on that
operation.

Downtime View Enables viewing downtime properties

Full
Control

Enables performing all available operations on downtimes, and
granting and removing permissions for those operations.
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Resources Operation Description

Databases Add Enables adding profile databases to the system.

Change Enables modifying profile database details in database
management.

View Enables viewing profile databasemanagement details.

Delete Enables deleting profile databases from the system.

Full
Control

Enables performing all available operations on profile databases in
databasemanagement, working with the purgingmanager, and
granting and removing permissions for those operations.

System
Recipient
Template

Add Enables creating and cloning system recipient templates.

Change Enables editing system recipient templates properties.

View Enables viewing system recipient templates properties.

Delete Enables deleting a system recipient templates.

Full
Control

Enables performing all available operations on system recipient
templates, and granting and removing permissions for those
operations.

Customer
Recipient
Template

Add Enables adding a customer-specific recipient template.

Change Enables editing a customer-specific recipient template.

View Enables viewing the properties of a customer-specific recipient
template.

Delete Enables deleting a customer-specific recipient template.

Full
Control

Enables performing all available operations on a customer-specific
recipient template, and granting and removing permissions for
those operations.

Package
Work
Manipulation
(HP Software-
as-a-Service
only)

Change Enables modifying package locations, renaming packages, and
selecting recipients for package notifications.

View Enables viewing package information.

Delete Enables removing packages from a location.

Full
Control

Enables performing all available operations on package
information, and granting and removing permissions for those
operations.
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Service Health

Resources Operation Description

User Pages Add Enables adding user pages

Change Enables editing user pages

View Enables viewing user pages

Delete Enables removing user pages

Full
Control

Enables performing all available operations on user pages

Predefined
Pages

View Enables viewing predefined pages

User
Components

Add Enables adding and cloning component definitions

Change Enables editing component definitions

View Enables viewing component definitions

Delete Enables removing component definitions

Full
Control

Enables performing all available operations on component
definitions

Service Level Management
Use theService Level Management context to assign permissions to all SLAs or specific
instances.

Resources Operation Description

SLAs Add Enables adding SLAs.

Change Enables renaming SLAs, adding descriptions to SLAs, viewing SLA
configuration in administration pages, and changing SLA
configurations.

View Enables generating and viewing reports and custom reports on SLAs.

Delete Enables deleting SLAs.

Full
Control

Enables performing all available operations on SLAs, and granting and
removing permissions for those operations.

System Availability Management
Use theSystem Availability Management context to assign permissions to the various
SiteScopes configured within the system.

Note: The permission levels granted in the System Availability Management context override
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any permission levels granted in the SiteScope standalone interface.

Resources Operation Description

SiteScopes Add Enables adding SiteScope profiles to System Availability
Management.

Change Enables modifying a SiteScope profile in System Availability
Management and enables adding the contents to the SiteScope root
node (group, alert, report) andmodifying contents to the SiteScope
root node (alert, report), if the user has permissions for these
resources.

View Enables viewing SiteScope profiles in System Availability
Management.

Delete Enables deleting a SiteScope profile from System Availability
Management and enables deleting the contents of the SiteScope root
node (alert, report), if the user has permissions for these resources.

Execute Enables executing contents of the SiteScope root node (alert, report),
if the user has permissions for these resources.

Full
Control

Enables performing all available operations on SiteScope profile and
SiteScope root node.

Transaction Management

Resources Operation Description

TransactionVision
Processing
Servers

Change Enables modifying TransactionVision processing servers

Full
Control

Enables performing all available operations on
TransactionVision processing servers, and granting and
removing permissions for those operations

TransactionVision
Analyzers

Change Enables modifying TransactionVision analyzers

Execute Enables starting and stopping TransactionVision analyzers

Full
Control

Enables performing all available operations on
TransactionVision analyzers, and granting and removing
permissions for those operations

TransactionVision
JobManagers

Change Enables modifying TransactionVision jobmanagers

Execute Enables starting and stopping TransactionVision jobmanagers

Full
Control

Enables performing all available operations on
TransactionVision jobmanagers, and granting and removing
permissions for those operations
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Resources Operation Description

TransactionVision
Query Engines

Change Enables modifying TransactionVision query engines

Execute Enables starting and stopping TransactionVision query engines

Full
Control

Enables performing all available operations on
TransactionVision query engines, and granting and removing
permissions for those operations

Administration Change Enables administration changes. Does not include
TransactionVision specific changes

Full
Control

Enables performing all available operations on administration,
and granting and removing permissions for those operations

User Data View Enables viewing user data in reports and in event details

Full
Control

Enables performing all available operations on user data, and
granting and removing permissions for those operations

Applications Add Enables adding applications

Change Enables modifying applications

View Enables viewing applications

Full
Control

Enables performing all available operations on applications, and
granting and removing permissions for those operations

User Defined Reports
Use theUser Defined Reports context to assign permissions to the various types of user-defined
reports and related settings.

Resources Operation Description

Custom
Reports

Add Enables adding custom reports.

Change Enables creating, editing, and deleting custom reports.

View Enables viewing custom reports.

Full
Control

Enables performing all available operations on custom reports, and
granting and removing permissions for those operations.

Trend Reports Add Enables creating trend reports.

Change Enables creating, editing, and deleting trend reports.

View Enables viewing trend reports.

Full
Control

Enables performing all available operations on trend reports, and
granting and removing permissions for those operations.
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Resources Operation Description

Custom Links Change Enables creating and deleting custom links.

View Enables viewing custom links.

Full
Control

Enables performing all available operations on custom links, and
granting and removing permissions for those operations.

Excel Reports Change Enables adding, deleting, and updating Excel open API reports.

View Enables viewing Excel open API reports.

Full
Control

Enables performing all available operations on Excel open API
reports, and granting and removing permissions for those
operations.

Default
Header/Footer

Change Enables modifying the default header and footer for custom and
trend reports.

Full
Control

Enables modifying, and granting and removing permissions to
modify, the default header and footer for custom and trend reports.

Favorite Filter Change Enables editing favorite filter.

Delete Enables deleting favorite filter

Full
Control

Enables performing all available operations on favorite filter, and
granting and removing permissions for those operations.

Annotation Change Enables editing an annotation.

Delete Enables deleting an annotation.

Full
Control

Enables performing all available operations on annotations, and
granting and removing permissions for those operations.

Service
Report

Change Enables editing a service report.

Delete Enables deleting a service report.

Full
Control

Enables performing all available operations on service reports, and
granting and removing permissions for those operations.
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User Management User Interface

Create Group Dialog Box
This dialog box enables you to create groups.

To
access

Select Admin > Platform > Users and Permissions > User Management, click

theCreate button, and select Create Group.

See also "Group and User Hierarchy" on page 228

User interface elements are described below:

UI Element (A-Z) Description

Group description Description of the group.

Note: This field is optional.

Syntax Exceptions:

l Cannot exceed 99 characters

Group name The name of the group.

Syntax Exceptions:

l Cannot exceed 40 characters

l The following characters are not supported: " \ / [ ] : | < > + = ; , ? * % &

l The namemust be unique

Create User Dialog Box
This dialog box enables you to create a user and a recipient linked to the user.

To access Select Admin > Platform > Users and Permissions > User Management,

click theCreate a user/group in the selected group button, and select
Create User.

Important
information

The Create User dialog box includes the following tabs:

l User Account. For details, see "General Tab (User Management)" on page
304.

l Recipient. For details, see "Recipient Tab (User Management)" on page 306.

Relevant
tasks

l "How to Configure Users and Permissions —Workflow" on page 231

l "How to Customize User Menus" on page 245

See also "User Management" on page 221
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Customization Tab (User Management)
This tab enables you to select the page users see when entering BSM, and choose themenu items
available on pages throughout BSM.

To access Select Admin > Platform > Users and Permissions > User Management,
select a node from theGroups/Users pane, and click theCustomization tab.

Important
information

Properties are inherited based on the hierarchy of the nodes. If a context is
deselected (hidden) for a group node, it cannot be selected for any child nodes.

Relevant
tasks

l "How to Configure Users and Permissions —Workflow" on page 231

l "How to Customize User Menus" on page 245

See also "Customizing User Menus" on page 230

User interface elements are described below:

UI Element
(A-Z) Description

Contexts Select a BSM context. You can perform the following actions on the context:

l Select contexts and applications in the Contexts pane to be visible for the
specified user or group. To hide a context or application, clear the check box.
By default, all contexts are visible.

l Select pages and tabs in the Pages and Tabs pane to be visible for the
specified user or group. By default, all pages and tabs are visible.

l Click theSet as Default Entry Context button tomake it the context that is
displayed when the user logs into BSM.

For details on BSM contexts, see "Resource Tree Pane" on page 308.

Pages and
Tabs

l Select the pages and tabs you want to be visible for the BSM context selected
in the Contexts pane.

l Assign a page or tab as the default page that opens for the context selected in
the Contexts pane.

Note: For the Service Health andOperations Management applications, you
cannot define user access to specific pages; you can only enable or disable user
access at the application level.

Set as
Default
Entry
Context

Sets the selected context in the Contexts pane as the entry context that is
displayed when a user logs into BSM.

Note: TheDefault Entry Context icon appears next to the specified context.
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UI Element
(A-Z) Description

Set as
Default
Entry Page

Assigns the specified page or tab as the default page that opens for the context
selected in the Contexts pane.

Note: TheDefault Entry Page icon appears next to the specified page or
tab.

General Tab (User Management)
This tab displays the parameters of the selected user or group.

To access Select Admin > Platform > Users and Permissions > User Management >
General tab

Important
information

l You can edit the user or group's parameters by editing the relevant fields on the
General tab.

l TheGroup Name andGroup Description fields appear only when a group is
selected in theGroups/Users pane. All other fields appear only when a user is
selected in theGroups/Users pane.

Relevant
tasks

"How to Configure Users and Permissions —Workflow" on page 231

See also l "User Management" on page 221

l "Create Group Dialog Box" on page 302

l "Create User Dialog Box" on page 302

l "Groups/Users Pane" on page 313

User interface elements are described below when you select a user in the left pane:

UI
Element
(A-Z) Description

Confirm
password

Re-enter the edited password that you entered in thePassword field.

Email The email address of the user.
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UI
Element
(A-Z) Description

Login
name

The name that the user uses to log into BSM.

Syntax Exceptions:

l Cannot exceed 99 characters

l The following characters are not supported: " \ / [ ] : | < > + = ; , ? * % & <space>

l The namemust be unique

Notes:

l The Login name appears as a tooltip when hovering over the user name in the
Browse tab of theGroups/Users pane.

l The Login name cannot be changed.

Password The password of the user used to log into BSM.

Syntax Exceptions:

l Cannot exceed 20 characters

Notes:

l As a security precaution, this field appears blank on theGeneral tab. To change
the password, enter the new password and re-enter it in the Confirm Password
field.

l Only the user assigned as security officer can change his or her own password

Time
zone

The time zone of the user's location as specified in the Create User dialog box.

Note:When youmodify the time zone, the linked recipient offset from GMT is also
updated after you confirm the change.

User
mode

The user mode, as configured in the Create User dialog box. Available options are:

l Unspecified. Leaves the user without a particular mode. Select this option if:

n BSM is working with user modes and you want this user to see KPIs for both
modes in Service Health views.

n Your system is not working with user modes.

l Operations User. Enables the user to view the operations version of KPIs.

l Business User. Enables the user to view the business version of KPIs.

User
name

The name of the user, as configured in the Create User dialog box.

Syntax Exceptions:

l Cannot exceed 50 characters

l The following characters are not supported: " \ / [ ] : | < > + = ; , ? * % &

User interface elements are described below when you select a group in the left pane:
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UI Element (A-Z) Description

Group
description

The description of the group, as configured on the Create Group dialog box.

Note: This field is optional.

Group name The name of the group, as configured on the Create Group dialog box.

Recipient Tab (User Management)
This tab enables you to define recipients, their email, pager, and SMS information, and the template
to use to send alert notices, or scheduled reports to those recipients.

For concept details, see "Recipient Management" on page 318.

For user interface details, see "New or Edit Recipient Dialog Box" on page 324.

Hierarchy Tab (User Management)
This tab enables you to assign users to a group, unassign users from a group, or nest one group
within another.

To access Select Admin > Platform > Users and Permissions > User Management,
select a group or user from theGroups/Users pane, and click theHierarchy tab.

The Hierarchy tab displays:

l Parent Groups. The groups that the selected group is nested under.

l Child Groups and Users. The groups and users that are nested directly
beneath the selected group.

Important
information

l To nest a user, youmust select the group into which you want to nest it and
click theEdit Child Groups and Users button.

l When removing a nested group from its parent, the group itself is not deleted.

l When deleting a parent group, the child groups and users are not deleted.

l If BSM groups have been synchronized with groups on an external LDAP
server, BSM users cannot bemoved between groups, and only groups appear
on the interface. For details on synchronizing groups, see "Synchronizing
Users" on page 371.

Relevant
tasks

l "How to Configure Users and Permissions —Workflow" on page 231

l "How to Configure Group and User Hierarchy" on page 240

See also "Group and User Hierarchy" on page 228

User interface elements are described below:
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UI Element
(A-Z) Description

Denotes a group that the selected group or user is nested under.

Denotes a user that is nested beneath the selected group.

Child
Groups
and Users

Displays the groups and users that are nested directly beneath the group selected
in theGroups/Users pane.

Edit Child
Groups
and Users

Opens the Edit Child Groups and Users window enabling you to nest or remove
groups and users from the selected group. For details, see "Hierarchy Tab (User
Management)" on previous page.

Note: This button is displayed only when selecting a group in theGroups/Users
pane.

Parent
Groups

Displays the groups that the group or user selected in theGroups/Users pane is
directly nested under.

Edit Child Groups and Users Dialog Box
User interface elements are described below:

UI Element
(A-Z) Description

Moves the group or user to theChild Groups and Users pane and nests the
group or user under the specified group.

Moves the group or user to theGroups/Users pane and removes the group or
user from being nested beneath the specified group.

Child Groups
and Users

Select a group or user you want to remove from the specified group.

Groups/Users Select a group or user you want to nest under the specified group.

Permissions Tab (User Management)
This tab enables you to apply permissions to groups and users for specific resources and instances
of those resources that are defined in the system.
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To access Select Admin > Platform > Users and Permissions > User Management >
Permissions tab.

ThePermissions tab is divided into the following areas:

l Groups/Users pane on the left side of the page. For details, see
"Groups/Users Pane" on page 313.

l Resource tree pane in the center of the page. For details, see "Resource Tree
Pane" below.

l Roles tab on the right side of the page. For details, see "Roles Tab" on page
310.

l Operations tab on the right side of the page. For details, see "Operations Tab"
on page 311.

Important
information

l You can grant permissions to only one user or group at a time.

l AssigningAdd permissions on theOperations tab does not automatically
grant View permissions on the given resource.

l If you havemany users for whom you have to grant permissions, it is
recommended that you organize your users into logical groups using the
Hierarchy tab. For details, see "Hierarchy Tab (User Management)" on page
306.

Relevant
tasks

l "How to Configure Users and Permissions —Workflow" on page 231

l "How to Assign Permissions" on page 239

See also "Permissions" on page 223

Resource Tree Pane

This tab displays the instances and resources available within each BSM context for which you set
permissions.

To access Select Admin > Platform > Users and Permissions > User Management >
Permissions tab.

The types of resources displayed in the Resource Tree pane are:

l Resource with instances

l Instances of a resource

Note:When a user defines or creates an instance of a resource, for example
creates a Business Process profile, that user has Full Control permission on
that resource instance and all of its child resources.

l Resource without instances
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Important
information

l TheBusiness Service Management resource refers to all contexts in BSM
and can have only roles applied to it.

l The resources are divided according to the context in which they function
within the platform and not necessarily where they are found in the user
interface.

l You can select multiple resources only when selecting instances. For
information on instances, see "Understanding Permissions Resources" on
page 224.

Relevant
tasks

"How to Assign Permissions" on page 239

See also l "Understanding Permissions Resources" on page 224

l "Resource Tree Pane" on previous page

User interface elements are described below:

UI
Element
(A-Z) Description

An instance of a resource.

A resource without instances.

A resource that has instances (a resource collection).

Select
Context

Select a BSM context for which to configure permissions. For details on BSM
contexts, see "Resource Tree Pane" on previous page.

Settings Applies specific permissions settings for configurations in your User Management
session. Select from the following options:

l Apply permissions automatically when selecting another resource.
Selecting this option removes the necessity for clicking theApply Permissions
button after each operation. If this option is not selected, youmust click Apply
Permissions before going on to the next operation.

l Do not display warning message when revoking VIEW from resource.
When the view operation is removed from a resource for a user, that user has no
access to the resource or to any of its child resources or instances. Therefore, by
default, a warningmessage appears when removing view permissions. Selecting
this option will disable that warningmessage.

Note:When you select the settings for applying permissions, the options selected
apply only to the current BSM session.

Resource Contexts
The following contexts are included:
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UI Element (A-Z) Description

Business Process
Insight

Includes the resources enabling permissions for operating and
administering the Business Process Insight application.

Diagnostics Includes all the resources relating to Diagnostics.

End User
Management

Includes all the resources relating to operating and administering the End
User Management application.

MyBSM Includes resources needed to administer user pages, predefined pages,
and user components.

MyBSM (Legacy) Includes resources needed to administer modules and portlet definitions.

Operations
Management

Includes all the resources relating to the Operations Management
application.

Operations
Orchestration
Integration

Includes the resources enabling permissions for operating and
administering the Operations Orchestration Administration application.

Platform Includes all the resources for administering the platform.

RTSM Includes all the resources for the Run-time ServiceModel (RTSM).

Service Health
Analyzer

Includes all the resources relating to the Service Health Analyzer
application.

Service Level
Management

Includes the SLA resource.

SiteScope On
Demand Monitors

System Availability
Management

Includes the various SiteScope groups.

Transaction
Management

Includes the resources relating to working with the TransactionVision
application.

User Defined
Reports

Includes the custom report, trend report, custom link, and Excel report
resources.

Roles Tab

Displays the roles configurable for groups and users in BSM.

To access Select Admin > Platform > Users and Permissions > User Management >
Permissions tab
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Relevant
tasks

"How to Assign Permissions" on page 239

See also l "Understanding Permissions Resources" on page 224

l "User Management Roles Applied Across BSM" on page 252

User interface elements are described below:

UI Element
(A-Z) Description

Apply
Permissions

Applies the permissions configured for the roles

Grant Select the check box to assign the specified roles to the group or user.

Roles The roles that can be assigned to a group or user for the selected resource or
instances. For a description of the available roles, see "User Management Roles
Applied Across BSM" on page 252.

Operations Tab

Displays the predefined operations configurable for groups and users in BSM.

To access Select Admin > Platform > Users and Permissions > User Management >
Permissions tab

Relevant
tasks

"How to Assign Permissions" on page 239

See also l "Understanding Permissions Resources" on page 224

l "User Management Operations" on page 286

User interface elements are described below:

UI Element (A-Z) Description

Apply Permissions Applies the permissions configured for the resource.

Grant Select the check box to assign the specified operation to the group or
user.
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UI Element (A-Z) Description

Granted from
Group/Roles/Parent

Displays those permissions that have been granted from either a group, a
role, or a parent resource.

Note:

l You cannot remove any of these permissions individually, but you can
grant additional permissions.

l If you want to remove permissions that are granted from a group, role
or parent resource, youmust make the change at the group, role or
parent resource level.

Inherit Select the check box in the Inherit column for the operation to be
inherited to all the child resources within the selected resource.

Note:

l The Inherit check box is enabled only for selected resources.

l By default, the Inherit check box is selected when you assign an
operation to specific resource instances. You can remove the Inherit
option to prevent the operation from being inherited to all the child
resources within the selected resource.

Operation The operations that can be assigned to a group or user for the selected
resource or instances. For details on the available operations, see "User
Management Operations" on page 286.

User Management Main Page
This page displays information on the groups and users configured to access BSM, including their
respective permission levels.

To access Select Admin > Platform > Users and Permissions > User Management
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Important
information

When you first access the User Management page or the cursor is located on the
All node, the page includes:

l the Groups/Users pane. For details, see "Groups/Users Pane" below.

l the workflow pane. TheWorkflow page displays introductory information
about the User Management application, and a suggested workflow for
configuring groups and users.

When you select a user, the page includes the following tabs:

l General. For details, see "General Tab (User Management)" on page 304.

l Recipient. For details, see "Recipient Tab (User Management)" on page 306.

l Permissions. For details, see "Permissions Tab (User Management)" on page
307.

l Hierarchy. For details, see "Hierarchy Tab (User Management)" on page 306.

l Customization. For details, see "Customization Tab (User Management)" on
page 303.

When you select a group, the page includes the following tabs:

l General. For details, see "General Tab (User Management)" on page 304.

l Permissions. For details, see "Permissions Tab (User Management)" on page
307.

l Hierarchy. For details, see "Hierarchy Tab (User Management)" on page 306.

Relevant
tasks

"How to Configure Users and Permissions —Workflow" on page 231

See also l "User Management" on page 221

l "Groups/Users Pane" below

Groups/Users Pane

This pane displays the list of users and groups of users configured to access BSM.
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To access Select Admin > Platform > User Management. TheGroups/Users pane
appears on the left side of the page, and is visible on all tabs of the User
Management application.

TheGroups/Users panecontains the following tabs:

l Browse. Displays a list of configured users and groups, and enables you to
create or delete users and groups.

l Search. Displays a table view of users and groups, and enables you to search
for a user or group by any of the following criteria:

n Group name

n Login name

n User name

n User last login

You can sort the columns by clicking on the column headers above the boxes.

You can include wildcards (*) in your search.

Important
information

l When selectingmore than one user or group andmodifying parameters, the
changes take effect only for the first selected user. The exception is the Delete
option, which deletes multiple users at once.

l When creating a group, the access permissions are automatically inherited by
the group's users.

l When creating users with the cursor on a group, the users are automatically
nested within that group.

Relevant
tasks

"How to Configure Users and Permissions —Workflow" on page 231

See also "User Management Main Page" on page 312

User interface elements are described below:

UI
Element Description

Creates a user or group.

Depending on whether you choose to create a user or group, theCreate User or
Create Groupwindow opens.

When you create a new group or user, theGroups/Users pane refreshes and the
newly created group or user is selected.

Note: In Firefox, after refresh, theAll node is selected.

For details, see "Create User Dialog Box" on page 302 or "Create Group Dialog Box"
on page 302.
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UI
Element Description

Clones the settings of an existing user or group to a new user or group

Deletes the selected user or group.

Note:When you delete a user, the linked recipient is also deleted.

Collapses or expands the groups selected in the hierarchy tree.

Note:Only previously loaded nodes are expanded.

Click and select Group Mappings to map local groups to groups configured on the
LDAP server, orDelete Obsolete Users to delete BSM users no longer configured on
the LDAP server. After selectingDelete Obsolete Users, you can removemulitple
users at once by holding the Ctrl button while selecting users.

For details, see "GroupMappings Dialog Box" below.

Note: This button is displayed only if theMapping option has been enabled in the
Authentication Strategy Wizard. For details, see "AuthenticationWizard" on page
345.

Click to assign or view the Security Officer. The security officer is a user who can
configure certain sensitive reporting information in the system, such as which RUM
transaction parameters to include or exclude from certain reports (Session Details,
Session Analyzer, etc).

There can be only one security officer assigned in the system. Only a user with
superuser permissions can assign the security officer for the first time. Only the
security officer himself can assign it to another user or change his own password once
it has been assigned. For details on this topic, see "Security Officer" on page 226.

A configured user

A configured group

Security officer

Root node

Group Mappings Dialog Box

This dialog box enables you tomap groups configured in BSM to groups configured on the LDAP
server.
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To access Select Admin > Platform > Users and Permissions > User Management. In

the Groups/Users pane, click the LDAP Configuration button and select
Group Mappings.

TheGroupMappings dialog box consists of the following panes:

l Corporate Directory Pane. For details, see "GroupMappings Dialog Box" on
previous page.

l BSMLocal Repository For Remote Group Pane: <group name>. For
details, see "GroupMappings Dialog Box" on previous page.

l Local Groups to Remote Group Mappings. Displays a table of the LDAP
groups and the BSM groups that they are assigned to. The LDAP groups are
displayed in theRemote Group Name column, and the BSMGroups are
listed in the Local Group Name column.

Important
information

Note: This dialog box is accessible only if LDAP mode has been enabled in the
AuthenticationWizard. For details, see "AuthenticationWizard" on page 345.

If you are switching from one LDAP server to another, ensure that you remove all
existing groupmappings from the original LDAP server beforemapping to the new
one.

Corporate Directory Pane
This pane enables you to assign BSM groups to LDAP groups, and to list the users in the LDAP
groups.

Description Select Admin > Platform > Users and Permissions; in the Groups/Users

pane, click the LDAP Configuration button and select Group Mappings.

Important
information

l To synchronize LDAP groups with BSM groups, click Assign Groups to open
the Select Local Groups for Remote Group dialog box.

l To view the list of users associated with the respective LDAP groups, click
List Users.

You can also select either of these options by right clicking on the group.

l Once the LDAP groups have beenmapped to the BSM groups, the BSM
groups aremanaged only from the LDAP interface. This means that the
following are fields are affected on the Users and Permissions interface:

n TheCreate User field is disabled.

n TheUser Name field is disabled.

n ThePassword field is invisible.

n TheHierarchy tab is enabled only for groups and not for users.

BSM Local Repository for Remote Group: <group name> Pane
This pane displays the BSMmapped to the LDAP group selected in the Corporate Directory Pane,
and enables you to remove themapped BSM groups.
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To access Select Admin > Platform > Users and Permissions; in the Groups/Users

pane, click the LDAP Configuration button and select Group
Mappings.

Important
information

l To remove groups, select the group you want to remove and click Remove
Groups.

l You can removemulitple groups at once by holding the Ctrl button while
selecting groups.

HP Business ServiceManagement (9.20)Page 317 of 427



Chapter 19

Recipient Management
You can assign recipients to users. A recipient definition includes information about how to
communicate with the recipient. Recipients can receive triggered alerts or scheduled reports:

l Alerts. For each recipient, you define one or more notificationmethods (email, pager, or SMS)
and the template to use for alert notices. You can configure alerts so specific recipients receive
information about the alerts when they are triggered. For details about alerts, see "Setting Up an
Alert Delivery System" on page 391.

l Scheduled reports. You can also configure, in the Report Manager, the scheduled intervals
when recipients can receive reports or report items. Only those recipients who have been
configured to receive email can be selected to receive scheduled reports. These recipients are
listed in Available Recipients when configuring scheduled reports. For details about scheduled
reports, see "Report ScheduleManager" on page 388.

For details on where to configure andmanage recipients, see "Recipients Page" on page 322.
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How to Configure and Manage Recipients
This task describes a suggested working order for managing recipients.

You create recipients by defining one or more notificationmethods, the template to use for alert
notices, and a notification schedule to receive reports. You create recipients andmanage existing
recipients in the Recipients page. For user interface details, see "Recipients Page" on page 322.

You can also create recipients while you are configuring users. Those recipients are automatically
added to the list of recipients in the Recipients page inAdmin > Platform > Recipients >
Recipient Management.

The recipients you create in the Recipients page are automatically listed as available recipients
when you configure users inAdmin > Platform > Users and Permissions > User
Management.
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How to Add a Custom Pager or SMS Service
Provider

If you are configuring alerts to be sent by pager or SMS, and your pager or SMS service provider
does not appear on the default provider list, and the provider uses an email gateway, you can
manually add your provider to BSM. After doing so, your provider appears on the list.

To add a provider that uses an email gateway, manually add the gateway information to the
management database. If necessary, ask your database administrator for assistance.

To add a provider that uses an email gateway:

1. Open theNOTIFICATION_PROVIDERS table in themanagement database.

2. In theNP_NOTIFICATION_PROVIDER_NAME column, add the name of the provider to the
bottom of the list.

Add the name exactly as you want it to appear in the provider list that opens in the SMS tab of
the Recipient Properties wizard. For details, see "SMS Tab" on page 329.

Note the ID number that is automatically assigned to the provider.

3. Close theNOTIFICATION_PROVIDERS table, and open theNOTIFPROVIDER_
NOTIFTYPE table.

4. In theNN_NOTIF_PROVIDER_ID column, add the ID number that was assigned to the new
provider.

5. In theNN_NOTIF_TYPE_ID column, assign the provider one of the following notification
types:

n 102 – for pager service provider

n 101 – for SMS service provider

6. Close theNOTIFPROVIDER_NOTIFTYPE table, and open theNOTIFICATION_
PROVIDER_PROP table.

7. In theNPP_NOTIFICATION_PROVIDER_ID column, add the ID number that was assigned
to the new provider.

Note that you add the ID number to two consecutive rows.

8. In theNPP_NPROVIDER_PROP_NAME andNPP_NPROVIDER_PROP_VALUE
columns, add the following new property names and values for the provider, one beneath the
other (for examples, see existing entries):

Property
Name

Property
Value Description

EMAIL_
SUFFIX

<email_
suffix>

The gateway's email suffix. For example, if the gateway email address
is 12345@xyz.com, enter xyz.com as the property value for EMAIL_
SUFFIX.
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Property
Name

Property
Value Description

EMAIL_
MAX_
LEN

<max_
length>

Themaximummessage length, in characters, of the body of the email
message. For example, 500.

When determining this value, take into consideration themaximum
length limit imposed by your service provider, as well as limitations to
your pager or mobile phone.

9. In theNPP_NPROVIDER_PROP_DATATYPE_ID column, specify an ID value as follows:

n for EMAIL_SUFFIX, specify: 1

n for EMAIL_MAX_LEN, specify: 2

10. Restart BSM.
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Recipient Management User Interface
This section includes:

l "Attach Recipient to a User Dialog Box" below

l "Recipients Page" below

l "New or Edit Recipient Dialog Box" on page 324

Attach Recipient to a User Dialog Box
This dialog box enables you to select the user you want to attach to the selected recipient.

To
access

Select Admin > Platform > Recipients > Recipient Management tab. Select a
recipient in the table and click the Attach user to selected recipient button in the
Recipient page.

See
also

"Group and User Hierarchy" on page 228

User interface elements are described below:

UI Element Description

User Login The name used to log into BSM.

User Name The name of the user, as configured in the User Management page.

Select To assign a user to the selected recipient, select the user and click Select.

Recipients Page
Enables you to create or edit recipient information including the corresponding user and the email,
SMS, and pager information. You can also, if you have the appropriate permissions, detach the
current recipient from the user, attach existing recipients to the user, or delete the attached
recipient.

To access Select Admin > Platform > Recipients > Recipient Management
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Important
information

l How you access the Recipients page and what you see in the page depends
on your user's permissions. For details, see "Permissions Tab (User
Management)" on page 307.

l To filter the information displayed in the table, enter the string in the box at the
top of the relevant column and press ENTER. Only the appropriate table lines
are displayed. To reset the filter, erase the string you used to filter the
information and press ENTER.

l There is a one-to-one relationship between the user and the recipient: a
recipient can be assigned to one user or to no user, and a user can have a link
to one recipient or to no recipient.

Relevant
tasks

"How to Configure andManage Recipients" on page 319

See also "Recipient Management" on page 318

User interface elements are described below:

UI
Element
(A-Z) Description

Add new recipient. Opens the New Recipient dialog box. For details, see "New or
Edit Recipient Dialog Box" on next page.

Edit selected recipient. Opens the Edit Recipient dialog box. For details, see
"New or Edit Recipient Dialog Box" on next page.

Delete the recipient attached to the selected user. Detaches the recipient and
deletes the current recipient.

Attach user to selected recipient. Select a recipient in the list of and click this
button to open the Attach Recipient to a User dialog box where you can select the
appropriate user. For details, see "Attach Recipient to a User Dialog Box" on
previous page.

Detach user from selected recipient. Detaches the current recipient from the
corresponding user (listed in the page). A confirmationmessage is issued.

Update selected recipients email address from LDAP. This icon appears only if
LDAP is connected to the BSM application. Click to synchronizes the user data,
meaning that the email information stored in the User Repository for the specific
user updates the email recipient information corresponding to the user linked to the
recipient.

Email The email address of the recipient as defined in the General tab.
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UI
Element
(A-Z) Description

Linked
User

The name of the user linked to the recipient.

Important:Cannot exceed 49 characters.

Syntax Exceptions: The following characters are not supported: ` ~ ! @ # $ % ^ & *
- + = [ ] { } \ | / ? . , " ' : ; < >

Pager The pager numbers of the recipient.

Syntax Exceptions:

l The following characters are not supported: @ & " ' ...

l The following special characters are allowed: ( ) - _ + = [ ] { } | : ; < > . ,

Recipient
Name

The name of the recipient.

Important:Cannot exceed 49 characters.

Syntax Exceptions: The following characters are not supported: ` ~ ! @ # $ % ^ & *
- + = [ ] { } \ | / ? . , " ' : ; < >

SMS The SMS numbers of the recipient.

Syntax Exceptions:

l The following characters are not supported: @ & " ' ...

l The following special characters are allowed: ( ) - _ + = [ ] { } | : ; < > . ,

New or Edit Recipient Dialog Box
This tab enables you to define recipients their email, pager and SMS, and the template to use to
send alert notices to those recipients.
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To access You can also access this page from:

l Select Admin > Platform > Recipients > Recipient Management, and

click .

l Select Admin > Platform > Users and Permissions > User Management,
select a user, and click theRecipient tab.

l Select Admin > Personal Settings > Recipient.

l Click theNew Recipient button in the Templates and Recipients page in the
Create New Alert wizard for CI Status alerts. For details, see Templates and
Recipients Page in the BSMUser Guide.

l Click theNew Recipient button in the Templates and Recipients page in the
Create New Alert wizard for SLA alerts. For details, see Templates and
Recipients Page in the BSMUser Guide.

l Click theCreate Recipient button in the Attach Recipient dialog box for event-
based alerts. For details, see Attach Recipients Dialog Box in the BSMUser
Guide.

l Click theNew Recipient button in theReport Manager Main page. For
details, see Report Manager Main Page in the BSMUser Guide.

Important
information

l How you access the Recipients page and what you see in the page depends
on your user's permissions. For details, see "Permissions Tab (User
Management)" on page 307.

l There is a one-to-one relationship between the user and the recipient: a
recipient can be assigned to one user or to no user, and a user can have a link
to one recipient or to no recipient.

Relevant
tasks

"How to Configure andManage Recipients" on page 319

See also "Recipient Management" on page 318

User interface elements are described below:

UI Element
(A-Z) Description

Attach user to selected recipient. Select a recipient in the list of and click the
button to open the Attach Recipient to a User dialog box where you can select the
appropriate user. For details, see "Attach Recipient to a User Dialog Box" on page
322.

Note: This button is displayed only when you access the dialog box from Admin
> Platform > Users and Permissions > User Management.
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UI Element
(A-Z) Description

Detach user from selected recipient. Detaches the current recipient from the
corresponding user (listed in the page). A confirmationmessage is issued.

Note: This button is displayed only when you access the dialog box from Admin
> Platform > Users and Permissions > User Management.

Delete the recipient attached to the selected user. Detaches the recipient from
the user and deletes the recipient.

Note: This button is displayed only when you access the dialog box from Admin
> Platform > Users and Permissions > User Management.

Update selected recipients email address from LDAP. This icon appears only
if LDAP is connected to the BSM application. Click to synchronize the user data,
meaning that the email information stored in the User Repository for the specific
user updates the email recipient information corresponding to the user linked to the
recipient.

EUM Alert
notification
template

Select the template you want to use for the EUM alert notification, or any custom
template already created.

Note:When you change the selection in theEUM Alertnotification template
field in the top part of the page, the changes are propagated to the Email, Pager,
and SMS tabs in the same page. If youmodify the selection in theEUM
Alertnotification template field in the Email, Pager, or SMS tabs, theSchedule
for receiving alerts changes toMixed Value. When you change oncemore, the
selection in theEUM Alertnotification template field in the top part of the page,
the changes are propagated to the Email, Pager, and SMS tabs in the same page
and theMixed Value button is cleared.

For details on EUM alert notification templates and creating custom templates,
see "How to Configure EUM Alerts Notification Templates" on page 413.

Note: This field is relevant only for event-based alerts.

For details on alert notification templates and creating custom templates, see
"Notification Templates Page" on page 419.

Note:

l The default template is LONG.

l For details on the parameters displayed in each template, see "Pager Tab" on
page 331.

l The field lists the default templates and the custom templates.

l Youmust select the alert notification template and specify an alert notices
schedule for alert recipients. You do not have to perform this procedure for
recipients who are to receive only scheduled reports.
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UI Element
(A-Z) Description

Link to
user

This field is displayed only when you access this page from:

l Admin > Platform > Users and Permissions > User Management, select
a user in the tree and click theRecipient tab.

l Admin > Personal Settings > Recipient.

Recipient
name

The name of the recipient.

Important:Cannot exceed 49 characters.

Syntax Exception: The following characters are not supported: ` ~ ! @ # $ % ^ & *
- + [ ] { } \ | / ? " ' < >

Schedule
for
receiving
alerts

Enabled if you selected thePer notification method scheduling option for the
recipient in theSchedule for Receiving Alerts in the General tab.

Select:

l Mixed value. When you change the selection in theEUM Alertnotification
template field in the top part of the page, the changes are propagated to the
Email, Pager, and SMS tabs in the same page. If youmodify the selection in
theEUM Alertnotification template field in the Email, Pager, or SMS tabs,
theSchedule for receiving alerts changes toMixed Value. When you
change oncemore, the selection in theEUM Alertnotification template field
in the top part of the page, the changes are propagated to the Email, Pager, and
SMS tabs in the same page and theMixed Value button is cleared.

l All Day. If you want the recipient to receive email messages all day.

l From... to. If you want the recipient to receive email messages during the
specified time period.

The time range is calculated based on theGMT offset selected for the recipient.

Scheduled reports are sent based on the schedule configured in the Scheduled
Reports page and not on the schedule configured for the recipient. For details, see
How to Schedule a Report in the BSMUser Guide.
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UI Element
(A-Z) Description

Time zone Select the time zone for the recipient. Business ServiceManagement uses the
time zone to send alert notices and HP Software-as-a-Service notifications to the
selected recipient.

Note:

l The time zone selected for the recipient is the time zone specified in the alert
notifications that the recipient receives. For example, if an alert is triggered
anywhere in the world and a notification is sent, the date and time of the alert
are converted to the recipient local time. The alert also specifies the GMT
offset of the recipient.

l If you defined a notification schedule for the recipient, the time zone selected
for the recipient is also the time zone that BSM uses for calculating when to
send the recipient notifications. For example, if you configure a recipient to
receive pager alerts from 9:00 AM - 9:00 PM, and choose aGMT offset of -5
hours, the recipient receives alerts through a pager only from 9:00 AM - 9:00
PM Eastern Time.

Scheduled reports are sent based on the schedule configured in the Scheduled
Reports page and not on the schedule configured for the recipient. For details,
see How to Schedule a Report in the BSMUser Guide.

l When youmodify the time zone of the user to which the recipient is assigned, a
confirmationmessage is issued to verify that you also want to propagate the
time zone change to the recipient's offset from GMT. If you change the
recipient's offset from GMT., the time zone of the user to which the recipient is
assigned is not affected.

Communication Method Area

Important information This area includes the following tabs:

l "Email Tab" below

l "SMS Tab" on next page

l "Pager Tab" on page 331

Email Tab

Enables you to specify multiple email addresses for the recipient, the type of notification template,
which overrides the notification template selected in the global level in the page, the schedule for
sending email notifications, and the security certificate if necessary.

To access Select Admin > Platform > Users and Permissions > User Management,
select a user in the tree and click theRecipient tab. In the Communication
Method pane for the user, click theEmail tab.
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Important
information

Only those recipients who have been configured to receive email can be selected
to receive scheduled reports and are listed in Available Recipients when
configuring scheduled reports.

Note: The text displayed in email messages can only be in Latin characters
except for the contents of fields inserted by the user that can be in any supported
and relevant language. Those fields can include, for example, Alert Name, Alert
description, and KPI name.

User interface elements are described below:

UI Element
(A-Z) Description

Email
Addresses

Enter one or more email addresses. Separatemultiple entries with a semi-colon
(;).

Enable
secure
mail

Select this option if you want the recipient to receive encryptedmail. Youmust
then copy, into the text box below the option, the contents of the certificate that
the recipient uses to secure incoming email messages.

Note:

l The encryptedmail option is supported only for alerts. Encryptedmail is not
supported for scheduled reports or subscription notification (HP Software-as-a-
Service customers only).

l The encryptedmail option is supported only when the BSMData Processing
Server is installed on aWindows machine.

EUM Alert
notification
template

Select the template you want to use. For details, see "EUM Alerts Notification
Templates" on page 411.

Note:When you change the selection in theEUM Alert notification template
field in the top part of the page, the changes are propagated to the Email, Pager,
and SMS tabs in the same page. If youmodify the selection in theEUM Alert
notification template field in the Email, Pager, or SMS tabs, theSchedule for
receiving alerts changes toMixed Value. When you change oncemore, the
selection in theEUM Alert notification template field in the top part of the page,
the changes are propagated to the Email, Pager, and SMS tabs in the same page
and theMixed Value button is cleared.

Schedule
for
receiving
Email
messages

Select the schedule you want to use for receiving emails. For details, see
Schedule for receiving alerts in "New or Edit Recipient Dialog Box" on page
324.

SMS Tab

This tab enables you to specify the SMS (short message service) service provider, the SMS
numbers, the type of notification template, which overrides the notification template selected in the
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global level in the page, and the schedule for sending alert notifications to the SMS.

To access Select Admin > Platform > Users and Permissions > User Management,
select a user in the tree and click theRecipient tab. In the Communication
Method pane for the user, click theSMS tab.

Important
information

SMS is a text messaging service provided by most GSM-based cellular phone
providers. SMS messages are useful to notify staff who aremobile, or who do not
have email or pager access. Note that themaximummessage length of SMS text
messages is generally 160 characters.

Note: You can use a pager or an SMS service provider that does not appear on
the default list. For details, see "How to Add a Custom Pager or SMS Service
Provider" on page 320.

User interface elements are described below:

UI Element
(A-Z) Description

EUM Alert
notification
template

Select the template you want to use. For details, see "EUM Alerts Notification
Templates" on page 411.

Note:When you change the selection in theEUM Alert notification template
field in the top part of the page, the changes are propagated to the Email, Pager,
and SMS tabs in the same page. If youmodify the selection in theEUM Alert
notification template field in the Email, Pager, or SMS tabs, theSchedule for
receiving alerts changes toMixed Value. When you change oncemore, the
selection in theEUM Alert notification template field in the top part of the page,
the changes are propagated to the Email, Pager, and SMS tabs in the same page
and theMixed Value button is cleared.

Provider Select an SMS service provider from the list:

l Genie-UK

l Itineris

l SFR-France

l GoSMS-Israel

l MtnSMS-Global

Note: If your provider does not appear on the default provider list, and the provider
uses an email gateway, you canmanually add your provider to BSM. For details,
see "How to Add a Custom Pager or SMS Service Provider" on page 320.

Schedule
for
receiving
SMS
messages

Select the schedule you want to use for receiving SMS text messages. For
details, seeSchedule for receiving alerts in "New or Edit Recipient Dialog Box"
on page 324.

SMS
numbers

Type one or more SMS access numbers in the box. Separatemultiple entries with
a semi-colon (;).

HP Business ServiceManagement (9.20)Page 330 of 427



BSM Platform Administration Guide
Chapter 19: Recipient Management

Pager Tab

This tab enables you to specify the pager service provider, the pager numbers, the type of
notification template, which overrides the notification template selected at the global level in the
page, and the schedule for sending alert notification to the pager.

To access Select Admin > Platform > Users and Permissions > User Management,
select a user in the tree and click theRecipient tab. In the Communication
Method pane for the user, click thePager tab.

Important
information

You can use a pager that does not appear on the default list. For details, see "How
to Add a Custom Pager or SMS Service Provider" on page 320.

Note: The text displayed in pager messages can only be in Latin characters
except for the contents of fields inserted by the user that can be in any supported
and relevant language. Those fields can include, for example, Alert Name, Alert
description, and KPI name.

User interface elements are described below:

UI Element
(A-Z) Description

EUM Alert
notification
template

Select the template you want to use. For details, see "EUM Alerts Notification
Templates" on page 411.

Note:When you change the selection in theEUM Alert notification template
field in the top part of the page, the changes are propagated to the Email, Pager,
and SMS tabs in the same page. If youmodify the selection in theEUM Alert
notification template field in the Email, Pager, or SMS tabs, theSchedule for
receiving alerts changes toMixed Value. When you change oncemore, the
selection in theEUM Alert notification template field in the top part of the page,
the changes are propagated to the Email, Pager, and SMS tabs in the same page
and theMixed Value button is cleared.

Pager
Numbers

Enter one or more pager access numbers. Separatemultiple entries with a semi-
colon (;).

Note: If your pager is numeric only, when creating an alert scheme in the Alert
Wizard, you can only type a numeric user message.

Schedule
for
receiving
pager
message

Select the schedule you want to use for receiving pager messages. For details,
seeSchedule for receiving alerts in "New or Edit Recipient Dialog Box" on page
324.
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UI Element
(A-Z) Description

Type Select a pager service provider. The following providers are supported:

l MetroCall

l Arch

l AirTouch

l PageMci

l SkyTel

l PageNet

l PageMart

l AmeriPage

l Nextel

l PageOne

Default Notification Templates

Important
information

Each template enables you to display, in the notification, selected information
that corresponds to specific parameters.

For details on the parameters displayed in each template, see "Notification
Template Properties Dialog Box" on page 415.

The following default notification templates are available:

UI Element
(A-Z) Description

DEFAULT_
LOG_
FORMAT

Includes all the elements needed to create a default long format notification for
reports.

DEFAULT_
POSITIVE_
FORMAT

Includes all the elements needed to create a default long format notification for
positive or follow-up alerts. For details on follow-up alerts, see "How to Configure
a Template for Clear Alert Notifications" on page 414.

LONG Includes all the elements needed to create a default long format notification.

SHORT Includes all the elements needed to create a default short format notification.
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Personal Settings
Personal settings enable customization of the way BSM presents information to individual users.

Individual users can configure personal settings to customize their specific user-related behavior of
BSM.

The Personal Settings tab contains the following options:

l General Settings. For details, see "User Account" below.

l Menu Customization. For details, see "Menu Customization" below.

User Account
On theGeneral Settings tab, you can configure the following personal settings:

l User name

l Usermode

l Time zone used when displaying reports

l Password

l Refresh rate of reports

l Customizedmenu items

For details on the user interface for changing your password and updating other Personal Settings,
see "User Account Page" on page 337.

Menu Customization
On theMenu Customization tab, you can:

l Specify the default context that is displayed when logging into BSM.

l Specify the first page that is displayed in each of the different parts of BSM.

l Specify the tabs and options that are available on pages throughout BSM.

Customizing your entry page, menu items, and tabs enables your interface to display only the areas
of BSM that are relevant to you. For details on theMenu Customization User Interface, see "Menu
Customization Page" on page 338.
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How to Customize Your BSM Menus and Pages —
Workflow

This task describes how to customize the page you see when entering BSM, and choose themenu
items available on pages throughout BSM.

Tip: For a use-case scenario related to this task, see "How to Customize Your BSMMenus
and Pages —Use-Case Scenario" on next page.

1. Assign a Default Context
Select a context from the Contexts pane that you want to be the default entry context you see
when logging into BSM, and click Set as Default Entry Context. For user interface details,
see "Menu Customization Page" on page 338.

2. Select Context Pages and Tabs
In the Pages and Tabs pane, select the context of the pages and tabs that you want to be
visible on the selected context for the user. Clear the check boxes of the pages and tabs that
you want hidden from the user.

3. Assign a Default Entry Page
Select a page or tab to be the default entry page for the selected context, and click Set as
Default Entry Page.

4. Results
The default entry icon appears next to the default entry context and page. Pages and tabs
visible to the user are selected in the Pages and Tabs pane. Pages and tabs hidden from the
user are cleared in the Pages and Tabs pane.

Example:
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How to Customize Your BSM Menus and Pages —
Use-Case Scenario

This use-case scenario describes how to customize user menus for individual users.

Note: For a task related to this scenario, see "How to Customize Your BSMMenus and Pages
—Workflow" on previous page.

1. Assigning a Default Context
John Smith is a registered BSM user for the ABC Insurance Company. He wants to configure
the Service Level Management application interface to be the default Business Service
Management context that he sees when logging in. He navigates to the Personal Settings
option by selectingAdmin > Personal Settings, and selects Menu Customization to open
theMenu Customization page. He selects Applications - Service Level Management in the
Contexts pane and clicks Set as Default Entry Context. The Applications - Service Level
Management option is indicated as the default entry context:

2. Selecting Context Pages and Tabs
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John wants to see only the pages and tabs that are relevant for his work, and wants to view the
Service Level Agreements (SLAs) Summary report immediately upon logging into BSM. In the
Pages and Tabs pane, he deselects the SLA Management option, as the information presented
on this tab is not relevant to his work. He selects theSLAs Summary option and clicks Set as
Default Entry Page. The SLAs Summary page is indicated as the default entry page that John
sees when logging into BSM:

3. Results
The context that opens when John Smith logs into BSM is theService Level Management
context on the Applications menu. TheSLAs Summary Report page is displayed on the SLA
Reports tab:
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Personal Settings User Interface
This section includes:

l "User Account Page" below

l "Menu Customization Page" on next page

l "Recipient Tab " on page 339

User Account Page
This page enables you to configure the user name, user mode, time zone, password, and refresh
rate settings.

To access Select Admin > Personal Settings > User Account

Note: The Personal Settings tab can also be accessed by clickingChange the
default page on the Site Map.

Important
information

BSM saves these settings per defined user. Any changes youmake remain in
effect for all futureWeb sessions for only that user.

See also "Personal Settings" on page 333

User interface elements are described below:

UI Element
(A-Z) Description

Confirm
Password

Re-enter the password specified in thePassword field.

Login name The name used to log into BSM.

Note: You cannot change the entry in this field.

Password Enter a password to be used when accessing BSM.

Select auto-
refresh rate

Select the rate at which you want BSM to automatically refresh the browser and
load themost up-to-date data from the database.

Note: This setting is active only when in thePast day orPast hour time
resolution in reports.

Time zone Select the appropriate time zone, according to the user's location.
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UI Element
(A-Z) Description

User mode Select the user mode for the user, from the following options:

l Unspecified. Leaves the user without a particular mode. Select this option
if:

n BSM is working with user modes and you want this user to see KPIs for
bothmodes in Service Health views.

n Your system is not working with user modes.

l Operations User. Enables the user to view the operations version of KPIs.

l Business User. Enables the user to view the business version of KPIs.

Note: For details on user modes, see KPIs for User Modes in the BSM
Application Administration Guide.

User name The user name for the user.

Notes:

l Themaximum number of characters you can enter is 50.

l All special characters are allowed except the following: " \ / [ ] : | < > + = ; , ?
* % &

Menu Customization Page
This page enables you to customize the view and entry pages per user. You can specify:

l The default context that is displayed when logging into BSM.

l The first page displayed in each of the different parts of BSM.

l The tabs and options available on pages throughout BSM.

To access Select Admin > Personal Settings > Menu Customization

Note: The Personal Settings tab can also be accessed by clickingChange the
default page on the Site Map.

Relevant
tasks

"How to Customize Your BSMMenus and Pages —Workflow" on page 334

See also "Personal Settings" on page 333

User interface elements are described below:
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UI Element (A-
Z) Description

Contexts Select a BSM context. You can perform the following actions on the context:

l Select pages and tabs in the Pages and Tabs pane to be visible for the
specified user.

l Click theSet as Default Entry Context button tomake it the context that
is displayed when the user logs into BSM.

Pages and Tabs l Select the pages and tabs you want to be visible for the BSM context
selected in the Contexts pane.

l Assign a page or tab as the default page that opens for the context
selected in theContexts pane.

Set as Default
Entry Context

Click to set the selected context in the Contexts pane as the entry context
that is displayed when the specified user logs into BSM.

Note: TheDefault Entry Context icon appears next to the specified
context.

Set as Default
Entry Page

Click to assign the specified page or tab as the default page that opens for
the context selected in the Contexts pane.

Note: TheDefault Entry Page icon appears next to the specified page
or tab.

Recipient Tab
This tab enables you to define recipients, their email, pager, and SMS information, and the template
to use to send alert notices to those recipients.

For user interface details, see "New or Edit Recipient Dialog Box" on page 324.
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Authentication Strategies
BSM authentication is based on a concept of authentication strategies. Each strategy handles
authentication against a specific authentication service. Only one authentication service can be
configured with BSM at any given time.

The default authentication strategy for logging into BSM is the BSM internal authentication service.
You enter your BSM user name and password from the login page, and your credentials are stored
and verified by the BSM database. For a description of the authentication process in BSM, see
"BSM Login Flow" on page 25.

You can choose to configure authentication using the Lightweight Directory Access Protocol
(LDAP). BSM uses the LDAP server to verify a user's credentials. For details on LDAP, see "LDAP
Authentication andMapping" on page 369.

Authentication strategies are configured in the AuthenticationManagement Wizard. For details on
the AuthenticationManagement Wizard, see "AuthenticationWizard" on page 345.
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Setting Up an SSO Authentication Strategy
Single Sign-On (SSO) is amethod of access control that enables a user to log in once and gain
access to the resources of multiple software systems without being prompted to log in again. The
applications inside the configured group of software systems trust the authentication, and you do
not need further authentication whenmoving from one application to another.

The default single sign-on authentication strategy for BSM is Lightweight Single Sign-On (LW-
SSO). LW-SSO is embedded in BSM and does not require an external machine for authentication.
For details on LW-SSO, see "Lightweight Single Sign-On Strategy" on page 357.

If the applications configured outside of BSM do not support LW-SSO, or if you want a stronger
Single Sign-On implementation, you can configure Identity Management Single Sign-On (IDM-
SSO) using the AuthenticationManagement Wizard. When enabled as a Single Sign-On strategy,
IDM-SSO also serves as an authenticator. Users authenticated through IDM-SSO can log into
BSM, provided they fulfill the criteria defined in theUsers Filter field of the LDAP Vendor Attributes
dialog box. For details, see "LDAP Vendor Attributes Dialog Box" on page 353.

All requests to client applications are channeled through the SSO authentication. The supported
applications need to know only the name of the authenticated user.

For details on the IDM-SSO authentication strategy, see "Identity Management Single Sign-On
Authentication" on page 365.
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Setting Up LDAP Authentication
The Lightweight Directory Access Protocol (LDAP) is an Internet protocol that email and other
programs use to look up information from an external server. LDAP can be configured with BSM in
one of the following ways:

l As an authenticationmechanism for users logging into BSM.

l Tomap groups and synchronize BSM users with users configured on the external LDAP server,
thereby simplifying the process of managing users for BSM administrators. For details, see
"How toMapGroups and Synchronize Users" on page 375.

You enable and disable LDAP using the AuthenticationManagement Wizard. For details, see
"AuthenticationWizard" on page 345.
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Authentication Modes in BSM
The following table displays the Authentication Strategy used by BSM, as determined by both the
Single Sign-Onmode and the LDAP mode selected in the AuthenticationManagement Wizard:

Single Sign-On Mode LDAP Mode Authenticator

Disabled Disabled BSM Internal

Enabled LDAP

LW-SSO Disabled BSM Internal

Enabled LDAP

IDM-SSO Disabled IDM-SSO

Enabled IDM-SSO
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Authentication Strategy User Interface
This section includes:

l "Authentication Strategy Page" below

l "LDAP Vendor Attributes Dialog Box" on page 353

l "AuthenticationWizard" on next page

Authentication Strategy Page
This page displays the current authentication strategy and Single Sign-on configurations for logging
into BSM.

To access Select Admin > Platform > Users and Permissions > Authentication
Management

Important
information

Access to the AuthenticationManagement page is dependent on the following
permission levels:

l View. Enables viewing the AuthenticationManagement Page.

l Change. Enables you to access the AuthenticationManagement Wizard and
change configurations. TheConfigure button is enabled.

You configure permissions on the Users and Permissions interface. For details,
see "How to Assign Permissions" on page 239.

See also l "Authentication Strategies" on page 340

l "Infrastructure Settings" on page 91

User interface elements are described below:

UI Element
(A-Z) Description

Configure Click to open the AuthenticationWizard and configure an authentication
strategy. For details on the AuthenticationWizard, see "AuthenticationWizard"
on next page.

The parameters are configured for both theSingle Sign-On Configuration
and the Lightweight Directory Access Protocol Configuration using the
samewizard accessed by clicking theConfigure button. You can configure
both sets of parameters at a time or you can configure them separately.

Lightweight
Directory
Access
Protocol
Configuration

The section displays:

l Name. The name of the Lightweight Directory Access Protocol
parameter.

l Value. The value of the Lightweight Directory Access Protocol
parameter as configured in the wizard.

HP Business ServiceManagement (9.20)Page 344 of 427



BSM Platform Administration Guide
Chapter 21: Authentication Strategies

UI Element
(A-Z) Description

Single Sign-
On
Configuration

The section displays:

l Name. The name of theSingle Sign-On parameter.

l Value. The current value of theSingle Sign-On parameter as configured in
the wizard.

User interface elements are described below:

UI
Element
(A-Z) Description

Configure Click to open the AuthenticationWizard and configure an authentication strategy.
For details on the AuthenticationWizard, see "AuthenticationWizard" below.

Name The name of the Single Sign-On or Lightweight Directory Access Protocol
parameter.

Value The value of the specified Single Sign-On or Lightweight Directory Access Protocol
parameter.

Authentication Wizard
This wizard enables you to create an authentication strategy for logging into BSM.

To access Select Admin > Platform > Users and Permissions > Authentication
Management, and click Configure.

Important
information

If the User Interface does not respond properly after upgrading your version of
BSM (for example, the page does not load, or an error message is displayed),
clean the java cache by following this procedure on your client PC:

1. Navigate toStart > Control Panel > Java.

2. In the Temporary Internet Files section, click Settings.

3. In the Temporary File Settings dialog box, click Delete Files.

General information about this wizard is available here: "AuthenticationWizard"
above.

Wizard
map

This wizard contains:

Authentication Wizard > "Single Sign-On Page" on next page > ("SAML2
Configuration Dialog Box" on page 348) > "LDAP General Configuration Page" on
page 350 > ("LDAP Vendor Attributes Dialog Box" on page 353) > "LDAP Users
Synchronization Configuration Page" on page 354 > "Summary Page" on page
355
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Single Sign-On Page
This wizard page enables you to configure a Single Sign-On strategy. The elements displayed on
the Single Sign-On page are determined by the Single Sign-Onmode you choose.

Important
information

l General information about this wizard is available here: "Authentication
Wizard" on previous page.

l If a value in one of the wizard fields is blank or invalid, an error icon is
displayed on the field's cell. You can view a description of the error in one of
the following ways:

n Hover over the error icon to display a tooltip with the error message.

n Access the log file <HPBSM>/log/EJBContainer/login.log.

Wizard
map

The "AuthenticationWizard" on previous page contains:

"AuthenticationWizard" on previous page > Single Sign-On Page > ("SAML2
Configuration Dialog Box" on page 348) > "LDAP General Configuration Page" on
page 350 > ("LDAP Vendor Attributes Dialog Box" on page 353) > "LDAP Users
Synchronization Configuration Page" on page 354 > "Summary Page" on page
355

User interface elements are described below:

UI Element (A-Z) Description

Disabled Select to disable the Single Sign-On (SSO) authentication strategy.

IdentityManagement Select to configure the Identity Management Single Sign-On (IDM-SSO)
authentication strategy. For details on the elements displayed this page,
see below. For details on this topic, see "Identity Management Single
Sign-On Authentication" on page 365.

Note: If you have selected this option, LDAP can be configured only for
groupmapping and not for authentication.

Lightweight Select to configure the Lightweight Single Sign-On (LW-SSO)
authentication strategy. For details on the elements displayed on this
page, see below. For details on this topic, see "Lightweight Single Sign-
On Strategy" on page 357.

Identity Management Single Sign-On (IDM-SSO) Configuration
User interface elements are described below:

HP Business ServiceManagement (9.20)Page 346 of 427



BSM Platform Administration Guide
Chapter 21: Authentication Strategies

UI
Element
(A-Z) Description

Indicates that the value in the specified field is empty or invalid.

Hover over this icon to view a tooltip describing the error.

Header
Name

Enter the header name for the token name passed by the Identity Management
Single Sign-On.

Example: sso_user

Note:Ensure that the Identity Management Single Sign-On strategy is securing
BSM resources before you enter this information.

Logout
URL

Enter an alternate logout URL, to view a page other than themain login page when
logging out of BSM.

Example:\<alternativeLogoutURL>.jsp

Note: This field is optional.

Lightweight Single Sign-On (LW-SSO) Configuration
User interface elements are described below:

UI Element Description

Indicates that the value in the specified field is empty or invalid.

Hover over this icon to view a tooltip describing the error.

Add Adds the host/domain to the list of protected hosts/domains.

Enable SAML2
authentication
schema

Select to enable authentication using the Security AssertionMarkup
Language 2.0 protocol.

HP Business
Service
Management
Domain

Enter the relevant BSM domain, to be used for token creation. This field is
required for multi-domain support and normalized URLs when the domain
cannot be parsed automatically, for example when using aliases.

Example: devlab.ad

Parse
automatically

Click to parse the BSM domain automatically.

SAML2
Settings

Click to set parameters in the SAML2Configuration Dialog Box.
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UI Element Description

Token Creation
Key (initString)

Enter an initString value, used for encryption and decryption of the LW-SSO
token. If changing this value, remember to set initString to the same value in
all HP products participating in LW-SSO integration.

Example: Xy6stqZ

Trusted
Hosts/Domains

Displays the list of trusted hosts and domains that are participating in an LW-
SSO integration.

List of trusted hosts can contain DNS domain name (myDomain.com),
NetBIOS name (myServer), IP address, or fully qualified domain name for the
specific server (myServer.myDomain).

To add a host or domain to the list of trusted hosts/domains, click theAdd

icon , enter the name of the host or domain in the text box under Trusted
Hosts/Domains, and select the type of host or domain name from the Type
drop-down box.

Examples: mercury.global, emea.hpqcorp.net, devlab.ad

To remove a host or domain from the list of trusted hosts/domains, select it

and click theRemove button .

SAML2 Configuration Dialog Box
This dialog box page enables you tomodify the SAML authentication parameters for your
Lightweight Single Sign-On configuration.

To access In the AuthenticationManagement Wizard, navigate to the Single Sign-On page,
select Lightweight, and select theEnable SAML2 authentication schema
check box. Click SAML Settings to open the SAMLConfiguration dialog box.

The SAMLConfiguration dialog box consists of the following sections:

l SAML2 Creation.Modify the SAML2 Authentication parameters for sending
SAML authentication requests from BSM.

l SAML2 Validation.Modify the SAML2 Authentication parameters for
decrypting SAML requests received by BSM.

Important
information

l General information about this wizard is available here: "Authentication
Wizard" on page 345.

l BSM comes with SAML enabled by default. If you want to disable SAML
authentication, clear theEnable SAML2 authentication schema check box.
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Wizard
map

The "AuthenticationWizard" on page 345 contains:

"AuthenticationWizard" on page 345 > "Single Sign-On Page" on page 346 >
(SAML2 Configuration Dialog Box) > "LDAP General Configuration Page" on
next page > ("LDAP Vendor Attributes Dialog Box" on page 353) > "LDAP Users
Synchronization Configuration Page" on page 354 > "Summary Page" on page
355

User interface elements are described below:

UI
Element Description

Restore Restores the SAML2 configuration attributes to their state upon logging into the
current session of BSM.

SAML2 Creation Section
User interface elements are described below:

UI Element
(A-Z) Description

Keystore
filename

The filename of the keystore in BSM.

l When Look for keystore in classpath is not selected, this valuemust be
the full path of the keystore's location, for example:
C:\mystore\java.keystore.

l When Look for keystore in classpath is selected, this valuemust be just
the file name of the keystore, for example: java.keystore.

Keystore
password

The password which enables access to the keystore containing the private key
used for encryption during the SAML authentication request.

Look for
keystore in
classpath

Select for the Lightweight Single Sign-On framework to search for the keystore
in the classpath.

Note:When this option is selected, you enter only the name of the actual
keystore file in theKeystore filename field.

Private key
alias

Indicates the alias of the private key used for encryption during the SAML
authentication request.

Private key
password

Indicates the password of the private key used for encryption during the SAML
authentication request.

SAML2 Validation Section
User interface elements are described below:
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UI Element
(A-Z) Description

Look for
keystore in
classpath

Select for the Lightweight Single Sign-on framework to search for the keystore
in the classpath.

Note:When this option is selected, you enter only the name of the actual
keystore file in theKeystore filename field.

Keystore
filename

The filename of the keystore in BSM.

l When Look for keystore in classpath is not selected, this valuemust be
the full path of the keystore's location, for example:
C:\mystore\java.keystore.

l When Look for keystore in classpath is selected, this valuemust be just
the file name of the keystore, for example: java.keystore.

Keystore
password

The password of the public key used for decryption during the SAML
authentication request.

LDAP General Configuration Page
This wizard page enables you to use an external LDAP server to store authentication information
(user names and passwords) and to enable user synchronization between LDAP users and BSM
users.

To access Select Admin > Platform > Users and Permissions > Authentication
Management, and click Configure. Navigate to the LDAP General
Configuration page.

The available LDAP modes are:

l Enabled

l Disabled

Note: LDAP cannot be used for authentication when you choose
IdentityManagement on the Single Sign-OnConfiguration page of the wizard.

Important
information

l General information about this wizard is available here: "Authentication
Wizard" on page 345.

l When configuring LDAP parameters, consult your LDAP Administrator for
assistance.

Wizard
map

The "AuthenticationWizard" on page 345 contains:

"AuthenticationWizard" on page 345 > "Single Sign-On Page" on page 346 >
("SAML2Configuration Dialog Box" on page 348) > LDAP General
Configuration Page > "LDAP Users Synchronization Configuration Page" on
page 354 > "Summary Page" on page 355
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LDAP General Configuration Section
User interface elements are described below:

UI Element
(A-Z) Description

Indicates that the value in the specified field is empty or invalid.

You can view a description of the error in one of the following ways:

l Hover over the error icon to display a tooltip with the error message.

l Access the log file <HPBSM root
directory>\log\EJBContainer\login.log.

Advanced Opens the LDAP Vendor Attributes dialog box enabling you tomodify
configurations for the selected LDAP vendor. For details, see "LDAP Vendor
Attributes Dialog Box" on page 353.

Distinguished
Name (DN)
Resolution

Select to enable entering LDAP search user credentials.

Note: If your LDAP requires user credentials to verify connection to LDAP
server, you will need to use the users-remote-repository service in the JMX
console to enter these credentials, because this UI will not let you past LDAP
server URLwithout valid user credentials.

Distinguished
Name of
Search-
Entitled User

Defines the Distinguished Name (DN) of a user with search privileges on the
LDAP directory server.

Note: Leave this entry blank for an anonymous user.
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UI Element
(A-Z) Description

LDAP server
URL

Enter the URL of the LDAP (or, for Active Directory users, Global Catalog [AD
GC]) server.

To represent different trees in the same forest, enter multiple DNs, separated
by semicolons.

To allow failover, enter multiple LDAP (AD GC) server URLs, separated by
semicolons.

The required format is: ldap://machine_name:port/scope??sub

l LDAP servers typically use port 389; AD GC servers typically use port 3268
or secure port 3269.

l Possible values of scope = sub, one, or base, and are case sensitive.

l BSM ignores the attribute between the two questionmarks, if one exists.

l When the port number and scope value are empty, default values are used.

n Default port number for regular communication: 389

n Default port number for SSL communication: 636

n Default scope value: sub

Examples:

Single DN, single LDAP server:
ldap://my.ldap.server:389/ou=People,o=myOrg.com??sub

Multiple DNs: ldap://my.ldap.server:389/ou=People,
o=myOrg.com??sub;

ldap://my.ldap.server:389/ou=Staff,o=my2ndOrg.net??sub

Multiple LDAP servers: ldap://my.ldap.server:389/ou=People,
o=myOrg.com??sub;

ldap://my.2ndldap.server:389/ou=People,o=myOrg.com??sub

Note: If you receive a red X after entering the URLwith the following
popup text: 

ERROR - sun.security.validator.ValidatorException: PKIX path building
failed: sun.security.provider.certpath.SunCertPathBuilderException:
unable to find valid certification path to requested target

This means that you need to establish trust to the LDAP server. For
details, see "How to Secure Communication Between the LDAP Server
and BSM Server Over SSL" on page 379
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UI Element
(A-Z) Description

LDAP vendor
type

Enter the LDAP vendor you are using. Select from:

l Common LDAP

l Microsoft Active Directory

l Other

Note: If you click Advanced andmodify the LDAP Vendor Attribute settings,
the value of this field automatically changes toOther.

Password of
Search
Entitled User

Defines the password of the user entitled to search the LDAP server entities for
groups.

Note: Leave this entry blank for an anonymous user.

Test DN Resolution Section
Enables you to verify that both the configured LDAP parameters and the credentials of a specified
user are valid.

User interface elements are described below:

UI
Element
(A-Z) Description

Password The password of the user whose credentials are entered in theUUID field.

Note: This field is optional. If left empty, anonymous user is used.

Test Tests the LDAP configuration and user credentials validity. A message is displayed
indicating whether or not the validation was successful.

UUID The actual login name (Unique User ID) of the LDAP user you want to verify.

LDAP Vendor Attributes Dialog Box
This dailog box page enables youmodify the default LDAP settings that are specific to the selected
vendor.

To access Click Advanced on the LDAP General Configuration Page of the
AuthenticationManagement Wizard.

Important
information

l General information about this wizard is available here: "Authentication
Wizard" on page 345.

l If youmodify the LDAP Vendor Attribute settings, the value of the LDAP
Vendor Type field on the LDAP General Configuration page automatically
changes toOther.
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Wizard
map

The "AuthenticationWizard" on page 345 contains:

"AuthenticationWizard" on page 345 > "Single Sign-On Page" on page 346 >
("SAML2Configuration Dialog Box" on page 348) > "LDAP General Configuration
Page" on page 350 > (LDAP Vendor Attributes Dialog Box) > "LDAP Users
Synchronization Configuration Page" below > "Summary Page" on next page

User interface elements are described below:

UI Element (A-
Z) Description

Group class
object

Defines which LDAP entities are to be considered groups on the LDAP server.

Groups
member
attribute

Defines the specific attribute that determines which of the LDAP group's
entities are to be consideredmembers of the LDAP group.

Restore
Current

Restores the LDAP vendor attributes to their state upon logging into the current
session of BSM.

Users filter Defines which LDAP users are enabled to log into BSM.

Users object
class

Defines which LDAP entities are to be considered users on the LDAP server.

Users unique
ID attribute

The attribute you want to log into BSM with, as it appears on the LDAP server.

Example: uid, mail

LDAP Users Synchronization Configuration Page
This wizard page enables you configure the LDAP server to synchronize LDAP users with BSM
users.

To access Select Admin > Platform > Users and Permissions > Authentication
Strategy, and click Configure. Navigate to the LDAP Users Synchronization
Configuration page.

Important
information

l General information about this wizard is available here: "Authentication
Wizard" on page 345.

l This page is enabled only if the LDAP General Configuration page has been
configured correctly.

Wizard
map

The "AuthenticationWizard" on page 345 contains:

"AuthenticationWizard" on page 345 > "Single Sign-On Page" on page 346 >
("SAML2Configuration Dialog Box" on page 348) > "LDAP General Configuration
Page" on page 350 > ("LDAP Vendor Attributes Dialog Box" on previous page) >
LDAP Users Synchronization Configuration Page > "Summary Page" on next
page
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User interface elements are described below:

UI Element (A-Z) Description

Indicates that the value entered in the specified field is invalid.

Enable User
Synchronization

Select to enable User Synchronization upon logging into BSM, to
synchronize LDAP users with BSM users.

Important:Ensure that you havemapped LDAP groups to BSM groups
before selecting this check box. If you have not performedGroupMapping,
all users are nested under the Root group and are assigned Viewer
permissions. For details onmapping groups, see "How toMapGroups and
Synchronize Users" on page 375.

Groups base
DN

The Distinguished Name (DN) of the LDAP entity from which you want to
start your groups search.

Groups search
filter

Enter the relevant parameters to indicate which attributes are to be included
in the groups search.

Root groups
base DN

The Distinguished Name (DN) of the LDAP groups that are to be first on the
hierarchical tree of mapped groups. This valuemust be a subset of the
Groups base DN.

Root groups
filter

Enter the parameters to determine which LDAP entities are to be the
hierarchical base for the LDAP groups. The specified entities are then
available to bemapped to groups in BSM.

Test Verifies that the parameters entered to define the LDAP groups structure are
valid.

Test Groups
Configuration
Pane

Displays the groups available for mapping with BSM groups and the LDAP
groups' hierarchical structure. The displayed groups are determined by the
parameters entered into the fields on the LDAP Users Synchronization
Configuration page.

Summary Page
This wizard page displays a summary of the authentication strategies configured in the
AuthenticationManagement Wizard.

To access Select Admin > Platform > Users and Permissions > Authentication
Management, and click Configure. Enter information in the Single Sign-On and
LDAP pages, and navigate to theSummary page.

Important
information

General information about this wizard is available here: "AuthenticationWizard"
on page 345.
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Wizard
map

The "AuthenticationWizard" on page 345 contains:

"AuthenticationWizard" on page 345 > "Single Sign-On Page" on page 346 >
("SAML2Configuration Dialog Box" on page 348) > "LDAP General Configuration
Page" on page 350 > ("LDAP Vendor Attributes Dialog Box" on page 353) >
"LDAP Users Synchronization Configuration Page" on page 354 > Summary
Page

User interface elements are described below:

UI Element (A-Z) Description

LDAP General
Configuration

Displays the LDAP General Configuration parameters, as configured on
the LDAP General Configuration page of the wizard.

LDAP Users
Synchronization
Configuration

Displays the LDAP Users Synchronization Configuration parameters, as
configured on the LDAP Users Synchronization Configuration page of
the wizard.

Single Sign-On
Configuration

Displays the Single Sign-On parameters, as configured in the wizard.
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Lightweight Single Sign-On Strategy
The default single sign-on authentication strategy for BSM is Lightweight Single Sign-On (LW-
SSO). LW-SSO is embedded in BSM and does not require an external machine for authentication.
BSM currently uses version 2.4 of LW-SSO.

For an overview of Single Sign-On strategies, see "Setting Up an SSOAuthentication Strategy" on
page 341.

You can configure LW-SSO in BSM using the AuthenticationWizard. For details on the
AuthenticationWizard, see "AuthenticationWizard" on page 345.

LW-SSO can be configured using the JMX console to accept client-side authentication certificates.
Once a certificate is recognized, LW-SSO creates the token to be used by other applications. For
details, see "How to Secure User Access to BSM Using Client-Side Authentication Certificates" on
page 361.

For details on limitations of working with LW-SSO, see "LW-SSOAuthentication –General
Reference" on page 382.
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LW-SSO Configuration for Multi-Domain and
Nested Domain Installations

LW-SSO configuration, set in the AuthenticationWizard (for details, see "AuthenticationWizard"
on page 345), depends on the architecture of your BSM installation.

If you log into BSM through aman-in-the-middle, such as reverse proxy, a load balancer, or NAT,
the BSM domain is the domain of theman-in-the-middle.

If you log in directly to the BSMGateway, the BSM domain is the domain of the BSMGateway.

For LW-SSO to work with another application in a domain different from the BSM domain, all of
these domains must be listed in the Trusted Hosts/Domains list of the LW-SSO configuration.

If your BSM domain and integrating application are located in nested domains, then the suffix of the
domain should be the defined as the LW-SSO domain for both applications. In addition, you should
disable automatic domain calculation (Parse automatically in the AuthenticationWizard) and
explicitly state the domain suffix.

Example 1:

BSM gateway server is located in emea.hp.com

TransactionVision server is located in cnd.hp.com

Disable automatic domain calculation and set domain name = hp.com

Example 2:

BSM gateway server is in corp.ad.example.com

NNMi server is in sdc.example.com

Load balancer is in example.com

Disable automatic domain calculation and set domain name = example.com
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How to Configure Unknown User Handling Mode
This task describes how to handle unknown users trying to log into BSM—users that were
authenticated by the hosting application but do not exist in the BSM users repository:

To configure unknown user handling mode:

1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings, choose
Foundations, and select Single Sign On.

2. Locate theUnknown User Handling Mode entry in the Single Sign On - Lightweight (LW-
SSO) field, and select one of the following options:

n Integration User. A user with the User name Integration User is created in place of the
user who attempted to login. This user has System Viewer permissions.

n Allow. The user is created as a new BSM user and allowed access to the system. This user
has System Viewer permissions, and his default password is his login name.

n Deny. The user is denied access to BSM, and is directed to the login page.

The changes take effect immediately.

Note:WhenUser Synchronization is enabled between BSM and the LDAP server,
unknown users are always denied entry into BSM.
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How to Modify LW-SSO Parameters Using the JMX
Console

This task describes how tomodify options and parameters used with LW-SSO in the JMX console.

You can also use the JMX console if you are locked out of BSM andmust change SSO parameters
to gain access.

To modify Lightweight Single Sign-On (LW-SSO) parameters using the JMX console:

1. Enter the URL of the JMX console (http://<server name>:8080/jmx-console/) in a web
browser.

2. Enter your JMX console authentication credentials. If you do not know your authentication
credentials, contact your system administrator.

3. Locate the Lightweight Single Sign-On context, as follows:

a. Domain name: Topaz

b. Service: LW-SSO Configuration

4. Modify parameters accordingly.

The changes take effect immediately.
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How to Secure User Access to BSM Using Client-
Side Authentication Certificates

You can secure user access to BSM using client-side authentication certificates. You configure
LW-SSO using the JMX console to accept such certificates. Once a certificate is accepted, the
user is logged into BSM. Client-side authentication certificates provide a secure alternative to
entering user credentials in the login screen.

To configure LW-SSO to work with client-side authentication certificates:

1. Determine which field and which attribute in the client-side certificate will be used for
authentication (example: EMAILADDRESS inSubjectDN). To do this, view your client
certificate details and look at theSubject orSubjectAlternativeName field. Decide which
attribute you are going to use.

2. Enter the URL of the JMX console (http://<Gateway or Data Processing Server
name>:8080/jmx-console/)in a web browser.

3. Enter your JMX console authentication credentials.

4. Under the domain name Topaz, locate service=LW-SSO Configuration.

5. To enable client-side authentication, set the attribute
ClientCertificateInboundHandlerEnabled to true.

Note: It is strongly recommended to enable client-side authentication only when this is
required, and otherwise to explicitly set the value to false.

6. To define the field that contains the User Identifier, locate the attribute
ClientCertificateUserIdentifierRetrieveField, and enter the name of the authentication
certificate field in which the User Identifier is located, for exampleSubjectDN or
SubjectAlternativeName.

7. To define how to retrieve the User Identifier from the field, locate the attribute
ClientCertificateUserIdentifierRetrieveMode, and enter the appropriate User Identifier
retrievemode -- eitherEntireField or FieldPart.

8. To define the part of the User Identifier Retrieve field that contains the User Identifier, locate
the attribute attributeClientCertificateUserIdentifierRetrieveFieldPart, and enter the name
of the part of the User Identifier Retrieve field in which the User Identifier is located, for
exampleEMAILADDRESS.

Note: If userIdentifierRetrieveMode is set as FieldPart, or if userIdentifierRetrieveField is
set as SubjectAlternativeName, the attribute
ClientCertificateUserIdentifierRetrieveFieldPart must be specified. Otherwise, it may be
left empty.

9. Click Apply Changes.

10. In the BSMUI, select Admin > Platform > Setup and Maintenance > Infrastructure
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Settings. Click Foundations and select Single Sign-On from the drop-down list box.

11. Set Unknown User Handling Mode toDeny.
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How to Secure User Access to BSM Using an
External Authentication Point

LW-SSO 2.4 enables the use of an external authentication point, allowing customers to plug in their
own credential validation for whatever authentication technology they wish to use: LDAP, a
proprietary user/password database, a custom SSO solution, etc.

The external authentication point is an external URL that does the actual user authentication. It
obtains the user credentials (usually the user name and password, but it could be something else,
such as the user's class-B certificate, or a proprietary SSO token), validates these credentials, and
then creates an "authentication assertion" — a token that states who the authenticated user is, and
usually also provides information about how the user was authenticated.

To use an external authentication solution with LW-SSO 2.4:

1. If using LDAP, ensure that the same user repository is being used by BSM and the
authentication point server. If not using LDAP, create the users manually in BSM.

2. Set LW-SSO configuration on the authentication point server side to use the same initString as
in BSM.

3. In LW-SSO configuration on the BSMGateway server, use the JMX Console to:

a. Specify AuthenticationPointServer URL

b. Set validationPoint enabled = true

c. Click Apply Changes.

d. Restart the BSM Gateway server.

4. Make sure you can log into BSM through the external authentication point. If you are unable to
log in, see "Troubleshooting and Limitations" on next page.

5. If you do not want particular URLs to use this feature, use the JMX Console to add them to the
list of non-secure URLs in the LW-SSO configuration.
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Troubleshooting and Limitations
This section describes troubleshooting and limitations for Lightweight Single Sign-On.

Unable to Access BSM Due to Changes in LW-SSO Parameters
If you are locked out of BSM, you can update selected Lightweight Single Sign-On (LW-SSO)
parameters remotely using the JMX console on the application server that is embedded in BSM.

For details on how to change LW-SSO parameters outside the BSM interface, see "How toModify
LW-SSOParameters Using the JMX Console" on page 360.

Synchronizing Users When Using LW-SSO
LW-SSO does not ensure user synchronization between integrated applications. Therefore, you
must enable LDAP and configure groupmapping for the integrated application tomonitor users.
Failure tomap groups and synchronize users may cause security breaches and negative
application behavior. For details onmapping users between applications, see "How toMapGroups
and Synchronize Users" on page 375.

Unable to Log into BSM when Using an External Authentication Point
If you enabled an external authentication point (AP) and are unable to log in through it, make sure
that the user whose credentials you are entering is defined as a user in BSM.
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Identity Management Single Sign-On
Authentication

You implement Identity Management Single Sign-On (IDM-SSO) if you want amore secure
connection than that offered by LW-SSO, or if the applications configured outside of BSM do not
support LW-SSO. The IDM server is monitored by a single center Policy Server, and consists of a
User Repository, a Policy Store (both could reside over the same server as the policy server), and a
Web Server Agent installed over each of the application's web servers communicating with the
Policy Server. The IDM server controls users' access to various organizational resources,
protecting confidential personal and business information from unauthorized users. For details, see
your IDM vendor's documentation.

BSM requires the IDM vendor to store user information to render it available as a header on http
requests. You configure both the Header name and the IDM-SSO strategy in the Authentication
Wizard. For details, see "AuthenticationWizard" on page 345.

Before configuring IDM-SSO in BSM, make sure you see your IDM login dialog before the BSM
login screen.

If you do not see it, work with your IDM administrator. If the same LDAP was defined in BSM as
used by IDM, you should be able to authenticate through both the IDM and BSM login screens
using the same credentials. If not, verify that LDAP settings in BSMmatch those used by IDM.
Now you are ready to configure IDM-SSO in BSM. If you need help dumping headers in order to
determine the correct IDM header to use in configuration, you can return to the BSM login screen
without closing the session and append /DumpSession.jsp to the login URL. Look for your user
login ID in the resulting list. Before it should be the header name supplied by IDM. You can verify it
using http://<HPBSM server>/topaz/verifyIDM.jsp in the same user session. Once it is verified
as correct, you should be able to use it in the AuthenticationManagement wizard.
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Securing BSM Resources Under IDM-SSO
When using IDM-SSO as a Single Sign-On strategy, BSM resources may be protected with form or
basic authentication schemes, or left unprotected.

Resources accessed by application users
If you want to use IDM-SSO to secure BSM resources accessed by application users, use form
authentication on the following resources:

l /filters/*

l /hpbsm/*

l /mam-images/*

l /mcrs/*

l /MercuryAM/*

l /odb/*

l /opal/*

l /opr-admin-server/*

l /opr-console/*

l /opr-gateway/*

l /opr-web/*

l /ovpm /*

l /topaz/*

l /topazSettings/*

l /tv/*

l /tvb/*

l /ucmdb-ui/*

l /uim/*

l /utility_portlets/*

l /webinfra/*

Resources accessed by data collectors
If you want to use IDM-SSO to secure BSM resources accessed by data collectors in machine-to-
machine communication, use an authenticationmethod that allows passing credentials, or basic
authentication.

The following resources are used by data collectors:

l /ext/* — used by RUM

l /mam/*— used by RTSM
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l /topaz/topaz_api/* — used by all data collectors to get BSM version, server time, etc.

Resources accessed by web services (required)
If you use IDM-SSOwith BSM, youmust protect the following resources with basic
authentication as they are used by various BSMweb services:

l /opr-admin-server/rest/*

l /opr-console/rest/*

l /opr-gateway/rest/*

l /topaz/bam/*

l /topaz/bsmservices/*

l /topaz/eumopenapi/*

l /topaz/servicehealth/*

l /topaz/slm/*

Additional resources to be protected with basic authentication
l /topaz/rfw/directAccess.do— used with published URL to a report

l /topaz/sitescope/* — used for SAM Admin embedded in BSM UI

Unprotected
The following resources should remain unprotected:

l /mam-collectors

l /topaz/Charts

l /topaz/images

l /topaz/Imgs/chartTemp

l /topaz/js

l /topaz/rfw/static

l /topaz/services/technical/time

l /topaz/static

l /topaz/stylesheets

l /tvb/rest

l /ucmdb-api

If you are using a Load Balancer, you should also unprotect the following resources:

l /topaz/topaz_api/loadBalancerVerify_core.jsp

l /topaz/topaz_api/loadBalancerVerify_centers.jsp
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Troubleshooting and Limitations
This section provides troubleshooting help related to IDM-SSO.

Errors When Entering IDM-SSO Header in Authentication Wizard
Make sure the correct header is used. Ask your Siteminder administrator to dump all headers and
look for one that matches what you expect to use. For example, if you want to use an email address
as your login username, look for a field containing only an email address. Or, for example, if it looks
likeHTTP_SEA, removeHTTP_ from the name and give sea as the header name.

Verifying Correct User ID
To verify that you get the correct user ID with the header you provided, go to https://<HPBSM
server>/topaz/verifyIDM.jsp?headerName=sea (if sea is your header).
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LDAP Authentication and Mapping
You can use an external LDAP server to store users' information (usernames and passwords) for
authentication purposes, instead of using the internal BSM service. You can also use the LDAP
server to synchronize BSM and LDAP users. For optimal performance, it is recommended that the
LDAP server be in the same subnet as the rest of the BSM servers. For optimal security, it is
recommended to either configure an SSL connection between the BSMGateway Server and the
LDAP server, or to have BSM servers and the LDAP server on the same secure internal network
segment.

Authentication is performed by the LDAP server, and authorization is handled by the BSM server.

You configure the LDAP server for authentication and user synchronization using the
AuthenticationWizard. For details on the AuthenticationWizard, see "AuthenticationWizard" on
page 345.

For details on securing communication between an LDAP server and your BSM server over SSL,
see "How to Secure Communication Between the LDAP Server and BSM Server Over SSL" on
page 379.
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Mapping Groups
Youmap groups to enable user synchronization between LDAP users and BSM users. TheGroup
Mapping feature is accessible through the Users and Permissions interface, by clicking the LDAP

Synchronization button and selectingGroup Mappings. This button is enabled only if the
following conditions aremet:

l The LDAP mode on the Authentication Strategy page is configured toEnabled.

l The user has administrator permissions.

Once user synchronization is enabled, the User Management interface has the following
limitations:

l You cannot create a user.

l The User name and Login name fields for individual users are disabled.

l The Password field is invisible.

l You cannot manually assign users to groups using the Hierarchy tab.

Note: Users who are not assigned to any group will appear at the Root (All) level, with the
role defined in Automatically Created User Roles, in Infrastructure Settings, under
LDAP Configuration. In this does not give you sufficient control of user permissions, see
"Achieving Finer Control over Default User Permission Assignments" on page 374.

Note: Some customers like the concept of automatic user creation but prefer to put users
into the appropriate BSM groups manually. However, as noted above, with user
synchronization enabled, manual group assignment is disabled in BSM.

Tomanually assign users to the appropriate BSM group when LDAP User Synchronization
is enabled, do the following:

1) Disable User Synchronization inGroup Mappings.

2) Assign users to groups manually using theHierarchy tab.

3) Re-enable User Synchronization inGroup Mappings.

You can optionally map an LDAP group tomultiple BSM groups, or multiple LDAP groups to a BSM
group.

When enabling the GroupMapping feature, you can log into BSM with any unique user attribute that
exists on the LDAP server (for example, an email address). For details, see "How toModify the
Attribute Used to Log into BSM" on page 378.
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Synchronizing Users
The user synchronization featuremaps users on an LDAP server to users in BSM. This simplifies
the process of managing users for BSM administrators, as all of the user management functions are
done through the LDAP server. It is recommended to grant permissions on the group level in BSM,
and then nest users into groups according to their desired permission level. If users aremoved
between LDAP groups, they aremoved between their correspondingmapped groups on the BSM
server after logging into BSM.

LDAP users who do not exist in, and log into, BSM, are created as BSM users. Their status is
determined as follows:

l If the user belongs to amapped LDAP group, she is automatically assigned to the BSM group
that is mapped to their LDAP group.

l If their group is not mapped to a BSM group, or if they do not belong to an LDAP group, they are
nested under theRoot group and created as a BSM user withSystem Viewer permissions.
Their permissions and user hierarchy can bemodified on the User Management interface.

The following flowchart displays the process of User Management when LDAP is enabled, as
performed by the BSM administrator and BSM itself when the user logs in:

HP Business ServiceManagement (9.20)Page 371 of 427



BSM Platform Administration Guide
Chapter 24: LDAP Authentication andMapping

For an LDAP user to log into BSM, hemust match the criteria defined in theUsers filter field on the
LDAP AdvancedGeneral Configuration dialog box in the AuthenticationWizard. For details on the
LDAP General Configuration page, see "LDAP Vendor Attributes Dialog Box" on page 353.

Note: Be aware that any new LDAP user who satisfies the user filter will be created as a BSM
user on first login. Ask your LDAP administrator to help you narrow down the filter definition so
that only appropriate users can gain access to BSM.

Users that have been removed from the LDAP server are still displayed as BSM users, even though
they are no longer registered as LDAP users and cannot log into BSM. These users are called
Obsolete Users. For details on removing Obsolete Users from BSM, see "How to Delete Obsolete
Users" on page 380.
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For details on synchronizing LDAP users with BSM users, see "How toMapGroups and
Synchronize Users" on page 375.

For details on synchronizing groups after upgrading from a previous version of BSM, see
"Synchronizing Users After Upgrading from a Previous Version of BSM" below.

Synchronizing Users After Upgrading from a Previous
Version of BSM

When upgrading from a previous version of BSM, theEnable User Synchronization setting in
Infrastructure Settings is set to False by default. This enables you tomap the LDAP groups to
groups in BSM using the LDAP Configuration button on the Users and Permissions interface. If
you do not map the groups at this time, all BSM groups are nested under the Root directory.

Once the LDAP and BSM groups have beenmapped, youmust change theEnable User
Synchronization setting in Infrastructure Settings to True for users to be synchronized upon login
to BSM.

For details on performing this task, see "How to Synchronize Users After Upgrading from a
Previous Version of BSM" on page 377.
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Achieving Finer Control over Default User
Permission Assignments

If you need a default groupmapping for all users who do not fit into any of the currently mapped
groups, and the default BSM user role (as defined in the infrastructure settingAutomatically
Created User Roles under LDAP Configuration) provides insufficient granularity, use the
Dynamic LDAP group feature in BSM.

Request that your corporate LDAP server administrator create a dynamic LDAP group based on the
same user filter that you specified in the BSM LDAP configuration.

This user filter automatically populates andmaintains members of the dynamic group in your
corporate LDAP.

In BSM, create a local group with the roles and permissions that you require by default. Map the
dynamic group created in your corporate LDAP to the BSM local group. Any user who is allowed to
enter BSM but does not belong to any other mapped group will belong to the default group. Without
such a default group, these users would be created at the root level in the User Management tree
and their permissions would need to be handled individually.

To enable dynamic LDAP groups in BSM, go to Infrastructure Settings, select the LDAP
Configuration context and set Enable Dynamic Groups to true. The change takes effect
immediately.

Before dynamic groups are enabled, List Users, in the GroupMappings dialog box underUsers
and Permissions, will not display members of the dynamic group.

Note: Because corporate LDAP groups can be very large, List Userswill display only up to
the first 100 users. To see the whole user list or search for specific users, use a standard
LDAP browser.
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How to Map Groups and Synchronize Users
This task describes how tomap LDAP groups to BSM groups, and how to synchronize LDAP users
with BSM users:

1. Configure the LDAP Server for Mapping Groups
You enable the LDAP server for GroupMapping, using the AuthenticationWizard. For task
details, see "AuthenticationWizard" on page 345.

2. Create BSM Groups and Hierarchy
You create local groups in BSM with the appropriate roles to nest users into, and users adopt
the permission level of the group they are nested in. For task details, see "Groups/Users Pane"
on page 313.

3. Map LDAP Groups to BSM Groups
Youmap user groups on the LDAP server to groups in BSM.

Caution: Administrators must do one of the following, to avoid being locked out of BSM
when logging out after enabling the LDAP server but before configuring group
mapping and user synchronization:

n Ensure that they havemapped their own group, to enable logging into BSM after
enabling User Synchronization.

n Create an account in BSM with superuser permissions.

a. On the Users and Permissions interface, navigate to the Groups/Users pane, click the

LDAP Configuration button and select Group Mappings to open theGroup
Mappings dialog box.

b. In the <Repository Name> Remote Repository pane, select a remote LDAP server
group and click Assign Groups.

The BSM groups mapped to the selected LDAP group are displayed in theBSM Local
Repository for Remote Group: <group name> pane.

Existingmapping of all LDAP groups is displayed in the Local Groups to Remote
Groups Mapping pane.
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Mapping local groups to remote groups:

4. Enable User Synchronization
You enable synchronization of user groups on the LDAP server with user groups in BSM by
configuring the relevant settings on the LDAP Users Synchronization Configuration page in the
AuthenticationWizard.

n Before enabling user synchronization, ensure that you have either created a superuser
account in BSM that matches your own LDAP user login, or mapped an appropriate
LDAP group to a BSM group that has the superuser role assigned to it. If you have not
done so, and log out of BSM after enabling LDAP but before groupmapping is
completed and user synchronization is enabled, the designated BSM superuser
account will be locked out of BSM.

n To disable user synchronization and enablemanagement of users through the User
Management interface in BSM, clear theEnable User Synchronization check box on
the LDAP Users Synchronization Configuration page in theUser Management
> LDAP > Group Mappings user interface.

For details on synchronizing users through the AuthenticationWizard, see "LDAP Users
Synchronization Configuration Page" on page 354.
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How to Synchronize Users After Upgrading from a
Previous Version of BSM

To synchronize LDAP and BSM users after upgrading from a previous version of BSM:

1. If you have upgraded from a version earlier than BSM 7.50, ensure that theEnable User
Synchronization check box on the LDAP Users Synchronization page of the
AuthenticationWizard is cleared.

2. Ensure that LDAP groups have beenmapped to BSM groups. For details on performing this
task, see "How toMapGroups and Synchronize Users" on page 375.

3. Navigate to the LDAP Users Synchronization page in the AuthenticationWizard, and select
theEnable User Synchronization check box.
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How to Modify the Attribute Used to Log into BSM
This task describes how tomodify the LDAP attribute with which you want to log into BSM.

To modify the LDAP attribute with which you want to log into BSM:

1. Navigate toAdmin > Platform > Users and Permissions > Authentication Strategy.

2. Click theConfigure button to activate the Authentication Strategy Wizard.

3. Navigate to the LDAP General Configuration page, and click theAdvanced button.

4. Modify theUser unique ID attribute to the attribute you want to log in with, as it appears on the
LDAP server.
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How to Secure Communication Between the LDAP
Server and BSM Server Over SSL

1. If the LDAP server requires a secure connection perform the following steps:

a. Obtain root CA certificate from the Certificate Authority that issued LDAP server certificate

b. Import it into the truststore of JVM on each BSM gateway (for both JRE and JRE64).

c. Restart the BSM gateway servers

For example:

cd C:\HPBSM\JRE64\bin

keytool -import -trustcacerts -alias myCA -file c:\RootCA.cer -keystore ..\lib\security\cacerts

cd C:\HPBSM\JRE\bin

keytool -import -trustcacerts -alias myCA -file c:\RootCA.cer -keystore ..\lib\security\cacerts :

2. Verify that communication between the LDAP server and the BSM server is valid over SSL,
using the AuthenticationManagement Wizard, as follows:

a. Navigate to the AuthenticationManagement Wizard by selectingAdmin > Platform >
Users and Permissions > Authentication Management, click Configure and navigate
to the LDAP General page.

b. Enter the URL of your LDAP server, according to the following syntax: ldaps://machine_
name:port/<scope>??sub.

Ensure that the protocol is ldaps://, and the port number is configured according to the SSL
port, as configured on the LDAP server (default is 636).

c. Test your configuration on the LDAP General Configuration page by entering the UUID and
password of a known LDAP user in the relevant fields. Click Test to authenticate the user.
For details, see "LDAP General Configuration Page" on page 350.
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How to Delete Obsolete Users
This task describes how to delete BSM users who no longer exist on the LDAP server.

This option is enabled only if the following conditions aremet:

l TheRemote user repository mode on the Authentication Strategy page is set toEnabled.

l The user has Delete permissions.

To delete obsolete users:

1. Select Admin > Platform > Users and Permissions, click the LDAP Configuration
button in the Groups/Users pane, and select Delete Obsolete Users.

2. Select the user you want to delete.
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Troubleshooting and Limitations
This section describes troubleshooting and limitations for Lightweight Directory Access Protocol
(LDAP) Authentication.

l When setting LDAP server URL: if you see a red cross containing the following error:

ERROR - sun.security.validator.ValidatorException: PKIX path building failed:
sun.security.provider.certpath.SunCertPathBuilderException: unable to find valid certification
path to requested target

You have not yet configured a secure connection to the LDAP server. For details about how to
do this, see Securing Communication Between an LDAP Server and BSM Server Over SSL in
the HP Business ServiceManagement Hardening Guide PDF.

l When BSM is installed with anOracle database and User Synchronization is enabled with an
LDAP Active Directory server, ensure that you log into BSM with the correct-case UID
(uppercase or lowercase), as configured on the LDAP server. This is because while the Oracle
database is case sensitive, the LDAP Active Directory is case insensitive, and logging in with
an incorrect case UID can create undesirable results.

For example, if a user called testuser exists on the LDAP Active Directory server and logs into
BSM, he is automatically created as BSM user testuser, who can be assigned permissions in the
BSMUserManagement interface. If you then log into BSM as Testuser, the LDAP Active
Directory server sends an acknowledgement that the user exists (because Active Directory is
case insensitive) and he is allowed entry to BSM. However, since the Oracle database does not
identify this user as testuser (because the Oracle database is case sensitive), the user Testuser
is treated as a new user, without the permissions that were assigned to testuser.
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LW-SSO Authentication – General Reference
LW-SSO is amethod of access control that enables a user to log on once and gain access to the
resources of multiple software systems without being prompted to log on again. The applications
inside the configured group of software systems trust the authentication, and there is no need for
further authentication whenmoving from one application to another.

The information in this section applies to LW-SSO version 2.4.

LW-SSO Token Expiration
The LW-SSO Token's expiration value determines the application's session validity. Therefore, its
expiration value should be at least the same value as that of the application session expiration
value.

Recommended Configuration of the LW-SSO Token Expiration
Each application using LW-SSO should configure token expiration. The recommended value is 60
minutes. For an application that does not require a high level of security, it is possible to configure a
value of 300minutes.

GMT Time
All applications participating in an LW-SSO integrationmust use the sameGMT time with a
maximum difference of 15minutes.

Multi-domain Functionality
Multi-domain functionality requires that all applications participating in LW-SSO integration
configure the trustedHosts settings (or the protectedDomains settings), if they are required to
integrate with applications in different DNS domains. In addition, they must also add the correct
domain in the lwsso element of the configuration.

Get SecurityToken for URL Functionality
To receive information sent as aSecurityToken for URL from other applications, the host
application should configure the correct domain in the lwsso element of the configuration.
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LW-SSO System Requirements
The following table lists LW-SSO configuration requirements:

Application Version Comments

Java 1.5 and higher

HTTP Sevlets API 2.1 and higher

Internet Explorer 6.0 and higher Browser should enable HTTP session cookie and
HTTP 302 Redirect functionality

FireFox 2.0 and higher Browser should enable HTTP session cookie and
HTTP 302 Redirect functionality

JBoss
Authentications

JBoss 4.0.3

JBoss 4.3.0

Tomcat
Authentications

Standalone
Tomcat 6.0.29

Standalone
Tomcat 5.0.28

Standalone
Tomcat 5.5.20

Acegi
Authentications

Acegi 0.9.0

Acegi 1.0.4

Spring Security
Authentication

Spring Security
2.0.4

Web Services
Engines

Axis 1 - 1.4

Axis 2 - 1.2

JAX-WS-RI
2.1.1
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LW-SSO Security Warnings
This section describes security warnings that are relevant to the LW-SSO configuration:

l Confidential InitString parameter in LW-SSO. LW-SSO uses Symmetric Encryption to
validate and create a LW-SSO token. The initString parameter within the configuration is used
for initialization of the secret key. An application creates a token, and each application using the
same initString parameter validates the token.

Caution:

n It is not possible to use LW-SSOwithout setting the initString parameter.

n The initString parameter is confidential information and should be treated as such in
terms of publishing, transporting, and persistency.

n The initString parameter should be shared only between applications integrating with
each other using LW-SSO.

n The initString parameter should have aminimum length of 12 characters.

l Level of authentication security. The application that uses the weakest authentication
framework and issues a LW-SSO token that is trusted by other integrated applications
determines the level of authentication security for all the applications.

It is recommended that only applications using strong and secure authentication frameworks
issue an LW-SSO token.

l Symmetric encryption implications. LW-SSO uses symmetric cryptography for issuing and
validating LW-SSO tokens. Therefore, any application using LW-SSO can issue a token to be
trusted by all other applications sharing the same initString parameter. This potential risk is
relevant when an application sharing an initString either resides on, or is accessible from, an
untrusted location.

l User mapping (Synchronization). The LW-SSO framework does not ensure user mapping
between the integrated applications. Therefore, the integrated applicationmust monitor user
mapping. We recommend that you share the same user registry (as LDAP/AD) among all
integrated applications.

Failure tomap users may cause security breaches and negative application behavior. For
example, the same user namemay be assigned to different real users in the various applications.

In addition, in cases where a user logs onto an application (AppA) and then accesses a second
application (AppB) that uses container or application authentication, the failure tomap the user will
force the user to manually log on to AppB and enter a user name. If the user enters a different user
name than was used to log on to AppA, the following behavior can arise: If the user subsequently
accesses a third application (AppC) from AppA or AppB, then they will access it using the user
names that were used to log on to AppA or AppB respectively.

l Identity Manager. Used for authentication purposes, all unprotected resources in the Identity
Manager must be configured with the nonsecureURLs setting in the LW-SSO configuration file.

HP Business ServiceManagement (9.20)Page 384 of 427



BSM Platform Administration Guide
Chapter 25: LW-SSOAuthentication –General Reference

Troubleshooting and Limitations
Known Issues
This section describes known issues for LW-SSO authentication.

l Security context. The LW-SSO security context supports only one attribute value per attribute
name.

Therefore, when the SAML2 token sends more than one value for the same attribute name, only
one value is accepted by the LW-SSO framework.

Similarly, if the IdM token is configured to sendmore than one value for the same attribute name,
only one value is accepted by the LW-SSO framework.

l Multi-domain logout functionality when using Internet Explorer 7. Multi-domain logout
functionality may fail when the browser used is Internet Explorer 7 and the application is
invokingmore than three consecutive HTTP 302 redirect verbs in the logout procedure.

In this case, Internet Explorer 7may mishandle the HTTP 302 redirect response and display an
Internet Explorer cannot display the webpage error page instead.

As a workaround, it is recommended to reduce, if possible, the number of application redirect
commands in the logout sequence.

Limitations
Note the following limitations when working with LW-SSO authentication:

l Client access to the application.

If a domain is defined in the LW-SSO configuration:

n The application clients must access the application with a Fully Qualified Domain Name
(FQDN) in the login URL, for example, http://myserver.companydomain.com/WebApp.

n LW-SSO cannot support URLs with an IP address, for example,
http://192.168.12.13/WebApp.

n LW-SSO cannot support URLs without a domain, for example, http://myserver/WebApp.

If a domain is not defined in the LW-SSO configuration: The client can access the
application without a FQDN in the login URL. In this case, an LW-SSO session cookie is
created specifically for a single machine without any domain information. Therefore, the cookie
is not delegated by the browser to another, and does not pass to other computers located in the
sameDNS domain. This means that LW-SSO does not work in the same domain.

l LW-SSO framework integration. Applications can leverage and use LW-SSO capabilities only
if integrated within the LW-SSO framework in advance.

l Multi-Domain Support.

n Multi-domain functionality is based on the HTTP referrer. Therefore, LW-SSO supports links
from one application to another and does not support typing a URL into a browser window,
except when both applications are in the same domain.

n The first cross domain link usingHTTP POST is not supported.
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Multi domain functionality does not support the first HTTP POST request to a second
application (only theHTTP GET request is supported). For example, if your application has
an HTTP link to a second application, anHTTP GET request is supported, but anHTTP
FORM request is not supported. All requests after the first can be eitherHTTP POST or
HTTP GET.

n LW-SSO Token size:

The size of information that LW-SSO can transfer from one application in one domain to
another application in another domain is limited to 15Groups/Roles/Attributes (note that each
itemmay be an average of 15 characters long).

n Linking from Protected (HTTPS) to non-protected (HTTP) in amulti-domain scenario:

Multi domain functionality does not work when linking from a protected (HTTPS) to a non-
protected (HTTP) page. This is a browser limitation where the referrer header is not sent when
linking from a protected to a non-protected resource.

n Third-party cookie behavior in Internet Explorer:

Microsoft Internet Explorer 6 contains amodule that supports the "Platform for Privacy
Preferences (P3P) Project," meaning that cookies coming from a Third Party domain are by
default blocked in the Internet security zone. Session cookies are also considered Third Party
cookies by IE, and therefore are blocked, causing LW-SSO to stop working.

To solve this issue, add the launched application (or a DNS domain subset as
*.mydomain.com) to the Intranet/Trusted zone on your computer (for example, in Microsoft
Internet Explorer, selectMenu > Tools > Internet Options > Security > Local Intranet >
Sites > Advanced), which causes the cookies to be accepted.

Caution: The LW-SSO session cookie is only one of the cookies used by the Third Party
application that is blocked.

l SAML2 token.

n Logout functionality is not supported when the SAML2 token is used.

Therefore, if the SAML2 token is used to access a second application, a user who logs out of
the first application is not logged out of the second application.

n The SAML2 token's expiration is not reflected in the application's sessionmanagement.

Therefore, if the SAML2 token is used to access a second application, each application's
sessionmanagement is handled independently.

l JAAS Realm. The JAAS Realm in Tomcat is not supported.

l Using spaces in Tomcat directories. Using spaces in Tomcat directories is not supported.

It is not possible to use LW-SSOwhen a Tomcat installation path (folders) includes spaces (for
example, Program Files) and the LW-SSO configuration file is located in the common\classes
Tomcat folder.

l Load balancer configuration. A load balancer deployed with LW-SSOmust be configured to
use sticky sessions.

HP Business ServiceManagement (9.20)Page 386 of 427



Part 5

Reports and Alerts Administration
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Report Schedule Manager
A user with administrator permissions can edit, delete, resume, or pause scheduled reports in the
Report ScheduleManager. You schedule Favorite FiltersUser reports (Custom reports, Trend
reports, Service reports), and Favorite Filters in the Report Manager to enable specific recipients to
automatically receive the specified report, through email, at regularly defined intervals. For details
on scheduling User reports, see How to Create andManage User Reports Using Report Manager in
the BSMUser Guide.
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Report Schedule Manager Main Page
This page enables you tomanage schedules configured on favorite filters in the Report Manager.

To access Select Admin > Platform > Report Scheduling

Important
information

You cannot create a new schedule from the Report ScheduleManager main page.
For details on creating schedules, see How to Create andManage User Reports
Using Report Manager in the BSMUser Guide.

Relevant
tasks

How to Create andManage User Reports Using Report Manager in the BSMUser
Guide.

User interface elements are described below:

UI Element
(A–Z) Description

Click to open the Edit schedule dialog box and edit the schedule configuration. For
details, see Create New Schedule Dialog Box.

Opens the Edit Schedule for the <Report Name> dialog box enabling you to edit
the selected schedule. For details, see Create New Schedule Dialog Box in the
BSMUser Guide.

Note: This dialog box enables you only to edit an existing schedule - you create a
new schedule from the Report Manager interface. For details, see Create New
Schedule Dialog Box in the BSMUser Guide.

Deletes the selected schedule.

Resumes the selected schedule.

Pauses the selected schedule.

Refreshes the Report ScheduleManager page.

Resets the width of the columns to the default setting.

Enables you to select columns to be visible in the table.

Generation
Time

The time (in the indicated time zone) that the schedule is to be generated.

Recipients The individuals configured in the Report Manager to receive the report or report
item at scheduled intervals. For details on configuring Schedules, see Creating a
New Schedule Dialog Box in the BSMUser Guide.

Recurrence The recurrence pattern for the selected schedule.
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UI Element
(A–Z) Description

Report
Name

The name of the report for which the schedule is configured.

Report
Type

The type of report for which the schedule is configured.

Status The status of the schedule. Possible values are:

l Active

l Paused
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Chapter 27

Setting Up an Alert Delivery System
BSM alerts proactively inform you when predefined performance limits are breached, by triggering
alerts.

For task details, see "How to Set Up an Alert Delivery System" on page 395.

This section includes the following topics:

l "Alert Recipients" below

l "Notification Template" below

l "Alert Schemes" below

l "Open Events in OM" on next page

l "Alert History" on next page

l "Delivery of Alerts" on next page

Alert Recipients
Alerts can be configured to send notification to specified recipients. For task details on configuring
recipients, see "Recipient Management" on page 318.

Notification Template
For each recipient, you can specify the notificationmethod (any combination of email, pager, and/or
SMS) and the template to use for alert notices. You can also create a notification schedule for the
alerts. For details, see "How to Configure EUM Alerts Notification Templates" on page 413.

Alert Schemes
In each alert scheme, you define a unique set of alert properties. After you create an alert scheme,
you view and edit it in the appropriate Alerts user interface. For detailed tips and guidelines, see
"Planning for Effective Alert Schemes" on page 394.

You can configure alerts and assign recipients to the alerts for:

l CIs in a view. CI Status alerts are triggered by a pre-defined status change for the selected
configuration item (CI) detected by the Business Logic Engine. For details, see CI Status Alerts
Administration Overview in the BSMUser Guide.

l HP ServiceManager automatically opens incidents when a CI Status alert is triggered in BSM.
For details, see HP ServiceManager in the BSM Platform section in the HP Software
Integrations site.

l SLAs. SLA status alerts are triggered by changes to an SLA's key performance indicator status.
For details, see SLA Alerts Overview in the BSMUser Guide.

l EUM alerts. EUM alerts are triggered when pre-defined conditions, such as transaction
response time, availability, success or failure, or completion time, are reached. For details, see
EUM Alerts Administration Overview in the BSMUser Guide.
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Open Events in OM
You can automatically open events in OM, when a CI Status alert, an SLA alert, or an EUM alert is
triggered in BSM. For details, seeOperations Manager in the BSM Platform section in the
HP Software Integrations site.

Alert History
You can view the history of the alerts in the following:

l CI Status Alerts Report tab. Enables you to list all of the CI Status alerts that were triggered
during the specified time range. For details, see Configuration Item Status Alerts Report in the
BSMUser Guide.

l SLA Alerts Report tab. Enables you to list all of the Service Level Management alerts that
were triggered during the specified time range. For details, see Alerts Log Report in the BSM
User Guide.

l EUMAlerts Report tab. Enables you to access the following reports:

n Alert Log report. Enables you to track all the details for the EUM alerts sent by BSM during
the specified time range. For details, see Alerts Log Report in the BSMUser Guide.

n Alert Count Over Time report. Enables you to display an overview of the frequency of alerts.
For details, see Alerts Count Over TimeReport in the BSMUser Guide.

Delivery of Alerts
If the online components are experiencing downtime, the Alerts applicationmakes sure that the
data is stored in the bus for one hour by default. After the components are back online, the Alerts
engine generates alerts from data in the bus.
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Alerts and Downtime
When you configure a CI Status alert, downtime can affect the CIs and skew the CI's data.

When you configure an EUM alert scheme for CIs whose status is based on data from Business
Process Monitor or SiteScope data sources, downtime can affect the CIs and skew the CI's data.

Youmay decide to trigger a CI Status alert or an EUM alert during downtime or not. For concept
details about downtime, see "DowntimeManagement" on page 199.

To specify how to handle the CI Status alerts and the EUM alerts during downtime, select Admin >
Platform > Downtime, and select one of the following options:

l Take no actions

l Suppress alerts and close events

l Enforce downtime on KPI calculations; suppress alerts and close events

l Enforce downtime on Reports and KPI calculations; suppress alerts and close events

l Stop active monitoring (BPM & SiteScope); enforce downtime on Reports & KPI
calculations; suppress alters and close events (affects all related SLAs)

CI Status or EUM alerts for CIs that are in a scheduled downtime are not sent for all the options
listed above apart from the Take no action option.

The CI alert is sent even if one of the options listed above is selected (apart from the Take no
action option), if you configured the alert to be triggered when the status of the CI changes to the
Downtime status. For user interface details, seeGeneral Page in the BSMUser Guide.

For task details, see "How to Set Up an Alert Delivery System" on page 395.

For user interface details, see "DowntimeManagement Page" on page 207.
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Planning for Effective Alert Schemes
Before creating alert schemes, you should consider how tomost effectively alert users to
performance issues. The information described below can assist you with effective alert planning.

Note: HP Professional Services offers best practice consulting on this subject. For information
on how to obtain this service, contact your HP representative.

l When creating alert schemes, categorize alerts by severity. Create critical alerts for events that
require immediate corrective action (for example, transaction failure, or excessive response
times for critical transactions). Create non-critical alerts for events that require early notification
(for example, slow response times).

l Determine the users that receive the different types of alerts, and consider the alert delivery
method that best suits the alert type. For example, pager delivery as opposed to email delivery
might bemore effective for critical alerts. When determining the delivery method, take the time
of day into account as well. For example, email alerts might not be effective during non-business
hours.

l Set BSM to alert you to a recurring problem, not one-time events. Recurring alerts are themost
accurate indicator of problems with your application. For example, as a rule, you should compare
the number of recurring events to the number of Business Process Monitor locations from which
you aremonitoring. For example, if you had three failures, but you weremonitoring from 100
locations, it would not be as critical as if you had five failures in all five locations.
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How to Set Up an Alert Delivery System
This task and the associated flowchart describe how to set up a system for delivering alerts to
recipients.

Setting Up an Alert Delivery System - Flowchart
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1. Plan the alert recipient requirements
It is recommended to:

n List the required recipients of alerts, including contact information and required delivery
method to the recipient (email, SMS, pager). For suggestions on how to proceed, see
"Planning for Effective Alert Schemes" on page 394.

n Map out the types of alerts you plan to deliver. For details on the types of alerts, see "How to
Set Up an Alert Delivery System" on previous page.

2. Specify the appropriate user permissions
Specify the appropriate user permissions for:

n The EUM alerts.

o You can specify that a user can have aView or Full Control permission per application.
Select Admin > Platform > Users and Permissions > User Management, create/edit
a user, and click Permissions, in theEnd User Management context, select Business
Service Management > Applications > <Application> > Alerts context.

o Youmust also specify the permission for the CEM event template. Select Admin >
Platform > Users and Permissions > User Management, create/edit a user, and click
Permissions, in theEnd User Management context, select Alert - Notification
template.

n The CI Status alerts. You can specify that a user can have aChange, View, Delete, or
Full Control permission per view. Select Admin > Platform > Users and Permissions >
User Management, create/edit a user, and click Permissions, in theRTSM context,
select Business Service Management > Views > <view_name> context.

n The SLA alerts. You can specify that a user can have anAdd, Change, View, Delete, or
Full Control permission per SLA. Select Admin > Platform > Users and Permissions >
User Management, create/edit a user, and click Permissions, in theService Level
Management context, select Business Service Management > SLAs > <sla_name>

context.

n The alert external actions (Run executable, Send SNMP trap, or Log to Event
Viewer). You can specify that a user can have aChange or Full Control permission at the
global level. Select Admin > Platform > Users and Permissions > User Management,
create/edit a user, and click Permissions, in thePlatform context, select Business
Service Management > Run executable, Send SNMP trap, or Log to Event Viewer
contexts separately.

n The notification template you can specify for the alerts. You can specify that a user can
have anAdd, Change, View, Delete, or Full Control permission for the template. To do
so, select Admin > Platform > Users and Permissions > User Management,
create/edit a user, and click Permissions. In theEnd User Management context, select
Business Service Management > System Recipient Template context. These
permissions are defined at the global level.

For user interface details, see "Operations" on page 226.

3. Specify how alerts are triggered during downtime
When you configure a CI Status alert or an EUM alert scheme for CIs whose status is based
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on data from Business Process Monitor or SiteScope data sources, downtime can affect the
CIs and skew the CI's data.

Youmay decide to trigger a CI Status alert or an EUM alert during downtime or not. To specify
how to handle the CI Status alerts and the EUM alerts during downtime, select Admin >
Platform > Downtime, and select one of the available options.

For concept details, see "Alerts and Downtime" on page 393.

For user interface details, see "DowntimeManagement Page" on page 207.

4. Customize the alerts triggering system, alerts system health, and event
handling characteristics – optional
Customize the alerts triggering system, system health, and event handling characteristics. For
more information, see "How to Customize Alerts" on next page.

5. Define recipients
On the Recipients page, you define system recipients for alerts (except SiteScope alerts). You
can specify email, SMS, or pager delivery methods. If required, enter specific alert delivery
schedules (for example, recipients who receive alerts during business hours as opposed to
evenings and weekends). For more information, see "Recipient Tab (User Management)" on
page 306.

6. Create custom notification templates – optional
If required, when defining EUM alerts, you have the option to create custom notification
templates that customize the format and information included in alert emails. For more
information, see "How to Configure EUM Alerts Notification Templates" on page 413.

7. Set up to open an event in Operations Manager and Operations
Management when an alert is triggered in BSM
You can set up to open events in Operations Manager andOperations Management when an
alert is triggered in BSM. For details, seeOperations Manager in the BSM Platform section in
the HP Software Integrations site.

8. Result - define the alerts schemes
You have planned the alert schemes, set up the relevant recipients, customized the alerts
general settings and customized the notification templates. You can now define the alert
schemes you require:

n CI Status Alerts. Define CI Status alerts as required to alert recipients to KPI status
changes for specific CIs and KPIs beingmonitored in Service Health. For more information,
see How to Create a CI Status Alert Scheme and Attach it to a CI in the BSMUser Guide.

n SLA Alerts. Define SLA alerts as required to alert recipients to changes in the current and
forecasted status for service agreements. For more information, see How to Define an SLA
Alert Scheme in the BSMUser Guide.

n EUM Alerts. Define EUM alerts as required to alert recipients to performance variance of
Real User Monitor entities or Business Process Monitor transactions. For more information,
see How to Create EUM Alert Schemes in the BSMUser Guide.
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How to Customize Alerts

Note: All the steps in the task are optional and can be performed in any order.

This task describes the customization you can perform for CI Status, SLA, and EUM alerts.

Modify the way events are handled
Tomodify the way events are handled, select Admin > Platform > Setup and Maintenance >
Infrastructure Settings:

l Select Foundations.

l Select Alerting.

l In theAlerting - Event handling table, locate andmodify the following parameters:

n Acceptable event delay (minutes). Used to specify the default delay for alerts. Modify the
default delay (60minutes) after which alerts are discarded.

n Calculation persistency. Used to enable/disable calculation persistency. When calculation
persistency is enabled, the calculated data, which existed before the system goes down, is
taken into consideration in data calculations after the system goes up. Select false to disable
calculation persistency and true to enable calculation persistency.

Modify the Alerting System Health parameters
Tomodify the way events are handled, select Admin > Platform > Setup and Maintenance >
Infrastructure Settings:

l Select Foundations.

l Select Alerting.

l In theAlerting - System Health table, locate andmodify the following parameters:

n Error threshold for the notification queue monitor. Used to specify when the notification
queue status changes to error. Enter themaximum number of messages that can wait in the
alert queue of the notification queuemonitor. When themaximum is reached the notification
queuemonitor status changes to error.

n Warning threshold for the notification queue monitor. Used to specify when the
notification queue status changes to warning. Enter themaximum number of messages that
can wait in the alert queue of the notification queuemonitor. When themaximum is reached
the notification queuemonitor status changes towarning.

n Error threshold for the alert queue monitor. Used to specify when alert queue status
changes to error. Enter themaximum number of messages that can wait in the alert queue of
the alert queuemonitor. When themaximum is reached the alert queuemonitor status
changes to error.

n Warning threshold for the alert queue monitor. Used to specify when alert queue status
changes to warning. Enter themaximum number of messages that can wait in the alert queue
of the alert queuemonitor. When themaximum is reached the alert queuemonitor status
changes towarning.
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Modify the alerts triggering defaults
Tomodify the way events are handled, select Admin > Platform > Setup and Maintenance >
Infrastructure Settings:

l Select Foundations.

l Select Alerting.

l In theAlerting - Triggered alerts table, locate andmodify the following parameters:

n Command line execution timeout (seconds). You canmodify the default timeout for an
action (30 seconds) after which a command line alert action is not executed.

n Default SNMP Target Address or Default SNMP Port. You canmodify the default SNMP
Trap host address, by entering the IP address or server name in theDefault SNMP Target
Address parameter, and the port number in theDefault SNMP Port parameter.

Note: You can specify only one SNMP target address. The default host address of the
SNMP trap appears automatically in theEnter host destination box in the Create
New/Edit SNMP Trap dialog box. For details, see Create New/Edit SNMP Trap Dialog
Box in the BSM Application Administration Guide or Create SNMP Trap/Edit SNMP Trap
Dialog Box in the BSM Application Administration Guide. If, when you create or edit an
SNMP trap, you select the default host address and thenmodify it afterwards in the
Infrastructure Settings, the address in all the SNMP traps you created are updated to the
new default. Any alert that is sent causes the SNMP trap to be sent to the new default
address.

Note to HP Software-as-a-Service customers:You can set the default host address
per customer by selecting a customer when you log in. The updated host address is
defined only for the specific customer. You can also define a global host address.

n Command line substitution pairs.When specifying a command in the Executable Files
action of an EUM alert, you can use special tokens that are replaced with actual values when
the command is prepared for execution. Those values might include a double quote (") or
other tokens that may cause the resulting command line to be inappropriately interpreted by
the operating system. To avoid this misinterpretation, you canmodify the default value of the
Command line substitution pairs infrastructure setting, as follows:

o Each pair is written using the |a|b| format.

o The a character is replaced by b.

o Multiple pairs are separated by a comma (,).
For example: |a|b|,|c|d|, |e|f|.

n Enable alert dependencies across CIs. Use to enable alert dependencies between CIs.
Select:

o false. (Default) Alert dependencies are not allowed between CIs.

o true. Alert dependencies are allowed between CIs.

n Enable alert timer reset. Used to reset the notification frequency timer. Select:
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o false. (Default) An alert is triggered by a specific condition, then the condition that
triggered the alert does not exist any more. If the condition that triggered the alert occurs
again before the end of time period specified in theAcceptable events delay parameter
ends, the alert is not sent.

o true. An alert is triggered by a specific condition, then the condition that triggered the alert
does not exist any more. If the condition that triggered the alert occurs again before the
end of time period specified in theAcceptable events delay parameter ends, the alert is
sent because the trigger condition has reset the notification frequency timer.

n Enable logging to DB. Enable logging alerts and notifications in the database. This
customization is available only for EUM alerts. Select:

o true. (Default) Alerts and notifications are logged in the Profile database.

o false. Alerts and notifications are not logged in the Profile database.

For details about the logs, see "Alert Logs" on page 405.

n Enable notifications and actions. Enable the alert engine to perform actions and send
notifications. This customization is available only for EUM alerts. Select:

o true. (Default) Actions are performed and notifications are sent by the alert engine.

o false. Actions are not performed and notifications are not sent to the user.

n Legacy SNMP Target Address or Legacy SNMP Port. Used tomodify the default SNMP
Trap host address for EUM alerts. Modify the default SNMP trap host address, by entering
the IP address or server name in theDefault SNMP Target Address parameter, and the port
number in theDefault SNMP Port parameter.

Note: You can specify only one SNMP target address. The default host address of the
SNMP trap appears automatically in theEnter host destination box in the Create
New/Edit SNMP Trap dialog box. For details, see Create New/Edit SNMP Trap Dialog
Box in the BSM Application Administration Guide or Create SNMP Trap/Edit SNMP Trap
Dialog Box in the BSM Application Administration Guide. If, when you create or edit an
SNMP trap, you select the default host address and thenmodify it afterwards in the
Infrastructure Settings, the address in all the SNMP trap you created are updated to the
new default. Any alert that is sent causes the SNMP trap to be sent to the new default
address.

Note to HP Software-as-a-Service customers:You can set the default host address
per customer by selecting a customer when you log in. The updated host address is
defined only for the specific customer. You can also define a global host address.

n Notification execution retries. Use to specify the number of retries of a notification. This
customization is available only for EUM alerts. By default, a notification is sent once. Change
the default using theNotification execution retries parameter. The number of retries that is
performed equals the number you specify plus one.

n Notification URL. Use to customize the URL embedded in the notifications.

n Symphony request timeout (seconds). Use to specify the number of seconds until an alert
action times out.
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n Wait interval between retries (seconds). Use to specify the number of seconds between
each attempt to execute a notification.

n Default EXE path. Use to specify the default path to the default executable for EUM alerts.

n Default URL. Use to specify the default URL address for EUM alerts.

n Recipient information format in template. Use tomodify how to display the recipient list in
Emails or SMSs.You can assign the following values:

o Address. To display the complete email of the recipients in the To field of Emails and
SMS notifications. For example, if you set Recipient information format in template to
Address and the template includes the following parameters: To:<<Recipients>>, Profile
Name: <<Profile Name>>, Severity: <<Severity>>, then the Email is as follows:

To:gaz@devlab.ad;shifv@devlab.ad;aahhh.hhheee@hp.com
Profile Name: forAlert
Severity: Major

o Logical Name. To display the logical name of the recipients in the To field of Emails and
SMS notifications. For example, if you set Recipient information format in template to
Logical Name and the template includes the same parameters as the example above,
then the Email is as follows:

To:aa;bac admins
Profile Name: forAlert
Severity: Major

Modify the way alerts are sent by email
Tomodify the way email alerts are handled, select Admin > Platform > Setup and Maintenance
> Infrastructure Settings:

l Select Foundations.

l Select Platform Administration.

l In thePlatform Administration - Alerts E-Mail Settings table, locate andmodify the following
parameters:

n Password for authorized email setting. Used tomodify the default password for
authorized sending of email alerts.

n SMTP server (Windows only). Used to specify the primary SMTP server used. In windows
NT, set as <SMTPSVC> if you want to send using the SMTP service.

n SMTP server port (Windows only). Used to specify the SMTP server port.

n User for authorized email sending. Used tomodify the default user for authorized sending
of email alerts. If not set, email alerts are sent without authorization.

Modify the way alerts are sent by pager
Tomodify the way pager alerts are handled, select Admin > Platform > Setup and Maintenance
> Infrastructure Settings:

l Select Foundations.

l Select Platform Administration.
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l In thePlatform Administration - Alerts Pager Settings table, locate andmodify the following
parameters:

n Password for authorized pager setting. Used tomodify the default password for
authorized sending of pager alerts.

n SMTP server (Windows only). Used to specify the primary SMTP server used. In windows
NT, set as <SMTPSVC> if you want to send using the SMTP service.

n SMTP server port (Windows only). Used to specify the SMTP server port.

n User for authorized pager sending. Used tomodify the default user for authorized sending
of pager alerts. If not set, pager alerts are sent without authorization.

Modify the way alerts are sent by SMS
Tomodify the way SMS alerts are handled, select Admin > Platform > Setup and Maintenance
> Infrastructure Settings:

l Select Foundations.

l Select Platform Administration.

l In thePlatform Administration - Alerts SMS Settings table, locate andmodify the following
parameters:

n Password for authorized SMS setting. Used tomodify the default password for authorized
sending of SMS alerts.

n SMTP server (Windows only). Used to specify the primary SMTP server used. In windows
NT, set as <SMTPSVC> if you want to send using the SMTP service.

n SMTP server port (Windows only). Used to specify the SMTP server port.

n User for authorized SMS sending. Used tomodify the default user for authorized sending
of SMS alerts. If not set, SMS alerts are sent without authorization.

Modify the way notifications are handled
Tomodify the way notifications are handled, select Admin > Platform > Setup and Maintenance
> Infrastructure Settings:

l Select Foundations.

l Select Platform Administration.

l In thePlatform Administration - Recipient Notification Service table, locate andmodify the
following parameters:

n Alerts email sender address. Used tomodify the default sender email address used in
emails. Use the parameter to modify the default value (HP_BSM_Alert_Manager) that
appears in the From field when BSM sends alerts is set when you install the Data Processing
Server.

n Alternate SMTP server port (Windows only), and Alternate SMTP server (Windows
only). Used tomodify the alternate SMTP server:

o A designated server with a defined port number. Enter a server name for sending SMTP
emails as the value in theAlternate SMTP server field and enter a port number for the server
in theAlternate SMTP server field.
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o Microsoft's SMTP services. Enter <SMTPSVC> as the value in theSMTP server or
Alternate SMTP server field.

Limitation: The following characters are invalid: _ . -

n Email notification charset. When an alert is triggered, recipients for the generated alert can
be notified by email, SMS, or pager messages. You can select one of the following character
sets:

o UTF-8. The default character set.

o ISO-2022-JP.

Note to HP Software-as-a-Service customers: The settings described in this section
are per customer.

n Email sender. Use to specify the name of the sender of alert emails.

n Enable recipient notifications. Set to false to prevent notifications from being sent to
recipients. Set to true to send notifications to recipients.

n Pager notifications charset. Defines the character set used to send pager notification
messages You can select one of the following character sets:

o UTF-8. The default character set.

o ISO-2022-JP.

Note to HP Software-as-a-Service customers: The settings described in this section
are per customer.

n Password for authorized message sending. Use the parameter to specify a default
password for authorizedmessage sending. If not set, messages are sent without authorization.

n SMS notifications charset. Defines the character set used to send SMS notification
messages. You can select one of the following character sets:

o UTF-8. The default character set.

o ISO-2022-JP.

Note to HP Software-as-a-Service customers: The settings described in this section
are per customer.

n SMTP server (Windows only). Used to specify the primary SMTP server used. In windows
NT, set as <SMTPSVC> if you want to send using the SMTP service.

n SMTP server port (Windows only). Used to specify the SMTP server port.

n SMTP server socket connection timeout (seconds) (Windows). Use the parameter to
modify the default timeout (60 seconds) after which an SMTP server socket is disconnected.

Note: This is forWindows operating systems only.
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n User for authorized message sending. Use the parameter to specify a default user for
authorizedmessage sending. If not set, messages are sent without authorization.
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Alert Logs
You can use the following logs to debug the CI Status, SLA, and EUM alerts.

Alert Type

Path to Log and
to Properties File for Log
Level Setup Description

All alerts Log: <BSM_data_
processing_
server>\log\alerts\
alerts.ejb.log

Setup: <BSM_data_
processing_server>\conf\
core\Tools\log4j\EJB\
alerts.properties

Alerts and notifications handling in the
MercuryAs process

Log: <BSM_Gateway_
server>\log\alerts\
alerts.reports.log

Setup: <BSM_Gateway_
server>\conf\core\
Tools\log4j\EJB\
alerts.properties

For all alert reports
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Alert Type

Path to Log and
to Properties File for Log
Level Setup Description

CI Status alerts
and SLA alerts

Log: <BSM_data_
processing_server>\log\
marble_worker_
1\status.alerts.log

Setup: <BSM_data_
processing_server>\conf\
core\Tools\log4j\marble_
worker\
cialerts.properties

Alert init and calculation in theMAR
Business Logic Engine worker process

Log: <BSM_data_
processing_server>\log\
marble_worker_
1\status.alerts.downtime.log

Setup: <BSM_data_
processing_server>\conf\
core\Tools\log4j\marble_
worker\
acialerts.properties

Alert downtime handling in theMAR
Business Logic Engine worker process

Log: <BSM_Gateway_
server>\log\alerts\
alertui.log

Setup: <BSM_Gateway_
server>\conf\core\
Tools\log4j\EJB\
alerts.properties

Alert administration
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Alert Type

Path to Log and
to Properties File for Log
Level Setup Description

EUM alerts Log: <BSM_data_
processing_
server>\log\alerts\
alert.rules.log

Setup: <BSM_data_
processing_
server>\conf\core\
Tools\log4j\marble_worker\
alerts-rules.properties

Alert calculation in theMAR Business Logic
Engine worker process

Log: <BSM_data_
processing_
server>\log\alerts\
alerts.rules.init.log

Setup: <BSM_data_
processing_
server>\conf\core\
Tools\log4j\marble_worker\
alerts-rules.properties

Alert initialization in theMAR Business
Logic Engine worker process

Log: <BSM_data_
processing_
server>\log\alerts\
alerts.downtime.log

Setup: <BSM_data_
processing_server>\conf\
core\Tools\log4j\marble_
worker\
alerts-rules.properties

Alert downtime handling in theMAR
Business Logic Engine worker process

Note:When youmodify a log properties file on one of the BSM processing servers, it affects
only the logs on this BSM processing server.
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Alert Details Report
This report displays the triggering information that is available for the alert, including the actual
conditions at the time of the alert.
The following is an example of the Alert Details report.

To access Click in the Configuration Item Status Alerts page, SLA Status Alerts page,
or Alerts Log reports.
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Important
information

For CI Status Alerts, see details about the Alert Details page in Configuration
Item Status Alert Notifications Report in the BSMUser Guide.

For SLA Status Alerts, see details about the Alert Details page in SLA Status
Alert Notifications Report in the BSMUser Guide.

For EUM alerts, see details about the Alert Details page in Alert Details in the
BSMUser Guide.
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Troubleshooting and Limitations
This section describes troubleshooting and limitations for alerts.

Emails Are Not Received by Recipients When an Alert Should Have Been Triggered

If emails are not received by recipients, check the following possibilities:

l The alert definition is not as expected. Check the alert definition in the relevant alert
administration.

l The data does not behave as expected so the alert triggering conditionmight not exist. Check
the alert calculation log or check the specific data origin logs and reports. For details, see "Alert
Logs" on page 405.

l Theremight be a connection problem with the SMTP email server. To check if the server works,
run telnet <smtp_server_host_name_or_IP_nbr> 25.

l The email address of the recipient might not be valid. Examine the recipient definition in the user
interface, andmanually send an email to the recipient to check the address's validity.

l The recipient considers the alert email as spam. Youmight have to ask the recipient's
administrator to reconfigure the spam filter.
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EUM Alerts Notification Templates
To determine the contents and appearance of the EUM alert notices, you can select predefined
templates or configure your own template for notifications.

Alerts notification templates specify the information that BSM includes when it sends various types
of alert notices. The available default templates are pre-configured with selected parameters for
each section of the alert notice. For details on the information included in the default templates, see
"Notification Templates Page" on page 419.

You can also create custom templates. For example, you can create different templates for
different alert notice delivery methods (email, pager, SMS), or for different recipients. A custom
template is defined in the Notification Template Properties page. Each section of the alert notice
includes a list of parameters that you can select. For details on the information that can be included
in a custom template, see "Notification Templates Page" on page 419.

Note for HP Software-as-a-Service customers:Your list of notification templates includes
the default notification templates, the notification templates created for your use by HP
Software-as-a-Service representatives and those created by your organization.
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Clear Alert Notification Templates
When configuring alert schemes, you can set up an alert scheme to automatically send a clear alert
notification. For details on selecting this option while creating your alert scheme, see How to Create
EUM Alert Schemes.

The default template for clear alert notifications is automatically used by BSM. If you do not want
BSM to use the default template, you can create your own clear alert template. The clear alert
templatemust be based on an existing notification template. BSM uses the clear alert notification
template that you create under the following circumstances:

l An alert has been triggered.

l Notification is sent to a recipient based on an existing template (default or user-defined).

l The alert scheme has been configured to send a clear alert.

For details on configuring a clear alert notification template, see "How to Configure a Template for
Clear Alert Notifications" on page 414.
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How to Configure EUM Alerts Notification
Templates

You can select predefined templates, modify existing templates, or create your own notification
templates to determine the contents and appearance of the alert notices. For details on notification
templates, see "EUM Alerts Notification Templates" on page 411.

Create custom templates
BSM gives you the flexibility to create different notification templates for the different alert schemes
and recipients that are defined for your platform.

Every template is divided into sections. You specify the information that you want to appear in each
section. For details, see "Notification Template Properties Dialog Box" on page 415.

Manage existing templates
Over time, youmay find it necessary tomake changes to notification templates that you create,
because of organizational changes, changes in notification policies, changes to service level
monitoring contracts, and so on. You use the Notification Templates page to edit, clone, and delete
notification templates defined in BSM. For details, see "Notification Templates Page" on page 419.
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How to Configure a Template for Clear Alert
Notifications

You can select predefined clear alert notification templates, modify existing templates, or create
your own clear alert notification templates to determine the contents and appearance of the clear
alert notices. For details on notification templates, see "Clear Alert Notification Templates" on page
412.

Note: The notification template selected for the recipient has a clear alert template based on
the notification template's name. For details on naming a clear alert template, see "Notification
Template Properties Dialog Box" on next page. For details on clear alerts, see Advanced
Settings Tab in the BSMUser Guide.

To create, modify, or manage clear alerts notification templates, see "Notification Templates Page"
on page 419.
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EUM Alerts Notification Templates User Interface
This section describes:

l "Notification Template Properties Dialog Box" below

l "Notification Templates Page" on page 419

Notification Template Properties Dialog Box
This dialog box enables you to define a new alerts notification template.

To access l To create a new template: in the Notification Templates page, click theNew
Template button.

l To edit an existing template: in the Notification Templates page, select an

existing template, and click .

Important
information

Clear alert notifications: To set up a clear alert notification, select the
notification template to use as the basis for your clear alert template and clone it.
Make you determination based on the notification templates that was selected for
users likely to receive a clear alert notification. Change the name of the template
by deleting Copy of and adding _FOLLOWUP (all caps, one word). Edit the
template details as required. It is recommended that you include in the Subject of
a clear alert email, the Header, the Alert Specific Information, or both.

Example: If you are creating a clear alert template based on the LONG default
template, you would call the clear alert template LONG_FOLLOWUP. If the clear
alert template is based on a user-defined template calledMyTemplate, name the
clear alert templateMyTemplate_FOLLOWUP.

Default: The _FOLLOWUP string is the default string recognized by BSM as the
template name for a clear alert message.

Customization: You can customize the _FOLLOWUP string. For details, see
"How to Configure a Template for Clear Alert Notifications" on previous page.

Relevant
tasks

"How to Configure a Template for Clear Alert Notifications" on previous page

General Information Area
User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Element
(A-Z) Description

<Insert> Select a parameter to add to the section. Repeat to add as many text parameters as
you want from the list.

Add free text before or after the text parameters. The text parameters available for
this section are:

l Alert Name. The name of the alert, as defined in the alert scheme.

l Severity. The severity label assigned to the alert in the alert scheme.

l HP BSM URL. The URL of the BSMWeb site.

l Entity Name. The name of the CI attached to the alert.

l Entity Type. The type of the CI attached to the alert.

l Alert User Description. The description you specified in the alert scheme.

l Actions Result. A description of the results of the alert actions specified in the
alert scheme.

Message
format

Select the format for themessage: Text orHTML.

Name Enter a name for the template.

If possible, use a descriptive name that includes information on the type of alert
(email, pager, SMS) for which you plan to use the template, or the recipients who
receive alerts using this template.

Subject Specify the information that you want BSM to include in the subject of the email,
pager message, or SMS message.

Use the <insert list for Subject / Header / Footer> to add parameters and free text
to create a customized subject. Use as many parameters as you want from the list.

Header Area
Use this area to specify the information that you want to appear at the top of the alert notice. Select
parameters from the <Insert> list and free text to create a customized header. Use as many
parameters as you want from the list.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Element
(A-Z) Description

<Insert> Select a parameter to add to the section. Repeat to add as many text parameters
as you want from the list.

Add free text before or after the text parameters. The text parameters available for
this section are:

l Alert Name. The name of the alert, as defined in the alert scheme.

l Severity. The severity label assigned to the alert in the alert scheme.

l HP BSM URL. The URL of the BSMWeb site.

l Entity Name. The name of the CI attached to the alert.

l Entity Type. The type of the CI attached to the alert.

l Alert User Description. The description you specified in the alert scheme.

l Actions Result. A description of the results of the alert actions specified in
the alert scheme.

l Entity ID. The ID of the CI attached to the alert.

Alert Specific Information Area
Use this area to add alert information to the notification.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

<insert list for Alert
Specific Information>

Select a text parameter to add to the section. Repeat to add as
many text parameters as you want from the list.

l Trigger Cause. A description of the alert trigger conditions, as
specified in the alert scheme.

l Actual Details. A description of the actual conditions at the
time of the alert.

Transaction Area
Use this area to specify the BMP transaction details relevant only for the BPM alert type.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Element
(A-Z) Description

<Insert> Select a parameter to add to the section. Repeat to add as many text parameters as
you want from the list. Add free text before or after the text parameters. The text
parameters available for this section are:

l Data Collector Name. The name of the data collector running the transaction
related to the alert.

l Script Name. The name of the script containing the transaction related to the
alert.

l Transaction Time. The date and time of the alert.

l Transaction Description. A description of the transaction, if it has been defined
in System Availability Management.

l Transaction Name. The name of the transaction related to the alert.

l Transaction Error. The error message generated by the data collector for the
transaction, if a transaction error occurred at the time of the alert.

l Location Name. The location of the data collector running the transaction related
to the alert.

Footer Area
Use this area to specify the information that you want to appear at the bottom of the alert notice.
Select parameters from the <Insert> list and free text to create a customized footer. Use as many
parameters as you want from the list.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Element
(A-Z) Description

<Insert> Select a parameter to add to the section. Repeat to add as many text parameters
as you want from the list.

Add free text before or after the text parameters. The text parameters available for
this section are:

l Alert Name. The name of the alert, as defined in the alert scheme.

l Severity. The severity label assigned to the alert in the alert scheme.

l HP BSM URL. The URL of the BSMWeb site.

l Entity Name. The name of the CI attached to the alert.

l Entity Type. The type of the CI attached to the alert.

l Alert User Description. The description you specified in the alert scheme.

l Actions Result. A description of the results of the alert actions specified in
the alert scheme.

l Entity ID. The ID of the CI attached to the alert.

Notification Templates Page
This page lists the default templates and any custom template that has been defined. It enables you
tomanage default and custom templates and to create new templates, or to edit clear alert
notification templates.

To access Admin > Platform > Recipients > EUM Notification Templates
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Important
information

When configuring alert schemes, you can instruct BSM to automatically follow up
the alert by sending a clear alert notification. For details on selecting this option
while creating your alert scheme, see "How to Configure a Template for Clear
Alert Notifications" on page 414.

The default template for clear alert notifications is automatically used by BSM. If
you do not want to use that default template, you can create your own clear alert
template. It is recommended to clone an existing notifications template and then
tomodify the cloned template.

BSM uses the clear alert notification template that you create under the following
circumstances:

l An alert has been triggered.

l Notification is sent to a recipient based on an existing template (default or user-
defined).

l The alert scheme has been configured to send a clear alert.

l The notification template (DEFAULT_POSITIVE_FORMAT) selected for the
recipient has a clear alert template based on the notification template's name.

Relevant
tasks

"How to Configure EUM Alerts Notification Templates" on page 413

User interface elements are described below:

UI Element
(A-Z) Description

Click to duplicate notification template. Clones the selected notification
template. The Notification Template Properties dialog box opens where you can
edit the cloded notification. For details, see "Notification Template Properties
Dialog Box" on page 415.

Click to modify notification template properties. Click to edit the selected
template. For details, see "Notification Template Properties Dialog Box" on page
415.

Click to delete notification template. Delete the selected templates
simultaneously.

To delete multiple templates simultaneously, select their check boxes, and click

the button located at the bottom of the templates list.

New
Template

Click theNew Template button to open the Notification Template Properties
dialog box. For details, see "Notification Template Properties Dialog Box" on page
415.
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UI Element
(A-Z) Description

Notification
Template
Name

Lists the default templates and the custom templates. The default templates are:

l DEFAULT_LOG_FORMAT. Includes all the elements needed to create a
default long format notification for reports.

l DEFAULT_POSITIVE_FORMAT. Includes all the elements needed to create
a default long format notification for positive or clear alerts. For details on clear
alerts, see "How to Configure a Template for Clear Alert Notifications" on page
414.

l LONG. Includes all the elements needed to create a default long format
notification.

l SHORT. Includes all the elements needed to create a default short format
notification.

Note: For details on the parameters displayed in each template, see "Notification
Template Properties Dialog Box" on page 415.
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Troubleshooting
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Troubleshooting and Limitations
This section describes common problems that youmay encounter when working in the Platform
Administration area of BSM.

For additional troubleshooting information, use the HP Software Self-solve knowledge base
(h20230.www2.hp.com/selfsolve/documents).

This section includes the following topics:

l "Need to change password for access from data collectors (RUM, TV, BPI, Diagnostics) to
RTSM" below

l "RTSM Administration pages do not load" on next page

l "Troubleshooting and Limitations" above

l "Java applets fail to load" on next page

l "Intermittent UI failures after connecting through Load Balancer" on next page

l "BSM Login page does not appear when connecting through Load Balancer" on next page

l "BSM dialog boxes and applets, such as the AuthenticationWizard, do not load properly" on
next page

l "BSM has been installed, but the Downloads page is empty" on page 425

l "General connectivity problems related to ports" on page 425

l "BSM connectivity is down, but the Tomcat servlet engine and jboss application server appear
to be working" on page 425

l "Inability to log into BSM, and jboss application server fails to initialize" on page 426

l "Browser unable to reach BSM and an error about insufficient heap space" on page 426

l "Browser unable to reach BSM or the .jsp source code appears in the browser window" on page
426

l "BSM is sitting behind a proxy and the server name is not recognized by the proxy" on page 427

l "Host names of Gateway or Data Processing Server has changed" on page 427

l "Processes do not resume restart automatically after automatic failover" on page 427

Need to change password for access from data collectors (RUM, TV, BPI,
Diagnostics) to RTSM
During deployment, you can optionally set anAccess to RTSM password to secure
communication between BSM data collectors (such as Real User Monitor, Business Process
Insight, and TransactionVision), and the Run-time ServiceModel. This password can be changed
later using the JMX console.

To modify the password for RTSM access using the JMX console:

HP Business ServiceManagement (9.20)Page 423 of 427

http://h20230.www2.hp.com/selfsolve/documents


BSM Platform Administration Guide
Chapter 29: Troubleshooting and Limitations

1. Enter the URL of the JMX console (http://<Gateway or Data Processing Server
name>:8080/jmx-console/) in a web browser. (For detailed instructions, see "Using the JMX
Console" on page 24.)

2. Enter your JMX console authentication credentials. If you do not know your authentication
credentials, contact your system administrator.

3. In the Foundations domain, select the serviceRTSM passwords manager.

4. Modify changeDataCollectorsOdbAccessPwd. The operation gets customer ID and new
password as parameters and changes all data collector passwords to the new one.

RTSM Administration pages do not load
If the links from RTSM Administration do not work, this may be caused by one of the following:

l Make sure that the BSMGateway Server is able to access the Default Virtual Server for
Application Users URL. This URL can be found inAdmin > Platform > Setup and
Maintenance > Infrastructure Settings. In the Foundations field, specify Platform
Administration. The URL is located in theHost Configuration table.

l If you are using a reverse proxy or load balancer, make sure you log in through the URL specified
above.

Java applets fail to load with "class not found" error
Make sure that you created a Profile Database. This databasemust be createdmanually in
Platform Administration. For more information, see "Database Administration" on page 68.

Java applets fail to load
OpenControl Panel > Java > Temporary Internet Files > Settings andmake sureKeep
temporary files on my computer is checked. If the problem persists, clear the Java cache by
clickingDelete Files in the same location.

Intermittent UI failures after connecting through Load Balancer
BSM requires sticky sessions for users. Make sure the persistency settings are set to stickiness
by session enabled orDestination Address Affinity (depending on the Load Balancer).

BSM Login page does not appear when connecting through Load
Balancer
l Check the KeepAlive URIs. For more information, see Load Balancing for the Gateway Server.

l Virtual hosts and Load Balancer should be configured with a fully qualified domain name (and not
an IP) for LW-SSO to work.

BSM dialog boxes and applets, such as the Authentication Wizard, do not
load properly
Possible Cause:

Old java files on your client PC.

Solution:

Clear the java cache by following this procedure:
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l Navigate toStart > Control Panel > Java.

l In the Temporary Internet Files section, click Settings.

l In the Temporary File Settings dialog box, click Delete Files.

BSM has been installed, but the Downloads page is empty
Possible Cause:

The components setup files have not been installed to the Downloads page.

Solution:

Install the components setup files to the Downloads page. For details on installing the component
setup files on aWindows platform, see Installing Component Setup Files.

General connectivity problems related to ports
Verify that all ports required by BSM servers are not in use by other applications on the same
machine. To do so, open a Command Prompt window, and run netstat (or use any utility that
enables you to view port information). Search for the required ports.

You can also check the <HPBSM root directory>\log\EJBContainer
\jboss_boot.log for ports in use. If the jboss_boot.log reports "Port <> in use" but you do
not see that this port is in use when you run netstat utility, restart the server and then start BSM.

For details on the ports required by BSM, see Port Usage in the BSMHardening Guide.

Tip: To troubleshoot port usage problems, use a utility that lists all ports in use and the
application that is using them.

BSM connectivity is down, but the Tomcat servlet engine and jboss
application server appear to be working
Connectivity problems include the inability to log into BSM, and the inability of Business Process
Monitor to connect to the Gateway Server.

Possible Cause:

This can happen if the TopazInfra.ini file is empty or corrupt.

To verify that this is the problem:

1. In the browser, type http://<Gateway Server>:8080/web-console to connect to the JMX
Console.

If prompted, enter the JMX Console authentication credentials (if you do not have these
credentials, contact your system administrator).

2. UnderSystem > JMX MBeans > Topaz, select Topaz:service=Connection Pool
Information.

3. Click the showConfigurationSummaryInvoke button toward the bottom of the page. If the
Operation Result page is blank, the TopazInfra.ini file is empty or corrupt.

Solution:
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To solve this problem, rerun the Setup and Database Configuration utility and either reconnect
to your existingmanagement database or define a new management database. If you did not
discover a problem with the TopazInfra.ini file, contact HP Software Support.

Inability to log into BSM, and jboss application server fails to initialize
Run the database schema verify program to verify that the database server on which the
management database is located is up and running. For details, see Database Schema Verification
in the BSMDatabaseGuide.

Browser unable to reach BSM and an error about insufficient heap space
A message box opens indicating that BSM is not available and you should try logging in at a later
time.

Possible Cause 1:

Check log files in <HPBSM root directory>\log directory for errors.

Microsoft's Security Update 921883 forWindows 2003 Service Pack 1 and forWindows XP
Professional x64 Editionmay cause applications usingmore than 700MB of contiguous memory to
fail. BSM JVM uses a heap size larger than 768MB memory. For more information about Security
Update 921883, see http://www.microsoft.com/technet/security/Bulletin/MS06-040.mspx.

If the BSM server goes down, look for the following error in <HPBSM server root
directory>\log\jboss_boot.logwhen the service or process is restarted:

Error occurred during initialization of VM.

Could not reserve enough space for object heap.

Solution:

AlthoughMicrosoft has a hotfix available only for Microsoft Support customers, it is recommend to
wait for the next Service Pack release. For more information about this hotfix, see
http://support.microsoft.com/kb/924054.

If Security Update 921883 is already installed, do the following:

l If the Security Update is not critical at your site:

n Uninstall it and wait for Microsoft's next Service Pack.

n DisableWindows Automatic Updates to prevent Security Update 921883 from being
installed again.

l If the Security Update is critical at your site, install the hotfix.

Possible Cause 2:

The page file size is too small.

Solution:

Configure the page file size to be at least 150% of RAM size. Restart the server.

Browser unable to reach BSM or the .jsp source code appears in the
browser window
A message box opens indicating that the BSM page does not exist.

Solution:
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Ensure that the Jakarta filter path is correct. The pathmight be incorrect—for example, if you
uninstall BSM servers and then reinstall to a different directory. In this case, the Jakarta filter path
is not updated, causing redirection problems.

To update the Jakarta filter path:

1. Open the IIS Internet Services Manager.

2. Right-click themachine name in the tree and select Properties.

3. WithWWW Service displayed in theMaster Properties list, click Edit.

4. Select the ISAPI Filter tab.

5. Select jakartaFilter and click Edit.

6. In the Filter Properties box, update the path to point to the drive and directory of the current
BSM installation.

7. Apply your changes and quit the Internet Services Manager.

8. Restart the IIS service.

BSM is sitting behind a proxy and the server name is not recognized by
the proxy
The problem occurs for bothMicrosoft IIS and ApacheWeb servers.

Possible Cause:

TheWeb server redirects the browser page to a URL that replaces the server name entered by the
user.

Solution:

Add the BSM server name to the <Windows system root
directory>\system32\drivers\etc\hosts file on the proxy server machine.

Host names of Gateway or Data Processing Server has changed
You can no longer access BSM on the server names on which they were installed andmust change
the names of the servers. Refer to the HP Software Self-solve knowledge base, article number
KM522738, which can be accessed at
http://h20230.www2.hp.com/selfsolve/document/KM522738.

Processes do not resume restart automatically after automatic failover
If the High Availability Controller's Automatic Failover mode is enabled and themanagement
database has been down for some time, some processes may be stopped and will not resume
automatically when themanagement database returns to normal operation. These processes will
have the status STARTING on the BSM Status page (<HPBSM root
directory>\AppServer\webapps\myStatus.war\myStatus.html, accessible on theWindows
operating system from Start > Programs > HP Business Service Management >
Administration > HP Business Service Management Status).

Solution:

Restart these processes once themanagement database is available again.
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